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Preface

Intended Audience
Welcome to Release 12 of the Oracle Financials for India User Guide.

This guide assumes you have a working knowledge of the following: 

• The principles and customary practices of your business area. 

• Computer desktop application usage and terminology 

If you have never used Oracle Applications, we suggest you attend one or more of the 
Oracle Applications training classes available through Oracle University. 

See Related Information Sources on page x for more Oracle Applications product 
information. 

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services 
within the United States of America 24 hours a day, seven days a week. For TTY 
support, call 800.446.2398. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading technology 
vendors to address technical obstacles so that our documentation can be accessible to all
of our customers. For more information, visit the Oracle Accessibility Program Web site 



x

at http://www.oracle.com/accessibility/ . 

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise 
empty line; however, some screen readers may not always read a line of text that 
consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 

Structure
1  India Local Inventory
2  India Local Purchasing
3  India Local Payables
4  India Local Order Management
5  India Local Receivables
6  India Local Fixed Assets
7  Trading Functionality
8  India Local Projects
9  India Local iProcurement
10  India Local iSupplier

Related Information Sources
This document is included on the Oracle Applications Document Library, which is 
supplied in the Release 12 DVD Pack. You can download soft-copy documentation as 
PDF files from the Oracle Technology Network at http://otn.oracle.com/documentation, 
or you can purchase hard-copy documentation from the Oracle Store at 
http://oraclestore.oracle.com. The Oracle E-Business Suite Documentation Library 
Release 12 contains the latest information, including any documents that have changed 
significantly between releases. If substantial changes to this book are necessary, a 
revised version will be made available on the online documentation CD on Oracle
MetaLink. 

If this guide refers you to other Oracle Applications documentation, use only the 
Release 12 versions of those guides.

For a full list of documentation resources for Oracle Applications Release 12, see Oracle 
Applications Documentation Resources, Release 12, OracleMetaLink Document 
394692.1.

Online Documentation 
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All Oracle Applications documentation is available online (HTML or PDF).

• PDF - PDF documentation is available for download from the Oracle Technology 
Network at http://otn.oracle.com/documentation.

• Oracle MetaLink Knowledge Browser - The Oracle MetaLink Knowledge Browser 
lets you browse the knowledge base, from a single product page, to find all 
documents for that product area. Use the Knowledge Browser to search for 
release-specific information, such as FAQs, recent patches, alerts, white papers, 
troubleshooting tips, and other archived documents.

• Oracle eBusiness Suite Electronic Technical Reference Manuals - Each Electronic 
Technical Reference Manual (eTRM) contains database diagrams and a detailed 
description of database tables, forms, reports, and programs for a specific Oracle 
Applications product. This information helps you convert data from your existing 
applications and integrate Oracle Applications data with non-Oracle applications, 
and write custom reports for Oracle Applications products. Oracle eTRM is 
available on OracleMetaLink.

Related Guides

You should have the following related books on hand. Depending on the requirements 
of your particular installation, you may also need additional manuals or guides.

Oracle Applications Installation Guide: Using Rapid Install:

This book is intended for use by anyone who is responsible for installing or upgrading 
Oracle Applications. It provides instructions for running Rapid Install either to carry 
out a fresh installation of Oracle Applications Release 12, or as part of an upgrade from 
Release 11i to Release 12. The book also describes the steps needed to install the 
technology stack components only, for the special situations where this is applicable. 

Oracle Applications Upgrade Guide: Release 11i to Release 12: 

This guide provides information for DBAs and Applications Specialists who are 
responsible for upgrading a Release 11i Oracle Applications system (techstack and 
products) to Release 12. In addition to information about applying the upgrade driver, 
it outlines pre-upgrade steps and post-upgrade steps, and provides descriptions of 
product-specific functional changes and suggestions for verifying the upgrade and 
reducing downtime.

Oracle Applications Patching Procedures:

This guide describes how to patch the Oracle Applications file system and database 
using AutoPatch, and how to use other patching-related tools like AD Merge Patch, 
OAM Patch Wizard, and OAM Registered Flagged Files. Describes patch types and 
structure, and outlines some of the most commonly used patching procedures. Part of 
Maintaining Oracle Applications, a 3-book set that also includes Oracle Applications 
Maintenance Utilities and Oracle Applications Maintenance Procedures.

Oracle Applications Maintenance Utilities:
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This guide describes how to run utilities, such as AD Administration and AD 
Controller, used to maintain the Oracle Applications file system and database. Outlines 
the actions performed by these utilities, such as monitoring parallel processes, 
generating Applications files, and maintaining Applications database entities. Part of 
Maintaining Oracle Applications, a 3-book set that also includes Oracle Applications 
Patching Procedures and Oracle Applications Maintenance Procedures.

Oracle Applications Maintenance Procedures:

This guide describes how to use AD maintenance utilities to complete tasks such as 
compiling invalid objects, managing parallel processing jobs, and maintaining snapshot 
information. Part of Maintaining Oracle Applications, a 3-book set that also includes 
Oracle Applications Patching Procedures and Oracle Applications Maintenance 
Utilities.

Oracle Applications Concepts:

This book is intended for all those planning to deploy Oracle E-Business Suite Release 
12, or contemplating significant changes to a configuration. After describing the Oracle 
Applications architecture and technology stack, it focuses on strategic topics, giving a 
broad outline of the actions needed to achieve a particular goal, plus the installation and
configuration choices that may be available.

Oracle Applications Multiple Organizations Implementation Guide:

This guide describes the multiple organizations concepts in Oracle Applications. It 
describes in detail on setting up and working effectively with multiple organizations in 
Oracle Applications.

Oracle Assets User Guide:

This guide provides you with information on how to implement and use Oracle Assets. 
Use this guide to understand the implementation steps required for application use, 
including defining depreciation books, depreciation method, and asset categories. It 
also contains information on setting up assets in the system, maintaining assets, retiring
and reinstating assets, depreciation, group depreciation, accounting and tax accounting,
budgeting, online inquiries, impairment processing, and Oracle Assets reporting. The 
guide explains using Oracle Assets with Multiple Reporting Currencies (MRC). This 
guide also includes a comprehensive list of profile options that you can set to customize
application behavior.

Oracle Bills of Material User's Guide:

This guide describes how Oracle Manufacturing and Oracle Order Management use 
bills of material to store lists of items that are associated with a parent item and 
information about how each item is related to its parent. Oracle Manufacturing 
supports standard, model, option class, and planning bills of material.

Oracle Cash Management User Guide:

This guide describes how to use Oracle Cash Management to clear your receipts, as well
as reconcile bank statements with your outstanding balances and transactions. This 
manual also explains how to effectively manage and control your cash cycle. It provides
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comprehensive bank reconciliation and flexible cash forecasting.

Oracle E-Business Tax User Guide:

This guide describes the entire process of setting up and maintaining tax configuration 
data, as well as applying tax data to the transaction line. It describes the entire 
regime-to-rate setup flow of tax regimes, taxes, statuses, rates, recovery rates, tax 
jurisdictions, and tax rules. It also describes setting up and maintaining tax reporting 
codes, fiscal classifications, tax profiles, tax registrations, configuration options, and 
third party service provider subscriptions. You also use this manual to maintain 
migrated tax data for use with E-Business Tax.

Oracle E-Business Tax Implementation Guide:

This guide provides a conceptual overview of the E-Business Tax, tax engine, and 
describes the prerequisite implementation steps to complete in other applications in 
order to set up and use E-Business Tax. The guide also includes extensive examples of 
setting up country-specific tax requirements.

Oracle Financials and Oracle Procurement Functional Upgrade Guide: Release 11i to 
Release 12: 

This guides provides detailed information about the functional impacts of upgrading 
Oracle Financials and Oracle Procurement products from Release 11i to Release 12. This 
guide supplements the Oracle Applications Upgrade Guide: Release 11i to Release 12.

Oracle Financials Concepts Guide:

This guide describes the fundamental concepts of Oracle Financials. The guide is 
intended to introduce readers to the concepts used in the applications, and help them 
compare their real world business, organization, and processes to those used in the 
applications.

Oracle Financials Country-Specific Installation Supplement:

This guide provides general country information, such as responsibilities and report 
security groups, as well as any post-install steps required by some countries.

Oracle Financials for India Implementation Guide:

This guide provides information on how to implement Oracle Financials for India. Use 
this guide to understand the implementation steps required for application use, 
including how to set up taxes, tax defaulting hierarchies, set up different tax regimes, 
organization and transactions.

Oracle Financials Glossary:

The glossary includes definitions of common terms that are shared by all Oracle 
Financials products. In some cases, there may be different definitions of the same term 
for different Financials products. If you are unsure of the meaning of a term you see in 
an Oracle Financials guide, please refer to the glossary for clarification. You can find the
glossary in the online help or in the Oracle Financials Implementation Guide.

Oracle General Ledger Implementation Guide:
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This guide provides information on how to implement Oracle General Ledger. Use this 
guide to understand the implementation steps required for application use, including 
how to set up Accounting Flexfields, Accounts, and Calendars.

Oracle General Ledger Reference Guide:

This guide provides detailed information about setting up General Ledger Profile 
Options and Applications Desktop Integrator (ADI) Profile Options.

Oracle General Ledger User's Guide:

This guide provides information on how to use Oracle General Ledger. Use this guide 
to learn how to create and maintain ledgers, ledger currencies, budgets, and journal 
entries. This guide also includes information about running financial reports.

Oracle HRMS Implementation Guide

This guide includes modular implementation flowcharts and checklists to assist with 
our project planning. It contains a summary of the sequence of recommended steps for 
implementing Oracle HRMS. The Oracle Human Resources and Oracle Payroll User's 
Guides contains full instructions for each implementation step.

Oracle Inventory User's Guide:

This guide describes how to define items and item information, perform receiving and 
inventory transactions, maintain cost control, plan items, perform cycle counting and 
physical inventories, and set up Oracle Inventory.

Oracle Order Management User's Guide:

This guide describes how to enter and process various types of orders in Order 
Management. It also provides information on the key integration points like workflow, 
pricing, shipping, receivables. Order Management receives detailed item information 
from the Inventory application and price list information from the Pricing application. 
Orders and returns can be entered manually or imported through an EDI, CRM, or 
external source. Once in the system the order is ready to be pick released and shipped, 
if needed by the Shipping application. It can then proceed through the AutoInvoice 
program into the Oracle Receivables application to be invoiced. All of the accounting 
information is transferred to the General Ledger by the Inventory and Receivables 
applications.

Oracle Order Management Implementation Manual:

The Oracle Order Management Suite enables you to capture orders from multiple 
channels, price orders, check product availability, schedule fulfillment, plan shipments, 
ship deliveries, and track shipments. The Oracle Order Management Suite consists of: a)
Oracle Order Management; b) Oracle Shipping Execution; c) Basic Pricing.

Oracle Payables User Guide:

This guide describes how to use Oracle Payables to create invoices and make payments.
In addition, it describes how to enter and manage suppliers, import invoices using the 
Payables open interface, manage purchase order and receipt matching, apply holds to 
invoices, and validate invoices. It contains information on managing expense reporting, 
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procurement cards, and credit cards. This guide also explains the accounting for 
Payables transactions.

Oracle Payables Implementation Guide:

This guide provides you with information on how to implement Oracle Payables. Use 
this guide to understand the implementation steps required for how to set up suppliers,
payments, accounting, and tax.

Oracle Payables Reference Guide:

This guide provides you with detailed information about the Oracle Payables open 
interfaces, such as the Invoice open interface, which lets you import invoices. It also 
includes reference information on purchase order matching and purging purchasing 
information.

Oracle Payments Implementation Guide:

This guide describes how Oracle Payments, as the central payment engine for the 
Oracle E-Business Suite, processes transactions, such as invoice payments from Oracle 
Payables, bank account transfers from Oracle Cash Management, and settlements 
against credit cards and bank accounts from Oracle Receivables. This guide also 
describes how Oracle Payments is integrated with financial institutions and payment 
systems for receipt and payment processing, known as funds capture and funds 
disbursement, respectively. Additionally, the guide explains to the implementer how to 
plan the implementation of Oracle Payments, how to configure it, set it up, test 
transactions, and how use it with external payment systems.

Oracle Payments User Guide:

This guide describes how Oracle Payments, as the central payment engine for the 
Oracle E-Business Suite, processes transactions, such as invoice payments from Oracle 
Payables, bank account transfers from Oracle Cash Management, and settlements 
against credit cards and bank accounts from Oracle Receivables. This guide also 
describes to the Payment Administrator how to monitor the funds capture and funds 
disbursement processes, as well as how to remedy any errors that may arise.

Oracle Process Manufacturing Process Execution User's Guide:

The OPM Process Execution application lets you track firm planned orders and 
production batches from incoming materials through finished goods. Seamlessly 
integrated to the Product Development application, Process Execution lets you convert 
firm planned orders to single or multiple production batches allocate ingredients, 
record actual ingredient usage, and then complete and close production batches. 
Production inquiries and preformatted reports help you optimize inventory costs while 
maintaining a high level of customer satisfaction with on time Delivery of high quality 
products. The OPM Process Execution User's Guide presents overviews of the tasks and
responsibilities for the Production Supervisor and the Production Operator. It provides 
prerequisite setup in other applications, and details the windows, features, and 
functionality of the OPM Process Execution application.

Oracle Purchasing User's Guide:
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This guide describes how to create and approve purchasing documents, including 
requisitions, different types of purchase orders, quotations, RFQs, and receipts. This 
guide also describes how to manage your supply base through agreements, sourcing 
rules, and approved supplier lists. In addition, this guide explains how you can 
automatically create purchasing documents based on business rules through integration
with Oracle Workflow technology, which automates many of the key procurement 
processes.

Oracle Receivables User Guide:

This guide provides you with information on how to use Oracle Receivables. Use this 
guide to learn how to create and maintain transactions and bills receivable, enter and 
apply receipts, enter customer information, and manage revenue. This guide also 
includes information about accounting in Receivables. Use the Standard Navigation 
Paths appendix to find out how to access each Receivables window.

Oracle Receivables Implementation Guide:

This guide provides you with information on how to implement Oracle Receivables. 
Use this guide to understand the implementation steps required for application use, 
including how to set up customers, transactions, receipts, accounting, tax, and 
collections. This guide also includes a comprehensive list of profile options that you can
set to customize application behavior.

Oracle Receivables Reference Guide:

This guide provides you with detailed information about all public application 
programming interfaces (APIs) that you can use to extend Oracle Receivables 
functionality. This guide also describes the Oracle Receivables open interfaces, such as 
AutoLockbox which lets you create and apply receipts and AutoInvoice which you can 
use to import and validate transactions from other systems. Archiving and purging 
Receivables data is also discussed in this guide.

Oracle Shipping Execution User's Guide:

This guide describes how to set up Oracle Shipping Execution to process and plan your 
trips, stops and deliveries, ship confirmation, query shipments, determine freight cost 
and charges to meet your business needs.

Oracle Trading Community Architecture User Guide:

This guide describes the Oracle Trading Community Architecture (TCA) and how to 
use features from the Trading Community Manager responsibility to create, update, 
enrich, and cleanse the data in the TCA Registry. It also describes how to use Resource 
Manager to define and manage resources.

Oracle Trading Community Architecture Administration Guide:

This guide describes how to administer and implement Oracle Trading Community 
Architecture (TCA). You set up, control, and manage functionality that affects data in 
the TCA Registry. It also describes how to set up and use Resource Manager to manage 
resources.
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Oracle Trading Community Architecture Reference Guide:

This guide contains seeded relationship types, seeded Data Quality Management data, 
D&B data elements, Bulk Import interface table fields and validations, and a 
comprehensive glossary. This guide supplements the documentation for Oracle Trading
Community Architecture and all products in the Oracle Customer Data Management 
family.

Oracle Trading Community Architecture Technical Implementation Guide:

This guide explains how to use the public Oracle Trading Community Architecture 
application programming interfaces (APIs) and develop callouts based on Oracle 
Workflow Business Events System (BES). For each API, this guide provides a 
description of the API, the PL/SQL procedure, and the Java method, as well as a table of
the parameter descriptions and validations. For each BES callout, this guide provides 
the name of the logical entity, its description, and the ID parameter name. Also 
included are setup instructions and sample code.

Integration Repository
The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your 
instance is patched, the repository is automatically updated with content appropriate 
for the precise revisions of interfaces in your environment. 

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data unless 
otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your 
data and you lose the ability to audit changes to your data. 

Because Oracle Applications tables are interrelated, any change you make using an 
Oracle Applications form can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your tables 
get out of synchronization with each other, you risk retrieving erroneous information 
and you risk unpredictable results throughout Oracle Applications. 

When you use Oracle Applications to modify your data, Oracle Applications 
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automatically checks that your changes are valid. Oracle Applications also keeps track 
of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
India Local Inventory

This chapter covers the following topics:

• Miscellaneous Transactions Overview

• Inventory & WIP Transactions Overview

• Organization Information Setup

• Defining Value Added Tax Regime

• Defining TCS Regime

• Service Tax by Inventory Organization and Service Type

• Inter Organization Transfer

• Defining Item Information

• Setting Up Tax Information

• Managing India Local Inventory

• RG - I Register Entry

• RG 23 Register Entry

• Apply Time Extension

• Master Organization RG Consolidation

• View Register Balance

• View Item Definition

• Outside Processing Transaction

• Processing Inter Organization Transfer Transactions

• Reports
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Miscellaneous Transactions Overview
You can use the Miscellaneous Transactions to register effect of Inventory movements 
on Excise Registers. You can record Inventory Issues and Receipts to and from 
production using Miscellaneous Issue/Receipt (RG Update) and the respective Excise 
Inventory Registers are updated with these transactions.

Inventory & WIP Transactions Overview
Oracle Financials for India supports certain transactions to track movement of Excise 
Goods. Whenever there is a Transaction using Excise goods is created from the 
following features supported by Base Application, then Oracle Financials for India 
updates Excise Quantity Registers - RG 1 in case of finished goods, RG 23 A for raw 
materials and RG 23 C Part 1 for capital goods. Following is a list of such transactions 
and their impact on Excise Registers:

Transaction 
Type

RMIN CCIN FGIN CGIN OTIN

Miscellaneous 
Receipt RG 
Update

RG 23A Part 1 RG 1 RG 1 RG 23C Part 1 NA

Miscellaneous 
Issue RG Update

RG 23A Part 1 First RG 23A 
Part 1, then RG 1

RG 1 RG 23C Part 1 NA

Cycle Count 
Adjustment. 

RG 23A Part 1 RG 23A Part 1 RG 1 NA NA

Physical 
Inventory 
Adjustment. 

RG 23A Part 1 RG 23A Part 1 RG 1 RG 23C Part 1 NA

Move Order 
Issue

RG 23A Part 1 RG 1 RG 1 RG 23 C Part 1 NA

WIP Component
Return.

RG 23A Part 1 RG 1 RG 1 NA NA 

WIP Assembly 
Completion. 

RG 23A Part 1 RG 1 RG 1 NA NA 
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Transaction 
Type

RMIN CCIN FGIN CGIN OTIN

WIP Assembly 
Return. 

RG 23A Part 1 RG 1 RG 1 NA NA 

WIP Negative 
Component 
Issue. 

RG 23A Part 1 RG 1 RG 1 NA NA 

WIP Negative 
Component 
Return. 

RG 23A Part 1 RG 1 RG 1 NA NA 

WIP Scrap 
Transaction. 

RG 23A Part 1 RG 1 RG 1 NA NA 

Staging transfer 
of a sales order 

RG 23A Part 1 RG 1 RG 1 NA NA 

Organization Information Setup
This section describes the setup procedures for Oracle Financials for India Inventory. 
You must enter the setup information for your company before using Inventory, 
Purchasing, Order Management and Receivables Modules of Oracle Financials for 
India.

1. Additional Organization Information, page 1-4

2. Define Tax Information, page 1-4

3. Define Trading Registration Details, page 1-8

4. Define Accounting Information, page 1-8

5. Define Organization Preferences, page 1-15

6. Define Tax Calendar, page 1-18

7. Define Excise Invoice Generation, page 1-19

8. Define Sub Inventory Locations, page 1-23
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Defining Additional Organization Information
The inventory organization information available in Additional Organization 
Information is the basic data for all Oracle Financials for India activities and accounting.
Define an Organization and Location through the Standard Application Form. Define 
Additional Information for an Organization Location and each Organization's Location 
will be identified as an Excise/Tax Unit.

While creating the Additional Organization Information, it is mandatory to create two 
sets of records, one at null location level and another with location. If multiple 
organizations are defined within the same excise registered premises, you can opt to 
identify one Organization and Location combination as "Master Organization" and all 
others will be treated as child organizations and should have the reference of the Master
Organization based on ECC code. In such setup, the Master Organization will be the 
Organization where Excise Registers are generated only from the Master Organization.

Important: The master-child relationship is used only to generate 
consolidated Excise Registers at Master Organization level. You need to
submit 'India Master Org RG' request set to consolidate Excise Registers
at Master Organization.

Prerequisites

Before you enter the Organization Additional Information, you must:

1. Define Organizations

2. Define Locations

3. Assign Organizations to Locations

Defining Tax Information
In Oracle Financials for India, navigate to the Organization Tax Information window 
from Setup > Organization > Addition Information. The table provides a detailed 
field-wise description of the screen:

Field Description Type Action Description

Organization 
Name/Location

(Required) EDIT / HELP / 
PICK

The user -defined Inventory 
Organization name needs to be 
picked up from list of values for 
which the Additional Information is 
going to be incorporated. You must 
create a 
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Field Description Type Action Description

Master Organization 
Information Block

     

Master Organization 
Flag

    This check box decides whether the 
Organization is a Master 
Organization or a Child 
Organization. If it is a Child 
Organization, this needs to be 
attached to the Master Organization.
Consolidated Excise Registers can be
generated from the Master 
Organization.

Important: In the Master Organization Information block you have to 
specify whether the Organization represents an Excise Licensed 
Organization or a Child Organization. If you select a Child 
Organization, you need to specify the Excise Licensed Organization 
that the Child Organization belongs to. For a Master Organization and 
Location combination enable the Master Organization Flag with 
Location specified. The ECC number defined for the Master 
Organization defaults to all Child Organizations when Master 
Organization is selected.

Field Description Type Action Description

Excise Block     The following information is related 
to Excise Registration for an 
Inventory Organization Location 
which is of Manufacturing or 
Trading organization. If No Values 
are entered in this block, then the 
Organization Location is considered 
as Trading organization. 

Excise Range (Optional)   Details of the Jurisdictional Central 
Excise Range Office of the 
Organization can be entered in this 
block. Values given in this field will 
be taken while printing all Excise 
related documents.
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Field Description Type Action Description

Excise Division (Optional)   Details of the jurisdictional Central 
Excise Division Office of the 
Organization can be entered in this 
block. Values given in this field will 
be taken while printing all Excise 
related documents.

Excise Registration 
Number 

(Optional)   Central Excise Registration 
Certificate Number can be entered in
this field. This information will be 
taken while printing all Excise 
related documents. 

Excise Zone (Optional)   This is an additional field provided 
where in the user can record some 
information which he needs to print 
in all excise related documents.

Excise Region (Optional)   This is an additional field provided 
where in the user can record some 
information which he needs to print 
in all excise related documents.

Excise Circle (Optional)   This is an additional field provided 
where in the user can record some 
information which he needs to print 
in all excise related documents.

Excise Collectorate (Optional)   Details of the jurisdictional office of 
the Central Excise Commissioner of 
the Organization can be entered in 
this block. Values given in this field 
will be taken while printing all 
Excise related documents. 

EC Code (Optional)   Use this field to enter Excise Control 
Code of an Inventory Organization 
Location. This would be printed on 
all the documents that are required 
under Excise Rules.
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Field Description Type Action Description

Excise Invoice at ECC
Code

(Optional)   Check this field in case you wish to 
generate Excise Invoice at Master 
Organization level.

In case you have multiple internal 
Inventory Organizations / 
Warehouses existing within the 
same Excise registered premises and
if you opt for Excise Invoice number 
generation at the Master 
Organization level then, check this 
option child organization location.

Export Oriented Unit (Optional)   Use this field to indicate whether the
Organization / Location is a Export 
Oriented Unit. On checking this flag 
the CENVAT liability arising on 
shipment would be matched 
component-wise with the credit 
available for that Excise Component.
You would not be able to complete 
shipment if the credit available for 
Excise Component is inadequate. 

Sales Tax Block      

CST Reg. No. (Optional)   Use this field to enter Central Sales 
Tax Registration Number of an 
Inventory Organization Location. 
This would be printed on all the 
documents that are required under 
Sales Tax Act.

LST Reg. No (Optional)   Use this field to enter State Sales Tax
Registration Number of an 
Inventory Organization Location. 
This would be printed on all the 
documents that are required under 
Sales Tax Act.

Income Tax Block (Optional)    
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Field Description Type Action Description

PAN No     Use this field to enter Permanent 
Account No of an Inventory 
Organization Location. This would 
be printed on all the documents that 
are required under Income Tax Act.

TAN No (Optional)   Use this field to enter TDS Account 
No of an Inventory Organization 
Location. This would be printed on 
all the documents that are required 
under Income Tax Act.

WARD No (Optional)   Use this field to enter Ward No of an
Inventory Organization Location. 
This would be printed on all the 
documents that are required under 
Income Tax Act.

VAT Reg No. (Optional)   Use this field to enter VAT 
Registration No of an Inventory 
Organization Location.

Important: If an Inventory Organization Location is a Manufacturing 
unit (not Trading) and you enter details in the Tax Info Block, then you 
will not be allowed to enter any information in the Excise - Trading 
Information Block through Trading Information Tab.

Defining Trading Registration Details
For information on defining trading registration details, refer to Trading Inventory 
Organization Setup, page 7-3.

Defining Accounting Information for Organization
Ensure that you specify appropriate general ledger accounts in the Accounts 
Information tab. This information will be used to account for Localization transactions. 
All fields are mandatory. Each of these fields is discussed in detail below.

Prerequisites

Before you enter the Accounts Information > Additional Organization Information, you 
must:
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• Define Organizations

• Define Locations

• Organization Additional Information 

In Oracle Financials for India, navigate to Setup > Organization > Additional 
Organization Information > Accounting Info. The table provides a detailed field-wise 
description of the screen:

Field Description Type Action Description

Excise Account 
Information Block

    These accounting information are 
necessary for an Inventory 
Organization through which all the 
charges related to an item on taxes 
will charged to respective 
accounting flex fields. The user 
needs to define separate accounting 
flexfields for OSP Excise a/c, Excise 
expenses, Excise receivable, 
CENVAT on Raw Material, 
CENVAT on Capital Goods, 
Personal Ledger Account, Excise - 
RG23D, Bill of entry, Scrap cost, 
CENVAT Reversal, Customs write 
off a/c.

OSP Excise (Required) PICK HELP 
EDIT 

This account will be used to pay the 
Excise Duty on goods sent for 
Outside Processing (OSP). This is 
usually a Expenses Account.

Excise Expenses (Required) PICK HELP 
EDIT 

Enter a General Ledger Account for 
Excise Expenses Account. This 
default account is being used to 
track the Excise duty due from the 
excise department on account of 
customer returns treated as FG 
return or scrap.
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Field Description Type Action Description

Excise Payable/paid (Required) PICK HELP 
EDIT 

Enter a default General Ledger 
account to be defaulted on all AR 
transaction entry windows for 
Accounting Excise Duty paid on 
delivery of goods. This account will 
debit for the total Excise amount 
whenever shipment is confirmed to 
a customer and AR Invoice is raised.

CENVAT RM (Required) PICK HELP 
EDIT 

Enter a General Ledger account to 
be defaulted on all transaction entry 
windows for CENVAT Raw 
Material account. This is the default 
GL account that will hit while 
performing a receipt with CENVAT 
Credit (inputs) This is usually an 
asset account. This account would 
be credited on shipment when the 
excise liability arising from the 
shipment transaction is met by 
utilizing the Cess credit available in 
RG 23 A Register.

CENVAT CG (Required) PICK HELP 
EDIT 

Enter a General Ledger account to 
be defaulted on all transaction entry 
windows for CENVAT Capital 
Goods account. This is the default 
GL account that will hit while 
performing a receipt with CENVAT 
credit (Capital Goods). This is 
usually an asset account. This 
account would be credited on 
shipment when the excise liability 
arising from the shipment 
transaction is met by utilizing the 
Cess credit available in RG 23 A 
Register.



India Local Inventory    1-11

Field Description Type Action Description

PLA Register (Required)   Enter a General Ledger account to 
be defaulted for Payment towards 
Excise Duty through TR - 6 Challan. 
Whenever the payment to Excise is 
made through the PLA Invoice/RG 
Consolidation screen will update 
this ledger account. This will also 
consider the PLA debit entries done 
through ship confirm transactions 
and AR Localized transactions.

Bill of Entry (Required ) PICK HELP 
EDIT 

Enter a General Ledger account to 
be defaulted on creation of Bill of 
Entry and on applying Bill of Entry 
to Receipt this GL account gets 
credited. This is usually an asset 
account. 

Excise RG23D (Required) PICK HELP 
EDIT 

Excise Duty Account for trading 
item and this account will be 
updated for transaction happened in
a Trading Organization Location.

CENVAT Reversal (Required) PICK HELP 
EDIT 

This CENVAT Reversal a/c will be 
updated for Reversal entry passed 
on account of Excise Exemption & 
CT2 form transactions in an 
Inventory Organization Location. 

CENVAT Receivable (Required) PICK HELP 
EDIT 

The user needs to define a GL 
Account of Asset type that needs to 
hit while performing CENVAT 
credit transactions for the Capital 
Goods. As per the provisions of 
Excise Rules, the manufacturer is 
permitted only to take 50% of the 
duty paid on Capital Goods at the 
time of receipt and the balance can 
be availed in the succeeding 
financial year. The amount that 
needs to be claimed later will be 
accounted in this ledger account.
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Field Description Type Action Description

Customs write off (Required) PICK HELP 
EDIT 

This Customs write off a/c will be 
updated for a written off amount 
from Bill of Entry a/c when ever 
amount is written off from BOE.

RG Excise Rounding (Required) PICK HELP 
EDIT

This field would be updated with 
the differential duty that needs to be
adjusted in setting Excise Duty 
amount to the nearest rupee.

Cess Accounts 
Information Block

    The information specified in this 
block would be used to account for 
the Cess on Excise taxes applicable 
to transactions in Procurement and 
Sale.

Cess Paid Payable (Required) PICK HELP 
EDIT

Specify a General Ledger account to 
be used in accounting for shipment 
Education Cess on Excise involved 
in Shipment transactions.

This account would be debits with 
the total Education Cess (on Excise) 
amount. While, the corresponding 
Duty Register account would be 
credited.

CESS RM (Required) PICK HELP 
EDIT

Specify a General Ledger account 
that would be used to Account for 
the Education Cess recovered on 
purchase of raw material. This 
account would be credited on 
shipment when the excise liability 
arising from the shipment 
transaction is met by utilizing the 
Cess credit available in RG 23 A 
Register.
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Field Description Type Action Description

CESS CG (Required) PICK HELP 
EDIT

Specify a General Ledger account 
that would be used to Account for 
the Education Cess recovered on 
purchase of Capital Goods. This 
account would be credited on 
shipment when the excise liability 
arising from the shipment 
transaction is met by utilizing the 
Cess credit available in RG 23 C 
Register.

Excise Cess Rounding (Required) CHECK BOX Specify an account that would be 
used in accounting the rounding 
differences arising from the 
Education Cess on Purchasing 
transactions.

This account would be debited 
when the Cess rounding amount for 
the Excise Invoice is a negative 
amount. Similarly, this account 
would be credited when the Cess 
rounding amount for the Excise 
Invoice is a positive amount.

CESS Receivable 
Account

(Required) PICK HELP 
EDIT

The GL Account specified here 
would be used in accounting for 
Cess included in purchase of Capital
Goods.

As per the CENVAT Credit Rules, 
the manufacturer is permitted only 
to take 50% of the duty paid on 
capital goods at the time of receipt 
and the balance can be availed in the
succeeding financial year. The 
amount that needs to be claimed 
later will be debited in this account.

Secondary and 
Higher Education 
Cess Information 
Block

    The information specified in this 
block would be used to account for 
the Secondary and Higher 
Education Cess on Excise taxes 
applicable to transactions in 
Procurement and Sales Module.
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Field Description Type Action Description

SHE Cess Paid 
Payable

Required PICK HELP 
EDIT

Specify a general ledger account to 
be used in accounting for Secondary 
and Higher Education Cess on 
Excise involved in Shipment 
transactions.

SHE Cess RM Required PICK HELP 
EDIT

Specify a general ledger account that
would be used to Account for the 
SHE Cess recovered on purchase of 
raw material. This account would be
credited when the excise liability 
arising from the shipment 
transaction is met by utilizing the 
SH Education Cess credit available 
in RG 23 A Regsiter.

SHE Cess CG Required PICK HELP 
EDIT

Specify a general ledger account that
would be used to Account for the 
SHE Cess recovered on purchase of 
Capital Goods. This account would 
be credited when the excise liability 
arising from the shipment 
transaction is met by utilizing the 
SH Education Cess credit available 
in RG 23 C Regsiter.

SHE Cess Receivable Required PICK HELP 
EDIT

The GL Account specified here 
would be used in accounting for 
Secondary and Higher Education 
Cess on purchase of Capital Goods 
for the deffered portion. 

As per the CENVAT Credit Rules, 
the manufacturer is permitted only 
to take 50% of the duty paid on 
capital goods at the time of receipt 
and the balance can be availed in the
succeeding financial year. The 
amount that needs to be claimed 
later will be debited in this account.
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Field Description Type Action Description

SHE Cess Rounding Required CHECKBOX Specify an account that would be 
used in accounting the rounding 
differences arising from the SHE 
Cess on Purchasing transactions. 

This account would be debited 
when the SHE Cess rounding 
amount for the Excise Invoice is a 
negative amount. Similarly, this 
account would be credited when the
Secondary and Higher Education 
Cess rounding amount for the Excise
Invoice is a positive amount.

Expense Excise Taxes 
on RTV

Debit this field with different duties 
to be paid in an RTV Transaction. 
You should have also checked the 
RTV Account Flag checkbox in this 
window. This account is also 
debited with third-party customs 
and CVD tax amounts included in 
the RTV transaction.

Defining Organization Preferences
Organization Preferences check whether a specific transaction is carried out within the 
stipulated time span specified by relevant tax laws. You can enter the data to control the
transaction from the respective tax point of view.

Field Description Type Action Description

Parameters Block      

OSP Return days (Optional)   Enter the number of days within 
which the OSP goods should come 
back to the Inventory Organization 
under 57F4. As per the Excise Rule it
is 180 days. 
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Field Description Type Action Description

OSP Excise 
percentage

(Optional)   Enter the rate of Excise duty 
charged for an OSP transaction. 
Since there is no need to pay duty 
while sending goods. While sending
goods for sub contracted operations,
the user needs to input zero in this 
field. If any other value is given in 
this fields, appropriate duty will get 
calculated whenever he cuts a 57 F4 
Challan.

Important: Since no duty needs 
to be paid while sending goods 
for sub contracting, user needs to
ensure that the value against this 
field is always 0.

Days allowed for 
173(L)

(Optional)   Enter the number of days allowed 
for a transaction under 173(L) of 
Excise Act in the case of Sales 
Return.

Sales tax return days (Optional)   Enter the number of days within 
which the Sales Return Goods 
should reach the Inventory 
Organization from the date of Sale 
as per Sales Tax Act. As per the 
Sales Tax Act, it is 180 days.

MODVAT Reversal 
(%) 

(Optional)   This value is the default percentage, 
which will be considered by the 
system whenever it performs a duty
debit under Rule 57 CC of the 
Central Excise Rules. You should 
enter the CENVAT recovery 
percentage in this field. For 
example, currently, the percentage 
of CENVAT recovered is 8% on all 
excise exempted transaction. Thus, 8
should be entered into this field. 
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Field Description Type Action Description

Defining Register 
Preferences 

This parameter decides the 
preference of hitting the duty 
payment register while performing 
a ship confirm transaction in Order 
Management or a Transaction 
Localized in the AR Module. You 
are not permitted to debit duty from
different duty paying registers for a 
single transaction.

VAT Return Days Enter the number of days within 
which the sales return goods should
reach the Inventory Organization 
from the date of delivery as per 
VAT act in each state.

Receipts Block

Update Qty register 
Event

This event lets you update the 
Quantity register on Receive and 
Amount register on claim of 
CENVAT.

• Allow Tax Change on WMS 
Receipts

• Allow Tax Change on Receipts

• Allow Tax Change on ROI 
Receipts

Bill only workflow 
Block

     

Default Location (Required)   This is mainly required for bill only 
workflows for determining location.

Negative balance in 
PLA

     

If the balance available in each of the CENVAT Registers and PLA is less than Excise 
Duty liability arising from the ship confirms transaction, then the 'Interface Trip Stop' 
request completes with error and the shipment transaction remains incomplete. In case 
of monthly Excise settlement, you can ship the goods with inadequate CENVAT Credit. 
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To meet such situations you can enable 'allow negative balance in PLA' and set PLA 
preference to 1. On doing this, all excise payments are done through PLA register and 
periodic adjustments towards payment of excise duty can be done through RG 
Consolidation screen. In such type of setup, the CENVAT registers will have entries 
only for the credit availed and the adjustments made while computing the exact excise 
liability (fund transfer from CENVAT register to PLA register).

Important: You should get necessary concurrence from the local excise 
authorities before rolling down with the new system.

On RTV, the registers will be updated based on the preferences.

Defining Tax Calendar
As part of Localization setup you need to define the Tax calendar. Excise Registers will 
be updated only for the Active Period. Only one period can be active at a time.

Prerequisites

Before you enter the Tax Calendar - Organization Additional Information, you must:

• Define Organizations

• Define Locations

• Organization Additional Information

• Define Bond Register

In Oracle Financials for India, navigate to Setup > Organization > Additional 
Information > Tax Calendar. If this checkbox is enabled, you can overdraw from the 
PLA Balance available. If this option is not enabled the system will hold shipments for 
want of funds in PLA.
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Field Description Type Action Description

Organization Name / 
Location

(Displayed)   The Inventory Organization / Location will 
be displayed from the Organization Tax 
Information.

Important: The Tax Calendar should be 
defined only at Organization level with 
null location. This calendar will be 
defaulted for each location falling under 
the Organization. The tax period in 
Localization is meant for setting up the 
Serial Numbers of Excise Registers and 
related Localization Reports. 

Year/Start Date/End date (Required)   The user needs to specify the year and the 
starting and ending date for that tax year.

You can define the next Tax Calendar year using the Open Next Year Button, which 
triggers a concurrent process that sets the next year as the active year for which the 
taxes will be accounted. While entering this Tax Calendar, if you select the next Open 
period accidentally, then the Active Flag gets enabled for the next year and it cannot be 
changed.

Defining Excise Invoice Generation
To generate Excise Invoices with pre-definable prefixes (Alpha/Numeric), you need to 
complete Excise Invoice Generation Setup. If this setup is not done, system will generate
only two series of Excise Invoices, one for Domestic Clearances and the other for Export
Clearances and no prefixes for the numbers generated can be maintained.

Prerequisites

Before you enter the Excise Invoice Generation - Organization Additional Information, 
you must:

• Define Organizations

• Define Locations

• Organization Additional Information 

In Oracle Financials for India, navigate to India Local Inventory > Organization 
Additional Information.

1. Query for the Organization Location you wish to set up.
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2. Click Tax Calendar > Excise Generation.

3. Create a new record for the Excise Invoice serial number to be generated for the 
Organization, Location, and Transaction Type and Order/Invoice Type 
combination.

4. This Excise Invoice Serial will be generated when Shipment & RTV is made from a 
Particular Inventory Organization Location.

The table below details the setup options:
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Field Description Type Action Description

Transaction Type (Required) PICK HELP Choose one of the options from:

Order: On selecting this option in 
combination with the Order Type, 
the Excise Invoice Number 
generated on shipping the delivery 
created with this Order Type would 
be based on the definition specified 
for this record. 

Return To Vendor:

The document sequence defined 
here would be applicable to Excise 
Invoice Numbers generated for a 
Return to Vendor Transaction.

Domestic:

The Document Sequence defined 
here would be applicable to Excise 
Invoice Numbers generated for a 
Domestic Transaction.

This would be applicable to all the 
Order/Invoice Types that are 

Define Bond Register: Chosen for 
the Organization / Location with the 
Register Type as 'Domestic with 
Excise' AND 

This Order Type is not chosen in the 
Excise creation India Localization 
screen for the Organization, 
Location.

Invoice:

On selecting this option in 
combination with the Invoice Type, 
the Excise Invoice Number 
generated on saving an AR Invoice 
would be based on the definition 
specified for this record.

Export: 

The document sequence defined 
here would be applicable to Excise 
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Field Description Type Action Description

Invoice Numbers generated for a 
Export Transaction.

This would be applicable to all the 
Order/Invoice Types that are 

Define Bond Register: Chosen for 
the Organization / Location with 
Register Type 'Export with Excise'. 
This Order Type is not chosen in the 
Excise creation India Local screen for
the Organization, Location. 

Order/Invoice Type (Required) PICK HELP The relevant Order Type/Invoice 
type related for a Inventory 
Organization Location have to be 
selected here from the LOV.

Register Code (Required) PICK HELP The appropriate Register Code for 
an Order/Invoice Type has to be 
selected here from the LOV.

Prefix (Optional)   Any alpha-numeric code that would 
be prefixed to the Excise Invoice 
number.

Start No (Required)   You can specify the Start Number 
for a specific Excise Invoice Serials 
which are to be generated from a 
particular Inventory Organization 
Location for a specific Order/Invoice 
Type 

Jump by (Required)   You can decide chronological series 
for Excise Invoice Numbers by 
specifying Jump by Number. 

End No     The User can specify the End 
Number for a specific Excise Invoice 
Serials, which are to be generated 
from a particular Inventory 
Organization Location for a specific 
Order/Invoice Type & Register 
Code.
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• Before defining user prefixes and Excise Invoice Numbers, 
appropriate setups need to be done in define Bond Register to 
associate an Order type for all Transactions Order Management 
Module. In addition, Transaction source for all transactions from 
Accounts Receivable Module needs to be defined. The Order Type 
and Transaction Source will be associated with different type of 
excise removals (like domestic with excise, Bond, Export with 
excise etc.). Only after associating an Order Type/Transaction 
source with an excise related transaction type, user should define 
the user definable prefixes and Excise Invoice Numbers in this 
region.

• It is not mandatory to define Excise Invoice Generation Serial 
Number. If you do not define the Excise Invoice Generation Screen, 
then auto generated system numbers will be allotted to the Excise 
Invoice as stipulated under Rule 52 A of the Central Excise Rules 
(one sequence for Domestic transactions and another for Exports).

Defining Sub Inventory Locations
Before you start using Oracle Financials for India Inventory, the Sub-inventories have to
be associated with Organization/Location combination. Excise related transactions and 
records will be updated only for those Sub inventories, which are identified as bonded 
for Manufacturing Organizations and as Trading for Trading Organizations. By 
considering the transactions of a Sub Inventory, the check box for bonded/traded needs 
to be enabled.

Important: It is mandatory to complete this setup, irrespective of the 
fact that the Sub inventory is not bonded. You can leave the 'Bonded' 
checkbox blank, if the Sub inventory is non-bonded.

Prerequisites

Before you enter the Sub Inventory Locations, you must:

• Define Organizations

• Define Locations

• Organization Additional Information

• Define Sub Inventories

In Oracle Financials for India, navigate to Setup > Organization > Sub Inventory 
Locations. The table below provides field-wise description of the Assign Sub 
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Inventories screen.

Field Description Type Action Description

Header Level      

Organization 
Name/Location

(Required) PICK HELP Inventory Organization's Name and
Location to be selected by the user 
from the LOV. 

Line Level      

Sub-Inventory (Required) PICK HELP You can select the Sub-Inventory 
name from the LOV

Description (Displayed)   The Description for the selected 
Sub-Inventory will be displayed 
here. 

Bonded (Flag) (Optional) CHECK BOX You need to specify whether a Sub 
Inventory belonging to the 
specified Organization and location
is Excise Bonded or Duty Paid. 
When this Flag is enabled the Sub 
Inventory is considered as Bonded. 

Trading (Flag) (Optional) CHECK BOX You need to specify whether a 
Sub-Inventory belonging to the 
specified Organization and 
Location is Trading. When this Flag
is enabled the Sub-Inventory is 
considered as Trading. If the 
Organization Location has a 
Manufacturing setup, this field is 
disabled.

Important: The above Sub Inventory setup is mandatory in nature & 
missing the same will result in shipping getting stopped.

Defining Value Added Tax Regime
Regime would be used to define rules that would be applicable to all Taxes assigned to 
it

On a Regime, you would define rules that would be applicable to all transactions 
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created from the Organizations assigned to it. Information defined here would be 
generic unless you assign different properties at an Organization Level.

• Value Added Tax Registration: Organizations have to register with the various 
Value Added Tax Authorities (specific to each state). The Registration would be the 
basis for all Recovering Credit on Input Tax, settling Tax Liability and Tax 
Reporting.

• Assigning Tax Types: Value Added Tax Type have to be assigned to the Value 
Added Tax Regime. This is a logical grouping of all transactions to which these 
taxes are applicable. If the values assigned for a particular tax are different, these 
would prevail over those defined for the Regime.

• Assigning Organizations: Regime has to be assigned to all Organizations to which 
it is applicable. Taxes defined under this Regime would default only for these 
Organizations.

Tax Information related to Value Added Tax Regime will be handled through a new 
screen called 'Regime Registration' that was introduced through the Service Tax 
Solution. The functionality of these forms has been enhanced so that Value Added Tax 
Regime can be setup through them.

To implement SHE Cess Solution, Regime Registrations for Service Tax and Tax 
Collected at Source needs to be updated with the SHE Cess Tax Type Accounts.

To update Service Tax Regime, access Regime Registration form from India Local 
Purchasing > India Localization > India VAT/Service Tax > Setup > Regime Registration.

Note: It is advisable to use different Accounts for Service SH Education 
Cess Tax Type - Interim Recovery Account, Recovery Account, Interim 
Liability Account and Liability account.

Field Description Type Action Description

Header Section     In this section Regime
Name, description 
and effective dates of 
the Regime is 
captured.



1-26    Oracle Financials for India User Guide

Field Description Type Action Description

Regime Required PICK The LOV contains

1. Service Tax

2. Value Added Tax

You should pick 
'Value Added Tax'.

Description Required ENTER

HELP EDIT

Short description of 
the Regime

Regime Registration 
Details block

     

Registrations tab     This section captures 
the Registration 
details of the Regime. 
These Registration 
details are used in the
reports that are 
generated. You 
should enter the 
Registration details in
the 'Registration 
Value' column by 
picking up the 
appropriate 
'Registration Type' 
and 'Registration 
Name'. You can 
capture as many 
Registration details as
required.

Sequence Required PICK

HELP EDIT

This is the Sequence 
Number of the 
Registration Types to 
be captured. This 
may not be Serially 
Numbered. You 
cannot use duplicate 
sequences.
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Field Description Type Action Description

Registration Type Required PICK

HELP EDIT

LOV containing:

1. Primary 
Registration Number

2. Secondary 
Registration Number

3. Others

Pick the appropriate 
Registration Type.

Registration Name Required PICK

HELP EDIT

LOV containing:

1. Registration 
Number

2. Jurisdiction

3. Ward No

4. Range No

5. Circle

6. Same Invoice No 
for Excise and VAT 
Regimes

Pick appropriate 
Registration Name

Registration Value Required PICK

HELP EDIT

You should enter the 
actual Registration 
value in this field.

These Registration details are applicable at the Regime Level. These Registration details 
will default on all the Organizations that are assigned to this Regime. The user has the 
facility to change the default values at an Organization Level.

Note: For Value Added Tax Regime, you need to specify value for "
Same Invoice No for Excise and VAT Regimes" attribute. A 'Yes' in this 
field indicates that the Excise Invoice Number, wherever available 
would be considered as VAT Invoice Number. If the value is set to 'No',
setup made in the VAT Document sequence setup would be considered
for VAT Invoice Number generation.
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The Service Tax distribution transaction only hits the PLA registers by default. If you 
want the service tax distribution to hit the RG register, you must perform the following 
setup:

1. Navigate to Registration Tab and Click Add Row.

2. Select Others for Sequence and Registration Type.

3. Enter 'Service Tax Distribution in RG / PLA' as the Registration Name.

4. Enter 'RG' or 'PLA' as the Registration Value.

Note: You must perform the above setup if you want the service tax 
distribution to hit the RG register.

Regime Registrations - Tax Type
This section of the screen shows the Tax Types associated to the regime and the 4 
accounts related to this Regime.

Field Description Type Action Description

Regime Registration 
Details block

     

Tax Types Tab     In this section of the screen Tax 
Types and the Accounting 
Information related to this 
Regime are setup.

Sequence (Required) PICK

HELP EDIT

This is the Sequence Number of 
the Tax Types to be captured.
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Field Description Type Action Description

Tax Types (Required) PICK

HELP EDIT

You should associate all the Tax 
Types falling under the VAT 
Regime and that are applicable to 
your business.

LOV containing:

• Value Added Tax

• Turnover Tax

• Purchase Tax

• Entry Tax

• Octroi - IND

Description   DISPLAY Displays the description of the 
Tax Type

Parent Tax Type   DISABLED This field is not relevant for VAT 
Regime

% of Parent   DISABLED This field is not relevant for VAT 
Regime

Tax Accounts Details 
block

    Accounts that are going to be 
used for accounting of Service Tax
are specified here.

Sequence (Required) PICK

HELP EDIT

This is the Sequence Number of 
the Account to be captured.
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Field Description Type Action Description

Account Name (Required) PICK

HELP EDIT

LOV contains:

Interim Recovery Account

Recovery Account

Interim Liability Account

Liability Account

Please refer Accounting Section 
for detailed discussion on the 
accounts

Account Value (Required) PICK

HELP EDIT

Pick Accounting flex fields for 
each of the account.

Click Organization to view the Regime Organization Registration screen. This screen 
shows the organizations assigned to the regime.

Field Description Type Action Description

Header      

Regime   DISPLAY This field will default from 
'Regime Registration' form.

Description   DISPLAY This field will default from 
'Regime Registration' form.

Organization Details 
block

    All the Organizations falling 
under this Regime are associated 
to the Regime here.

Organization Type (Required) PICK

HELP

EDIT

For VAT only 'Inventory 
Organizations' is applicable
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Field Description Type Action Description

Organization Name (Required) PICK

HELP

EDIT

Name of the Organization that 
has to be associated to this 
Regime.

Registrations Tab      

Registration Details 
block

    The Registration details that are 
given at the Regime Registration 
details are defaulted to the 
Organizations. These Registration
details will default on all the 
Organizations that are assigned to
this Regime. The user has the 
facility to change the default 
values at an Organization level. 
You cannot delete a Registration 
here.

Registration Type   DISPLAY Will show default Value from 
'Regime Registrations' screen.

Registration Name   DISPLAY Will show default value from 
'Regime Registrations' screen.

Registration Value (Required) PICK

HELP

EDIT

Will show default value from 
'Regime Registrations' screen. You
can edit the information.

Default   CHECKBOX This checkbox will be checked 
whenever default Registration 
Value at the Regime level are 
retained. It gets unchecked when 
Registration Value is modified.

The Tax Types tab shows the Tax Types associated to the regime and Organization and 
the 4 accounts related to this Regime and Organization combination.
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Field Description Type Action Description

Tax Types Tab     The Tax Details that are given at 
the Regime Registration details 
are defaulted to the 
Organizations. These tax details 
will default on all the 
Organizations that are assigned to
this Regime. The user has the 
facility to change the default 
values at an Organization level.

Tax Details block      

Tax Type   DISPLAY Will show default value from 
'Regime Registrations' screen.

Description   DISPLAY Will show default value from 
'Regime Registrations' screen.

Account Details block      

Account Name   DISPLAY Will show default value from 
'Regime Registrations' screen.

Account Value (Required) PICK

HELP

EDIT

Will show default value from 
'Regime Registrations' screen.

Pick accounting flex fields for 
each of the account specific to the 
Organization.

Default   CHECKBOX This checkbox will be checked 
whenever default Account Value 
at the Regime Level are retained. 
It gets unchecked when account 
value is modified.

Defining VAT Journal Sources and Categories
Journal Sources need to be defined to transfer VAT Related Accounting entries to 
General Ledger.

VAT GL Entries created from PO-Receiving Transactions, Source would be 'Purchasing' 
and Category would be 'Receiving India'.
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Value Added Taxes on Transaction

This section provides details on the implication of Value Added Taxes on transactions.

VAT Defaulting & Calculation
VAT Taxes default on following documents

• Purchase Requisitions

• Internal Requisitions

• Request for Quotations

• Quotations

• Purchase Orders

• PO Releases

• PO Receipts

• ISO Receipts

• RMA Receipts

Current Tax defaulting and calculation capabilities of Oracle Financials for India Tax 
Engine can handle these requirements. Tax defaulting and calculation happens based 
on Tax Setups. Appropriate setup of Tax Codes, Tax Categories with Precedence and 
Item Categories will ensure appropriate Tax defaulting and Calculation.

Added Tax Recovery Process
VAT Taxes applicable to a Purchase Transactions can be recovered to set-off the VAT 
Liability arising from the Sale of Goods arising in the course of intra-state trade. This 
section provides details of the VAT Recovery process.

Claim VAT - During Receipt creation
VAT Tax Amounts included in the Purchase transaction can be recovered on Receipt of 
VAT Invoice from the Supplier. This document can be received either with the Receipt 
of Material or at a later stage. If the document is received along with the material then, 
the user has an option to enter the VAT Invoice details by opening the Claim Details 
window through the Receipts India Local window.

To open the Claim Details window while creating the Receipt, click on the Claim VAT 
button on the Receipt India Local screen.
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• You should have frozen the Tax lines and amounts before you open
the Claim Details screen. 

If you have any Tax modifications pending, click 'No'. On clicking on 'Yes' Claim 
Details would be opened.

The field wise description of the form is given below for ready reference.

Field Description Description

Receipt Header Block In this block you would see the List of Receipts that 
meet your query criteria. In case you have opened 
this Form from Receipts India Local Screen, only the 
current Receipt would appear in this block.

In this block you can view Total of VAT Recoverable 
Amount. Of which how much is recovered, the VAT 
Invoice details would appear in this Block

Receipt Number Receipt Number is displayed here

Recoverable Amount This field reflects the Total of Recoverable VAT Tax 
amounts applicable to the Receipt.

Important: All Tax Types Assigned to the VAT 
Regime would be considered as VAT Taxes.

Recovered Amount This field displays the Total of VAT Amount 
Recovered so far.

In the following cases Recovered Amount would not 
be equal to the Recoverable Amount:

1. When you have processed claim for any of the 
Receipt Lines.

2. When only some of the Receipt lines are Recovered

3. Based on the claim terms only a part of the VAT 
Amount is recovered
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Field Description Description

Invoice No. This field would display the VAT Invoice Number.

In the following scenarios, no value would be 
displayed in this field:

1. You have not specified VAT Invoice Number for 
any of the fields

2. More than one VAT Invoice Number has been 
specified for the Invoice Lines.

Invoice Date VAT Invoice Date is displayed here. The date would 
be displayed only when the VAT Invoice Number is 
displayed.

Party If the VAT Invoice is received from a Supplier who is 
different from the PO supplier, you would enter the 
Party on the Receipt Lines. Such Party would be 
shown in this field. However, if this value is not 
distinct for all lines, the field would not display any 
value.

Such Party would be shown in this field.

However, if this value is not distinct for all lines, the 
field would not display any value.

Party Site The Site corresponding to the VAT Supplier Site 
would be displayed here.

If this value is not distinct for all lines, the field would
not display any value.

Claim Status VAT Claim status would be displayed here.

Following would be the distinct statuses:

1.Not Claimed: This value would appear if none of 
the Receipt lines are processed

2. Full Claimed: This status would appear if VAT on 
all the lines are claimed.

3. Partial Claimed: This status would appear when 
only some of the lines are claimed.

4. Non Claimable: This status would appear when all 
the lines are not eligible for claim and all of them are 
marked as not claimable.
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Field Description Description

Total Lines Displays Number of Receipt lines.

Lines W/O VAT Details Displays lines without VAT Invoice Details

Query Lines Block Use this block to query for specific Receipt Lines.

Item Class Select a Item Class from the LOV only when you 
would like to view and process lines of a specific Item
Class

Item Name Select a Item Name from the LOV only when you 
would like to view and process lines of a specific 
item.

Lines W/O VAT Details Check this box only when you would like to view 
lines that do not have VAT Invoice Number and Date.

Claim Status Select a specific Claim Status from the LOV. All lines 
with the matching status would be selected.

Query Lines Click this button to Query all Lines with values 
matching those entered in this block

Populate Defaults Block Specify values here that should be defaulted on all 
Receipt Lines that are being queried.

Processing Action Select a processing action that should be stamped on 
all lines that are queried.

You can select from the following options:

1. Claim: This implies that the lines will be claimed 
in the next claim process.

2. Not Claimable: This status indicates that the lines
will not be eligible for claim.

3. Pending: By marking lines as pending, you are 
indicating that these lines would remain in 
pending status and would be separated from the 
claim process.
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Field Description Description

Invoice No. Specify a value that should be stamped on to the 
Invoice Number field of all selected lines

Invoice Date Specify a value that should be stamped on to the 
Invoice Date field of all selected lines

Party This field displays the PO Vendor Name. If the 
Vendor providing the VAT Invoice is different from 
the PO Vendor then, select appropriate value here.

Party Site This field displays the PO Vendor Site. If the Vendor 
Site providing the VAT Invoice is different from the 
PO Vendor/Site then, select appropriate value here.

Populate Defaults Click this button to populate all the selected lines 
with the values entered in this block

Receipt Lines All Receipt Lines with matching query criteria would 
be displayed here

Item Name Item Name is displayed here.

Item Class Item Class as assigned for the combination of VAT 
Regime and Item would be displayed here

Claim Status Claim Status of the Line would be displayed here. If 
the status is not populated using Populate Defaults 
block, user needs to specify the status for each line.

Following are the details of each claim status:

1. Not Claimed: This implies that the line is eligible 
for claim process. But is not yet claimed.

2. Not Claimable: This status indicates that the line 
is not eligible for claim.

3. Partial Claimed: Implies that the line is partially 
claimed.

4. Full Claimed: Indicates that the line has been 
completed processed.
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Field Description Description

Processing Action In this field, select from one of the following 
processing action.

1. Claim: This would imply that the lines would be 
claimed in the next claim process.

2. Not Claimable: This status would indicate that the 
lines would not be eligible for claim.

3. Pending: By marking lines as pending, you are 
indicating that these lines would remain in pending 
status and would be separated from the claim 
process.

Claim Term Displays the default Claim Term. User has an option 
to change this until the line has been processed for 
Claim.

Invoice No. Specify The VAT Invoice Number here.

Invoice Date Specify a Invoice Date here.

Party This field displays the PO Vendor Name. If the 
Vendor providing the VAT Invoice is different from 
the PO Vendor then, select appropriate value here.

Party Site This field displays the PO Vendor Site. If the Vendor 
Site providing the VAT Invoice is different from the 
PO Vendor/Site then, select appropriate value here.

Recoverable Amount This field reflects the Total of Recoverable VAT Tax 
Amounts applicable to the Receipt Line.

Important: All Tax Types Assigned to the VAT 
Regime would be considered as VAT Taxes.
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Field Description Description

Recovered Amount This field displays the Total of VAT Amount 
Recovered so far.

In the following cases Recovered Amount would not 
be equal to the Recoverable Amount:

1. When you have processed claim for any of the 
Receipt Lines.

2. When only some of the Receipt lines are recovered

3. Based on the claim terms only a part of the VAT 
Amount is recovered

Net Quantity This value displays Receipt Quantity net of Returned 
and Correction Quantity.

Receive Qty. Quantity received is shown here. This is before 
correction and returned quantity.

Correct Rcv. Quantity Correct of Receive Quantity is displayed here.

RTV Quantity Quantity returned to Supplier is displayed here

Correct RTV Qty. This field displays Correction to quantity returned to 
Vendor

Tax Details This block displays Tax Amount details.

Only taxes of the Type assigned to the Regime 
Registration are displayed here

Tax Type Tax Type is displayed here.

Tax Name Tax Name is displayed here

Recoverable Amount Amount of Tax that can be recovered is displayed 
here

Recoverable Amount This field displays the Tax Amount that is already 
recovered

Installment Details This block displays the Installment Details.
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Field Description Description

Installment No. Displays Sequence Number; Starting with 1 and 
incremented by 1 for each record

Scheduled Date Displays the Date on which the record would be 
available for VAT Recovery

Installment Amount Displays the Equal Installment Amount that would 
be eligible for recovery as on the scheduled date

Status Displays the Claim Status of the line. If the 
installment is claimed then, the Status would be 
'Claimed'. If the installment is not yet claimed, the 
Status would be set to 'Not Claimed'

Claim VAT After Creating Receipt
If the VAT Invoice details are not entered while creating the Receipt, the option is to 
enter these details by accessing the Claim VAT screen through the Menu Option. The 
Options available would be the same as those when the form is Opened through the 
Receipts localized screen. However, here the user has an option to query for Multiple 
Receipts based on the options in the query-find screen.

Field Description Description

Regime The value in this field would be "Value Added Tax"

Organization Displays the current Organization from the profile

Location Select the Location from the LOV

Receipt Type Select from the following Values

PO: Purchase Receipt

RMA: Customer Receipt

ISO: Internal Receipt

Party Select a Supplier Name here
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Field Description Description

Receipt From Date Specify a date here. This would restrict the Receipts to
those created after this Date

Receipt to Date Specify a Date here. This would restrict the Receipts to
those created before this Date

Claim Status Select a Claim Status from the LOV

Following are the details of each claim status

1. Not Claimed: This implies that the line is eligible for
Claim Process, but is not yet claimed.

2. Not Claimable: This status would indicate that the 
line is not be eligible for Claim.

3. Partial Claimed: Implies that the line is partially 
claimed.

3. Full Claimed: Indicates that the line has been 
completed processed.

Item Class Select an Item Class from the LOV. Only those Receipt
Lines with this Item Class specified here would be 
fetched

Receipt Number Specify a specific Receipt Number here. Only lines 
related to the Receipt would be returned

VAT Manual Entry 
Manual Entry Transactions for VAT may be used for passing Adjustment entries (both 
VAT Repository / Accounting) for VAT Recovery / VAT Liability transactions done in 
the P2P and O2C Cycles. VAT Recovery / VAT Liability, VAT Payment transactions can 
also be created directly using this window 

This functionality is provided as a means for handling exceptional scenarios in your 
business process that necessitate capturing of such transactions outside the normal 
transaction cycles.

On saving the transaction system will generate a transaction number. If the 'Generate 
Invoice Number' flag is checked, system will generate the VAT Invoice number as well. 
System also generates appropriate accounting entries / VAT repository entries for the 
transactions. 

You will use the following screen to do manual entries related to Service Tax.
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Navigation: India Local Purchasing - VAT/Service Tax - Transactions- Manual Entry

Field Description Type Action Description

Header Section     All the Transaction details are 
captured in the Header Section.

Regimes (Required) PICK

HELP

EDIT

Select VAT Regime

Organization Type (Required) PICK

HELP

EDIT

Select Inventory Organization for 
VAT

Organization Name (Required) PICK

HELP

EDIT

Select Organization from LOV. 
LOV contains all Organizations 
where Oracle Financials for India 
is installed.

Transaction Number     An Auto generated Number for 
each manual transaction 
successfully performed.

Location Name   DISPLAY Organization Location is 
displayed here.

Transaction Type (Required) PICK

HELP

EDIT

Select Transaction type. LOV 
contains:

1. Recovery

2. Adjustment Recovery

3. Liability

4. Adjustment Liability

5. Payment

Transaction Date (Required) PICK

HELP

EDIT

Select Transaction Date. 
Transaction Date has to be more 
than the last Settlement Date and 
less than the Current System Date.
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Field Description Type Action Description

Party Type (Required) PICK

HELP

EDIT

Select Party Type. LOV contains:

1. Vendor

2. Customer

3. Tax Authority

You should select Vendor based 
on the Transaction Type. For e.g. 
if the Transaction Type is 
Recovery, you will fill in Vendor 
details in the 'Party Details' 
section and similarly if the 
Transaction Type is liability, you 
will fill in Customer details in the 
'Party Details' section. In case you 
are capturing VAT payment 
through this screen then you 
should select Tax Authority in 
'Party Details'.

Party Name (Required) PICK

HELP

EDIT

Select Party Name

Party Site (Required) PICK

HELP

EDIT

Select Party Site.

Invoice Number (Optional) PICK

HELP

EDIT

Number of Invoice issued by the 
party.

Invoice Date (Optional) PICK

HELP

EDIT

Date of Invoice issued by the 
party.



1-44    Oracle Financials for India User Guide

Field Description Type Action Description

Item Class (Optional) PICK

HELP

EDIT

You can select Item Class here.

Item Name (Optional) PICK

HELP

EDIT

You can select the Item here

Remarks (Optional) PICK

HELP

EDIT

Enter Remarks, if any.

Tax Details block     In this block you will enter Tax 
information related to the 
transaction.

Tax Type (Required) PICK

HELP

EDIT

Select Tax Type.

LOV containing:

1. Value Added Tax

2. Turnover Tax

3. Purchase Tax

4. Entry Tax

5. Octroi - IND

You should select the appropriate 
tax types. You can choose multiple
tax types.

Parent Tax Type   DISPLAY This field will display the Parent 
Tax Type that has been setup for a
Child Tax in the Regime setup.

Assessable Value (Required) PICK

HELP

EDIT

Enter Assessable Value for the 
transaction. Assessable Value for 
Child Tax will default as Value of 
Parent Tax.
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Field Description Type Action Description

Rate (%) (Required) PICK

HELP

EDIT

Enter Rate of Tax.

Tax Amount   DISPLAY Calculated Amount based on 
Assessable Value and Rate of Tax.

Adjustment Account (Required) PICK

HELP

EDIT

Select Adjustment Account where 
the amount needs to be adjusted.

Payment of VAT can also be captured through the Manual Entry Screen.

On saving the transaction system will generate a Transaction Number.

Value Added Tax Accounting
This section provides an overview on the Tax Accounting process. Following figure 
depicts the Accounting required for VAT Taxes. Tax Accounting happens along with 
base transaction accounting. This varies when the Tax is deferred and can be recovered 
or the liability arises only on happening of a particular Accounting event in the future. 
For example, VAT Recovery is on Receipt of Supplier VAT Invoice. So is the 
Accounting. In such cases, the actual Recovery happens on claiming VAT through after 
Receiving Supplier Invoice and Liability accounting happens on generating the VAT 
Invoice for Customs.

Once the transaction has passed through the Recovery and Liability event, the next 
phase would be settlement. The total of recovered amount (net of transferred amounts) 
is what remains to set-off against the Tax Liability under the Regime. The Net Liability 
is settled by making a payment to the Tax Authority.

This process is applicable to all taxes in Procure to Pay (P2P) and Order to Cash (O2C) 
Cycles.

Accounting Entries
Accounting for VAT Taxes would be done in two phases. The first would be on the 
Purchasing and the second would be on Sale event. On initial Purchase and Sale event, 
the VAT Tax would be Debited/Credited to an Interim Account. This Debit/Credit to 
Interim Account would be reversed on to Recovery/Liability accounts on 
Recovery/Liability event.
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VAT Repository
All transactions that lead to VAT Recovery or Liability or adjustment to the same would
update the VAT Repository. You can use this repository for meeting the reporting 
requirements specific to the state.

Following events update the VAT Repository:

1. Claim VAT

2. Process VAT Installments 

3. Return to Vendor after VAT Claim

4. VAT Invoice Generation based on

• Shipment

• AR Transaction Completion 

5. Manual Entry following transaction types

• Recovery

• Recovery Adjustments

• Liability

• Liability Adjustment

6. Settlement

Defining TCS Regime
Regime is used define rules applicable to all taxes assigned to it. You need to complete 
this setup step before you move ahead with other setups.

Setups made for a regime are applicable to all transactions created for the organizations 
assigned to it. Information defined here is generic unless you assign different properties
at the organization level.

To create a TCS Regime, access Regime Registration screen from India Local 
Receivables > India TCS/VAT/Service Tax > Setup > Regime Registrations.
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Field Description Type Action Description

Header Section In this section regime 
name, description 
and effective dates of 
the regime is 
captured

Regime (Required) PICK The LOV contains a 
new value - 'Tax 
Collected At Source' 
regime.

Description (Required) HELP EDIT Short description of 
the regime

Short description of 
the regime

Registrations tab This section captures 
the registration 
details of the regime. 
These registration 
details are used in the
reports that are 
generated. You 
should enter the 
registration details in 
the 'registration 
value' column by 
picking up the 
appropriate 
'registration type' and
'registration name'. 
You can capture as 
many registration 
details as required.

Sequence (Required) PICK HELP EDIT This is the sequence 
number of the 
registration types to 
be captured. This 
may not be serially 
numbered. You 
cannot use duplicate 
sequences.
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Field Description Type Action Description

Registration Type (Required) PICK HELP EDIT Pick appropriate 
Registration Type 
from Primary 
Registration Number,
Secondary 
Registration Number,
Others.

Registration Name (Required) PICK HELP EDIT Pick appropriate 
Registration Name 
from TAN No, AR 
Receipt Class, Batch 
Source Debit Memo, 
Batch Source Credit 
Memo.

These registration details are applicable at the regime level and will default on all the 
organizations that are assigned to this regime. However, you can change the default 
values at the organization level.

To implement SHE Cess Solution, Regime Registrations for Service Tax and Tax 
Collected at Source needs to be updated with the SHE Cess Tax Type Accounts. To 
update TCS Regime, access Regime Registration form from India Local Receivables > 
India TCS/VAT/Service Tax > Setup Regime Registrations.

Note: It is advisable to use different Accounts for TCS SH Education 
Cess Tax Type - Interim Liability Account and Liability account.

Define Registration Details
Organizations have to register with various TCS Authorities. The registration are the 
basis for all settling tax liability and tax repository updates. You can setup TCS 
registration details using TCS Regime. If the TCS Registration varies by organization, 
you have the option to change the default values at the organization level.

To create TCS Registration Details, access Regime Registration screen from India Local 
Receivables > India TCS/VAT/Service Tax > Setup > Regime Registrations > 
Registrations.

• TCS tracking or reporting for Organization is based on the TAN 
Number defined. Hence it is mandatory to define the correct TAN 
number for the organization. You must not attempt to change the 
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TAN Number.

• For entry of Advance Receipts, Receipt Class entry is required. The 
Zoom feature is enabled only for the Receipt Class entered in 
Regime Registration.

• Batch Source for 'Debit Memo' and 'Credit Memo' are required to 
enable system to generate Debit / Credit memos for TCS 
Transactions. Debit notes are generated whenever you save an 
Advance receipt while Credit note is generated when this advance 
receipt is applied to an Invoice transaction with TCS. Localization 
inserts data in AR interface tables based on this setup. User needs 
to run Autoinvoice import program to get the actual Debit/Credit 
Memos for TCS in Receivables.

Assign Tax Types
TCS Tax Types have to be assigned to the TCS regime. All transactions with taxes of 
these Tax Types assigned would be considered for TCS Repository updates. The 
following three Tax Types have been seeded and can be used for TCS Tax:

• Tax Collected at Source

• TCS Cess

• TCS Surcharge

You cannot add additional Tax types for Tax definition and need to use only the seeded 
Tax types. You can assign TCS Tax Types to TCS Regime. Transactions for the Tax 
Types that are assigned to the regime will be considered for TCS related processing and 
settlement. For each Tax Type, the user can also specify GL Accounts. You can change 
these accounts for each organization.

To assign TCS Tax Types, access Regime Registration screen from India Local 
Receivables > India TCS/VAT/Service Tax > Setup > Regime Registrations > Tax Types.

Assigning Tax Accounts
For each Tax Type, you can specify GL Accounts and also have a separate GL Account 
for each organization. To assign GL Accounts for Tax Types, access Regime Registration
screen from India Local Purchasing > India TCS/VAT/Service Tax > Setup > Regime 
Registrations > Tax Types > Tax Account Details.
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Field Description Type Action Description

Regime Registration 
Details block

Tax Types tab In this section of the 
screen Tax Types and 
the accounting 
information related to
this regime are setup.

Sequence (Required) PICK HELP EDIT This is the sequence 
number of the tax 
types to be captured.

Tax Types (Required) PICK HELP EDIT You should associate 
all three tax types - 
Tax Collected at 
Source, TCS Cess and 
TCS Surcharge.

Description DISPLAY Displays the 
description of the Tax
Type

Parent Tax Type PICK HELP EDIT Parent Tax Type is 
not applicable for Tax
collected at source.

% of Parent PICK HELP EDIT % of Parent is not 
applicable for Tax 
collected at source.

Tax Accounts Details 
block

Accounts that are 
going to be used for 
accounting of Tax 
Collected at Source 
are specified here.

Sequence (Required) PICK HELP EDIT This is the sequence 
number of the 
Account to be 
captured.
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Field Description Type Action Description

(Required) PICK HELP EDIT Choose from Interim 
Liability Account and
Liability Account.

Note: Refer 
Accounting section
for detailed 
discussion on the 
accounts.

Account Value (Required) PICK HELP EDIT Pick accounting flex 
fields for each of the 
account.

Apart from the final Liability Account, you must define one interim account to store the
TCS that is not accrued. Eg., Shipment is made but Invoice not raised would result in 
balance in Interim account. Defining separate accounts for each tax type and specific to 
each Organization in General Ledger helps in better tracking of TCS accounting.

Assigning Organization/Locations
Regime must be assigned to all organizations it applies to. Taxes defined under this 
regime will default only for transactions created for these organizations.

As TCS is applicable on sale of specified goods, Inventory organizations and locations 
are considered for TCS setup. User can assign Inventory organizations and locations to 
the TCS Regime. If the Registration details and the Tax Account details vary by 
organization, you can change the default values. To assign organization/locations, 
access Regime Organization Registration screen from India Local Receivables > India 
TCS/VAT/Service Tax > Setup > Regime Registrations > Organizations.

Field Description Type Action Description

Header

Regime DISPLAY This field will default 
from 'Regime 
Registration form.
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Field Description Type Action Description

Description DISPLAY This field will default 
from 'Regime 
Registration form.

Organization Details 
block

All the organizations 
falling under this 
regime are associated 
to the regime here.

Organization Type (Required) PICK HELP EDIT For TCS, only 
Inventory 
Organization is 
applicable

Organization Name (Required) PICK HELP EDIT Name of the 
Inventory 
organization that has 
to be associated to 
this regime.

Registrations Tab

Registration Details 
block

The registration 
details specified in 
'Regime Registration' 
are defaulted to the 
organizations. These 
registration details 
will default on all the 
organizations that are
assigned to this 
regime. You can 
change the default 
values at the 
organization level.

Registration Type DISPLAY This field will default 
from 'Regime 
Registrations' screen.

Registration Name DISPLAY This field will default 
from 'Regime 
Registrations' screen.
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Field Description Type Action Description

Registration Value (Required) PICK HELP EDIT This field will default 
from 'Regime 
Registrations' screen. 
You can edit this 
information.

Default CHECKBOX This checkbox will be 
checked whenever 
default registration 
value at the regime 
level are retained. It is
unchecked when 
registration value is 
modified.

Defining Organization Registration Details
Organizations having their operations spanning across different states would register 
under each state. In such cases, you can define TCS Registration number for each 
Inventory Organization/Location combination. To assign organization/locations 
location details, access Regime Organization Registration screen from India Local 
Receivables > India TCS/VAT/Service Tax > Setup > Regime > Registrations 
>Organizations.

Defining Organization Tax Accounts
You can have different GL code combinations for each of the Organization/Location. To 
enable this, you must assign Tax Accounts for Organization/Locations. Unless, different
accounts are setup for each organization/location combination, the Accounts specified 
at Regime Registration level will be used for all organizations. To create GL Accounts 
by Organization/location access Regime Organization Registration screen from India 
Local Receivables > India TCS/VAT/Service Tax > Setup > Regime Registrations > 
Organizations.
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Field Description Type Action Description

Tax Types Tab     The tax details that 
are given at the 
regime registration 
details are defaulted 
to the organizations. 
These tax details will 
default on all the 
organizations that are
assigned to this 
regime. The user has 
the facility to change 
the default values at 
an organization level. 
You cannot delete a 
registration here.

Tax Details block      

Tax Type   DISPLAY This field will default 
from 'Regime 
Registration' screen.

Description   DISPLAY This field will default 
from 'Regime 
Registration' screen.

Account Details block      

Account Name   DISPLAY This field will default 
from 'Regime 
Registration' screen.

Account Value (Required) PICK HELP EDIT This field will default 
from 'Regime 
Registration' screen. 
Pick accounting 
flexfields for each 
account specific to the
organization.
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Field Description Type Action Description

Default   CHECKBOX This checkbox will be 
checked whenever 
default account value 
at the regime level are
retained. It will be 
unchecked when 
account value is 
modified.

Defining Item Classification
Under TCS Regime, items have to be classified into following categories:

• Alcoholic liquor for human consumption

• Timber obtained under a forest lease

• Timber obtained under any mode other than forest lease

• Any other forest product not being timber or tendu leave

• Scrap

• Parking Lot

• Toll Plaza

• Mining and Quarrying

• Tendu leaves

You must classify the items under the above categories, which would be required for 
proper reporting. You can setup templates with possible Item classifications. Multiple 
items can be assigned to templates at a time. This feature enhances usability and 
minimizes time required to complete this setup.

To define Item Classifications, navigate to India Local Receivables > India 
TCS/VAT/Service Tax > Setup > Item Classification.

Note: If item classification is not carried out for an item, when you book
a sales order or when you try to complete a Receivables Invoice with 
TCS Taxes, you will get the error: "cannot find item classification for 
"TCS" regime and "LocFGIN" item of 2832 organization (id)".
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• You cannot enter a TCS AR Invoice without using items ie., using 
description or memo line. In such cases item classification is not 
possible.

• Item classification is mandatory to meet the reporting requirements
of TCS regime and hence the above restriction to use an item that is 
properly classified.

Defining Tax Codes
New Tax code needs to be defined for tracking TCS Taxes. You can identify a TCS tax 
by defining a Tax code using the following Tax types:

• Tax Collected at Source

• TCS Cess

• TCS Surcharge

To define a Tax code, access Tax code definition window from India Local Receivables >
Setup > Tax > Taxes.

Note: You need to define a different Tax Code each for TCS Cess and 
TCS Surcharge Cess. .TCS Cess should not be used for TCS Surcharge 
Cess even though the Tax percentage is the same. This is essential 
because a single transaction cannot have the same tax ID multiple 
times.

To carry out a transaction classified as TCS exempted transaction, you must define a tax
code with zero Tax Percent and the Original Tax Percent that would have been 
normally charged. Similarly, to carry out a transaction classified as Concessional TCS 
transaction, you must define a tax code with reduced Tax Percentage that needs to be 
charged and the Original Tax Percent that would have been normally charged, if such 
transaction did not attract a concessional TCS rate.

Defining Tax Categories
Tax category should be defined for defaulting Taxes. You can create multiple Tax 
Categories with TCS Taxes to ensure that defaulting / selecting right Tax category 
results in correct TCS taxes with Surcharge and Cess. Apart from above, you need to 
create two additional separate Tax categories:

• Tax Category with only tax type of Tax Collected at Source and TCS Cess to attach 
to receipts to deduct TCS on Advance Receipts.
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• Tax Category with only tax type of TCS Surcharge and TCS Cess to be attached to 
Threshold setup. This would ensure automatic charging of Surcharge whenever the 
total billing to the customer exceeds the threshold setup.

To define a Tax category, access Tax category definition window from India Local 
Receivables > Setup > Tax > Tax Categories.

Note: If the Tax category has other type of taxes, then the same would 
not appear in LOV of the TCS Threshold definition screen. Hence, you 
must perform the above Tax category setup before TCS Threshold 
setup.

Defining Item Categories
Item category should be defined to default TCS taxes based on Customer/Site 
combination selected. You can create Item Category to ensure the right Tax Categories 
with TCS Taxes is attached to corresponding items to ensure that defaulting/selecting 
right Tax Category results in correct TCS taxes with Surcharge and Cess. To define an 
Item category, access Item category definition window from India Local Receivables > 
Setup > Tax > Item Categories.

Thresholds Setup
You must define TCS Thresholds to ensure the system automatically tracks cumulative 
sales above a particular limit (current limit is 10 Lakhs) and starts charging Surcharge 
for sales when such Threshold is crossed. To perform Threshold Setup, access 
thresholds setup window from India Local Receivables > Setup > Tax > Threshold 
Setup.

Defining Customer Registrations
Tax Identification or Permanent Account numbers (PAN number) will be allotted to 
eligible organizations. You must capture these details through the Customer Additional
Information, page 4-22. To enter TCS Registration number for a Customer, access 
Customer Tax Information India Local window from India Local Receivables > 
Customers > Additional Information.

Defining TCS Receipt
The Receipt Class needs to be defined in Base Receivables by navigating to Oracle 
Receivables > Setup > Receipts > Receipt Classes. The Advance Receipt for TCS Receipt 
Class or Payment Method is used for TCS Advance Receipts only and not for generic 
receipts that do not attract TCS Tax Type. The Receipt Class defined here will be 
attached in Regime Registration and Payment Method entered in the Receipt Class will 
be available in the LOV while entering receipts.
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Defining Transaction Type
To define the transaction type, navigate to Oracle Receivables > Setup > Transactions > 
Transaction Types. Select Debit Memo as the Class and you must specify value for 
Terms field to enable import. Creation Sign must be set to Negative.

Defining Transaction Source
Define the transaction source in Oracle receivables by navigating to Oracle Receivables 
> Setup > Transactions > Sources.

It is recommended that you define and use separate TCS Credit Debit notes to ensure 
that the same does not clash with other transactions and are easily tracked. The TCS 
Debit Notes are generated when you enter an Advance Receipt. It is also generated for 
the total Threshold amount when the TCS Threshold limit is exceeded. Similarly, a TCS 
Credit Note is generated when an advance receipt is applied to a transaction having 
TCS, or such receipt is cancelled or reversed. A TCS Credit Note also gets generated 
when the TCS Threshold limit which was exceeded earlier is decreased due to either 
reversal or incompletion of invoices. You must run the AutoInvoice program to get the 
TCS Debit or Credit Note reflected in Receivables.

Attaching Receipt Class
You must have a Receipt Class attached for TCS Regime. This enables attaching TCS tax
category to the receipt using the Zoom feature. This is used to deduct TCS Taxes against
Advance Receipts made by customers. To attach Receipt Class, access Regime 
Organization Registration screen by navigating to India Local Receivables > India 
TCS/VAT/Service Tax > Setup > Regime Registrations Organizations.

Note: Receipt Class can be attached either at the Regime level or at the 
Organization level.

Service Tax by Inventory Organization and Service Type
The Service Tax Regime Registration will now be stored at Inventory Organization level
instead of Operating Unit level. The Migration script provided in the patch would 
update the Operating Unit level setup to Inventory Organization which needs to be 
reviewed and corrected if required.

Major Features
• Provision to capture Service Type for a Customer or Supplier: The default Service 

Type can be setup for Customer or Supplier at Null Site and Site Level. This setup 
will be used to automatically default the Service Type on Documents like Sales 
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Order, Receivable Transaction and Purchase Orders.

• Provision to default and change Service Type for a Sales Order / Purchase Order /
Receivable Transaction: The Service Type Defaulted can be changed on the Sales 
Order / Purchase Order and the Receivable Transaction

• Option to Review and update Service Type for existing Transactions: The 
Transactions which have taken place after last settlement and prior to Patch 
application would get stripped by Inventory organization by the migration script, 
but would continue to have null Service Type. As the Service Type would not be 
captured automatically, a form has been provided which would enable you to 
review such transactions prior to settlement after applying the patch and make 
necessary changes or update the Service Type. However, it is suggested that the 
patch should be applied only after making settlement and without carrying out any 
transactions.

• Option of viewing the Accounting for any particular Service Tax Repository 
entry: The Service Type Review form also has an option for viewing Accounting for
any particular Service Tax Repository Entry.

• Option to Distribute Service Tax by Inventory Organization and Service Type: 
The Service Tax Distribution form has been upgraded. This is to enable you to 
distribute the Service Tax by Inventory Organization in place of Operating Units 
and also by Service Type.

• Provision to generate and Print India-Service Tax ST3 Report in the latest format:
The half-yearly India - Service Tax ST3 Report is modified based on the the latest 
format provided.

Service Tax Setup Steps
1. Review and rectify Service Tax Regime Registration

Navigate to India Local Inventory > India TCS/VAT/Service Tax > Setup > Regime 
Registration. The Organization screen will show the Organization Type as 
Inventory Organizations instead of Operating Units after application of patch and 
the migration script.

2. Review and Transfer balance to Inventory Organizations and Service Type

In case it is not a fresh implementation, the Service Tax balance would be of a value 
greater than zero on date of application of the patch. This balance cannot be 
classified by the system based on Service Type or Inventory Organizations. It is 
recommended to carry out a settlement and then apply the patch.

3. Set up Customer Additional Information, page 4-22

4. Set up Supplier Additional Information, page 2-29
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5. Define Service Types

The existing Service types have been provided as seeded lookup values. You need 
to add the lookup for new Service types whenever new Services get notified. Super 
users can add values to the lookup.

Inter Organization Transfer
As a part of day-to-day business needs, organizations may require transfer of material 
from one Inventory Organization to another Inventory Organization. Whenever, such 
movement of material from one Organization to another happen, necessary tax 
implications relating to Central Excise and Value Added Tax regimes need to be 
addressed to facilitate movement of goods.

Oracle Inventory provides 2 ways to transfer goods between inventory organizations:

• Internal Sales Order, and

• Inter Organization Transfer

Oracle Financials for India also supports Inter Organization Transfer now.

Whenever there is movement of goods from one Inventory Organization to another 
Inventory Organization through inter organization transfer using Oracle Financials for 
India, the business needs addressed are:

• Default Tax Category at the transaction level.

• Define the Receiving Organization as the Internal Customer

• Define or Change Other Taxes at the time of Shipment in the Shipping Organization

• Generate Excise Invoice Number at the time of Shipment in the Shipping 
Organization

• Generate VAT Invoice Number at the time of Shipment in the Shipping 
Organization

• Update Excise Records at the time of Shipment in the Shipping Organization - RG 
23 D in the case of Trading Organization and relevant registers in case of 
Manufacturing Organization.

• Generate VAT Invoice Number at the time of Shipment in the Shipping 
Organization

• Generate Accounting Entries related to Central Excise at the time of Shipment in the
Shipping Organization

• Generate VAT Accounting Entries at the time of Shipment in the Shipping 
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Organization

• Generate Accounting Entries at the time of Shipment for Other Taxes in the 
Shipping Organization

• Default taxes at the time of receiving

• Define Other Taxes at the time of Receiving in the Receiving Organization

• Update Excise Records at the time of Receiving in the Receiving Organization - RG 
23 D in the case of Trading Organization and relevant registers in case of 
Manufacturing Organization.

• Claim Credit for CENVAT able Taxes in the Receiving Organization.

• Generate Accounting Entries for CENVAT Credit in the Receiving Organization.

• Generate Accounting Entries for VAT Credit at the time of Receiving in the 
Receiving Organization.

• Account Other Type of Taxes at the time of Receiving in the Receiving 
Organization.

• Update VAT Records at the time of Receiving in the Receiving Organization.

• Claim VAT Credit at the time of Receiving in the Receiving Organization.

• Update Item Cost at the time of Receiving in the Receiving Organization for 
nonrecoverable taxes.

Major Features
• Defaulting Taxes to IL Inter Organization Transfer: For Items that attract 

Localization Taxes, Tax Category will be defaulted on the IL Inter Organization 
form when an Inter Org Transfer is performed. These taxes will be defaulted based 
on the Tax Defaulting Rules. Taxed would be Defaulted automatically based on 
Item Category assigned to the Customer - Customer Site; Customer – Null Site or 
based on the Item Class assigned to the Tax Category for the internal customer.

• Manual Changes to Defaulted Taxes to IL Inter Organization Transfer: Taxes 
defaulted during Inter Organization transfer can be modified manually in case of a 
need.

• Tax Base Amount: User can define precedence logic for calculation of Tax Base 
Amount on which the Tax Rate would be applied. The Tax Base Amount can either 
be the line amount or line amount including other taxes calculated for the 
transaction.
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• Defaulting Assessable Value to IL Inter Organization Transfer: The user has an 
option to use Assessable value that is different from the Cost of the Item. This 
Assessable price is picked for the respective taxes defaulted based on Tax 
Defaulting Rules. Assessable Prices are defaulted automatically when an Assessable
Price List is assigned to the Customer, Customer Site or Null Site for the internal 
customer.

• Generation of Excise Invoice Number: When the Item shipped has Excise related 
Taxes, an Excise Invoice Number gets generated once the transaction is saved. All 
excise related registers will get updated on completion of the transaction. The 
sequence used or followed for the Excise Invoice Number generation is that of the 
Domestic Sequence set up in the Organization Additional Information.

• Generation of VAT Invoice Number: When the item being shipped has VAT type 
of Taxes and is marked as VAT able, a VAT Invoice Number is generated once the 
transaction is saved. The tax repository gets updated on completion of the 
transaction.

• Tax Accounting: The India Local Tax engine generates Accounting Entries only for 
the items related to Localization Taxes. Oracle base Inventory will generate the 
accounting entries for the basic value of Inventory transferred.

• Costing: Item cost of the material transferred is calculated and updated by the base 
inventory. The nonrecoverable taxes are moved separately to the item cost by the 
localization engine. Oracle Financials for India Inventory Transfer supports transfer
and receipts of inventory from an average cost organization to standard cost 
organizations and vice versa.

• Updating RG 23 D Registers: In case of Trading Organization, RG 23D gets 
updated both in the Sending and Receiving Organization as against RG 23 A / C or 
RG1 for raw materials, capital goods or finished goods item in a manufacturing 
organization.

• Reversal of CENVAT Claim: In case of Capital Goods being shipped during the 
same year of purchase, the accrued CENVAT Claim will be reversed and Excise 
Invoice will be generated for the same. The user needs to match the items 
transferred with its original receipt quantity in order to claim the accrued CENVAT 
credit. Note: This is possible only in case of In Transit Inventory Transfer.

• Reversal of VAT Claim: In case of Items attracting VAT Type of Taxes and the 
Claim of VAT is being spread across a period of time and transfer of item happens 
during the period, the unclaimed VAT will be reversed and VAT Invoice Number 
will be generated in the Shipping Organization. Note: This is possible only in case 
of In Transit Inventory Transfer. The user needs to match the items transferred with
its original receipt in order to claim the accrued VAT credit.
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Define Organization Additional Information
Identify and Define Inventory Organizations and Locations that would be reporting to 
the Tax Authorities. The information defined at this level would be the basis for 
Recording, Reporting and Accounting of the local taxes. Apart from this the user would 
also define the Organization Registration details with Excise, Customs, Sales Tax and 
TDS authorities. This information available in Additional Organization Information is 
the basic data for all Oracle Financials for India activities. The Organization and 
Locations defined through Common Application would be available for setup. While 
creating the Additional Organization Information, it is mandatory to create two sets of 
records, one at Null Location level and another with Location. The master child 
relationship among the Organization and Location would be used only for 
consolidation of Excise Registers at Master Organization Level. For further information, 
see: Defining Organization Additional Information, page 1-4.

Define Organization Trading Information
You would enter the information of the Organizations Registered under the Central 
Excise Rules as a Dealer/Depot. Navigate to Trading Information Tab of the Additional 
Organization Information to enter Excise Registration details of a Dealer. The 
information entered here would be printed on all relevant reports and invoices raised 
from this Organization. You would ensure that no values are entered in any of the fields
falling under the Excise region of the Tax Information tab of the Additional 
Organization Information. Any value entered in this region would categorize this 
Organization as a Manufacturing Organization. For further information, see: Defining 
Trading Registration Details, page 1-8.

Define Excise Invoice Generation
This feature can be used to automate the Excise Invoice document sequence generation. 
You can setup a document sequence for the combination of Transaction Type, Order or 
Invoice Type and Register Type. You can define an alpha or alphanumeric value which 
would be prefixed to the number series generated for each Excise Invoice. The setup 
would be restricted to the Order or Invoice Types for which it is created. For all other 
Excise Invoices which are created using Order or Invoice Types for which setup has not 
been made, the system use the default number series. This would be a numeric series, 
starting with one, increased by one. The sequence would be different for each 
Organization or Location and the nature of clearance. Within the Organization, the 
sequence would be different for the Domestic clearances and Export Clearances. For 
further information, see: Defining Excise Invoice Generation, page 1-19.

Define Sub Inventory Location
As a part of localization setup, sub-inventories have to be associated to a combination of
Organization or Location. Excise related transactions and records would be updated 
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only for those sub Inventories that are identified as bonded for Manufacturing 
Organizations and as traded for Trading Organizations. For further information, see: 
<Defining Sub Inventory Location, India Local Inventory Chapter>.

Define Localization Item Information
The recording, recoverability and reporting of Localization Taxes would depend on 
Oracle Financials for India related information setup for the Item. These values have to 
be entered in Oracle Financials for India context of the Items DFF, attached to the Item 
Master. Excise Registers would be updated only when the Excise Flag is set to 'YES'. 
Similarly, considering CENVAT Credit and updating the Excise Registers for a 
Receiving transaction would happen only when the 'MODVAT' flag is set to 'Yes'. The 
option chosen in the Item Class attribute would be the basis on which the type of Excise 
Credit Register that has to be hit. Items classified in the other classes (such as OTIN, 
OTEX) would not be update Excise Records.

The Trading Flag works together with the Organization Trading Information setup. 
RG23D Register is hit only when the Trading item is transacted in a trading 
organization. For further information, see: <Defining Item Information, India Local 
Inventory Chapter>.

Define Inter Organization Relationship
Inter Organization relation needs to be assigned before carrying out the transactions. 
Inter Organization relations can be defined through the Shipping Networks Form in the
India Local Inventory Responsibility.

Define Tax Codes
The Tax Definition is a localization feature to define taxes that are applicable to the 
transactions created in your Organization. The Taxes can be classified in different 
Types. The Type would be useful to recognize the relevance of the tax for the Excise 
Registers, Sales Tax Form generation and TDS Certificate generation. The Type chosen 
would also have influence over the behavior of other fields in this form. You can specify
the Tax Rate, Surcharge, Recoverability, Rounding Rule, Expense Account Code, Tax 
(Third party) Vendor, Multi-currency and Effective Period for the Tax. In a 
multi-organization setup, Taxes would be specific to an Organization. On choosing the 
Taxes Localized option from the menu, you would get the list of Inventory 
Organizations, to choose from. The tax defined can be used only for the Organization 
for which it is defined. Taxes once saved cannot be updated.

Define Tax Categories
If you can identify your purchase and sales transactions into clear categories for which a
similar set of taxes with similar precedence and calculation are applicable, then you can 
group such taxes into a Tax Category. In a Tax Category you can choose the Taxes along
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with the precedence order and calculation basis.

An Item Class can be identified for a Tax Category. These taxes would default for all the
Items falling in this class. This would be useful, where the Item class drives the tax 
applicability. These taxes would default for the transactions created for the items in the 
item class. You can however, manually add new tax lines and can change, delete, 
change precedence for the defaulted lines. For further information, see: <Defining Tax 
Categories, India Local Inventory Chapter>.

Define Item Categories
Item Category allows you to assign Tax Categories to an inventory item in an 
Organization. You can attach an Item Category to the Additional Internal Customer 
information. The Taxes defaulted for a transaction line would be based on the Item 
Category attached to the Internal Customer and the Tax Category assigned to the Item 
in this category. For further information, see: <Defining Item Category List, India 
Local Inventory Chapter>.

Define Assessable Price Lists
When the Taxable basis for the calculation of the Excise Duty is different from the Price 
at which the Item is transferred, then the user will has to create additional Price Lists 
with the Item Excise Assessable Price. This price list has to be attached to the Internal 
Customer or Customer Site. The Assessable Price would be considered only for 
calculation of the Excise Duty. Assessable Price Lists needs to be defined separately for 
Excise and VAT if the taxable basis is different. For further information, see: <Defining 
Assessable Price List, India Local Inventory Chapter>.

Define VAT Regime
Regime would be used to define rules that would be applicable to all Taxes assigned to 
it. You need to complete this setup step before you move ahead with other setups. 
Setups made for a Regime would be applicable to all transactions created from the 
Organizations assigned to it. Information defined here would be generic unless you 
assign different properties at an Organization Level.

In the Regime the user has to provide VAT Registration Number and Accounts 
associated with the Regime such as Liability and Interim Liability accounts for the 
Taxes and assign Organizations to it. For further information, see: <Define VAT 
Regime, Oracle Inventory Chapter>.

Define VAT Claim Terms
VAT taxes applicable to a purchase of Capital Goods can be recovered over a period of 
time as specified under the VAT Act. The VAT Claim terms enables users to define VAT
Recovery Term. These terms can be assigned to the VAT Item Classes. For further 
information, see: <Claim VAT under Define VAT regime in Oracle Inventory 
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chapter>.

Define VAT Generation Sequence
VAT Invoice sequence can be defined for an Order/Invoice Type. The user can also 
specify prefixes for each series. A default series would be defined automatically for the 
regime. This would be applicable to the Transaction Types to which no series has been 
defined.

Define Customer Additional Information
Before you start creating transactions for the Customer, it would prerequisite to record 
the localization related information for the Customer Site. You would enter the 
Customer Registration details with the Excise, Sales Tax and Income Tax Authorities. 
You will also attach the Assessable Price list that should be considered for the 
calculation of Excise Duty & VAT. You would also define the Item Category list to 
default localization taxes. You will have to make this setup for each Customer Site. For 
further information, see: Define Customer Additional Information, page 4-22.

Defining Item Information
You need to associate Localization related information of an Item before you start using 
the Item for Oracle Financials for India transactions.

Prerequisites 

Before you enter the Item Information, you must:

• Define Organizations

• Define Items

Under VAT/Excise Regime, items have to be classified into Capital Goods, Raw 
Material, Finished Goods (Non-capital Goods). You can classify the items into these 
categories. Along with classification of items, you can also specify CENVAT/VAT 
applicability, recoverability and Classification code for each Item. You can setup 
templates with possible Item classifications. Multiple items can be assigned to templates
at the same time.

This feature enhances usability and minimizes time required to complete this setup. To 
define Item Classifications, access India Local Inventory responsibility by navigating to 
Setup > Item Setup > VAT / EXCISE Item Classification.

Item Classification

Items need to be classified to define recovery claim terms for them. The following 
attributes need to be captured for each item:
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Attribute Name Attribute Value

Applicable This attribute defines the applicability of VAT to 
items. This attribute is important in determining 
whether VAT will be charged in the OM - AR cycle.

Possible Values:

1. Yes

VAT is applicable on the OM - AR cycle and VAT 
liability on these transactions will be accounted. All 
items on which VAT liability arises should be 
defined as Yes.

2. No

VAT is not applicable for these items and you 
should not attach VAT taxes at the time of 
transactions.

Item Class This is the Item Classification for the purpose of 
VAT. This Item Classification is important from the 
accounting and VAT claim point of view. You can 
define different accounting and VAT claim rules for 
different Classes of Items.

Possible Values:

1. Raw Materials: All material on which VAT needs 
to be claimed in PO - AP cycle should be defined as 
Raw Materials.

2. Capital Goods: All Capital Items on which VAT 
needs to be claimed in PO - AP cycle should be 
defined as Capital Goods.

3. Finished Goods: All items on which VAT liability 
arises in the OM - AR cycle should be defined as 
Finished Goods.

4. Other Goods: This is the residuary category. 
Items may be defined as Other Goods and 
accounting rules can be defined for these as well.
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Attribute Name Attribute Value

Recoverable This attribute defines whether input tax claim of 
VAT Taxes can be availed. This attribute is 
important in determining whether VAT claim can 
be made for an item in the PO - AP cycle.

Possible Values:

1. Yes: Input VAT claim in PO - AP cycle can be 
availed based on this attribute. All input material on
which input VAT claim has to be made should be 
defined as Yes.

2. No: Input VAT claim is not applicable if this 
attribute set to No.

Item Folio This is dummy attribute where users can store any 
requisite data, which can be used in future for 
custom needs.

Item Attribute Definition Process

As part of the VAT solution, Oracle Financials for India allows you to define templates 
for item attributes and assign them to items.

You can define an Item Template and its name along with combination of the Tax 
Regime, the Applicability, Item class and other common attributes. This defined 
template can then be attached to multiple items, reducing the need to revisit individual 
items and repetitive defining of attributes for each item. You can also assign the same 
template to various organizations for that item.

Assigning Item Attributes 

To assign item attributes, navigate to India Local Inventory > Setup > Item Setup > 
India/VAT Service Tax > Setup > India VAT/Excise > Item Classification

The Find Item / Template / Assignment window allows you to search for:

• Item Attributes for a Single Item

• Attribute Template for a Single template

• Template Assignments currently made

Find Item Attribute

The table provides a detailed field-wise description of the Find Item Attribute screen.
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Field Description Type Action Description

Item / Template (Required) DISPLAY You will choose this to find the Item
attributes of a Single Item

Regime (Required) PICK

HELP 

EDIT

You will have to pick the Regime 
here. Currently only Value Added 
Tax is available here.

Organization (Required) PICK

HELP 

EDIT

You will have to choose the 
Organization here.

Item Name (Required) PICK

HELP 

EDIT

You will have to choose the item for
which you want to view the Item 
Attributes

Click Find to search for an existing item for which these attributes are setup. Click New 
to defines attributes of a single item and navigate to Item / Template Attribute 
Registration Form.

Field Description Type Action Description

Header Section      

Regime (Required) PICK

HELP

EDIT

You will have to pick the Regime
here. Currently only Value Added
Tax is available here.

Organization (Required) PICK

HELP

EDIT

You will have to choose the
Organization here.

Item Name (Required) PICK

HELP

EDIT

You will have to choose the Item for
which you want to define the Item
Attributes
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Field Description Type Action Description

Attributes
Registration Section

    On entering the header information,
the 3 Attribute Names will appear
in this block. You will have to
choose the Attribute Values from
the LOV provided. For details of the
Attribute Names, possible Attribute
Values and their meaning please
refer the detailed discussion above.

Field Description Type Action Description

Item / Template (Required) DISPLAY You will choose this to find the
Item attributes of a Single Item

Regime (Required) PICK

HELP

EDIT

You will have to pick the Regime
here. Currently only Value Added
Tax is available here.

Organization     This field is disabled.

Item Name (Required) PICK

HELP

EDIT

You will have to choose the item for
which you want to view the Item
Attributes.

You can use the "New" button to create a new template without giving any details in 
the find window.

If you have already defined a template after entering the 3 mandatory fields above you 
should click on the "Find" button that takes you to the Item / Template Attribute 
Registration screen

Field Description Type Action Description

Header Section      
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Field Description Type Action Description

Regime (Required) PICK

HELP

EDIT

You will have to pick the Regime
here. Currently only Value Added
Tax is available here.

Template Name (Required) PICK

HELP

EDIT

You should give a name to the
template. An easily identifiable
name should be given to the
template.

Attributes
Registration Section

    On entering the header
information, the 3 Attribute Names
will appear in this block. You will
have to choose the Attribute Values
from the LOV provided. For details
of the Attribute Names, possible
Attribute Values and their meaning
please refer the detailed discussion
above.

It is recommended that you define the following templates before hand & the same can 
be then attached to items as necessary.

Template Name Item Class Excisable/VA
T

Applicable

Recoverable

Raw Materials VAT
able Recoverable
Template

RM Y Y

Capital Goods VAT
able Recoverable
Template

CG Y Y

Finished Goods VAT
able Recoverable
Template

FG Y Y
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Template Name Item Class Excisable/VA
T

Applicable

Recoverable

Other Goods VAT
able Recoverable
Template

OT Y Y

Raw Materials VAT
able Non Recoverable
Template

RM Y N

Capital Goods VAT
able Non Recoverable
Template

CG Y N

Finished Goods VAT
able Non Recoverable
Template

FG Y N

Other Goods VAT
able Non Recoverable
Template

OT Y N

Raw Materials VAT
able Recoverable
Template

RM N Y

Capital Goods VAT
able Recoverable
Template

CG N Y

Finished Goods VAT
able Recoverable
Template

FG N Y

Other Goods VAT
able Recoverable
Template

OT N Y

Raw Materials VAT
able Non Recoverable
Template

RM N N
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Template Name Item Class Excisable/VA
T

Applicable

Recoverable

Capital Goods VAT
able Non Recoverable
Template

CG N N

Finished Goods VAT
able Non Recoverable
Template

FG N N

Other Goods VAT
able Non Recoverable
Template

OT N N

Field Description Type Action Description

Folio No (Optional) PICK

EDIT

HELP

This is an additional field
provided to you to define any
other relevant information. Folio
No is user definable and has no
validations.

Item Tariff (Optional)   This is an additional field
provided to you to define any
other relevant information. Item
Tarrif is user definable has no
validation.

Trading Flag (Optional) PICK EDIT
HELP

By enabling this Flag the entries
into RG23D will be controlled.
For a Non-Trading item this Flag
can be set to 'NO'.

Description of Item Class Code and Impact

Following are the item class codes and its relevant impact.
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Item class code Impact

RMIN All inputs / raw materials / consumables used in or in
relation to the manufacture need to be classified under
this category. All transactions to the Bonded Sub
Inventory with this item class will have an impact on
the records/reports generated for CENVAT credit on
raw materials. (RG 23 A registers will be affected).

RMEX All inputs/raw materials / consumables used in or in
relation to the manufacture needs to be classified
under this category. All transactions to the Bonded
Sub Inventory with this item class will have an impact
on the records/reports generated for CENVAT credit
on raw materials. (RG 23 A registers will be affected).

CGIN All capital goods (as per excise definition) used in or
in relation to the manufacture needs to be classified
under this category. All transactions to the Bonded
Sub Inventory with this item class will have an impact
on the records/reports generated for CENVAT credit
on capital goods. (RG 23 C registers will be affected).

CGEX All capital goods (as per excise definition) used in or
in relation to the manufacture needs to be classified
under this category. All transactions to the Bonded
Sub Inventory with this item class will have an impact
on the records/reports generated for CENVAT credit
on capital goods. (RG 23 C registers will be affected).

CCIN All intermediate goods need to be grouped under this
category. Based on the transaction, records will get
generated in the RG-1 register/CENVAT registers.

CCEX All intermediate goods need to be grouped under this
category. Based on the transaction, records will get
generated in the RG-1 register/CENVAT registers.

FGIN All finished goods manufactured needs to be grouped
under this category. Goods attached to this category
will be posted to RG-1 register at the time of
shipment/production.
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Item class code Impact

FGEX All finished goods manufactured needs to be grouped
under this category. Goods attached to this category
will be posted to RG-1 register at the time of
shipment/production.

OTIN Items falling under this category will not be
considered for any excise related transactions even
though the transactions are from bonded Sub
Inventory.

OTEX Items falling under this category not considered for
any excise related transactions even though the
transactions are from bonded Sub inventory 173 G
Declaration filed by the Organization, the user needs
to associate the excise Tariff to each excisable item.

Following are the other attribute values

Item class code Impact

TRADABLE This value should be set to YES only if the item
defined is to be used as a TRADING ITEM in a
Trading Organization. In case of Manufacturing and
Other items, this value should be set to NO.

MODVATABLE This value should be set to YES only if the Excise
Credit can be availed for this item. For all other items
this values should be set to NO.

EXCISABLE This value should be set to YES only if Excise has to be
charged on goods shipped and an Excise Invoice
needs to be generated.

Item Template Attributes are described below for assignment.

Field Description Type Action Description

Item / Template (Required) DISPLAY You will choose this to find the Item
attributes of a Single Item
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Field Description Type Action Description

Regime (Required) PICK

HELP

EDIT

You will have to pick the Regime
here. Currently only Value Added
Tax is available here.

Organization   PICK

HELP

EDIT

You will have to choose the
Organization here.

Item Name   PICK

HELP

EDIT

You will have to choose the item for
which you want to view the Item
Attributes.

You can create a new Template Assignment for Items not already assigned. You can 
find template assignment for a combination of Regime / Organization / Template. 
Regime field is mandatory above. On defining a template, you should press the "Find" 
button. You have to query find an existing template and assign items to that.

On clicking the "Find" button the Template Assignment form will be opened for existing
items assignments. The field wise description for the Template Assignment is given 
below

Field Description Type Action Description

Header Section      

Regime   DISPLAY The regime will be displayed here.

Template Name   DISPLAY The template name will be
displayed here.

Master Organization     This field will display the Master
Organization when you query a
template assignment. You can enter
the Master Organization when you
are creating a new template
assignment.
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Field Description Type Action Description

Organizations Section     This field will display the Inventory
Organization when you query a
template assignment. You can enter
the Inventory Origination when you
are creating a new template
assignment.

Code   PICK /

DISPLAY

The Organization code is displayed
here.

Name   PICK /

DISPLAY

Organization name will be
displayed here.

Template LOV PICK Will show you a LOV of Templates
defined and available for picking
up.

Item Registration
Section

    You can select items here and assign
them to the template

Items Like     This is a query find facility to find
items by name.

Find Item BUTTON   You can use this button to find the
items after entering value in "Items
Like" field.

Clear BUTTON   Use this button to clear the query
find criteria.

Item Name   DISPLAY This field shows the items queried.

Description   DISPLAY This field shows item description

Assign Template   CHECK BOX Click this checkbox to assign the
template to the item
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Field Description Type Action Description

Show Attributes BUTTON   On clicking this button you can see
and change attributes for that
particular item. However changes to
a item would result in the same
being removed from the template
assignment.

Check all / Uncheck
All

BUTTON   This is a toggle key, which will
enable you to assign or unassign all
the selected items.

Setting Up Tax Information
Detailed explanation for the user is provided here for Setting up the Tax Information

Defining Tax Names/Codes
You must define Taxes before you start using Oracle Financials for India. Tax codes will
be the basis for all localization tax calculations. You should define all taxes applicable to
your Organization.

Tax codes cannot be updated once saved. However, you can disable the tax by entering 
the End Date. Thus, you should adopt adequate caution while defining the taxes.

Prerequisites

Before you enter the Tax Codes, you must:

• Define Organizations

• Define Locations

• Organization Additional Information

• Define Form Names

• Define TDS Sections

• Define Suppliers and Supplier Sites

• Define Tax Authorities

In Oracle Financials for India, navigate to Setup > Tax Setup > Taxes. The taxes are 
relevant to a particular Operating Unit in case of a Multi-Org setup. Once the screen is 
selected from the navigator menu, you have to select the Organization from the list, so 



India Local Inventory    1-79

that the taxes can be related to the corresponding Operating Unit.

The table below provides field-wise description for the Tax Definition screen.

Field Description Type Action Description

Tax Name (Required)   Enter a short tax name/tax code in
this field. It is recommend that
you follow a naming convention
for defining taxes so that the tax
name defines the usage of tax. For
example, CST-4%-C: this means
the tax type is of type Central
Sales Tax, Rate is 4%, and
requires C-Form

Type (Required) EDIT HELP
PICK

Select type of tax from list of
values. This will indicate how to
treat the tax at transaction level.
The options available are:

Tax Name Description Tax Short ID

Excise - Basic BED

Excise - Additional AED

Excise - Special SED

Customs Duty Basic Customs Duty/SAD

Customs Duty Additional CVD

Central Sales Tax CST

Sales Tax LST

Octroi Octroi

Insurance Insurance

Freight Freight
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Tax Name Description Tax Short ID

Service Tax Service Tax

Tax Deduction at Source TDS

Any Other Tax Other taxes/Discounts

Modvat Recovery Modvat Reversal Debit (Rule 6 of CENVAT 
Credit Rules)

Value Added Tax VAT

Value Added Tax Reversal VAT Reversal

Additional CVD Additional CVD

Note: You can review modify existing tax and item categories to 
include the VAT Reversal Tax Type based on your business 
requirement. This tax code can also be manually added on Sales Orders
and AR transactions.

Tax Type determines the type of treatment or procedure that needs to be initiated to 
calculat, record or update tax records. You should ensure that you associate Tax Codes 
with appropriate Tax Types, in tune with your Organizations requirements. For 
example, while defining a tax code/name for Sales Tax you should be using either CST 
or Sales tax as Tax Type. You should take adequate care in selecting tax type.

Important: Apart from the normal tax types like Excise, Customs, Sales 
Tax etc. which are widely used in the industry, Localization provides 
for additional tax types like Insurance, freight, any other tax and 
Modvat Reversal.

Modvat Recovery - Modvat Reversal:

Modvat Reversal needs to be mapped as per the requirements under Rule 57 CC of the 
Central Excise Rules.

Freight, Insurance and Any Other Tax:

Can be used for Accounting for any expense incidental to the Purchase transaction. Any
tax (cost component) defined under these categories will be taken into consideration for 
the calculation item cost, subject to the condition that the Credit Percentage is not 
specified.
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Third Party Taxes:

In the Procure to Pay Cycle, you can make use of the functionality of third Party taxes. 
This can be setup by specifying the Vendor Name and Vendor Site for the Tax Code. 
After receipt, you have to run the Third party taxes concurrent to generate AP Invoices 
for all third part taxes included in the Receipt. While computing the cost of the item, 
these costs also will be considered.

Handling Discounts:

You can use 'Any other Tax' type of taxes with negative Percentage or Unit Rate to 
handle discounts. Oracle Financials for India will also handle any other debit/credit that
needs to be done for any transaction.

Additional CVD:

Assign this Tax Type to Tax Categories having Basic Customs and CVD Tax. When 
Additional CVD is not recoverable, credit percentage at the time of tax definition needs 
to be maintained at '0' or NULL.

Field Description Type Action Description

Description (Required)   Enter meaningful description for
the Tax you define. This should
describe the Tax Name in detail.
Description can have maximum
length of 100 characters
(including spaces).
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Field Description Type Action Description

Account (Required) EDIT HELP
PICK

You can enter the account code by
using accounting flex-field on
which the respective taxes will be
charged and whenever a
particular Tax is used in a
transaction, this respective
General Ledger Account will be
debited or credited. In the Order
to Cash Cycle this account will be
used to account for the Tax
transactions. In Procure to Pay
Cycle, this account will be
charged for the recoverable
portion of the taxes specified for
tax types other than Excise and
Add. Customs.

For example, for a Sales Tax Type
of tax you have defined, tax as
10% and credit % as 50%. During
delivery, sales tax to the tune of
50% will be considered for Item
Cost and the balance 50% (of
recoverable tax amount) will hit
this account.

It is suggested to have dedicated
Tax Names for Procure to Pay
Cycle and then you need to
define the credit percentage.
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Field Description Type Action Description

Vendor Name (Optional/Requir
ed)

EDIT HELP
PICK

You can specify the Vendor Name
here for a Tax Type other than
Excise-Basic, Excise Additional,
Excise-Special, Customs Duty,
and Customs Duty- Additional.
This is a required field in the case
where Tax Type is Tax Deduction
at Source. In case of a 'TDS' Type
of Tax, Vendors of type 'TDS
Authorities' will be displayed in
the list, for all other types of tax,
vendors of type other than 'TDS
Authorities', 'Customs', 'Excise'
will be displayed in the list. The
vendor name appearing here will
be defaulted in the PO tax lines
and it can be changed if the user
enables the update Vendor Flag at
the Additional Organization
Information.

      While creating an III Party Tax
(that can be used in Procure to
Pay Cycle), you need to attach a
Supplier to whom the payment
needs to be done on receipt of the
goods. For example: for a 'Freight'
type of tax, you attach ABC
Transport Company (should have
defined this Vendor in the
Supplier Master), and attach this
tax to a PO. On receipt of the
goods, system by considering the
values at the time of receipt
creates an invoice to ABC
Transport company
automatically. At the same time,
for costing purpose, the freight
will be considered.

Vendor Site (Optional) EDIT HELP
PICK

The user can enter relevant
Vendor Site for the above selected
Vendor Name.
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Field Description Type Action Description

Rate Block     Tax can be defined as based on
any one of the Rates, Unit rate,
Unit of Measure or adhoc type.

Rate (Optional)   Enter the Tax Rate at which the
Tax will be calculated. The user
can either enter Tax rate based on
amount or per unit or on Adhoc
basis.

Discounts can be specified as
Negative Taxes. But this works
only when the Tax Types is 'Any
Other Tax'.

Unit Rate (Optional)   If the Tax is charged per unit then
the user needs to specify the Tax
Rate Per Unit, then the Tax will
be Number of units times Rate
per unit. This field will be
disabled whenever the Tax Type
is Tax Deduction at Source.

Unit of Measure (Optional) EDIT HELP
PICK

Amount Per Unit based taxes can
be used with items having UOM
belonging to same base class of
UOM as that of UOM in tax
definition, unless you have
defined interclass conversion rate
for that item. In Precedence
calculation this type of tax will
not depend on any other tax,
however other taxes of rate basis
can be dependent on result of this
tax.

Example: If a unit tax rate is
defined as Rs.10 per KG you
cannot use the same with item
purchased in Meters unless the
conversion rate between Kg and
meter for that item.
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Field Description Type Action Description

Duty Drawback
Credit Percentage

(Optional)   This percentage is applicable for
Taxes of Type Excise- Basic /
Additional / Special or Customs
Duty or CVD. This percentage
will be used to calculate Duty
drawback.

Adhoc Amount (Optional) Adhoc basis of tax can be used to
define tax amount, which will be
known only at transaction level
(i.e. Freight). You can change
these taxes at transaction level. In
Precedence calculation amount of
such type of tax will not depend
on any other tax whereas other
taxes will be dependent on
amount of this tax type. When
adhoc basis is enabled, then other
fields in the Rate Block will get
disabled.

Field Description Type Action Description

Credit percentage (Optional)   For all input type of taxes, this 
field determines the percentage of
recoverable and irrecoverable 
taxes.
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Field Description Type Action Description

Form 
Name/Certificate

(Optional) EDIT HELP 
PICK 

This column is relevant only for 
Sales Tax & TDS Tax Types. You 
can enter the relevant Tax form 
name like C Form or Form 17 in 
the case of Sales Tax and based on
this information, the Sales Tax 
Forms tracking will done for the 
Customers as and when 
transactions have this tax levied. 
The user can take out reports on 
transactions for which these 
forms are to be issued/received. 
This field is enabled only when 
the tax type is Sales Tax, Central 
Sales Tax and Tax Deduction at 
Source.

TDS Section No. (Optional) EDIT HELP 
PICK 

You can specify the respective 
TDS section for which a particular
tax is being charged on. Since the 
TDS returns needs to be 
submitted in accordance with 
their corresponding section , the 
user can generate TDS reports 
made for the respective TDS 
sections. This field is enabled only
when the tax type is Tax 
Deduction at Source.
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Field Description Type Action Description

Original Tax Percent (Optional)   If the Concessional Tax Rate has
been used for a particular Tax
Code then the user can specify
the actual and Original Tax
Percent in this field. The user can
identify the amount of Tax
benefits or concession for all the
transaction done through
Concessional Tax Rate. This field
will be enabled only when the
Sales Tax Form Name or TDS
Certificate name is specified
otherwise the user cannot enter
any rate in this field.

Important: In case of Excise and Add Customs (CVD) type of taxes, 
where you can take CENVAT Credit under Rule 57 of the Central 
Excise Rules, you must specify the CENVAT Credit percentage 
permitted on that tax. As per the Rules, total credit on the duty paid by 
the supplier can be claimed. Hence for all Excise Type of Taxes you 
must record 100% in this field.

In case of Tax Types other than Excise and Add Customs, you can 
specify the percentage of tax that can be recovered. The 
non-recoverable portion will be accounted in the tax / account defined.

Field Description Type Action Description

Rounding Factor (Optional)   Rounding factor differs for
different Tax Codes. The user can
specify the required rounding
factor for a particular Tax based
on the legal requirement. If this
field is left blank, then the
calculated Tax figure will be
rounded to the nearest Rupee.
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Field Description Type Action Description

Update Vendor (Optional) CHECK BOX This flag is providing flexibility
to the user to change the Vendor
Name at the transaction tax lines
while entering a transaction. But
this Flag cannot be checked for
Customs, Additional Customs,
and TDS Type of Taxes since the
respective tax dues needs to be
paid to the respective
Department Authorities.

For Example: When the tax
amount needs to be paid to the
respective Tax Authorities
instead to the Vendor, then the
user needs to enable this flag and
in effect he can change the
Vendor Name appearing in the
tax lines and the tax liability will
be booked the respective Tax
Authority - Account. By enabling
this option, at the time of receipt,
user will be allowed to change
the Vendor. For example, In the
purchase order, for freight is
considered as III Party Tax and
Vendor attached to the PO is
ABC Transport Company. On
receipt, if the goods were not
transported through ABC
Transport Company and were
brought by TVS, user will be able
to change the Tax Vendor from
ABC Transport Company to TVS.
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Field Description Type Action Description

Update Currency (Optional) CHECK BOX By enabling this flag the user can
change the currency code from
the document currency to the
functional currency if both are
different.

For Example: Assuming a case
where the PO is raised in Foreign
Currency (USD) but the tax like
Customs needs to be paid in
functional currency (INR). By
enabling this Update Currency
Flag the document currency
amount will be converted into
functional currency amount for
the calculation tax.

Update Transaction (Optional) CHECK BOX By enabling this flag the tax
transaction lines can be updated
or modified whenever any
changes are required at the
transaction level.

CESS % age (Optional)   Cess on TDS

Start Date, End Date (Optional) EDIT HELP
PICK

By default the start date is always
current date and end date should
be greater than the start date or it
can be left blank. The period
between start and end date
specifies the effective period of
the tax and when the end date is
null, then it is in effect
indefinitely from the start date. If
you enter end date for a tax, then
the tax will become ineffective
from that date.

Defining Tax Categories
This is a mandatory setup to enable Tax defaulting and automatic calculation at the 
transaction line level. Tax Categories will be based on the taxes that will be applicable to
the transaction and the Tax Base Amount calculation will be determined.

You can associate an Item Class to the Tax category. This Tax category will apply to all 
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items under this class.

Tax Category is a group of relevant Tax Codes with precedence applicable to them.

Prerequisites

Before you enter the Tax Categories, you must: 

• Define Organizations

• Define Locations

• Assign Organization to Locations

• Organization Additional Information

In Oracle Financials for India, navigate to Setup > Tax Setup > Tax Categories. The table 
provides field-wise descriptions of the Tax Categories screen.

Field Description Type Action Description

Header level      

Tax Category (Required) ENTER Enter a Unique name for Tax 
Category. The Tax Category 
Name should be Suggestive, so 
that the User should be able to 
identify the applicability of the 
Tax Category.

Description (Required) ENTER Enter meaningful description for 
the Tax Category you define. This 
should describe the Tax Category 
Name in detail. 

Item Class Code (Optional)   If a Tax Category is associated to a
particular Inventory item class 
then the respective Inventory 
class code can be entered here. 



India Local Inventory    1-91

Field Description Type Action Description

Item Class (Optional)   Optionally enter item class. One 
Tax Category cannot be applied to
more than one Item Class and 
vice-versa. The Tax Category 
defined with an Item class 
defaults at the transaction level 
based on the Item Class that has 
been associated to the transaction 
level 'Item Attribute'. Once an 
Item Class (Predefined by Oracle 
Financials for India) is associated 
to a Tax Category, the same Item 
Class CANNOT BE associated to 
any other Tax category. Based on 
this Item Class the Excise Register
updation will be done for an item.

Line Level      

Line No. (Displayed 
only) 

  Auto generated line number will 
be displayed here. This is the 
value used to define precedence.

Tax Name (Required) EDIT HELP PICK Use this column to enter Tax 
Names from LOV. You can 
associate any number of Tax 
Names to a Tax category. A Tax 
Name can be associated in any 
number of Tax Categories, 
however you cannot use same Tax
Name more than once in a Tax 
Category. The Tax Rate applicable
on transaction date will be 
applicable for that transaction.
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Field Description Type Action Description

Tax Precedence 1- 10 (Optional)   Precedence refers to the manner 
in which the tax will be applied. 
The Tax Rate may be applied on 
the transaction base value or on 
another tax line or compounding 
them or combination of all. The 
base amount or material sale 
value is by default given a 
precedence value of '0'. The 
subsequent precedence are 
assigned to the Tax Names' 
respective Line Numbers. A 
maximum of five levels of 
precedence are permitted. 

The Taxes included in Tax 
Category would default on a 
transaction line. But, you would 
also have a provision to add new 
tax lines manually.

Tax precedence for Additional 
CVD Tax Type should be set to 
the Tax on which it is calculated.

If a tax name is defined as adhoc 
or as Amount Per Unit of measure
then the Precedence has no 
Relevance in tax computation of 
such tax, however, calculation of 
other taxes can be based on this 
tax. A tax cannot be dependent on
itself. However, interdependent 
taxes can be set up in precedence 
e.g. tax at line 1 can depend on tax
at line 2. Similarly, tax on line 2 
can depend on tax at line 1. 

For example Define a Tax 
Category for a Item A purchased 
for Location B and the following 
taxes are applicable. 

Step 1 - Define the above Tax 
Names and percentages in the Tax
Name Definition. 

Step 2 - Associate the above Tax 
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Field Description Type Action Description

Names in the Tax Categories 
window accordingly for tax 
calculations. At this point, the 
dependence of tax on other tax 
needs to be defined in the system. 
If Sales Tax needs to be calculated 
on both line price and Excise 
Duty, the same can be defined in 
this screen. If '0' is defined then 
tax will get calculated only on the 
line price. In the 2nd line if it is 0 
and 1, then the 2 nd line tax will 
be calculated on the line price and
the I st tax.

In this example line amount is Rs. 1000/-. The taxes mentioned below are applicable.

Tax Calculation

Excise duty 16% to be worked on the line amount

Sales tax 4% to be worked on line price and Excise Duty

Freight Rs.100 Adhoc tax not depending on other taxes

Insurance 2% to be worked on the line amount

Tax name Tax Calculation

Excise duty 16% to be worked on the line amount/Assessable value

Sales tax 4% to be worked on line price and Excise Duty

Freight - Adhoc Adhoc amount - no precedence needs to be
attached

Insurance 2% to be worked on the line amount

To implement SHE Cess solution, you must update the Tax Categories to include the 
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newly defined Tax Codes. For detailed information on new Tax Codes, see Defining 
Accounting Information for Organization, page 1-8.

Defining Item Category List
Item Category List associates the Tax Category to an Inventory Item in an Organization.
The user can add many items in a list and select relevant Tax Category for them. There 
can be many such item category lists defined and associated to the Vendor/Customer 
sites.

If the Item Category is attached to the Additional Customer/Supplier Information, the 
Item Category will get defaulted whenever a transaction is done with the 
Customer/Supplier.

Use this form to associate Inventory items to Tax Categories.

Prerequisites

Before you enter the Item Category List, you must: 

• Define Organizations

• Define Locations

• Organization Additional Information

• Define Tax Categories

• Define Items

In Oracle Financials for India, navigate to Setup > Tax Setup > Item Categories.

The table below details field-wise descriptions of the Item Categories screen.

Field Description Type Action Description

Header level      

Name (Required) ENTER The user has to specify the unique
Item Category List Name.

Description (Required) ENTER Enter a description for the Item
Category List. This should
describe the Item Category List
Name in detail.

Line level      
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Field Description Type Action Description

Item (Required) EDIT HELP
PICK

Select the Items from the LOV.

Tax Category (Required) EDIT HELP
PICK

Select the relevant Tax Category
from the LOV.

Important: By assigning this Tax Category list to a Supplier Site in the 
Supplier Tax Information - India Local window, the tax lines for a 
particular Vendor/Vendor Site or Customer / Customer Site, for a 
particular Item will get defaulted according to the precedence set in the 
Tax Category. The user should use a unique Item Category List Name 
and meaningful description.

Defining Manual BOM
The objective of this screen is to facilitate Duty Drawback processing and reporting. If 
you are not using localization for Duty Drawback processing, this feature can be 
ignored.

Data in this form can be used for OSP related transactions and Drawback related a 
report if a standard BOM is not defined.

This form will be exclusively used to design Manual Bill Of Material for a finished 
goods Inventory item.

Use This Window to enter Bill of Material for a Finished Item, if you are not using 
Oracle BOM. You can enter different Bill of Material for same item, effective in different 
Dates ranges. This BOM definition will be used for Duty Drawback Processing and 
Outside Processing purpose.

Prerequisites

Before you enter the Manual BOM, you must:

• Define Organizations

• Define Locations

• Define Routings

• Define Operations

• Define Departments

In Oracle Financials for India, navigate to Setup > Items > Define Manual BOM.
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The table below details field-wise description of the Manual Bills of Materials screen.

Field Description Type Action Description

Item (Required) EDIT HELP
PICK

You need to enter a Finished
Goods Item from the LOV for
which you want to define the Bill
of Material. LOV will be restricted
to the Items with item class as
Finished Goods

UOM (Displayed)   The UOM for the above Finished
Goods Item will be displayed.

Item (Required) EDIT HELP
PICK

Enter Items, which are used in
Manufacture of Finished good. A
same item cannot be used twice in
a BOM. The Finished Item for
which BOM is defined cannot be
included in its BOM.

UOM (Displayed)   The UOM for the above input
item will be displayed.

Quantity (Required)   Enter a Quantity required to
manufacture one unit (primary
UOM) of Finished item.

Managing India Local Inventory
This section elaborates on the effect of Transactions that can be handled through Oracle 
Financials for India Inventory.

Transactions
The Miscellaneous transaction form has been customized to accommodate the RG 
Register entries through a separate transaction type.

In Oracle Financials for India, navigate to Transactions > Miscellaneous Transaction.

Additional types of 'Miscellaneous Issue (RG update)' and 'Miscellaneous Receipt (RG 
update)' are introduced under Oracle Financials for India. However, there is No change 
in the Transaction Lines window.

The only difference between Miscellaneous Issue/Receipt (RG Update) and 
Miscellaneous Issue/Receipt is that the respective Excise Inventory Registers are 
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updated when the input material is issued from stores to the production or finished 
goods / input material is received back into stores from production.

RG - I Register Entry
This is a view / entry form that can be used to view/enter the Manual RG-I Transaction. 
RG -I Register is the daily stock account for all excisable products. It displays on query 
all the transactions that have an entry in the RG-I Register. Each Inventory Organization
will be considered, as an Excise Unit and the user need to specify the Organization 
Name and Location both for querying & for making manual entries into the register. 
Querying can be done based on certain fields on the Entry Block and also Transaction 
Details block.

In Oracle Financials for India, navigate to Transactions > RG Registers > RG1 Register 
Entry.

The field wise description of RG-I Register and its feature are given here for your ready 
reference. The following fields are to be entered by the user for manual Entry. Based on 
your requirement, specify any one of the following fields to View/Enter a Manual Entry 
in the Register.

Field Description Type Action Description

Operating Unit (Required) EDIT

HELP

PICK

Use needs to select the Operating
Unit from the LOV.

Organization (Required) EDIT HELP
PICK

The user needs to specify the
Inventory Organization name
from LOV for which the Manual
Excise Entry is going to be
accounted. The user needs to
specify a Inventory Organization
for which he wants to view the
RG-I Register balance and
information.
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Field Description Type Action Description

Location (Required) EDIT HELP
PICK

The user needs to specify the
Location of an Inventory
Organization from LOV for which
Manual Excise Entry is going to
be accounted. The user needs to
specify a Location of an Inventory
Organization for which he wants
to view the RG-I Register balance
and information.

Serial No     It is system generated serial
number, which is generated
automatically after entering a
transaction.

Transaction Date (Required)   The Transaction Date will be
entered here, If the user wants to
view the RG-I Register for a
particular day then he has to
specify the Transaction Date.

Transaction Type (Required) EDIT HELP
PICK

The Transaction Types are
Receipts, Issue, Inter-Org-Receipt,
Inter-Org-Issue, Receipts
Adjustment, Issue Adjustment,
Production Receipts, Production
Issue and Customer Return. By
picking one the type, the user can
view/enter a RG-1 entries for that
type.

Item (Required) EDIT HELP
PICK

The user needs to specify the Item
for which the receipts or issue
entry is going to be passed.

Customer/Vendor
Name Location

(Optional) EDIT HELP
PICK

Details such as Name as per
Vendor Site will be shown for
Receipt Transactions. For Manual
Entry these fields are optional. If
item is sold directly similar
details of Customer will be
shown.
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Field Description Type Action Description

Customer/Vendor site (Optional) EDIT HELP
PICK

Details such as Vendor Site, will
be shown for Receipt
Transactions. For Manual Entry
these fields are optional. If item is
sold directly similar details of
Customer Site will be shown.

Transaction Detail
Block

(Required/Displ
ayed)

  This Block will have the
Transaction details with respect
to Reference Number, Packed
Quantity, Loose quantity, UOM
and Registers RG23A or RG23C
or PLA which has been used for
Issue. These can be entered by the
User while entering Manual RG-I
Entry. Please note for a
Transaction Type ' Issue', the
Excise Invoice Number will be
displayed in the Reference No
field.

Additional Detail
Block

    This Block will have the
Transaction details depending
upon the Transaction Type Issue,
Inter-Org-Issue, Issue
Adjustment, and Customer
Return.

Excise Rate / Excise
Amount in the
Additional Details
Block

    These fields will be
enabled/disabled depending
upon the Issue Type in the
Additional Details block.

Excise Amount Block     This will be enabled only for
Issue related transactions while
entering a Manual Entry. Excise
Basic, Additional, Others , Excise
Cess, CVD Cess amount paid on
delivery of goods will be
displayed here.
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Field Description Type Action Description

Account     This will be enabled only for issue
related transactions to enter the
account code.

User need to take enough care to
ensure that proper GL Account is
selected for the transaction, as
selection of improper GL
accounts will have far reaching
consequences for account
reconciliation.

Additional
Information Block

(Optional)   The user can enter the Purpose &
remarks regarding a Manual RG-I
entry.

RG 23 Register Entry

RG 23A Register
Adjustments/Manual entries in the CENVAT on inputs can be done in this register. All 
excisable goods of item type RMIN and RMEX , and credits availed on inputs will be 
accounted in this register

Important: This feature can also be used to upload the opening balances
for a newly created Organization.

RG 23C Register
Adjustments/Manual entries in the CENVAT on Capital Goods can be done in this 
register. All excisable goods with item type CGIN and CGEX, and credits availed on 
capital goods will be accounted in this Register

This RG23 Manual Entry form can be used for both view/enter RG 23A & C Part I & II 
entries.

Navigate to this screen from Oracle Financials for India responsibility Registers > RG23 
Register Entry.
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Field Description Type Action Description

Organization Required EDIT HELP
PICK

The user need to specify the
Inventory Organization name
from LOV in which RG23
Register entries are going to be
accounted. The user needs to
specify an Inventory
Organization for which he wants
to view the RG-23A & C Register
balance and information.

Location Required EDIT HELP
PICK

The user needs to specify the
Location of an Inventory
Organization from LOV in which
the RG23 entries are going to be
accounted. The user needs to
specify a Location of an
Inventory Organization for which
he wants to view the RG-23A & C
Register balance and information.

Serial No     It is system generated Serial
Number after entering a
transaction.

Transaction Date Required   The Transaction Date will be
entered here and If the user
wants to view the RG-23A & C
Register for a particular day then
he has to specify the Transaction
Date.

Transaction Type Required EDIT HELP
PICK

The Transaction Types are
Receipts, Issue,
Inter-Org-Receipt,
Inter-Org-Issue, Receipts
Adjustment, Issue Adjustment,
Production Receipts, Production
Issue; Customer return can be
entered here. By picking one the
types, the user can view all
RG-23A & C entries for that type.
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Field Description Type Action Description

Issue Type Optional PICK Select the destination of issue
here. If the destination of Issue is
within the country then, select
'Domestic'. Else, it should be
'Export'

Generate Excise
Invoice

Optional Enter Check this field if Excise Invoice
has to be generated for this
transaction. This will be
applicable for issue transaction
alone.

Item Required EDIT HELP
PICK

The user needs to specify Item for
which the receipts/issue entry is
going to be passed.

Customer/Vendor
Name

Optional Enter Enter Customer/Vendor Name
and make a Manual Entry in
RG-23 Register.

Customer/Vendor
Location

Optional Enter Enter Customer/Vendor Location.

Transaction Detail
Block

    This lock will have transaction
details like Reference Number,
Packed Quantity, Loose Quantity,
UOM and Registers RG23A or
RG23C or PLA, specific to the
transaction.

Additional Details
Block

    Union Budget 2000-2001 allows
instant credit on capital goods on
receipt to the tune of 50% and the
procedure of taking credit, only
on installation, is dispensed with.
These tables/fields are
maintained only for future
requirements. You can still use
these fields to capture
information & the same would
not have an impact of RG23
Reports.
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Field Description Type Action Description

Verification Date (Optional)   This field is relevant in RG 23C
for Capital Goods purchase.
Enter the verification date of the
Capital Item.

Installation Date Optional   This field is relevant in RG 23C
for Capital Goods purchase.
Enter the Installation date of the
Capital Item.

Commission Date Optional   This field is relevant in RG 23C
for Capital Goods purchase.
Enter the Commission date of the
Capital Item.

Brand Name Optional   This field is relevant in RG 23C
for Capital Goods purchase.
Enter the Brand name of the
Capital Item.

Identification
Number

Optional   Enter Identification Number of
the Capital Item.

Excise Amount Block Displayed None Shows the amount of CENVAT
credit taken on inputs

Basic/Additional/Oth
ers

Displayed EDIT HELP
PICK

Amount of MODVAT credit
taken on account of Basic,
Additional and other Excise Duty
on the items purchased &
received. This field will display
the amount of CENVAT credit
utilized for the dispatch of final
products.

Additional CVD     Enter Additional CVD amount in
this column.
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Field Description Type Action Description

Excise Cess, CVD
Cess

Displayed EDIT HELP
PICK

Amount of Cess credit taken on
account of Basic and CVD Duty
on the items purchased &
received. This field will display
the amount of CENVAT credit
utilized for the dispatch of final
products.

Account Required EDIT HELP
PICK

Enter the Account code to which
the credit taken on the inputs will
be debited in the General Ledger
and the sane account will be
credited when dispatches sent
out.

Place of Installation Optional   Enter the location where the
Capital Item is installed.

Identification Mark Optional   Enter a relevant Identification
mark of a capital item.

Remarks Block     You can enter relevant remarks
for RG23 Part-I & II register for
reference and correspondence

Apply Time Extension
Apply Time Extensions screen can be invoked to apply for additional time. In the case 
of OSP from Inventory or Sales Returns Transactions if the Vendor wants some more 
time means, he can invoke the time extensions screen & find the appropriate 
information by entering the transaction type or the start & end date limits or by 
entering both. He can apply for the time extension, he need. Then the due date is 
automatically defaulted. It can either be applied or rejected by the appropriate 
authority. In the case of rejection, the due date is cleared.

This screen can also be used for recording the additional time granted by the Excise 
Authorities to Receive/Return goods under Rule 173 H and 173 L of the Central Excise 
Rules.

As per the changes announced in Union Budget 2000-2001, there is no need to debit 
duty while clearing goods for sub contracting operations under Rule 57 F (4). The 
requirement for taking time extensions to bring the goods sent under 57 F (4) Challan 
also stands withdrawn.
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As per the current provisions of the Law, duty need to be debited only if the goods sent 
for sub contracting operations are not received back within 180 days. Later if the goods 
are received back, the duty debited can be availed. This requirement can be mapped 
through Manual RG 23 Entries.

Though the requirement for recording the time extensions granted by the Excise 
authorities does not exist, the form is maintained in the current release by considering 
similar future requirements.

Navigation to India Localization > Transaction > Apply time Extension.

Field Description Type Action Description

Trans Name (Required) ENTER The user needs to pick up either 
OSP Transaction or Sales return. 

Vendor/Customer 
Name

(Required) EDIT HELP 
PICK 

The user need to enter valid 
Customer/Vendor Name.

User Ref. No. (Optional) EDIT HELP 
PICK 

Reference No. can be entered 
here. The user need to enter valid 
Customer/Vendor Name. 

After querying the OSP or Sales Transaction, the user can enter extended time limit for a
transaction and create a record then the due date gets extended by using the below 
mentioned form.

Navigation to India Localization > Transaction > Apply time Extension.

Trans Name, Vendor Name, User Ref No., Trans Date, Original Due Date Extended Due
date is displayed as per referenced transaction.

Field Description Type Action Description

Sl. No. (Required)   Sl. No. is a system generated Serial
No.

Ext Days (Required)   You can enter Number of Days for
Extension.

Status (Required) PICK Select Status from drop list. The
Options available are Applied,
Approved and Rejected. Initially it
will be applied. It can be changed to
Approved or Rejected.
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Field Description Type Action Description

Due Date (Displayed)   Display only field giving the Due
Date after applying the Time
Extension.

Master Organization RG Consolidation
If Multiple Organizations are defined within the same Excise Registered premises, user 
can opt to identify One Organization & Location Combination as "Master Organization"
and all other Organizations needs to be treated as Child Organizations and should have
the reference of the master Organization based on ECC code. In such type of setup, the 
Master Organization will be the Organization at which all excise registers should be 
generated.

The master child relationship among the Organization and location are used only to 
generate consolidated excise registers at Master Organization level. You need to submit 
'India Master Org RG' request set in order to get Excise Registers consolidated at Master
Organization.

Steps for running the Master Organization RG Consolidation:

• Ensure that proper setup is done to establish the relationship between the Master 
and Child Organizations. Please note that the Master Organization flag should be 
ticked in the Organization-Location record of the Master Organization.

• Organization Location defined, as Master Organization should be a Dummy 
Organization only used for Excise Reporting. No transactions should be done in the
Master Organization Location directly.

• Master Organization Consolidation request set could be run at periodic intervals 
depending on the reporting requirements.

Master Org RG Entries Request Set
Navigate to Inventory > Reports > All > Request Set > Master Org RG Entries to run the 
request set. This request set consists of 4 requests, one each for consolidation RG23 A, C,
PLA and RG1 Registers. Parameters for each of the requests are same: 

Organization (Required) PICK HELP

Name of the Master Organization is to be given in this parameter.

Location (Required) PICK HELP

Name of the Master Organization Location is to be given in this parameter 
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After completion of the Request Set, the consolidated RG Entries and balances shall be 
available at the Master Organization Location. This request set is only a program to 
copy and consolidate the Child Organization records. Normal RG reports shall have to 
be used for viewing and printing the RG reports for the Master Organization. The 
entries for individual Child Organizations shall still be available and if required reports 
could be obtained for Child Organizations as well.

View Register Balance
This section gives us details of the various Register balances.

The user can view the Excise Registers RG23A Part-II, RG23C Part-II and PLA balances 
through this form.

Transactions RG Registers View Register Balance

After specifying the Operating Unit, Inventory Organization Name, Location and 
currency the user will get Excise Register balances in the Balances Block.

RG23A Part-II balance represents the balance available on Account of credit availed on 
Inputs.

RG23 A CESS Amount represents the balance available on Account of credit availed on 
Inputs.

RG23C Part-II balance represents the balance available on account of credits availed on 
capital goods.

RG23 C CESS Amount represents the balance available on Account of credit availed on 
capital goods

PLA Register represents the balance available in PLA Register.

PLA CESS represents the cess balance available in PLA Register.

View Item Definition
This view form has been designed to find the relevant Tax Information for an Item. Item
definition provides the Localization information for an item with respect to Tax 
applicability for an Inventory Organization Location.

By invoking the screen India Local Find Item Information we can find the Tax 
Information relating to Localization. Items - Item Definition.
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Field Description Type Action Description

Organization Scope (Required) EDIT HELP 
PICK 

User can select Organization 
scope which to enter Items 
definition. The Quick pick for 
Organization scope are Single or 
Single with Master or All 
Organizations.

Organization (Optionally 
Required) 

EDIT HELP 
PICK 

When the user has Single or 
Single with Master Organization 
Scope then he need to pickup the 
Inventory Organization from the 
LOV. 

Item/Description (Required) EDIT HELP 
PICK 

Select the item from LOV for 
which you want to view the Item 
definition.

Localization Info     India Local Item Information 
form is invoked by opening the 
Localization Info Button and the 
information are defaulted from 
the Master Item regarding the 
Excise Flag, Modvat Flag, Item 
Class, Item Folio and Item Tariff.

The Standard Applications Item Information form can be invoked by clicking the Open 
button in this form and view the item categories, attributes and Revision details.

Outside Processing Transaction
Outside Processing (OSP) may happen in two circumstances:

1. Where processing is done without any additional material being input by the OSP 
Vendor

2. Where processing is done with additional use of materials

The case where additional material are used by the Vendor, the transaction is not being 
covered under Excise Rule 57(F)

Under Rule 57(F) of Excise, material may be sent outside the factory for processing on 
payment of specified percentage (presently 10%) of the value of the goods, which can be
reversed provided the goods comeback within the specified (180) number of days. No 
additional material is permitted to be added by the vendor to ensure that the value 
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addition relates to labor only.

The above provisions of Excise pertaining to debiting ( 10% of the material cost as ) duty
and reversing the same once the OSP material is received back in total held goods only 
upto 31-March-2000. W.E.F 01-April-2000, there is no need to keep a manual track on 
overdue issues i.e those pending for more than 180 days. The duty on such issues has to
be calculated manually and debited to the duty paying register through RG 23 Manual 
Entry Screen.

Basic Business Needs
The India Local OPM outside functionality satisfies the following requirements of 
Tracking Goods sent for Outside Processing:

• Track Issue of Process Material

• Track Receipt of Process Material

• Select Payment Register at the time of Issue and Receipt

Major Features

Maintenance of details of 57F(4).

User is provided with facility to maintain the details of 57F(4) and select Payment 
Registers at the time of Issue and Receipt of Process Material.

Prerequisites:

• A Production batch should be created giving all the issue and receivable items and 
WIP warehouse should be defined as on OSP warehouse in the Warehouse 
Attributes Form.

• A Purchase Order for conversion charges should be attached to the above 
production batch in the Purchasing Module.

• The credit entries can be passed only after receiving the last consignment of 
material even if the material is received in batches (staggered delivery). In India 
Local OPM this can happen only when the OSP batch is closed.

Outside Processing Transaction
By using India Local OPM features, issue and receipt of goods for subcontracting can be
tracked based on parameters setup in the Additional Organization Information, duty 
will be debited at the time of removal of goods and the same can be credited on receipt 
of the goods. If there is no need to pay on removal of goods for subcontracting, user 
needs to take care to setup ZERO in the OSP percentage field of Additional 
Organization Information. User needs to keep a manual track for the receipt of goods 
and if the goods are not received back in 180 days, duty needs to be worked out 
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manually and amount should be debited in paying duty registers through RG23 
Manual Entry Screen.

Prerequisites:

• All Items sent for Outside Processing must exist in Item Master.

• OPS Relation is properly defined.

• All issues for Outside Processing takes place from OPM Inventory and receiving 
happens into OPM Inventory.

• Excise records will get generated if the item being issued for outside processing has 
the attribute of Excise Flag 'YES'.

In Oracle Financials for India additional setups are required.

• In Organization Parameters under Taxation Parameters alternative region enter 
Outside Processing Return Days and Outside Processing Excise Percentage you 
want to default in 57F (4) Challan.

• While defining OSP Item the Excise and Cenvat flags should be set to YES.

In India Local Oracle Process Manufacturing OSP transactions are handled through 
production batches. When a WIP warehouse in a production batch is a warehouse 
marked as OSP Warehouse in Localization the date will be populated into OSP tables. A
Purchase Order has to be created for the processing charges and should be received in 
OPM so that it can be passed to AP for Payment of these processing charges. As these 
processing charges are treated as one of the ingredients, cost rollup will consider all the 
costs correctly.

Under Localization following additional steps or processes are involved:

• As soon as a production batch is released i.e. production batch having OSP marked 
warehouse as WIP warehouse the relevant details are populated in localization OSP
table.

• Go to OSP Transactions Screen. You are required to verify the details populated and
attach a purchase order raised for the processing charges. There you have to give 
the values for the items so that the excise duty payable will be calculated basing on 
the value and the percentage specified in the organization additional information 
form. You have to select a register for payment of this duty. At this point there are 
no RG registers hit.

• When the batch is certified RG Registers are hit with the excise payable and 
quantities depending upon the batch actual consumption of ingredients.

• When the actual quantities of product are given, RG registers will hit for the 
quantities. At this point reversal of excise credit will not take place.
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• When the batch is closed, you can go to the OSP transactions –OSP receipts form 
and select a register and post the excise receivable amount to RG register.

OSP Issue
Navigate to India OPM Process Execution > Production Mgmt > OSP Transactions.

Sub-letting, job-work or Out Side Processing is a common business requirement. Basic 
information regarding the OSP transaction is captured using this screen. Vendor Name, 
Form number is very vital. Issue batch number is used as reference. Only WIP 
warehouse can be an OSP warehouse.

Issue Ref No: It can be selected from a lookup. Lookup consists of all the batch 
numbers of production batches released and where the WIP warehouse is marked as 
OSP warehouse.

Date: The date on which the above OSP issue is made.

Type: Enter whether it is an OSP Issue or OSP Receipt.

PO Number: It can be selected from a lookup. Lookup consists of all the purchase order
numbers where at least one line item is on inventory item or expense item for OSP labor
charges.

Select Payment Registers
Navigate to India OPM Process Execution > Production > OSP Transactions > (B) OSP 
Lines > (B) Select Payment Registers.

This screen will show the balances available in all the three Registers – RG 23 A Part II, 
RG 23 C Part II and PLA.

You can enter the Excise amount to be debited will be entered here with break up. 
Having done the entry, the register selection can be made through the radio button 
displayed against each of the above three registers.

OSP Receipt
Navigate to India OPM Process Execution > Production Mgmt > OSP Transactions > (B) 
OSP Lines.

All the fields are display only fields. These fields are populated based on the ref no 
(Batch No) entered on the previous screen.

If the batch status is closed Select Register will be enabled. You must select a register to 
credit the excise amount. On selection of Excise Register 'Post RGII Entry' push button 
will be enabled. On clicking this push button excise register RG II entry will be made. If 
the receivable excise amount is null , you need not select any register.

The following accounting entries are passed in the localization at the time of claiming 
the receivable excise amount.
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Dr. CENVAT RM/CG Excise duty

Cr. Excise Paid Excise duty

Item No: Displays the Item Number.

UOM: Displays the Unit of Measure of the item. This is the primary unit of measure of 
the item.

Unit Price: Displayed unit rate of each item.

Plan Qty: The total expected quantity will be displayed.

Received In due date: The total quantity received with in the due date will be displayed
here. Due date will be calculated taking batch certify date as the start date and 
considering the no of days mentioned OSP Return days field mentioned in the 
organization additional information screen.

Received after due date: The total quantity that is received after the due date.

Total qty: The total quantity received before and after the due date. Transaction Details 
push button will take you to the screen where individual receipt quantities along with 
date of receipt will be displayed.

Payable Excise

The payable excise amount will be calculated and displayed. The excise amount payable
will depend upon the value of batch ingredients and OSP excise percentage mentioned 
in the Organization Additional Information Form.

Receivable Excise

Displayed field. The receivable excise amount will be calculated based on the payable 
excise, expected quantity of the batch output and actual quantity received before due 
date. If total quantity is received before the due date then receivable excise amount will 
be equal to the payable excise. Other wise it will be proportionately calculated.

Processing Inter Organization Transfer Transactions
Oracle Financials for India Inter Organization Transfer helps in transfer of material 
between Inventory Units. Transfer of materials can be either from manufacturing to 
trading unit or vice versa. Existing form of Inventory Transfer of Oracle Base Inventory 
has been added with two new buttons at the bottom of the screen to meet the Indian 
Tax Requirements. Similar to the Internal Sales Order Cycle, the user needs to define the
Receiving Organization as the Internal Customer in the Sending Organization. Item 
Category and Tax Category needs to be defined for the Item to be shipped from the 
Sending Organization to the Receiving Organization. This needs to be defined and 
attached in the Internal Customers set up. Tax defaulting hierarchy in the Inter 
Organization Transfer is similar to Oracle Financials for India process of Tax Defaulting 
for Sales Order.

Navigate to India Local Inventory > Transactions > IL Inter Organization Transfer. This 
opens the Base Inventory form of Inter Organization Transfer. Before making a 
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shipment ensure that all Oracle Base Inventory setup is completed.

Click Transaction Lines to view the base detailed transaction form. Match and Taxes 
button enable Inter Organization Transfer specific to Indian requirements.

Based on the defaulting logic defined and setups for the item transacted, the Tax 
Category will be defaulted. You can view the tax lines by clicking Taxes in the form. 
You can modify the taxes like add new tax lines, delete defaulted tax lines and alter 
precedence of existing tax lines.

Note: While defining the Shipping Networks for the Organizations 
ensure that Inter Organization Transfer Charges Type is set to None. If 
the same is set to any other type, India Local tax engine neither 
considers that in the valuation of the Inventory nor in the tax lines.

Close the taxes form after saving your changes to get back to the transaction details 
form. Save the transfer transaction to update and confirm the transaction and restrict 
further modifications. Saving the inventory transfer record also generates the Excise 
and VAT Invoice Numbers when the item has Excise and VAT Taxes. The Invoice 
numbers generated on saving the transaction are shown in a separate form.

Field Description

Line Number Line Number of the item being transacted.

Exc. Inv. No. Excise Invoice Number generated for the 
Transaction if the item is excisable and 
transaction has Excise Type of Taxes.

Vat Inv. No. VAT Invoice Number generated for the 
Transaction if the item is defined in the VAT 
Item Classification and transaction has VAT 
Type of Taxes.

Item Gives the description of the Item being 
shipped.

Quantity Displays the Quantity being shipped for the 
Item against the transaction.

From Org Displays the name of the Organization from 
where the goods have been shipped for this 
transaction.
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Field Description

To Org Displays the name of the To Organization, 
where the goods have been shipped for this 
transaction.

From Subinv. Displays the Sub Inventory of the Shipping 
Organization from where the goods have been
shipped for this transaction.

To Subinv. Displays the Sub Inventory of the Receiving 
Organization to which the goods have been 
shipped for this transaction.

The register updates for the various type of Inter Organization Transfer from Excise 
perspective are:

Shipping 
Organization Item 
Attribute

Registers to be 
Updated In Shipping
Organization

Receiving 
Organization Item 
Attribute

Registers to be 
Updated In 
Receiving 
Organization

RMIN RG23 A Part 1 RMIN RG23 A Part 1

RMIN RG23 A Part 1 FGIN RG 1

RMIN RG23 A Part 1 CGIN RG23 C Part 1

RMIN RG23 A Part 1 CCIN RG23 A Part 1

FGIN RG 1 RMIN RG23 A Part 1

FGIN RG 1 FGIN RG 1

FGIN RG 1 CGIN RG23 C Part 1

FGIN RG 1 CCIN RG23 A Part 1

CGIN RG23 C Part 1 RMIN RG23 A Part 1

CGIN RG23 C Part 1 FGIN RG 1
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Shipping 
Organization Item 
Attribute

Registers to be 
Updated In Shipping
Organization

Receiving 
Organization Item 
Attribute

Registers to be 
Updated In 
Receiving 
Organization

CGIN RG23 C Part 1 CGIN RG23 C Part 1

CGIN RG23 C Part 1 CCIN RG23 A Part 1

CCIN RG23 A Part 1 RMIN RG23 A Part 1

CCIN RG23 A Part 1 FGIN RG 1

CCIN RG23 A Part 1 CGIN RG23 C Part 1

CCIN RG23 A Part 1 CCIN RG23 A Part 1

To view register entries navigate to Tools > View Registers after saving the transfer 
record.

In case of Direct Organization transfer you need not record the receipt of material as the
quantities in the Receiving Organization gets updated automatically on shipment. 
Excise and VAT claims for the same is performed by the system online without any user
intervention. The costing for the item also gets updated based on the nature of the tax 
lines in the Tax Category. You can view register entries of the receiving organization by 
querying the transfer document from the Receiving Organization Inventory 
responsibility.

Assessable price for the Transaction is picked up from the Customer Additional 
Information form for Excise and VAT Taxes. If the same is not defined, it takes the value
from the Item Cost for the item being shipped.

In case of In Transit Inventory Organization Transfer, you must receive goods as 
normal receipt and follow the same process of claiming CENVAT and VAT tax credit. 
In the Receipts, the transaction can be captured through the Shipment Number or 
through various filters available in the query form.

The default Document Sequence followed for Excise Invoice Number Generation is that 
of the Domestic Series. The same sequence is followed for the Direct and In Transit Inter
Organization Transfers. VAT Invoice Number generation is based on the Default 
Document Type set up done against the Regime Registration Number of the 
Organization. The same sequence is followed for the Direct and In Transit Inter 
Organization Transfers.

The India Local tax engine generates Accounting Entries only for the items related to 
Localization Taxes. Oracle Base Inventory will generate the accounting entries for the 
basic value of Inventory transferred and for variances if any in case of Standard Costing
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in Receiving Organization.

Inter Organization Transfer of Capital Goods
When Capital Goods are being transferred in the same year of purchase, the Accrued 
Excise Credit on Capital Goods needs to be claimed in the Sending Organization. This 
claim will be done by the system automatically and the accounting entry for the same 
will also be generated on matching the line quantity with the original receipt.

You can match the shipment quantity against a specific Receipt to claim the balance 
accrued excise credit. The system will prompt you to match the shipment with its 
receipt when you save the record without matching. This option of selecting the receipt 
from which the claim is to be made is optional and can be ignored when the Capital 
Goods are more than a year old or hundred percent excise credit has already been 
availed.

Once the claim for the Capital Goods is carried out, the goods can be sent as normal 
duty paid goods by charging the relevant rate of Excise Duty. Transfer of Capital Goods
is available only for In Transit Inter Organization Transfer.

Similar to CENVAT Claim, you can claim the VAT accrued credit.

Click Match on the detail form to match against the relevant Receipt. You must ensure 
that the shipment is being matched to the correct receipt. The Match form contains all 
capital receipts that contain Excise or VAT type of taxes attached to it. You have the 
flexibility to apply the shipment quantity against multiple receipts. The system ensures 
that the sum of all quantities applied in the match form equals the shipment quantity. 
The claimed percentage is also shown in the CENVAT Receipt Details form to facilitate 
identification of the receipt.

Field Description Description

Receipt Number Displays various receipts numbers of the 
capital goods item being shipped by the 
Sending Organization.

Receipt Quantity Displays the number of quantities received 
against the particular receipt.

Available Quantity Quantity available for application. (Receipt 
Quantity – Sum of all Quantity Applied)

Excise Claimed Percentage Displays the percentage of excise duty 
claimed against the receipt for CENVAT 
purpose. (Amount Claimed / Total Excise to 
be claimed)
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Field Description Description

VAT Claimed Percentage Displays the percentage of VAT claimed 
against the receipt. (VAT Amount Claimed / 
Total VAT to be claimed)

Quantity to Apply Quantities to be shipped for the Inter 
Organization Transfer needs to be entered in 
this column against which receipt the 
transaction is to be carried out.

Apart from claiming the accrued CENVAT and VAT claims by matching the shipment 
to a Receipt, rest of the process is same in the Sending Organization and in the 
Receiving Organization. Closing the CENVAT Receipt Details form reduces the 
pending quantity available against the receipt.

Note: Matching the receipt quantity also restricts modification of taxes 
in the tax screen. Thus all activities with respect to taxes such as 
addition or modification should be completed before matching the 
receipt quantities.

When line values are modified after completion of match activity, the 
system reverts the quantities that were already matched against the 
Receipts. You will need to re-match the shipped quantities in order to 
claim the balance accrued credit.

Inter Organization Transfer for Trading Organization
When material is transferred from a Trading Organization, the user has to match the 
shipment against a receipt in order to update the Localization Excise Registers. Unlike 
Manufacturing Organization where RG 1 is updated, RG23D register gets updated in 
case of a Trading Organization.

The Match receipts functionality allows you to satisfy all requirements related to a 
Trading Organization or location registered under the Central Excise Rules to pass on 
Excise Credit to the Customers. The Excise Duty tracked while receiving the goods in a 
Trading Organization can be allowed as CENVAT credit for the Customers. Thus, 
before confirming the shipment, you must allocate the excise duty involved during 
receipt of the excisable goods. While sending goods from the Trading Organization, you
are required to track the exact amount of Duty paid by the Original Manufacturer for 
passing down the credit under CENVAT procedures. Clicking Match will let you match
the required receipt against the shipment.
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Field Description Description

Customer name Name of the Internal Customer will be 
displayed here.

Customer Number Customer Number will be displayed here.

Quantity Invoiced Shipped quantity will be displayed here.

Matched Quantity Before matching, this field will be blank and 
after matching this field shows the matched 
quantity.

Item Item code of the material shipped will be 
displayed here.

UOM UOM of an item will be displayed here.

Transaction Type Transaction type like Receipts and Return will
be displayed here.

Supplier Invoice No Supplier Invoice Number for a particular 
receipt will be displayed here.

Quantity in Receipt UOM UOM of the item in the Receipt line will be 
displayed here.

Received Quantity received in a particular Receipt will 
be displayed here.

Available Available Quantity in a particular Receipt will
be displayed here.

Apply This represents the proposed match quantity. 
This will be filled by the system for a Release 
Quantity if the User selected Automatic 
Matching. The User can also enter number of 
quantity manually for matching.

Quantity in Issue - UOM UOM of the item in the Issue line will be 
displayed here.
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Field Description Description

Available Available Quantity in a particular Issue will 
be displayed here, this is equivalent to 
Available receipt quantity.

Apply This represents the match quantity.

Receipt Number Receipt Number will be displayed here.

Receipt Date Receipt Date will be displayed here.

Duty Per Unit Excise Duty per unit as per receipt line will be 
displayed here.

SH Cess Cess per unit as per receipt line will be 
displayed here.

Closing the RG23D Register Entries India Local (match claim) form reduces the pending
quantity available against the receipt.

Note: Matching the receipt quantity also restricts modification of taxes 
in the tax screen. Thus all activities with respect to taxes such as 
addition or modification should be completed before matching the 
receipt quantities. When line values are modified after completion of 
match activity, the system reverts the quantities that were already 
matched against the Receipts. You will need to re-match the shipped 
quantities in order to claim the balance accrued credit.

View Inter Organization Transactions
View Interorg Excise / VAT Details facilitates to view the Inter Organization 
Transactions. This form is only a view form and no modifications can be made to the 
form. Navigate to India Local Inventory > Transactions > View Interorg Excise / VAT 
Details.

Field Description Description

Find Excise/VAT Details  
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Field Description Description

From Organization Select the Name of the Organization form 
where the Inter Organization Transfer has 
taken place.

To Organization Select the name of the Organization to where 
the goods are shipped at the time of 
transacting the Inter Organization Transfer.

From Date Starting from this date the Inter Organization 
Transactions will be part of the Query criteria.

To Date End date of the Query Criteria for the Inter 
Organization records to be displayed.

Excise Invoice No Excise Invoice Number for the Inter 
Organization Transfer being generated at the 
time of transaction creation. Based on this the 
query criteria the record(s) will be displayed. 
If a particular Excise Invoice Number is given 
then the same is displayed.

VAT Invoice No VAT Invoice Number for the Inter 
Organization Transfer being generated at the 
time of transaction creation. Based on this the 
query criteria the record(s) will be displayed. 
If a particular VAT Invoice Number is given 
then the same is displayed.

Reports
This section provides overview and detailed description of these reports:

Tax List Report

Excise Duty Claim for RMA Report

India-Tax List Report 
This Report gives you the List of Tax Category for an Item Class and its associated Tax 
Code & Tax type. The user can view and review this report before defining a New Tax 
Category.

Report Submission
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Use the Request Transaction Reports form and enter India-Tax List Report in the Name 
field to submit the report.

Report Parameters: 

Tax Category Name: PICK HELP (optional)

Oracle Financials for India accepts Tax Category name as an optional parameter. If you 
do not give any value to this field, system will print all the Tax Category names defined 
in the system till date.

Item Class ID: PICK HELP (optional)

Oracle Financials for India accepts an optional Item Class also.

Tax Name: PICK HELP

Oracle Financials for India accepts Tax Name as an optional parameter. If you do not 
give any value to this field, system will print all the Tax Names defined in the system 
till date.

Category Start Date: (Optional)

Oracle Financials for India accepts Category Start Date as an optional parameter. This is
to produce the report to your choice. Transactions with Tax Categories defined, on or 
after the date will be selected for reporting.

Category End Date: (Optional)

Oracle Financials for India accepts Category End Date as an optional parameter. This is 
to produce the report to your choice. Transactions with Tax Categories defined on or 
before the date will be selected for reporting. Blank End date means, no check is made 
on end dates. 

Tax name Start Date: (Optional)

Oracle Financials for India accepts Tax Name Start Date as an optional parameter. This 
is to produce the report to your choice. Transactions with Tax Name defined, on or after
the date will be selected for reporting.

Tax name End Date: (Optional)

Oracle Financials for India accepts Tax Name End Date as an optional parameter. This is
to produce the report to your choice. Transactions with Tax Name defined on or before 
the date will be selected for reporting. Blank End date means, no check is made on end 
dates.

Report Headings

Report Headings provide you with general information about the contents of the report.
Oracle lists information on Various Tax Categories and Tax Names defined in the 
system.

Column Headings:

Tax Category
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Item Class Code

Category effective date from

Category effective date to

Tax Name

Amount 

UOM

Rate

Adhoc Flag 

Tax Name effective date from 

India - Excise Duty Claim for RMA Report
This Report gives you the Amount that can be claimed from Excise Authorities on the 
Excise amount of a RMA Receipts.

Report Submission

Use the Submit Requests (India Local INV module) form and enter India- Excise Duty 
Claim For RMA Receipts in the Name field to submit the report.

Report Parameters

Customer Name: PICK (Optional)

The User wants to see the RMA Receipt from Particular Customer and the Excise 
Claimable amount, then he can specify the Customer Name here.

Customer Number

Customer Number of the above Customer will be defaulted here.

RMA No

The User can enter specific RMA Number

Start Date (Required)

End Date: (Required)

Report Headings

Report Headings provide you with general information about the contents of the report.
Oracle lists Company Name based on User parameter input.

Column Headings

RMA No

RMA Line

RMA Date

RMA Type
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Sub Inventory

The Delivered Sub Inventory for the Return material.

Customer Name

Customer Number

Ex.Invoice Number

Original Excise Invoice Number in which the goods where sent

Ex.Invoice Date

Original Excise Invoice Date in which the goods where sent

Excise Due Amount

Excise duty amount that can be claimed from the Excise Department on account of an 
return.





India Local Purchasing    2-1

2
India Local Purchasing

This chapter covers the following topics:

• Defining Tax Overview

• Outside Processing Transactions

• Receiving Corrections

• Mass Tax Update

• Transactions Handled

• Encumbrance Accounting

• Setting Up India Local Purchasing

• Managing Purchasing Transactions

• Receiving Corrections

• Using India - Mass Tax Update

• Receipts (Localized)

• India Localization Receipt Details

• Inquiry

• Reports

Defining Tax Overview
Businesses in India must pay to the Supplier Taxes related to Central, State, and City 
Tax Authorities on most of the goods and services that they purchase. Tax Handling 
helps you to manage taxes for Purchase Orders, Requisitions, Request for Quotations, 
Quotations, Releases and Receipts.

The Tax Handling functionality lets you satisfy all your Tax requirements related to 
Purchasing. You can:
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• Define Taxes of Excise, Customs, Sales Tax, Value Added Tax, Central Sales Tax 
and other Type of Taxes

• Define Item Category lists and attach them to the Suppliers and Supplier Sites to 
enable Tax defaulting.

• Define Tax Categories with Item Classes for last level of Tax defaulting.

• Define precedence for calculation of Taxes to handle Tax-on-Tax Type of 
calculations including cumulative and compounded Tax calculations.

• Define Adhoc Taxes. The Taxes that do not directly depend on the transaction value
can be defined as Adhoc Tax and appropriate value can be assigned during the 
transaction

• Calculate Taxes in multiple currencies

• Define Tax Recoverable information and the same will be used for Inventory 
Valuation.

• Track other costs incidental to the Purchase transaction. The same will be used for 
valuation of the Item.

• Define Third Party Taxes. Separate Invoices are generated for Third Party Taxes.

• Default Taxes on to documents that are created based on other documents.

• Define Tax Registration details of the Supplier, which can be used for Statutory 
Reports.

• Carry forward taxes defaulted and added to a Purchase Order to Receipts.

• Carry forward taxes defaulted and added to a RMA to Receipts.

• Carry forward taxes defaulted and added to a Internal Sales Order to Receipts.

• Control modification of taxes defaulted on Purchase Receipts

• Claim CENVAT during Receipt. Else, can claim it manually after Receipt.

• Allow corrections to quantities.

• Create Return to Vendor Transactions with respective Tax Implications.

• Receive unordered material.
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Quote Analysis at the Landed Cost
The quotations are analyzed based on the non-recoverable localization taxes for the 
calculation of Per Landed Unit Cost. This will not consider the CENVAT able Taxes and
VAT Taxes.

Excise Defaulting for PO
While creating the Purchase Order, Excise information defined will be defaulted. If the 
Purchase Order is created from a Quotation, then the taxes defined for the Quotation 
will be considered. Tax defaulting will be proportional to the quantity specified at the 
PO level.

Taxes at Time of Receipt
When the material is received against a Purchase Order, the taxes defined at the PO 
level will default. Defaulting will be proportional to the quantity received. Since the 
taxes specified on the Invoice are actually applicable, user will be able to modify the 
Taxes as per the Invoice. Localization provides the functionality to Modify the Taxes at 
the time of Receipt. You can effectively use this functionality, when there are changes in
Tax Rates due to change in the statute/budget etc. In case of any change in Taxes from 
the PO, the user needs to take care to update the Taxes Immediately while performing the
Receipt. Tax changes will not be allowed once the user comes out from the Receipt 
screen.

Receipt of Unordered Material and Applicable Taxes
For Unordered Receipts, users will not be able to attach or specify the Taxes applicable 
while creating Receipt. As a result the Tax Amount will not be calculated or defaulted 
(as the item price and currency is not known). Taxes defined at the time of purchasing 
will be applicable here. Tax can be attached or modified to Unordered Receipt in 
Receipt (Localized) window after matching to PO, this can be achieved based on "Allow
tax change on Receipts flag" set in Additional information. If you set Allow Tax change 
on Receipts to Y, accounting and RG is updated when Receipt localized form is closed. 
If Allow Tax change on Receipts is set to N, then RG and accounting will be passed 
when matched to purchase order.

CENVAT Records and Registers
You have an option to generate consolidated CENVAT Report or to continue with RG 
23 Registers. Option has been provided to the user either to avail CENVAT credit 
immediately on Receipt of the goods or to defer taking credit for a later time. In the case
of Capital Goods, provision to avail partial credit at the time of receipt and balance later
is being provided.
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Payments to Vendors Other Than PO Vendor
Provision to pay to the Vendor other than the PO Vendor is provided. This will be 
required for paying the services offered by other Vendors related to that PO. An 
approved Invoice for the Non-PO Vendor will be created on running an India 
Concurrent for Third Party Invoices program. This functionality of Oracle Financials for
India can be effectively used for expenses like freight, insurance etc. where payment in 
normal case will be done directly to such agencies.

PO/Receipt Matching
You have an option to specify whether the Invoice need to be matched to a Receipt or to
a Purchase Order. If the user opts for 'match to PO', at the time of matching, the 
Localization Taxes attached to PO will be taken into consideration and Taxes will be 
apportioned based on the quantity matched. In this case taxes will be calculated based 
on the taxes defined in the Purchase Order.

If the user opts for Receipt Matching, system will work out the Taxes based on the 
Taxes available for the particular Receipt and based on the matched quantity, Taxes will
be apportioned.

In India, as the occurrence of variance in the Taxes defined in PO with actual receipt 
being very frequent, it is suggested to opt for Receipt Matching, so that the taxes in AP 
will be in sync with the taxes at the time of Receipt.

Automatic Creation of Invoices Based On Receipts
Pay on Receipt functionality in Oracle Applications will also consider Taxes Payable to 
the PO Vendor for the payment of Receipts entered. Localization supports Pay on 
Receipts based on Receipt Number as well as Packing Slip Number. If the user opts for 
Packing Slip Number, he need to take care to enter the Packing Slip Number at the time 
of creating a Receipt. Pay on Receipt program takes into account the RTV Transactions 
against the Receipt.

Purchase Returns
While performing Return to Vendor transaction, system can take care of the reversal of 
CENVAT Credit that needs to be done before removal of goods. Based on the 
user-defined parameters, the proportionate amount of CENVAT Credit availed will get 
reversed in Excise Records *. The user can generate the Excise Invoice Number that 
needs to be issued for such removals **. Provision for defining user definable prefixes 
for the Excise document that is generated for RTV transactions is also provided.

System will put a hold to RTV transaction for a CENVAT able Item on which credit was
not availed. In such cases, user needs to take credit and process RTV transaction from 
Return to Vendor India Form. This check has been built for ensuring that payment of 
duty does not happen if credit is not availed.
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* The Excise Register updated on RTV transaction depends on Register preferences. The
credit in PLA will be updated when the PLA Preference is set to '1'.

** Excise Invoice Number will be generated only when you select process action as "
Generate"

CENVAT on Additional Customs Duty (CVD) Paid
Provision to allow users to claim CENVAT for the Additional Customs Duty paid, if 
applicable. While availing the CENVAT it will be restricted to the percentage specified 
for availing CENVAT at the tax level. Also, the appropriate Excise registers will be 
updated.

Non - CENVAT Customs Duty
For the taxes where CENVAT cannot be claimed or the percentage of Customs Duty for 
which the CENVAT is not available, acquisition cost of the item will be increased to that
effect.

CENVAT Accounting on CVD
The process of claiming CENVAT is similar to that of the Excise Duty CENVAT. The 
accounts set for the BOE Account will be used in this case.

Currency Change for Customs Duty
Since, the Customs Duty is to be paid in the Functional Currency (INR), you are 
allowed to change the applicable Currency at the transaction level. However, the 
provision to change Currency will depend upon the parameters set while Defining the 
Tax in the India Local Tax Definition option.

Customs Duty Payment Before Receiving Material
Since, the Customs Duty is always paid in advance. i.e. the amount is paid before the 
material is received in stores, there is a facility where the duty could be paid before 
receiving the material. For this purpose, an on Account (prepayment) payment can be 
made in the name of Customs Authorities. Bill of Entry (BOE) as given by Customs 
Authorities is then entered in the system. BOE is settled against the prepayment.

Bill of Entry (BOE) on Receipt
Provision to apply the BOE to the Receipt is required. Only the fully paid Bill of Entries 
will be considered for application at the time of Receipt. This will identify the BOE used
for any particular Receipt. The Bill of Entry can only be applied against the Customs 
Duty type of Taxes i.e. Basic and Additional Customs Duty.
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Applying Bill of Entries (BOE) to PO Receipts
During Receipts, the BOE amount applied to the line will be considered as the 
applicable Customs Duty Amount, instead of the Amount specified at the Receipt 
Level.

Reversal of Taxes on Purchase Returns
In the event of Purchase Returns, all the taxes applicable to the item will be reversed 
and for Average Costing Organization the new Average Cost of the Item will 
re-calculated.

Mass Tax Updates
Mass Tax Update is a batch program to recalculate taxes applicable on the Open 
Documents. You can use this program to process Open Documents of the selected 
Document Type. The program uses the localization 3-way defaulting mechanism to 
derive the Revised Taxes that are applicable to a document. Optionally, you can map 
the Tax Categories (through request parameters) to replace the existing tax lines with 
those defined in the New Tax Category. As you process, a record of all documents 
considered for processing will be maintained.

Bulk Claim CENVAT After Receipts
You can process the Receipt lines to be claimed in claim CENVAT screen line by Line. 
This option can be used to process each line independently. Else, you can use the option
of Bulk Claim CENVAT on Receipts. You can enter values related to Excise Invoice 
Number and Date on each of the lines and then check 'Check All' and press the 'Claim' 
Button to process all the selected records simultaneously, through one concurrent 
request.

Receipt of Goods from Third Party Excise Vendor
Where goods are received from a third party Vendor and an Excise Invoice is issued, 
then you can update the Excise Vendor name in the 'Claim CENVAT on Receipts' 
screen. The Name and Registration details of this Vendor will be considered for 
updating Excise Registers.

Outside Processing Transactions
The Outside Processing Feature of Oracle Financials for India provides the functionality
of tracking the goods sent to a Sub-Contractor for processing. This feature provides you 
with reports that you can use to review the status of each Challan and track each issue. 
You need to keep a manual track on overdue issues i.e., those pending for more than 
180 days. The duty on overdue issues has to be calculated manually and debited to the 
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duty paying register through RG 23 Manual entry screen.

The Outside Processing functionality lets you satisfy all your needs on Tracking of 
goods sent for outside processing. You can: 

• Create OSP Challan based on the OSP Purchase Order, approve the same

• Create Manual OSP Challans in case of staggered material dispatches.

• Track Receipt of Processed Material

• Authorize issues and Receipts

• Generate reports to maintain private records of useful information

By using the Localization features, goods that need to be sent for Sub-contracting can be
tracked through a Challan. Based on the parameters set up in the Additional 
Organization Information, duty will be debited at the time of removal of goods and the 
same can be credited on receipt of the goods. Hence there is no need to pay duty on 
removal of goods for Sub-contracting, user need to take care to set up zero in the OSP 
percentage field of Additional Organization Information Different reports are being 
provided by Localization to track the dispatch and receipt of goods sent under OSP 
transactions. User needs to keep a manual track for the receipt of goods by monitoring 
OSP reports and if the goods are not received back within 180 days, duty needs to be 
worked out manually and the amount should be debited in the duty paying register 
through RG 23 Manual Entry screen.

Prerequisites:

• All items sent for outside processing must exist in Organization items and outside 
processing item attribute is enabled.

• OSP relation is properly defined.

• All issues for outside processing take place from inventory and receiving happens 
into Inventory.

• Excise records will get generated if the item being issued for outside processing has 
the attribute of Excise flag - set to 'Yes'. 

• Standard Oracle Applications supports Outside Processing Operations in Oracle 
WIP. In Oracle Financials for India - user will be able to monitor the movement of 
goods to the Sub-contractor.

• In Oracle WIP when material is moved to queue of OSP Operation, an approved 
Requisition is created in interface tables. Then we run Requisition Import to 
populate the Requisition in PO Module. Using this requisition we auto create PO 
and approve the PO. When we receive material it is directly updated in WIP 
Operations.
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Under Localization following additional steps or processes are involved: 

• Go to 57F4 Dispatch approval Screen. You are required to verify the details 
populated, update the actual Items and quantities being dispatched and approve 
57F4 Form for Dispatch. This will generate Form (Challan) Number.

• 57F4 Forms are created on the basis of BOM components defined for the Item being 
sub contracted. In case the issue of material to the sub contractor is in a staggered 
manner (items or quantities), Enter Manual 57F4 Form can be used for the 
subsequent material dispatches. Each dispatch in the Manual 57F4 generates a 
separate Challan Number.

• Receive the Items against the PO, 57F4 receipt quantity will get updated.

• On final Receipt of Material go to 57F4 Receipt Approval window and Approve the 
Receipt.

• If an OSP item is returned, a fresh 57F4 will be generated and then steps 1 to 4 
should be followed.

Under Localization following additional setups are required.

• In Organization parameters under Taxation Parameters alternative region enter 
Outside Processing Return Days and Outside Processing Excise Percentage you 
want to default in 57F4 Challan.

• While defining OSP Item the Excise and CENVAT flag should be set to YES.

Populating 57F4 details on moving material for Outside Processing
In Oracle WIP when material is moved to queue of OSP operation, an approved 
requisition is created in interface tables. Then we run Requisition Import to populate 
the Requisition in PO Module. Using this Requisition we auto create PO and approve 
the PO. When we Receive Material it is directly updated in WIP Operations.

Under Localization following additional steps or processes are involved:

• As soon as a PO of OSP type is approved the relevant details are populated in 57F4 
table.

• Go to 57F4 Dispatch Approval Screen. You are required to verify the details 
populated, update the actual Items and quantities being dispatched and approve 
57F4 Form for Dispatch. This will generate Form (Challan) Number.

• 57F4 Forms are created on the basis of BOM Components defined for the Item being
Sub Contracted. In case the issue of material to the Sub-contractor is in a staggered 
manner ( items or quantities), the Manual 57F4 Form can be used for the subsequent
Material dispatches. Each dispatch in the Manual 57F4 generates a separate Challan 
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Number.

• Receive the items against the PO, 57F4 receipt quantity will get updated .

• On final Receipt of Material to 57F4 Receipt Approval window and approve the 
Receipt.

• If an OSP item is returned, a fresh 57F4 will be generated and then steps 2 to 4 
should be followed.

Support for User-defined Limit Days
Users will be able to define applicable validity period in number of days for each type 
of Excise Transaction. These days will be checked while providing Excise treatment. 
Out Side Processing Material is required to be received in 180 days. Other wise 
differential duty, based on actual duty on goods not received, has to be paid.

Approve 57F4 Dispatch
Using this Form the user can find out the 57F4 dispatch Forms for a PO or a Vendor and
the same can be Approved.

Form Approved in this Form is the Primary Form for a particular OSP PO. System 
creates the 57F4 form comprising all the WIP Components required for the specific WIP 
Operation attached to OSP PO in the Outside Processing Details. If the WIP Operation 
is the First Operation, only the Components are to be dispatched to the Sub Contractor. 
If the WIP Operation is the second or higher, the intermediate assembly of earlier 
operations along with the Components required for the current operation need to be 
dispatched to the Sub Contractor. Hence an additional item line with the PO OSP Item 
description is created in the 57F4 forms for such OSP Purchase Orders. The PO OSP 
Item Description could be provided in such a way to identify with the Intermediate 
Assembly. This is a specific workaround to meet the India specific OSP Excise 
requirement.

It is not mandatory to dispatch all the components or their full quantities in the Primary
Form itself. If the dispatches are done in a staggered manner, the first batch could be 
dispatched through the Primary form. Subsequent dispatches could be done through 
the Manual 57F4 Forms.

Transactions Outside Processing Approve 57F4 dispatch Find. The field wise 
description of the screen is given in the table below for your ready reference.
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Field Description Type Action Description

PO Number (Optional) EDIT HELP
PICK

Select PO Number from LOV to
find and review or approve
Dispatch / Receipt

Vendor Name (Optional) EDIT HELP
PICK

Select Vendor Name from LOV to
find and review or approve
Dispatches/Receipts for that
Vendor.

Form Date (Optional) EDIT HELP
PICK

Select Form Date from LOV to
find and review or approve
Dispatch / Receipt.

Transactions Outside Processing Approve 57F4 Dispatch 

Field Description Type Action Description

Organization Name,
Location

(Display only)   These fields will show the
Organization and its Location in
the selected PO.

Form Number (Generated) HELP This will get generated
automatically on approval of
Dispatch

Form Date (Display only)   This will be the date on which PO
was approved and the relevant
data was populated.

Supplier Name (Display only)   This field will display the
Supplier Name as per the
corresponding PO.

Dispatch Date (Required) EDIT HELP
PIC

You can enter future date as
dispatch date and time. Limit of
days will be calculated from this
date according to the transaction.

Maximum days
permitted

(Display only)   This field will have default value
from Organization parameters.
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Field Description Type Action Description

Receive upto (Display only)   This field will show the Date by
which you need to receive the
material back from Vendor.

Dispatch Register (Required) EDIT HELP
PICK

Select Register in which you want
to debit the CENVAT Credit
Reversal. PICK is available which
will show the Register Name and
current balance available.

Entry Number (Display only)   On approval of dispatch entry is
made in the selected Register and
Entry Number is generated.

Receipt Register (Display only) PICK This will always be RG 23 A Part
II, as per the legal requirement.

Entry Number (Display only)   On approval of Receipt entry is
made in RG 23 A Part II and
Entry Number is generated

In Lines      

Assembly (Display only)   This will show the assembly as
per WIP Work Order.

Description (Display only)   Description of Assembly will be
defaulted as defined in Item
Definition

Job Name (Display only)   Pick the Job Name from LOV

Item, Description (Display only)   These fields will show Item Code
and Description
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Field Description Type Action Description

Unit of Measure     Unit of Measure for the Item
being dispatched. Primary UOM
of the Item shall be defaulted.
However other UOM's could be
used if UOM conversion is
defined for the Item. The quantity
and rate details shall be
automatically recalculated based
on the UOM conversions defined

Identification (Display only)   Enter Identification Mark if any.
There is no validation for this
field.

Tariff Code (Display only)   Tariff Code will be defaulted
from Item Definition. User can
change the same. There is no
validation for this field.

Dispatch Quantity     This is the Quantity as per
Purchase Order. This could be
modified based on the Actual
Quantity being dispatched in the
current form.
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Field Description Type Action Description

Item Rate (Display only)   Value is defaulted in this field in
the following order:

1. List Price from Price list
attached combination of Item,
Vendor, Vendor Site and UOM
Code.

2. List Price from Price List
attached for the combination of
Item, Vendor (Null Site) and
UOM Code.

3. List Price for Item,
Organization

combination in Item Definition

4. Item Cost for Organization,
Item

This can be updated as per the
valuation for excise per unit of
OSP item.

Dispatch value (Display only)   Dispatch value = Dispatch
Quantity * Item Rate

Excise Rate (Display only)   Excise rate will be defaulted from
Organization Parameters. You
can change if required as per
legal provisions. This is
percentage rate on Dispatch
value and not a per unit rate.

Dispatch Excise
Amount

(Display only)   Dispatch Excise Amount =
Dispatch value * Excise Rate

Processing Nature (Display only)   This will default from Operation
Description of OSP operation
from the related job. This can be
edited if required.

Enter Manual 57F4

This form can be used to create a Manual 57F4 for sending material for Outside 
Processing and view the 57F4 Forms. Manual Forms can be created based on an OSP PO
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or just on the basis of Supplier Information filled in the Query window.

Report Submission
If the Manual 57F4 Form is being created based on a OSP PO, the system checks for the 
dispatched quantity in the Primary Form. An entry is allowed in the Manual 57F4 Form 
only if the full quantity is not dispatched through the Primary Form. System does not 
allow to dispatch any additional material against the PO in excess of the materials 
required for the WIP Job linked to the OSP PO Item line. Use the Submit Requests (INV 
& PO Modules) Form and enter OSP Pending Receipts Report in the Name field to 
submit the report.

If the Manual 57F4 form being is created based on the Supplier, there is no linkage to 
the WIP Job and hence the update to the Form is entirely Manual. The system shall not 
default any Job related data while creating the Form entries - neither it updates the 
'Return Quantity' value as there is no linkage to any PO in this case. The form updates 
have to be done manually based on manual controls of issue and receipt.

Transactions Outside Processing - Enter Manual 57F4

Field description Type Action Description

PO Number (Required/optional) EDIT HELP PICK Select PO Number
from LOV if a PO has
been raised for this
OSP transaction,
otherwise leave
blank.

Vendor Name Optional EDIT HELP PICK Select Vendor Name
from LOV for whom
the 57F4 is going to
be created.

Vendor Site Optional EDIT HELP PICK Select Vendor Site for
the above Vendor
from LOV relevant
for a 57F4 transaction.

Click Open and enter values into the 57F4 - India Local Form based on the details 
below.
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Field Description Type Action Description

Organization (Required/Defau
lted)

ENTER The user needs to enter the
Inventory Organization name
here. If the Manual 57F4 referred
through a Purchase Order, then
the PO Organization will be
defaulted here.

Location (Required) ENTER The users need to enter the
Location of the above Inventory
Organization where this Manual
57F4 is to be raised.

Form Number (Display Only)   System generated Form Number
will be displayed after completion
and approval of a transaction.

Form Date (Display Only) ENTER By default this will be Current
Date.

Supplier Name (Required/Defau
lted)

ENTER If the Manual 57F4 referred
through a Purchase Order, then
the PO Supplier Name will be
defaulted here otherwise the user
need to enter the Supplier Name.

Dispatch Date (Display only)   By default Current Date and Time
will be displayed here.

Supplier Name (Required/Defau
lted)

ENTER If the Manual 57F4 referred
through a Purchase Order, then
the PO Supplier Name will be
defaulted here otherwise the user
need to enter the Supplier Name.

Max Days Permitted (Display only)   This field will have default value
from Organization Parameters.

Receive upto (Display only)   This will be the cutoff date for
Receiving back the OSP materials
from the delivery date from the
Vendor.

Registers Block      
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Field Description Type Action Description

Dispatch Register (Required) ENTER The users need to select the Excise
Register to be used for this OSP
transaction from the LOV.

Entry Number (Display only)   On approval of dispatch entry in
the selected register and Entry
Number is generated and
displayed here.

Receipt Register (Display only)   This will always be RG23 A Part II
as per the legal requirement.

Entry Number (Display only)   On approval of Receipt Entry is
made in RG 23 A Part-II and
Entry Number is generated.

Line level (Display /
Required)

   

Job Name ENTER   Job Name associated in the PO
will be defaulted here if the user
enter Manual 57F4 with PO
reference otherwise the user need
to select the respective Job Name
from the LOV.

Assembly (Display only)   Assembly for the above Job Name
will be displayed here.

Description (Display only)   Description for the above Job
Name will be displayed here.

Item (Required) ENTER The user needs to select the
Inventory Item from the LOV.

Description (Display only)   Description of the above
Inventory will display here.
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Field Description Type Action Description

Unit of Measure (Display only in
PO linked
Manual Forms)

  Unit of Measure for the Item
being dispatched. Primary UOM
of the Item shall be defaulted.
However other UOMs could be
used if UOM conversion is
defined for the Item.

Identification (Display only)   Enter Identification Mark if any.
There is no validation for this
field.

Tariff Code (Display only)   Tariff Code will be defaulted from
Item Definition. User can change
the same. There is no validation
for this field.

Dispatch Quantity (Required/Displa
y only)

  This is the Quantity as per
Purchase Order or the user can
enter the Dispatch Quantity.

Item Rate (Display only)   List Price in Item Definition will
be defaulted in this field. This can
be updated as per the valuation
for Excise Per Unit of OSP Item.

Dispatch value (Display only)   Dispatch value = Dispatch
Quantity * Item Rate

Excise Rate (Display only)   Excise Rate will be defaulted from
Organization Parameters. This is
percentage rate on Dispatch value
and not a per unit rate.

Dispatch Excise
Amount

(Display only)   Dispatch Excise Amount =
Dispatch value * Excise Rate

This amount of duty will be
debited to the Selected Register of
approval of Dispatch.
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Field Description Type Action Description

Processing Nature (Display only)   This will default from Operation
Description of OSP Operation
from the related job and this can
be edited if required. The user can
enter the relevant processing
details here if the Manual 57F4 is
created without PO reference.

After entering data press the
Approve dispatch button, then
the transaction will be saved and
approved.

Approval 57F4 Receipts
Through this form the user can find out the 57F4 Receipt and approve them. An 
automatic update feature is provided for the 'Return Quantity' field on Receipt of the 
materials against the PO. The 'Return Quantity' field is updated on Receipt in the 
following sequence:

• Primary Form 

• Manual Form 

• RTV Form ( in case of RTV re-receipt)

Such automatic update of the Receipt Quantities is provided only for the Forms linked 
to Purchase Orders. This is not available for Manual Forms created without any linkage 
to Purchase Order.

Transactions - Outside Processing - Approve 57F4 Receipts

The field wise description of the form is given below for ready reference.

Field Description Type Action Description

Return Quantity     This will be Quantity Received till
date. On Receipt of the Material
from OSP Vendor this Quantity
will get updated.

Return value (Display only)   Return value = Return Quantity *
Item Rate
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Field Description Type Action Description

Return Excise
Amount

(Display only)   Return Excise Amount = Return
value * Excise Rate.

Important: : It is advisable to
have single distribution line
for return of material under
57F4 in order to update the
57F4 forms in an Inventory
Location.

Using India - Control over Printing of OSP Challans
This section gives brief overview of 57F4 Challan Printing and Control

Overview
This feature enables you to control printing of 57F4 Challans. It would restrict repeated 
prints of a Challans. Control over printing of Duplicates would be controlled and 
Duplicate Challans would be marked as such.

In cases where the print could not be generated due to Printer errors, authorized users 
can generate an original print.

Using India - Control over Printing of OSP Challans
Records in 'Approve 57F4 Dispatch' window would be populated on Approval of a PO 
with Line 'Type' as Outside Processing. The user would check the accuracy of the 
Records and Approve the Dispatch and not the Form Number. On approval a record 
would be populated in 'Print Control 57F4 window, the 'Original' in this Form would be
set to 'Yes' and the value in the 'Duplicate' field would be set to 'No'.

After approval, the user would navigate to India Local Purchasing Reports Run, to run 
the 'India - Outside Processing Challan' report. The 'Form Numbers From' and 'Form 
Numbers To' fields would display only the unprinted Challans i.e., challans with either 
the 'Original' or 'Duplicate' status set to 'Yes' (in the 'View 57F4 Challan' window). On 
Printing the Challan, the value in the 'Original' field would be set to 'No'. At this stage, 
both 'Original' and 'Duplicate' fields can be updated.

The Access to 'View 57F4 Challans' window would be restricted to authorized users. 
These users can query for the Forms, and change either 'Original' or 'Duplicate'. The 
value in either one of these fields can be set to 'Yes'. On changing value in one of these 
fields the other field would be disabled. This change would list the Form for Printing 
once more. The Challan Report that have 'Duplicate' as 'Yes' would be marked as 
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'Duplicate'.

On printing the Challan the values in both 'Original' and 'Duplicate' fields would be set 
to set to 'No'.

Print Control 57F4
Organization Name

The User can select from the Organizations. The LOV for all other fields would be based
on value selected in this field. This would be a mandatory field.

Location

The User can select from the Locations defined for the Organization. The LOV for all 
other fields would be based on value selected in this field. This would be a mandatory 
field. 

Fin Year

The LOV for this field would list the Fin Year (Localization) defined for the select 
Organization and Location. This would be a mandatory field. 

Vendor Name

The LOV for this parameter would display the Suppliers with OSP transactions.

PO Number

The LOV for this field would display the Purchase Orders with OSP Items created for 
the selected Organization, Location, and Financial Year. This would be restricted based 
on the value selected in the Vendor Name field.

Form Number

The LOV for this field would display the Form Numbers created for the selected 
Organization, Location, and Financial Year. This would be restricted to Unapproved 
57F4 Receipts.

This would be restricted based on the value selected in the Vendor Name field.

Print Control 57F4 Form
PO Number

This field would display the Purchase Order Number based on which the Form 
Number has been generated.

Form Number

This field would display the 57F4 Form Number. 

Vendor Name

This field would display the Supplier Name for which the Form has been generated 

Original
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The Check box would be enabled when the 57F4 is dispatched. Once the Challan is 
printed the check would be removed. However, the user can check this to Print a 
'Original' Challan. This field cannot be checked if the 'Duplicate' field is checked.

Duplicate

The Check box can be enabled only on user intervention. Once the Challan is printed 
the check would be removed. However, the user can check this to Print a 'Duplicate' 
Challan. This field cannot be checked if the 'Original' field is checked.

Reports
System generates following Reports for Oracle Financials for India Outside Processing 
Transaction.

• OSP Pending Dispatch Report: Lists Unapproved 57F4 dispatches made in an 
Organization, location, for a given period of time and a given Vendor. The output is
listed Work Order Number wise.

• OSP Pending Receipt Report: Lists Unapproved 57F4 Receipts in an Organization, 
location, for a given period of time and a given Vendor. The output is listed Work 
Order Number wise.

• OSP Stock Register: This Report is an extract of all 57F4 transactions in an Inventory
Organization, Location for a given period of time and the format of the Report is as 
specified by the Central Excise Act.

• Outside Processing Challan: This report gives you the 57F4 Forms used. The output 
is listed Challan Number wise. 

Receiving Corrections
Oracle Financials for India product supports Receiving Corrections feature provided by 
Base Receiving. Oracle Financials for India automates adjustment to Taxes and 
corresponding Accounting and Register Entries on corrections to Receiving 
Transactions using Receiving Corrections feature.

Oracle Financials for India supports Corrections to following transactions.

• Receiving

• Delivery

• Return to Receiving and 

• Return to Vendor Transaction

Oracle Financials for India adjusts following entries on correcting any of the 
transactions, specified above:
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• Adjust Receiving Entries (created for India Local Taxes)

• Create Cost Adjustments (for non-recoverable taxes)

• Create CENVAT Adjustment Entries (to adjust the accounting Impact of the 
CENVAT Entries created on Claim CENVAT)

• Adjust CENVAT Quantity and Duty Registers

The above list varies depending on the stage of transaction at which it is corrected.

Mass Tax Update
Mass Tax Update is a batch program that enables you to recalculate taxes applicable to 
the Open Documents. You can use this program to process open documents of the 
selected Document Type. The program uses the localization 3-way defaulting 
mechanism to derive the revised taxes that are applicable to a Document. Optionally, 
you can map the Tax Categories (through request parameters) to replace the existing tax
lines with those defined in the New Tax Category. As you process, a record of all 
documents records considered for processing will be maintained.

Mass Tax Changes functionality enables you to address all your needs related to 
changes in Tax applicability and Tax Rates. Using this functionality, you can:

• Recalculate taxes whenever there is a change in the Tax Rates and Tax applicability

• Process Documents selectively

• Process only a particular Type of Documents

• Recalculate taxes for partially processed documents, optionally.

• Map Tax Categories. This selects documents wherever tax category is applicable 
and replaces it with the new Tax Category.

• Manually added taxes can be overridden.

Recalculating Taxes
Whenever there is change in Tax Rates or Tax applicability that applies to a particular 
type of documents or documents related to a particular Supplier, you can define the 
New Taxes, Tax Categories and attach them to a Item Category List. On running the 
program the system will follow the localization defaulting logic to check the revised tax 
applicability. The Taxes will be defaulted and recalculated accordingly. Optionally, you 
can map Tax Categories (in the request parameters) to replace the existing Taxes with 
the Taxes in the new Category.

The Mass Tax Recalculation feature can be used to apply Additional CVD to existing 
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open transactions.

Maintaining History of Processed Records
After every run of the program, the system administrator can query for the records that 
are processed and check the old Tax Category and the new Tax Category, error codes 
for the records that are left unprocessed.

Transactions Handled
Oracle Financials for India is designed to handle tax defaulting and calculation for the 
transactions entered by the user in Requisitions, RFQ, Quotations, Purchase Orders, PO 
Releases and Receipts. Apart from the transactions created manually, when a 
transaction is created based on any other document, Taxes are also copied from the 
Source Document. This section lists such Documents, Source Documents and the events.

Requisitions

• Default Localization Taxes on creating Requisitions, manually from Requisitions 
(Localized) window.

• Creation of RFQ from Requisitions (Localized) using Auto Create window.

• Creation of Standard Purchase Order from Requisitions (Localized) using Auto 
Create window.

• Creation of Standard Purchase Order from Requisitions Using Auto Create 
window. Taxes will be defaulted on the SPO, though no taxes are attached to 
Requisition. This will work only when the 'Tax Override' flag is enabled for the 
Supplier Site.

• Creation of Planned Purchase Order from Requisitions (Localized) using Auto 
Create window.

• Creation of Blanket Release from Requisitions (Localized) using Auto Create 
window for Blanket Purchase Agreement.

• Localization Tax defaulting on Requisition import.

RFQ

Default Localization Taxes on creating RFQ from RFQ (Localized) window.* 

* Taxes will defaulted only from item class, 3 level tax defaulting is not supported for 
RFQ.

Quotations

• Default Localization Taxes on creating Quotations, manually from Quotations 
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(Localized) Window

• Creation of Quotation from RFQ (Localized)

• Creation of Standard Purchase Order from Quotations (Localized) using Copy 
Document (Tools Copy Document) 

• Creation of Planned Purchase Order from Quotations (Localized) using Copy 
Document (Tools Copy Document) 

• Creation of Blanket Purchase Agreement from Quotations (Localized) using Copy 
Document (Tools Copy Document)

Quote Analysis

• Default Localization Taxes on Quote Analysis created from Standard Quotations 
(Localized)

• Calculate Per Landed Cost on Quote Analysis created from Standard Quotations 
(Localized)

Standard Purchase Order

• Default Localization Taxes on creating Standard Purchase Order, manually from 
the Purchase Order (localized) Window

• Creation of Standard Purchase Order from Existing PO using Copy Document

• Creation of Standard Purchase Order based on Catalog Quotation using Catalog 
(function)

• Creation of SPO from Requisition using Auto Create Window

Planned Purchase Order

• Default Localization Taxes on creating Planned Purchase Order, manually from the 
Purchase Order (localized) Window.

• Creation of Planned Purchase Order from Existing PO using Copy Document

• Creation of Planned Purchase Order based On Quotation using MRP Workbench, 
when Approved Supplier List (ASL) is attached to Quotation

Blanket Purchase Agreement

• Default Localization Taxes on creating Blanket Purchase Agreement, manually from
the Purchase Order (localized) Window

• Creation of Blanket Purchase Agreement from Existing PO using Copy Document
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• Creation of Blanket Purchase Agreement from Existing Quotation using Copy 
Document

Blanket Release

• Default Localization Taxes (from Blanket Purchase Agreement) on creating Release, 
manually from the Release (Localize screen) Window.

• Creation of Blanket Release Based On Blanket Agreement using MRP Workbench, 
when Approved Supplier List (ASL) is attached to Quotation.

• Creation of Blanket Release FROM Existing Blanket Purchase Agreement using 
Auto Create against a Requisition. 

Receipts

• Default Localization Taxes on Receipt, when created from a Standard PO, Blanket 
Release, Planned Release from, Receipt (Localized) Window.

Receipts (RMA/ISO)

• Default Localization Taxes on Receipt (RMA) Created from Sales Order (Localized)

• Default Localization Taxes on Receipt (ISO) Created from Ship confirm (Localized)

Returns

• Default Localization Taxes (of Excise Type) on Returns created from Return to 
Vendor - India window

Unordered Receipts

• Default Localization Taxes on Unordered Receipts when matched to a Purchase 
Order with Localization Taxes. 

Claim CENVAT on Receipt

Defaulting of Excise Type of Taxes (included in the Receipt) to Claim CENVAT on 
Receipts screen. This happens only when: -

• The CENVAT is not claimed on Receipt.

• Excise tax should be set as 100% CENVAT recoverable.

• EXCISE and MODVAT Flags for the Item are set to 'YES'.

Encumbrance Accounting
India Local taxes are stored separately in India Local tables; this data is not visible to the
Base application processes. Hence base application encumbrance processes were not 
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considering India Local taxes while doing the Funds checking or generating 
encumbrance accounting. Now India Local taxes will be considered in encumbrance 
accounting as the India Local tax amounts are interfaced into the base application 
encumbrance processes in a streamlined fashion without any change in the user process
flows.

Encumbrance accounting is available for the following events in the P2P cycle:

• Requisitions (External and Internal)

• Creation of Requisition encumbrance

• Purchase Orders

• Creation of PO Encumbrance

• Relieving of Requisition encumbrance (if PO is sourced from a requisition)

• Receipts (if PO line has 'Accrue on Receipt' flag checked)

• Relieving of PO / Internal Requisition encumbrance

• PO / Internal Requisition Encumbrance relieving adjustments on Receipt 
corrections

• PO Encumbrance relieving adjustments on Returns

• Invoice Validation

• Creation of Invoice Encumbrance

• Relieving of PO encumbrance (if PO line has 'Accrue on Receipt flag unchecked 
– Period End Accrual)

• Invoice Accounting

• Relieving of Invoice encumbrance

Funds Available = Budget amount – Encumbrance (till date) – Actual utilization (till 
date).

Transaction processing is allowed only on the basis of the Funds check control level set 
up i.e. Absolute (No overspending allowed), Advisory (Raises warning on 
overspending) or None (Allows overspending).

Requisition / Purchase Order Funds Checking, Reserve / Approval /Modification
Requisition / Purchase Order Encumbrance actions such as Funds checking, Reserve, 
Approval, Modifications and Control actions will include the attached IL Non- 
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Recoverable (NR) taxes also.

Currently no tax modification is allowed if the Requisition / Purchase Order is in 
'Approved' or 'Approved and Reserved' status. This restriction will now be extended to 
the status of 'Reserved' also under the Encumbrance support to ensure that the reserved
amount is equal to the non-recoverable taxes attached to the Requisition / Purchase 
Order line.

India Local taxes are currently attached at the Requisition line / Purchase Order 
Shipment level only. Encumbrance is calculated and accounted based on the Requisition
/ Purchase Order Distribution level. Hence the non-recoverable taxes will be 
apportioned to the distributions, if multiple distributions exist for the line, and the 
encumbrance amount is calculated. Such apportioning is done through:

• Non-Recoverable Tax amount will be summed up at the line level

• Non-Recoverable Tax amount at the line level will be apportioned to various 
distribution lines based on the distribution line quantity, whether the value basis 
for the line is quantity or amount

• Distribution level Non-Recoverable tax amounts will be rounded to 2 decimals and 
rounding difference if any between the distribution level tax amounts and line level
tax amount, will be adjusted against the last distribution line.

Receiving /Corrections / Returns for Inventory items
Purchase Order / Internal Requisition encumbrances are reversed on the Inventory 
items' Receipt Deliver event. Non-recoverable tax amounts of Purchase Order / Internal 
Requisition distribution that is being received / corrected / returned will be included in 
the Encumbrance accounting actions of the respective event.

Note: Deliveries to Process Manufacturing Organizations do not 
generate Encumbrance reversal entries since Oracle Process 
Manufacturing Costing and Sub ledger accounting does not support 
Encumbrance currently. Hence there will be no support for India Local 
taxes for Inventory item deliveries to Process Manufacturing 
Organizations.

Receiving /Corrections / Returns for Expense items with 'At Receipt' accrual method
Purchase Order / Internal Requisition encumbrances are reversed on the Expense 
Delivery event. Similar to the Inventory destination deliveries, non-recoverable tax 
amounts of Purchase Order / Internal Requisition distribution that is being received / 
corrected / returned will be included in the Encumbrance accounting actions of the 
respective event.
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Receiving /Corrections / Returns for Expense items with 'Period End' accrual method
Oracle Financials for India does not support 'Period End' accrual method, as it is not 
compatible with India Tax Regimes. Hence Oracle Financials for India support is not 
being provided for this feature.

Invoicing Encumbrance actions
In the Procure to Pay cycle, encumbrance accounting impact is only applicable for PO 
matched invoices for Expense items with 'Period End' Accrual method. As Oracle 
Financials for India does not support this accrual method, Oracle Financials for India 
support is not extended for encumbrance accounting in such an event.

Invoice level encumbrance accounting on invoice validation / invoice accounting will 
automatically consider the India Local tax distributions as these are created as Invoice 
distributions.

Encumbrance Reporting
'PO Encumbrance Details' report shall be including the IL non-recoverable tax amounts 
also with the respective transaction amounts.

Migration / Upgrade Script
If any customer has been using the Encumbrance feature (without the IL support) and 
then adopts the IL encumbrance support solution, there shall be discrepancies in 
encumbrance accounting in the following scenarios:

• Purchase Requisition lines with non-recoverable taxes – Reserved before IL 
encumbrance solution application and Unreserved after IL solution application

• Purchase Requisition lines with non-recoverable taxes – Approved before IL 
encumbrance solution application and related PO created after IL solution 
application

• Internal Requisition lines with non-recoverable taxes – Reserved before IL 
encumbrance solution application and Unreserved after IL solution application

• Internal Requisition lines with non-recoverable taxes – Approved before IL 
encumbrance solution application and ISO receipt created after IL solution 
application

• Purchase Order lines with non-recoverable taxes - Reserved before IL encumbrance 
solution application and Unreserved after IL solution application

• Purchase Order lines with non-recoverable taxes - Approved before IL 
encumbrance solution application and Receipt created after IL solution application
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Documents reserved or approved before IL encumbrance solution application will not 
have India Local tax amounts in the Encumbrance accounting entries. Hence 
post-migration to the new solution, it will be ensured that the Encumbrance reversal 
entries generated for the migrated documents do not include the tax amounts so that 
there is no discrepancy in the resulting encumbrance accounting.

Setting Up India Local Purchasing
This section describes the setup procedures for India Localization Purchasing. You 
should have completed the Organization, Inventory and Tax Setups before you start 
setting up Oracle Financials for India Purchasing.

To set up India Local Purchasing, you must:

1. Define Supplier Additional Information, page 2-29

2. Set up Profile Options, page 2-34

3. Run India Receiving Transaction Processor

4. Run India RG Period Balances Calculation

5. Round off Excise Amount

6. Run India RG Rounding Process

Defining Supplier Additional Information
You need to setup Supplier Additional Information before you start using Oracle 
Financials for India for Purchase Module. This lets you record the Tax Registration 
Information, Item Category List and Assessable Price List. This information setup for 
the Supplier and Supplier Sites will be the basis for Tax defaulting and calculation. The 
Tax Registration Information will be used for Reporting. 

As a part of set up, you need to create separate records for each Supplier with Null 
Location, where in you need to set the IT/TDS related information pertaining to the 
Supplier as IT/TDS calculations are not based on Supplier Sites.

You can setup the Supplier Additional Information for a Supplier NULL Site. The 
information defined in this record will default to transactions created for all Sites. 
However, if you create this setup for Supplier Sites, then the Information defined there 
will be the basis for Tax defaulting and calculation.

In the Excise block, you record all Excise related information of the Supplier Site like 
Range, Division, Commissionerate, ECC Number, Supplier Type and Document Type 
as these values are used for printing different Excise related reports pertaining to the 
supplier related transactions.

If the Supplier Site is a Sales Tax registered Site located within the Site, he should give 
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only his LST Number and the CST field should be left as null. Like wise if the Supplier 
is a Sales Tax Registered Site located out side the State LST field should be null and only
his CST details should be recorded. If the Supplier is not registered under the Sales Tax 
Rules, the user should leave the CST and LST Number fields as Null.

Important: Excise zone needs to be filled in order to generate Excise 
Related reports.

Prerequisites

Before you enter the Supplier Additional Information Details, you must:

• Define Organizations

• Define Locations

• Define Organization Additional Information

• Define Taxes

• Define Tax Categories

• Define Items

• Define Item Categories 

• Define Supplier, Supplier Sites

• Define Assessable Price Lists

Navigation:

India Local Purchasing > India Localization > Suppliers > Supplier Additional Info

Field Description Type Action Description

Operating Unit (Required) HELP

EDIT

PICK

You have to select Operating Unit
from the LOV.
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Field Description Type Action Description

Vendor Name/Site (Required) HELP EDIT 
PICK 

You can select the Vendor Name 
from LOV for whom the 
Additional Information 
Regarding Tax are to be defined, 
the Vendor Number will be 
defaulted and relevant Vendor 
Site will be selected from LOV.

Excise Block (Optional )    

Excise Range     Use this field to enter Excise 
Range under which this Supplier's
Site falls. This would be printed 
on all the documents that are 
required under Excise Act. 

Excise Division (Optional)   Use this field to enter Excise 
Division under which this 
Supplier's Site falls. This would be
printed on all the documents that 
are required under Excise Act. 

Excise Registration 
Number

(Optional)   Use this field to enter Excise 
Registration Number of this 
Supplier's Site. This would be 
printed on all the documents that 
are required under Excise Act.

Excise Zone ( Optional ) EDIT HELP Use this field to review and enter 
Excise Zone under which this 
Supplier's Site falls. This would be
printed on all the documents that 
are required under Excise Act.

Excise Region ( Optional )   Use this field to review and enter 
Excise Region under which this 
Supplier's Site falls. This would be
printed on all the documents that 
are required under Excise Act.



2-32    Oracle Financials for India User Guide

Field Description Type Action Description

Excise Circle ( Optional )   Use this field to review and enter 
Excise Circle under which this 
Supplier's Site falls. This would be
printed on all the documents that 
are required under Excise Act.

Excise 
Commissionerate

( Optional )   Use this field to review and enter 
Excise Range under which this 
Supplier's Site falls. This would be
printed on all the documents that 
are required under Excise Act.

Excise EC Code (Optional)   Use this field to review and enter 
Excise EC Code of this Supplier's 
Site. This would be printed on all 
the documents that are required 
under Excise Act. 

Document type     You need to specify the 
Document, which will be 
supplied by the Supplier/Site. 
User can specify any duty 
document name like Invoice, 
Delivery Challan, Excise Invoice, 
Excise Challan, Dealer Invoice, 
Bill of Entry etc. in this field. This 
information is used for printing 
CENVAT reports that need to be 
submitted to the Central Excise 
Authorities.

Vendor type     You need to pick the Vendor Type
from the pick list. The options 
available are Manufacturer, 
Depot, First Stage Dealer, Second 
Stage Dealer and Importer. This 
information is used for printing 
the CENVAT reports that need to 
be submitted to the Central Excise
Authorities.

Sales Tax Block      
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Field Description Type Action Description

Sales Tax - Central ST
Reg. No.

(Optional)   Use this field to review and enter 
Central Sales Tax Registration 
Number of this Supplier's Site. 
This field should be null for those 
Supplier Sites, which are not 
registered under Sales Tax Act 
and for those registered Supplier 
Sites falling within the state. 

Sales Tax - State ST 
Reg. No.

(Optional)   Use this field to review and enter 
State Sales Tax Registration 
Number of this Supplier's Site. 
This field should be null for those 
Supplier Sites, which are not 
registered under Sales Tax Act 
and for those registered Supplier 
Sites falling outside the state.

Item Category List (Optional) EDIT HELP 
PICK 

The user can enter the Item 
Category list then for all the items
appearing in this list. The taxes 
lines will be defaulted as per the 
Tax Category attached to this 
Item. This is an optional field and 
if the user decides to enter the tax 
lines for a Vendor manually, it 
can be left blank.

Assessable Value (Optional) EDIT HELP 
PICK 

In case of Excisable products, 
assessable value on which Excise 
Duty is calculated is not the basic 
Sales Price. Then the user need to 
specify whether Assessable Value 
for a particular Item have to be 
considered or not in the price list 
column of Vendor Information - 
India Form. Only the Excise Duty 
will be calculated on Assessable 
Value and the other Taxes will be 
actual Invoice Value. 

Invoice Approval 
block
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Field Description Type Action Description

Create pre-approved 
TDS Invoice and 
Credit Memo

    You have to enable this check box 
at Supplier Site level if you 
require the Credit Memo and 
Invoices generated for TDS 
transactions to be pre-approved. 
You would also have an option to 
enter this value at the Supplier 
Null Site Level. In such a case, the
TDS Invoices & Credit Memos 
created from any of the Sites 
would be pre-approved. Unless, 
the setup for a specific Site does 
not have this check enabled.

VAT Tax Block      

Reg No (Optional) EDIT Specify the VAT Registration 
Number applicable to the 
Supplier Site

Assessable Value (Optional) PICK You can select from the list of 
Price Lists. The price specified in 
the list here would replace the 
Line Amount while calculating 
VAT Taxes

Service Tax Block      

Reg No (Optional) EDIT Specify the Service Tax 
Registration Number applicable 
to the Supplier Site

Setting Up Profile Options
To use Oracle Financials for India Purchasing, you need to ensure that the Profile 
Options mentioned below are set up accordingly in the Personal Profiles of Purchasing. 
These settings are mandatory for using the features of Oracle Financials for India.

Display the Auto-created Documents in PO : NO

Display the Auto-created Quotation in PO : NO

Processing Mode in RCV : Immediate/Online
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India Receiving Transaction Processor
To process pending records, India Receiving Transaction Processor can be submitted 
manually or can be scheduled. This will handle following transactions:

• Corrections 

• Deliver 

• Return to Receiving 

• Receiving

• Return to Supplier.

This concurrent program can process in batches when 'RCV: Processing Mode ' profile 
option is set to 'BATCH'.

This concurrent program can also be scheduled for a particular Inventory Organization,
when P_CALLED_FROM is set to JAINPORE in concurrent program definition.

Navigate to India Local Purchasing > Reports > Run > India Receiving Transaction 
Processor.

India - Concurrent request for defaulting taxes in PO when linked with Quotation 

A Purchase Order can be created based on a Quotation using Sourcing rules. In such 
cases, taxes assigned to a Quotation should be carried to PO. The program 'India - 
Concurrent request for defaulting Taxes in PO when linked with Quotation' defaults 
taxes from Quotation to PO.

You can schedule this program so that taxes default on all eligible PO's.

Navigation: India Local Purchasing - Reports - Run - India - Concurrent request for 
defaulting taxes in PO when linked with Quotation 

India - RG Period Balances Calculation 
This program calculates balances for the CENVAT Taxes. These balances are 
maintained on a monthly basis. These balances are used in the India - RG 23 Register 
Reports. If the balance for the previous month is not calculated before running India - RG 23 
Register Report, then India - RG 23 Register Report ends with an error.

Navigate to India Local Purchasing > Reports > Run > India > RG Period Balances 
Calculation.

Parameters

Register Type: The register Type can either be 'A' for Input register and 'C' for Capital 
Goods.

Consolidate Till: This should be last date of the unprocessed month. Any other date will
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end this program with an error.

Rounding Excise Amounts
This feature is to comply with the rounding of Total Excise Duty on an Excise Invoice. 
This feature ensures that the Total of Excise Duty in an Excise Invoice is rounded to the 
nearest rupee.

Prerequisite Setup

You should specify '2' as the Rounding Precision for the Excise Tax that you are 
defining. For Complete information on Setting up Taxes refer to 'Setting Up Tax 
Information' section of Oracle Financials for India User Reference Manual.

Specify the Excise Rounding Account for the Organization through the 'Organization 
Additional Information' screen. For Complete information on Setting up Organization 
Tax Information refer to 'Defining Organization Additional Information' section of 
Oracle Financials for India User Reference Manual.

Tax on the Purchase Order and the Receipt is rounded to '2' decimal places.

On CENVAT Claim, the Accounting Entries and the Register updates are made upto 
two decimal places.

India - RG Rounding Process
This concurrent program creates Rounding Adjustment Entries for the Excise Invoices 
falling between specified dates.

You should schedule 'India - RG Rounding Process' by specifying the Organization and 
the Excise Invoice Date Range.

This program creates accounting entries to:

• Dr/Cr CENVAT RM/CG Account

• Cr/Dr Excise Rounding Account

The CENVAT Account will be debited when the Excise Amount on the Invoice is 
rounded up. The CENVAT account (RM or CG) picked up will be based on the type of 
Items purchased.

In cases where the Excise Invoice consists of both Raw Material and Capital Goods 
Purchased, then the rounding amount will be passed to the Register Type specified in 
the 'India - RG Rounding Process' concurrent request.

Navigate to India Local Purchasing > Reports > Run > India > RG Rounding Process.

Parameters

Organization: Select an Inventory Organization that has been setup for Oracle 
Financials for India.
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Transaction Type: Select the Transaction Type from the LOV for which you wish to 
process rounding entries.

Register Type: Select either 'A' or 'C'. 'A' Implies 'Inputs' and 'C' implies 'Capital Goods'.
This applies only to Excise Invoices including both Inputs and Capital Goods. In such 
cases, rounding adjustment amount will be passed to the Register you select here.

From Excise Invoice Date: Specify a Date here. The program will show only those Excise
Invoices with dates after this date.

To Excise Invoice Date: Specify a date here. The program will show only those Excise 
Invoices till this date.

In case of CGIN Items, the CENVAT claimed in any year will be rounded to the nearest 
rupee. In the year subsequent to the year of purchase (and first claim), rounding entry 
will be created for the total amount and will be passed as and when the Concurrent 
request is submitted.

Managing Purchasing Transactions
This section elaborates on the transactions for which you can default and calculate the 
Localization taxes. This is possible only when you create the transactions navigating 
through the localization windows.

Purchase Requisition is the one from where the business cycle for all Purchases begins 
and it is always better to consider all Indian business aspect and tax requirement from 
the Requisition level itself. The tax and incidental expenses information captured here 
flows to other documents created based on the Requisition.

To default and calculate localization taxes you have to create a Requisition navigating 
through Requisitions (Localized) window. India Local Requisition is a view form and 
the data in this window is populated based on the transaction details entered in Base 
Applications form and the Tax Setups.

Creating Requisitions
In India Local Purchasing Responsibility, navigate to the India Local Requisitions 
window from Requisitions > Requisitions (Localized).

Field Description Type Action Description.

Header Block 
Number

(Display only)   The Requisition Number is a 
system-generated number will be
displayed after enter and save a 
Requisition.
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Field Description Type Action Description.

Operating Unit   HELP

EDIT

PICK

You have to select the Operating 
Unit from the LOV.

Type (Display only)   The Type selected in the Standard
Apps form will be defaulted.

Preparer (Display only)   The Preparer's Name will be 
displayed here. 

Description (Display only)   Description of a Requisition will 
be displayed here.

Status (Display only)   The status of the Requisition will 
be displayed here. (Quick field 
are Incomplete, In-Process and 
Approved)

Total (Display only)   The Total value of the Requisition
including Tax Amount will be 
displayed here and this field will 
get updated whenever any 
change made in the tax 
calculation.

Line Block      

Line No (Display only)   Line Number of a Requisition 
will be displayed here.

Item (Displayed)   The Item selected in the Std Apps
Requisition form for this line will 
be displayed here.

Description (Displayed)   The Item Description will be 
displayed here. 

UOM (Displayed)   UOM of the entered Item will be 
displayed. 
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Field Description Type Action Description.

Qty (Display only)   Requisition Quantity will be 
displayed here. 

Price (Display only)   Price at which requisition is 
raised for an Item will be 
displayed here. 

Amount (Display only)   Represents the Material Cost 
excluding Tax will be displayed 
here. 

Tax Amount (Display only)   Tax Amount for a Item in a line 
are defaulted from India Local 
Tax Details form and this field 
will get updated whenever any 
change made in the tax 
calculation.

Total Line Amount (Display only)   Represents the Total Line 
Amount for a line. 

Footer Block     The information relating to 
Inventory Module like 
Destination type, Requester, 
Organization, Location, 
Sub-inventory are defaulted from
Standard Applications 
Requisition form.

The information regarding Supplier like Source, Supplier Name, Site, Contact, Phone 
are defaulted from Standard Applications, Requisition Form.

See Also: Oracle Purchasing reference User Manual for details on Requisitions in the 
Standard Applications.

Click Taxes in the India Local Requisition to open the tax details.

The Tax Lines will default based on the Tax Category attached to the Item Class 
applicable to the Item or based on the Item Category list attached to the 
Supplier/Supplier Site. You can add Tax lines manually.

Precedence of taxes will decide the basis for calculating the Tax Amount. You can 
specify the precedence in the Precedence fields.

Important:  It is advised that you verify the tax lines and Approve the 
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Requisition; otherwise you cannot change the tax line after Approval of
Requisition.

For Excise/CVD related taxes on which credit can be claimed under CENVAT scheme, 
you need to ensure that appropriate credit percentage is defined in the Tax Definition 
and the CENVAT credit is considered for deriving the Item Cost while performing a 
Receipt.

The Vendor Name for a Tax in the Tax Details window will be the same as specified in 
the header line of a requisition or the Vendor Name specified in the Tax Definition. But, 
for the Tax lines with Taxes that have Update Vendor Flag enabled, you can 
Add/Change the Vendor Name in the Tax Details window.

While creating a requisition you can enable the RFQ Required Flag depending upon the
type of requisition being entered.

RFQ (Localized)
You can create a RFQ from India Local RFQ window. This will enable defaulting and 
calculation of Localization Taxes. The defaulting is based on the Three-way defaulting 
logic followed for Oracle Financials for India i.e., based on Supplier, Supplier Site or 
Item Class. You can alternatively create a RFQ from the Requisitions. The localization 
taxes flow to RFQs, if such Requisition is created from Requisitions (Localized) 
window. For the Quotations created from India Local RFQ, taxes flow to the same.

Click Open in the India Local RFQ window to create RFQs in the Standard Applications
RFQ window. This will take you to the India Local RFQ window; the information 
entered in the Standard Applications window would be defaulted here along with the 
India Local Taxes.

Creating RFQs
In India Local Purchasing Responsibility, navigate to the India Local RFQ window from
RFQ and Quotation - RFQs (Localized).

Functionality of RFQ's India Localization is similar to Requisition India Localization. 
You need to follow the regular functionality of Standard Applications while entering 
data in the Standard Applications RFQ window.

Click Taxes to open the Tax Form to enter the Tax details in the same manner as 
mentioned in the Requisition form. In India Local Tax Details window the tax lines are 
defaulted based on the Tax Category attached to the Item Class applicable to the Item or
based on the Item Category list attached to the Supplier/Supplier Site. You would also 
have an Option to Add Tax Lines Manually.

Quotations (Localized)
You can create a Quotation by navigating through India Local Quotations window. This
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would enable defaulting and calculation of Localization Taxes. The defaulting would be
based on the Three-way defaulting logic followed for Oracle Financials for India i.e., 
based on Supplier, Supplier Site or Item Class. You can alternatively create a Quotation 
from an RFQ. The Localization Taxes would flow to Quotation, if such RFQ is created 
from RFQ (Localized) window. For the Purchase Orders created from India Local 
Quotations, taxes would flow to the same.

You can navigate to Standard Applications Quotations Entry window by clicking on the
Open button of India Local Quotations. On closing this form after entering and saving 
the details, the same would flow to India Local Quotations. The Tax Amounts in this 
form would default from the India Local Tax Details window.

India Local Quotations is a view form and the data in this window is defaulted from the
Standard Applications Quotations and India Local Tax Details.

Creating Quotations
In India Local Purchasing Responsibility, navigate to RFQ's and Quotations > 
Quotations (Localized).

Functionality of the India Local Quotations window is similar to India Local RFQ and 
you need to follow the regular functionality of Standard Applications while entering 
data in the Standard Applications Quotations form.

Purchase Orders (Localized)
India Local Purchase Orders is designed to meet the requirements related to Tax 
defaulting and calculation for a purchase transaction. The Purchase Order can be 
created manually or automatically, based on an existing Purchase Order or based on a 
Quotation or a Requisition.

Taxes on a Purchase Order are either created:

• Based on the Tax Category attached to the Item, in the Item Category List attached 
to the Supplier

• Based on the Tax Category attached to the Item, in the Item Category List attached 
to the Supplier Site

• Based on the Item Class attached to the Item, which, in turn, is attached to a Tax 
Category

• Tax Lines added manually

• Tax attached to the Requisition, Quotation that is used to auto-create Purchase 
Order.

In all the cases, you can modify the tax lines.

India Local Purchase Orders is a view form, displays the details entered in the Purchase
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Orders Standard Applications window, which in turn, is opened navigating through 
India Local Purchase Orders window. The Tax details in this form are based on the 
India Local Tax Details.

Creating Purchase Orders
In India Local Purchasing Responsibility, navigate to Purchase Orders > Purchase 
Orders (Localized).

Field Description Type Action Description

Header Block      

Operating Unit   EDIT

PICK

HELP

You have to select Operating Unit
from the LOV.

PO Rev. (Display only)   The PO Number allotted in the
Standard Apps form will be
displayed here.

Type (Display only)   The PO Type selected in the
Standard Apps Form will be
displayed here.

Currency (Display only)   PO Currency will be displayed
here.

Supplier/Site (Display only)   Defaulted from Standard Apps
PO Forms.

Ship To / Bill To (Display only)   Defaulted Ship To / Bill To
Inventory Organization Location
from Standard Apps PO Forms
will be displayed.

Buyer (Display only)   Buyer Name will be displayed
from Standard Apps PO Forms.

Status (Display only)   The Status of the PO will be
displayed here.
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Field Description Type Action Description

Description (Display only)   Description of the PO is displayed
here from Standard Apps PO
Forms.

Amount (Display only)   Defaulted the PO Material Cost
from Standard Apps PO Forms.

Tax Amount (Display only)   The Total Tax Amount for the PO
will be displayed here.

Total (Display only)   The Total PO Value will be
displayed here.

Line Block      

Line No (Display only)   Auto generated Line Number will
be displayed here.

Shipment No (Display only)   Auto generated Shipment
Number will be displayed here.

Item / Description (Display only)   The Item selected in the Std Apps
PO form for this line and its
Description will be displayed
here.

UOM/Qty (Display only)   UOM and Qty entered for an Item
will be displayed.

Price (Display only)   Price for the Item in a line will be
displayed here from Std Apps PO
Form.

Ship To Organization (Display only)   Displayed from Standard Apps
PO Forms.

Bill To Location (Display only)   Displayed from Standard Apps
PO Forms respective the
Operating Unit.

Needy date (Display only)   Defaulted from Standard Apps
PO Forms.
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Field Description Type Action Description

Line Amount (Display only)   Represents the material cost
excluding tax and defaulted from
Std Apps PO Form.

Tax Amount (Display only)   Tax Amount for a Item in a line
are defaulted here. India Local
Tax Details Form and this field
will get updated whenever any
change made in the Tax
Calculation.

The following is the Tax form for the above Purchase Order India Localization and 
which shows all the taxes related to that PO and the user can add or delete a tax lines 
depending upon his requirement. Through Apply Button the user can save the tax lines.

Navigate to Purchase Orders > India Local Purchase Order > Taxes

• Taxes can be defaulted based on the Three-way defaulting logic 
used by Oracle Financials for India.

• You can modify the defaulted Taxes.

• Taxes can be modified only before approving the Purchase Order.

• If you need to change the taxes on approval of the Purchase Order, 
the solution suggested is to create a purchase order revision by 
modifying the PO lines and then change the Taxes.

PO Releases (Localized)
This feature is designed to take care Taxes for a PO Release against Blanket Agreement 
and Contract Agreement. Standard Applications PO Releases Form will be invoked 
through Open button and after filling up the inventory details for a Blanket or Contract 
Agreement save and close the Standard Application Form.

Creating PO Releases
In India Local Purchasing Responsibility, navigate to Purchase Orders > Releases 
(Localized).

The user can move to the Tax Form and verify whether the tax lines are defaulted as per
the tax specified in the Blanket or Contract Agreement.
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• Whenever you change the quantity in Releases (Base Apps screen), 
the user needs to navigate to Releases (Localized) screen and 
should click Apply in India Local Tax Details so that the taxes are 
recalculated based on the changed quantity. 

PLA Manual Entry
PLA Manual Entry is a View / Entry form that can be used to View/Enter the Manual 
PLA transaction. It displays on query all the transactions that have an entry in the PLA 
Register. Each Inventory Organization is considered as Excise Unit. Thus, you need to 
specify the Organization Name and Location both for querying & for making manual 
entries into the Register. Querying can be done based on certain fields on the Entry 
Block and also Transaction Details block.

India Local Purchasing - Registers - PLA Manual Entry 

Use the details given here to create a manual entry in PLA Register. The screen's field 
wise description and its feature are described below for ready reference.

Field Description Type Action Description

Operating Unit (Required) EDIT

HELP

PICK

You have to select Operating
Unit from the LOV.

Organization (Required) EDIT HELP
PICK

You need to specify the Inventory
Organization Name to which
PLA Register entries are to be
updated. Where you would like
to use this window to view the
existing PLA Entries, specify an
Inventory Organization for which
you would like to view the PLA
Register balance and information.

Location (Required) EDIT HELP
PICK

You need to specify the Location
for the Organization you have
chosen. The display of existing
entries or creation of a new entry
would be for the chosen
Organization and Location.



2-46    Oracle Financials for India User Guide

Field Description Type Action Description

Serial No (Required)   It is system generated Serial
Number after entering a
transaction.

Transaction Date     The Transaction Date should be
entered here. If you would like to
view existing PLA Register
entries for a particular day then
you can specify the Transaction
Date.

Transaction Type     The transaction types of either
Receipt, Issue should be chosen
here.

Item     You need to specify Item for
which the Receipts/Issue entry is
going to be passed.

Customer/Vendor
Name

    Enter Customer/Vendor Name
should be entered here and the
manual entry is being made in
PLA Register.

Customer/Vendor
Location

    Enter Customer / Vendor
Location should be entered here.

Transaction Detail
Block

    This block has Transaction details
with respect to Reference
Number, Invoice No, and Invoice
Date.

Excise Amount     Excise utilization details should
be entered here.

Excise Cess     Enter Excise Cess Amount in this
column.

CVD Cess     Enter CVD Cess Amount in this
column.
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Field Description Type Action Description

Account     You need to enter the Account
Code to which the Excise
Amount on Receipt transaction
has to be credited. This account
would be debited with the Excise
Amount on Issue transaction.

Remarks     In the Remarks Block you can
enter relevant remarks for PLA
register for your reference and
correspondence.

Receiving Corrections
• On correcting a base Receiving Transaction, Oracle Financials for India creates 

accounting and Register Entries to adjust taxes assigned to the Receipt

• To correct a Receiving Transaction, navigate to the Receiving Corrections screen 
and query for the Receipt. The lines fetched will depend on the status of the 
Transaction. In case you have received, delivered and Returned to Vendor then you
would have three lines here.

• You will have to Correct the Deliver transaction before correcting the Receiving 
Transaction. Similarly the Return to receiving has to be corrected before correcting 
Return to Vendor.

• You have to select the line to be corrected and enter the correction quantity. On 
saving this transaction, system would create a record in the base Receiving Table. 
On doing this 'India - Receiving Transaction Processor for Corrections' concurrent 
request would be submitted by Oracle Financials for India. This request will create 
adjustment Accounting, Costing and Excise Register Entries. 

• The program will not create CENVAT adjustments to Receipts on which CENVAT 
is claimed in the previous months. 

• In cases where AP Invoice is created before making a Correction entry, the Invoice 
has to be adjusted by creating a corresponding Debit Memo. On matching this Debit
Memo to the Receipt, Oracle Financials for India concurrent program 'To Insert Tax 
Distributions' would be submitted to fetch Tax Amounts from the Receipts, in 
proportion to the Quantity matched.
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Using India - Mass Tax Update
In Oracle Financials for India, the Mass Tax update program is designed to handle 
impacts of Tax Rate revisions and Tax applicability changes for the following 
documents:

• Internal Requisitions

• Purchase Requisitions

• Request for Quotations

• Quotations

• Standard Purchase Orders

• Planned Purchase Orders

• Blanket Purchase Agreements

• Blanket Releases

• Sales Orders

• Contract Purchase Orders

On running this concurrent, taxes will be recalculated for all selected OPEN documents.

Prerequisite Setups:
You must list changes in Taxes that will. impact the Open transactions. Following 
Changes/Additions will be made to current Tax Setup:

• Tax Rate Changes / New Tax: Wherever, the Tax Rates have changed or a new Tax 
has been introduced, a New Tax code has to be defined. A new Tax Category has to 
be defined with the New Tax Code. For all the Item, Supplier combinations where 
the new rate is applicable, the Tax Categories in the Item Category list would be 
changed appropriately. 

• Change in Classification: Identify Items with changes in classification. Identify 
applicable New Tax Category. Replace Assign the new Tax Category to Items on 
the Item Category list.

India - Mass Tax Recalculation
After completing the above setup changes, submit the Mass Tax Changes Concurrent 
request. To submit the request navigate toIndia Local Purchasing > Submit: Requests > 
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Mass Tax Updates.

Choose the 'Document Type' (mandatory), From Date, To Date (Mandatory) and any 
other parameter fields (optionally). On successful completion of the Request, the Taxes 
on the Open transactions in the chosen Document Type would be recalculated, where 
applicable. The Taxes on the Tax Details window will be updated with the Taxes from 
the revised Tax Categories. The Tax Amount and the Total Amount on the Document 
header and lines would be recalculated to reflect the latest Tax Amounts. All Tax lines, 
manually added before the update, will be retained if these lines do not have 
precedence on any other lines (except the Base Item Line) and neither does any other 
Tax line have precedence over these lines. All documents with manual tax lines having 
precedence on other lines, will not be processed and audit tables will be updated 
accordingly.

Successful completion of the Concurrent Request updates the audit tables with the 
documents that are affected, the Old Tax Category and the New Tax Category. It will 
also list the documents that could not be updated and needs manual intervention.

If you do not wish to change the Supplier Additional Information and the Item 
Category Lists, then the Old Tax Category and the New Tax Category Codes can be 
chosen in the Parameters window. On running the concurrent request, all lines that 
have Old Tax Category Codes will be replaced with the new Tax Category Codes.

India- Mass Tax Recalculation - Request
Document Type

The User can select from the List of Document Type. This is a mandatory parameter

From Date

Enter a Date Value in this field. The Transaction lines with the document date created 
on or after this date would be considered for processing. This is a mandatory 
parameter.

To Date

Enter a Date Value in this field. The Transaction lines with document date created on or 
before this date would not be considered for process This is a mandatory parameter.

Supplier

The LOV for this parameter would display the Suppliers with transactions. This field is 
enabled only if Purchase Type of document is chosen in the Document Type field.

Supplier Site

The User can choose Supplier Site Id from the LOV. The LOV is restricted to the value 
chosen in the Supplier field.

Customer

The LOV for this parameter displays the Customers with transactions. This field is 
enabled only if Sales Type of document is chosen in the Document Type field. 
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Customer Site

The User can choose Customer Site Id from the LOV. The LOV is restricted to the value 
chosen in the Customer field.

Old Tax Category

The User can choose Tax Category from the LOV. The Transaction lines with this Tax 
Category is considered for processing. This Tax Category will be replaced with the 
value chosen in the 'New Tax Category' parameter and the Taxes will be recalculated 
accordingly.

New Tax Category

The User can choose Tax Category from the LOV. The Tax Category on the Transaction 
lines chosen for processing will be replaced with the value chosen in this field and the 
Taxes will be recalculated accordingly.

Document No.

Enter a Transaction Number of the document type of the transaction that you would 
restrict the processing to.

Blanket Release No.

Enter the Release Number to be processed.

Document Line No.

Enter the corresponding Document Line Number to be processed.

Shipment No.

Enter the corresponding Shipment Line Number to be processed.

Override Manual Taxes

On selecting 'Yes' in this field you would be restricting the processing to documents that
do not have Manual Tax Lines. Else, all selected documents would be processed and 
any Manual Lines on these document would be deleted and new tax lines that would be
defaulted for the transaction would be restricted to the taxes that are included in the 
Tax Category.

Commit Interval

Enter a Numeric Value here. The program will commit the processed records in groups 
defined by this Number.

Process Partial

Select 'Yes' or 'No'. All OPEN Documents including those Partially Processed, will be 
considered for update if you selected 'Yes'.

Update Tax Category
On completion of Patch application the Tax Category will default on the existing 
documents. The Tax Categories would be defaulted, based on the existing Localization 
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setup.

Oracle Financials for India is designed to handle tax defaulting and calculation for the 
transactions entered by the user through Requisitions, RFQ, Quotations, Purchase 
Orders, PO Releases, Receipts, Sales Orders and RMA. The Defaulting would be based 
on the Three-way defaulting logic followed for Oracle Financials for India i.e., based on 
Supplier/Customer, Supplier Site/Customer Site or Item Class. However, following 
would be exceptions:

• Internal Requisitions (Localized) : in case of Internal Requisitions created from 
Requisitions (Local) the taxes would be defaulting only from the Item class 
applicable to the lines.

• Blanket Releases (Localized) : Taxes would be flowing from the Blanket Purchase 
Agreement

• Internal Sales Order: Internal Sales Order would be created on importing Internal 
Requisitions.

Receipts (Localized)
The Localization Taxes defined in the Purchase Order will be defaulted and the 
procedure for Accounting / treating different Localization taxes can be handled at the 
time of Receipt. For this, user need to Open Receipt through Receipt Localized window.
By activating the "NEW" button, user will be taken to the Standard Receipt screen 
where he needs to match the receipt with a Purchase Order.

Navigate to India Local Purchasing - Receiving - Receipts (Localized) and use the India 
Local Receipts India Localization form to view and create receipts.

You can view receipts by querying any field like Receipt Number, Receipt Date, 
Shipment Number, Shipment Date, Excise Invoice No, Excise Invoice Date, Supplier 
Name, Inventory Organization.

1. Click New to create receipts. Enter the Header information for the receipt.

2. In the Transaction Type field, select either Express or Non Express. Selecting 
Express ensures that a single India Receiving Transaction processor concurrent 
request is submitted to Process all Receipt lines. The default value in this field is 
blank, which is equivalent to Non Express.

After the Receipt is created, Receipt details will be auto-queried to Receipt localized 
window where details of the Excise Documents need to be captured. Excise Invoice 
Number and Excise Invoice Date is captured in this screen. If you wish to avail 
CENVAT credit in Auto mode immediately on Receipt, you must check claim CENVAT
on Receipt Flag.

Important: Whenever credit on Capital Goods is availed, you can claim 
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50% of Credit at the time of Receipt by specifying 'Yes' in the 'Claim 
CENVAT on Receipts'. The balance Credit can be availed using 'Claim 
CENVAT on Receipt' screen.

If a Receipt has multiple lines and share the same Excise Information, then the use can 
fill these details at the Header level and click on populate defaults button to default the 
details to shipment lines. You also have an option to change these details at line level.

If there are Multiple Excise Documents for a Single Receipt, user can incorporate this 
information in the line level also. The user need to enter the Line information for the 
shipment line and save the data as per the regular standard Applications functionality.

Through the Tax button the user can view the Tax lines for the Receipt, which is as per 
the PO terms and the user is empowered to modify the tax lines at the times of Receipts.
Only the modified tax lines for which the tax Vendor is other than the PO Vendor in the
Receipts will be considered for AP Invoices raised for receipts for the respective tax and 
Third Party Vendor.

Important: The standard applications 'Receiving Transaction Processor' 
needs to be completed before the localization screen reflects the taxes. 

On Receipt, all modifications are permitted to the tax lines provided the Receipt Modify
Flag in Additional Organization Information screen is enabled. The modifications 
include:

• Deletion of a tax line

• Addition of a tax line

• Modification of a tax amount 

• Modification of the amount computed for any tax line

• Changing the vendor on receipt for tax lines if allowed by tax definition.

• Changing the currency applicable to the particular tax line if allowed by tax 
definition.

Important: These modification of tax lines can be done only before 
closing of Receipt (Localized) form, once the Receipts (localized) form is
closed, the corresponding accounting entries will be passed and the 
System won't allow the user to modify the tax lines. 

The Total Amount will get updated with the Revised Amounts on saving the screen. 
However, on change of the Tax Amount the dependent tax amounts would not be 
re-calculated.
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Once the Receipt localization screen is closed, India Receiving transaction processor 
concurrent program is submitted. This concurrent updates Excise Registers and creates 
Accounting Entries. In case of a Trading Organization RG 23D Register Entry and 
corresponding Accounting Entries are created by this Concurrent Request.

In case of a Manufacturing Organization, updates to Excise Registers and creates 
Accounting Entries would be based on the Receipt Routing Type and the value entered 
for Claim CENVAT in the Receipt.

• If Receipt Routing is Standard and Claim CENVAT on Receipts is 'Yes', Excise 
Quantity and Duty Registers are updated and Accounting Entries are passed. None 
of the Excise Registers will be updated when Claim CENVAT is Set to 'N'. 

• If Receipt Routing is Direct Delivery and Claim CENVAT on Receipts is 'Yes', 
Excise Quantity and Duty Registers are updated and Accounting Entries are passed.
If the Claim CENVAT is Set to 'N' then, Receiving and Delivery Accounting Entries 
will be passed but Excise Registers will not be updated.

You can check for the successful completion of the above concurrent program by 
navigating through view request.

Auto Accounting using NEW Button
A new Receipt can be created without closing Receipt localized form. This can be done 
using NEW button on India Local Receipts screen. Following message is populated 
when the user tries to create a new receipt using this path.

Accounting Entries and Excise Register Entries for the Receipt would be generated on 
accepting the message. You need to ensure that the taxes are updated before creating a 
new Receipt.

View Accounting
An option to view the Accounting Entries for Tax Accounting generated during the 
receipt is being provided. You can use this option to verify accounting entries are 
generated for the Receipt properly. Navigate to Tools > View accounting.

In the Transaction Type segment, you can select the transaction like Receive, Deliver, 
RTV etc. and look for the accounting entries generated.

Field Description Type Action Description

Account Type     The user can look for Accounting
Entries generated for different
account types like CENVAT,
Receiving etc.
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Field Description Type Action Description

Account Mode     Accounting can be viewed for
logistic transactions like Receipts,
Return to Vendor etc. For Receipts
Type of transactions, Account
mode will be regular and for
Return related transactions
account mode will be reversal.

UOM     This field displays the Unit of
Measurement in which the
transaction was recorded.

Line number     This field displays the Accounting
Transactions lines for which view
Accounting Entries are displayed.
By using the down/up arrows,
user can view the Accounting
Entries for different lines in the
Receipt.

Transaction Date     This field displays the date on
which Accounting Transaction is
recorded.

Quantity     This field displays the Quantity
Received against the transaction

• In the transaction segment, system displays the GL Account, the 
Debit and Credits against the Accounting line, Transaction 
Currency, Currency Conversions, Period Name, Created Date and 
Transaction Date.

• This feature is provided to enable the user to confirm that the 
receipts are accounted properly. User is provided an option to view
the localization tax entries in the " T " Shape accounts form.

View Registers
On completion of the Receipt Accounting process, by navigating through the

Tools - View Register Menu, the user can check the updates in the CENVAT Registers.

In the Receipt Segment, Receipt related information like Transaction Date, Unit of 
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measurement, Quantity Received, Sub Inventory and Lines Numbers are displayed. 
This functionality facilitates the user to confirm updation of excise registers on 
completion of a Receipt transaction and the amount flown into the CENVAT Registers.

In the Register segment, by using the TAB key, user can move to part I, part II, RG 23 D 
and PLA * registers as per the transaction parameters.

* PLA will be updated only for RTV Transactions when preference is set to 1 or when 
sufficient balances are not available. 

Field Description Type Action Description

Register Type     This field displays the Register in
which the transactions are
recorded. This will be updated
based on the values for the Items
defined in the Item Class. This
can be CENVAT on input (RG 23
A), CENVAT on Capital Goods
(RG 23 C) or Dealers CENVAT
Register (RG 23 D)

Serial Number     This field displays the Serial
Number in the respective
Register under which the
transaction was recorded.

UOM     This displays the Unit of
Measurement in which Excise
Registers got updated. Always
Excise Registers will get updated
only in the primary Unit of
Measurements and users need to
take enough care while defining
the conversion factor from
primary Unit of Measurement to
secondary Unit of Measurement.

Invoice Number     This field displays the Excise
Document Number that was
recorded for the transaction

Invoice Date     This field displays the Duty
paying Document Date on which
credit was availed.
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Field Description Type Action Description

Vendor Name     This field displays the
Vendor/Customer Name with
whom the transaction was
performed.

Apply BOE to Receipts
In all Receipts where tax of type Customs Duty or Additional Customs Duty is defined 
in the tax lines, the system will not permit saving the record, without applying Bill of 
Entry (BOE). BOE Button will be enabled only when the receipts tax lines have tax type 
like Customs Duty, Additional Customs Duty.

Payment towards Customs Duty need to be done through BOE Invoices in AP Module 
(Invoices- BOE Invoices) At the time of Receipt, Items need to be matched with the 
payment of Customs Duty paid on the item. This is done by matching the BOE Invoice 
with the Receipt. Matching is done on Item-to-Item basis. Each Item where Customs 
type of taxes are attached,

Choose 'Apply BOE' to indicate against which Bill Of Entry the Duty Amount was paid.

The Customs Duty is paid to Customs Authorities on the Bill of Entry Value before the 
Receipts of Goods. You can record the BOE details using BOE Invoices feature in India 
Local Payables. This will automate creation of a AP Invoice for the Customs Authority. 
BOE created through BOE Invoices can be applied against a Receipt by using the ' 
Apply BOE' form.

In the Header Block 

Field Description Type Action Description

Customs (Displayed)   The amount of Customs Duty in
the Receipt Tax Line will be
defaulted here.

CVD (Displayed)   The amount of CVD in the
Receipt Tax Line will be
defaulted here.

Total Customs Duty (Displayed)   Total of Customs Duty and CVD
in the Receipt Tax line will be
defaulted here
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Field Description Type Action Description

Total Amount
Applied

(Displayed)   The Total Amount of Customs
Duty will be displayed after
entering the line data.

In the Line Level

Field Description Type Action Description

BOE No (Displayed)   All the BOE No's raised in AP but
not yet applied will de displayed
here.

Import Dept. Sl. No. (Displayed)   Value entered in the
corresponding field of the BOE
Payment Screen would appear in
this field.

Customs Authority (Displayed)   You can view the Customs
Authority Name in this field.

BOE Amount (Displayed)   BOE Amount will de displayed
here.

Amount written off (Displayed)   If part of the BOE Amount is
already written off through the
Written off functionality in
Accounts Payable, then the same
amount will de displayed here

Amount already
applied

(Displayed)   If part of the BOE Amount has
been applied, then the same will
appear here.

Amount to be applied (Enterable)   The user can enter the amount to
be applied, which can not exceed
the Total Customs Amount.

The User need to save this screen
after entering the above
information. Once a BOE is fully
applied it won't be appearing in
this form for application.
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Unordered Receipt
At the time of Receipt of Items it may not be possible to ascertain the Purchase Order 
against which an Item is being received. In such case you enter an Unordered Receipt.

In respect of Unordered Receipt, no taxes are defaulted for the receipt since the 
purchase order against which the receipt is done is unknown.

Unless the Receipt is matched to Purchase Order the Taxes does not default.

While matching Receipt with PO, Oracle Financials for India will provide the taxes from
the Purchase Order and these taxes cannot be modified.

The option to claim CENVAT on receiving is not available on the Unordered Receipts 
screen. It is available while matching Receipt with PO . The Excise Records are updated 
for Material Receipt in RG23A/C Part I only on matching the Receipt to a Purchase 
Order.

No Accounting Entries are generated at the time of Receiving. The Accounting Entries 
are generated at the time of matching with Purchase Order.

You can also access the 'Claim CENVAT on Receipts' screen under Inventory Receiving 
to generate the Excise Entries and accounting for CENVAT if you do not claim 
CENVAT Credit while matching Receipt with PO.

After matching the Unordered Receipts, the User has to query the Receipt Number in 
the Receipt Localization screen and BOE has to be applied for the Receipt if the receipts 
tax line are having customs type of taxes.

Match Unordered Receipt
The Unordered Receipts needs to be matched to a Purchase Order later. CENVAT credit
on Unordered Receipts can be claimed only once the Receipt is matched with a 
Purchase Order. In the flex field, user needs to select India Receipt as the context value 
and record the Excise Duty paying document details.

Navigation: Receiving - Match Unordered Receipts

The Excise related information like Excise Invoice, Excise Invoice Date and Claim 
CENVAT on Receipts would be entered. Receipt Localized window. *. 

* CENVAT Credit cannot be taken for Unordered Receipt on Receipt of the Goods. 
Credit can be taken only on matching the Unordered Receipts with a Purchase Order. 
Query the Receipt from Receipt localized window and provide Excise information to 
claim. The provision for Tax Corrections at the time of Receipt is not available for 
Unordered Receipts. Hence User need to ensure that the Purchase Order has the actual 
tax figures.

India Localization Receipt Details
India Local Receipt Details form summarizes taxes, Excise Registers (both quantity and 
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amount), Accounting, Costing and BOE details of receiving transactions.

1. Navigate to India Local Purchasing > Receiving > Receiving Transactions Summary.

2. Query the transaction to display the Receiving Headers Summary window.

3. Click 'Transactions' to display the Receiving Transaction Summary window.

4. Click View > Zoom to display India Local Receipt Details window.

In the Header Block

Field Description Description

Receipt Number Receipt Number that is queried will be displayed here.

Unit of Measurement UOM of the Item will be displayed here.

Quantity Quantity of the Item received will be displayed here.

Transaction Type Transaction Type will be displayed here.

Tax Amount Total Tax Amount of the Receipt Tax line will be
displayed here.

Cenvat Amount Cenvat Amount of the Receipt Tax Line will be
displayed here.

Item Class Item Class of the Item Received will be displayed here.

Excise Invoice Number Excise Invoice Number of the Vendor will be
displayed here.

Excise Invoice Date Date of the Excise Invoice will be displayed here.

Processing Status This field displays process status related to
Non-Cenvat Taxes included in the Receipt. This field
displays following values:

E - Implies error during processing

Y - Implies successful completion of the program

X - means that taxes are not applicable to the receipt
line

O - Implies missing setup
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Field Description Description

Cenvat Process Status This field displays process status related to cenvat
taxes included in the receipt. This field displays
following values:

E - Implies error during processing

Y - Implies successful completion of the program

X - means that taxes are not applicable to the receipt
line

O - Implies missing setup

XT - Implies that correction could not be completed
due to change in the period of receipt and the
correction.

Process Message This message displays process message for
Non-Cenvat Taxes. The message depends on the value
in the Processing status.

Cenvat Process Message This message displays process message for
Non-Cenvat Taxes. The message depends on the value
in CENVAT Process status field.

In the Line Level 

Field Description Description

Tax Tab  

Line Number Serial Number

Name Name of the Tax will be displayed here.

Type Type of Tax as selected while Defining Tax.

Rate Type Rate type will be displayed here.

It can either be Percentage Adhoc or UOM

Depending on the Tax Definition

Rate Rate of Tax as defined while Tax Definition.
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Field Description Description

Precedence / UOM Precedence used to calculate Taxable Basis. This field
would be populated for percentage-based taxes.

In case of UOM based Taxes, Unit of Measure assigned
to the Tax Code will be shown.

Currency Tax Currency will be displayed here.

Amount Amount of Tax will be displayed here.

Recovery % Recovery Percentage as specified while Defining Tax.

Recoverable The value in this field would be set to 'Yes' whenever
the Tax is Recoverable in the context of the transaction.

In cases where a Recoverable Tax is not recovered due
to certain Item and Organization setup, this field
would reflect 'No' irrespective of the value in the
'Recovery % ' field.

Modified Manually This will be 'Yes' when the Tax Amounts or the Taxes
have been modified by the user.

Vendor Name of the Vendor will be displayed here.

In case of the First Party Taxes, the PO Vendor Name
would be displayed here.

In case of Third Party Taxes, the Tax Vendor Name
would be displayed here.

Vendor Site Vendor Site Name will be displayed here.

In case of the First Party Taxes, the PO Vendor Site
would be displayed here.

In case of Third Party Taxes, the Tax Vendor Site
would be displayed here.

Quantity Register Tab  

Organization Name of the Organization will be displayed here.

Location
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Field Description Description

Fin Year

Register Register type will be either RG23A or RG23C.

Sl No. Serial Number of the entry in the Quantity Register
will be displayed here.

Creation Date

Excise Invoice Number Excise Invoice Number of the Vendor will be
displayed here.

Excise Invoice Date Date of the Excise Invoice will be displayed here.

Transaction UOM UOM in which the Transaction has been made will be
displayed here.

Primary UOM Primary UOM assigned to the Organization item will
be displayed here.

Quantity Received Quantity Received will be displayed here.

Amount Register Tab  

Organization Name of the Organization will be displayed here.

Location Location of Receipt will be displayed here.

Fin Year Financial year in which the receipt was created will be
displayed here.

Register Register type will be either RG23A or RG23C.

Sl No. Serial number of the entry in the amount register will
be displayed here.

Creation Date Creation date of the CENVAT Register Entry will be
displayed here.

Excise Invoice Number  
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Field Description Description

Date of the excise invoice will be displayed here.

Debit Amount debited to the register through the transaction
will be displayed here.

Credit Amount credited to the register through the
transaction will be displayed here.

Accounting Tab  

Transaction Date

Creation Date Creation date of the Accounting Entry will be
displayed here

Account Number of the account in which the effect of the
transaction is going will be displayed here.

Account Type This field displays the class of accounting entries.

Period Accounting period

Debit Amount Debited will be displayed here.

Credit Amount Credited will be displayed here.

GL Posting Status Displays the status of posting to GL

Sub Ledger Displays the status of posting to Ja_In_Rcv_Journals

Date of the receipt transaction will be displayed here.

This field displays the class of accounting entries.

Organization Name of the Organization will be displayed here.

Costing Tab  

Creation Date Date of the receipt transaction will be displayed here.
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Field Description Description

Account Number of the Account in which the effect of the
transaction is going will be displayed here.

Period Displays Accounting Period

Debit Amount Debited will be displayed here.

Credit Amount Credited will be displayed here.

Organization Name of the Organization will be displayed here.

BOE Tab  

Customs Authority

Site Site of customs authority will be displayed here.

Agent Name

Number of the BOE will be displayed here.

Amount Amount applied against the BOE will be displayed
here.

Claim CENVAT on Receipts
If you do not wish to take credit on inputs or capital goods immediately on Receipt, you
can claim the credit from the Claim Credit on Receipts window. In the case of capital 
goods, balance Credit of 50% that can be availed in the Next Financial Year can be 
claimed through this screen.

While taking Credit on Capital Goods through this windows the Accounting Entries 
mentioned will get generated.

This form can be used to claim CENVAT Credit on Receipt if the CENVAT Credit is not
taken at the time of Receipt because of non-availability of adequate information. 
Further, for Capital Goods the CENVAT Credit could be taken only after installation 
and thus this feature of claiming CENVAT at a later stage after the Receipt is provided.

1. Receiving and CENVAT entries are not generated for Receipts with
routing as Standard, unless CENVAT Credit is claimed.
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2. Ensure that CENVAT is claimed before the Purchasing and 
Inventory periods are closed.

Navigate to India Local Purchasing > India Localization > Receipts > Claim Modvat on 
Receipts > Find Receipts India Localization.

This Query Find window provides following checkboxes.

• Last Years claim only

• CGIN only 

• 50% Claim only.

This feature would help you in querying eligible Receipts for Claim CENVAT, in a 
Batch Mode. This feature would be of great use to claim remaining CENVAT on Capital
Goods (CGIN Items) purchased during the Previous Year.

Following would be the behavior in each combination of options above:

• Combination A: 1+2+3: If the user checks all the fields then, all receipt lines 
pertaining to purchase of CGIN Items in the previous year would be fetched. Only 
those CGIN purchases for which 50% of CENVAT has been claimed in the previous 
year would be fetched.

Combination B: 1: All purchases made in the previous year, for which CENVAT is 
available for claim would be fetched. This would include both RMIN and CGIN Items.

Rather this is an exclusion of Receipt lines in the current year (pending CENVAT 
Claim).

Combination C: 2: All CGIN purchases with CENVAT attached, not claimed completely
would be fetched. This would include receipt lines of the current and also the previous 
year.

Combination D: 3: All CGIN purchases for which first 50% CENVAT has been claimed 
would be fetched. This would be irrespective of the year.

Combination F: 1+3: All CGIN purchases made in the previous year for which first 50% 
CENVAT has been claimed in the previous year would be fetched.

Combination G: 2+3: All CGIN purchases for which first 50% CENVAT has been 
claimed would be fetched. This would be irrespective of the year in which the goods are
purchased.

The below mentioned screen will be used to claim CENVAT for the Receipts. These 
Receipts should have associated tax lines and CENVAT = 'Yes'

Navigate to India Local Purchasing > India Localization > Receipts > Claim Modvat on 
Receipts > Find Receipts India Localization.

Receipt Number (Displayed)
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The Receipt Number for which CENVAT is to be claimed.

Receipt Date (Displayed) 

Date on which the receipt has been entered.

Item (Displayed)

The Item for which the Receipt has been entered.

Description (Displayed)

Description of the Item.

Item Class

The Item Class of the Item will be defaulted in this field. By default, this will be CGIN 
or CGEX as defined in the Item Category flex-field.

Total CENVAT Amount 

This field displays the total CENVAT Credit available on the Item

Claimed CENVAT Amount 

If partial Credit is availed on the Receipt, this field displays the amount of credit that is 
already availed.

Claimed CENVAT Percentage

This field displays the Percentage of Credit availed on the item for the Receipt under 
reference.

CENVAT percentage to be availed

This field displays the percentage of credit which is available for claiming credit

Original Quantity 

This field displays the Quantity of Goods received against Receipt under reference

Location 

This field displays the Location in which the Receipt under reference was performed

Vendor Changed

You need to check this field whenever, the Vendor Name and Vendor Site has to be 
changed. This would enable the Vendor Name and Vendor Site field.

Vendor Name (Displayed)

Name of the Vendor from whom the Inventory is received. The PO Vendor would be 
displayed in this field. However, in case you have received the goods from a different 
Vendor, then you can update the Vendor Name with the Vendor from whom you have 
received the goods. To do this, check the 'Vendor Changed' Checkbox. Select a new 
Vendor and Vendor Site.

Vendor Site (Displayed)

Name of the Vendor Site from whom the Inventory is received. The PO Vendor Site 
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would be displayed in this field. However, in case you have received the goods from a 
different Vendor, then you can update the Vendor Name with the Vendor From whom 
you have received the goods. To do this, check the 'Vendor Changed' Checkbox. After 
you update the Vendor Name you can select the Vendor Site in this field.

Excise Invoice No (Required) ENTER 

You have to enter the Excise Invoice Number.

Excise Invoice Date (Required) ENTER

Date of the above Excise Invoice Number.

Claim CENVAT (Required) CHECK BOX

You have to enable this check box to take CENVAT credit on a particular Receipts

Unclaim CENVAT (Required) CHECK BOX

You have to enable this check box to take unclaim CENVAT credit on a particular 
Receipts.

Check All

Click this field to select all the Receipt Lines for processing.

Clear All 

Click this field to deselect all the Receipts.

Unclaim All 

Click this field to Unclaim all the Receipts and load Excise Amount to Item Cost.

Claim 

Click this button, process the selected Receipt Lines. A single concurrent would be fired 
to process all the selected Lines.

Unclaim 

Click this button, process the selected Receipt Lines for Unclaim. A single concurrent 
would be fired to process all the selected Lines.

You can select lines one at a time by Clicking on 'Unclaim CENVAT' checkbox on the 
line. Else, you can check the 'Unclaim All' checkbox on the header.

All selected lines are processed for Unclaim on clicking on the 'Unclaim' button.

1. Oracle Financials for India supports Receipts corrections with 
IN60106. Entries to adjust taxes would be automated on saving 
Receipt corrections. Hence the 'Modify' facility has been removed 
from Claim CENVAT on Receipts' screen. 

2. You cannot claim CENVAT for a receipt if the same combination of 
Excise Invoice Number, Excise Invoice Date has been used for 
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another Receipt created in the current Organization from the same 
Vendor Site.

CENVAT Credit on Capital Goods
At the time of taking CENVAT Credit on Capital Goods, the user can define the 
percentage of CENVAT Credit the user wants to take immediately on Receipt of the 
Goods. For using this functionality, the user needs to carry out the steps mentioned 
below. 

Following setups are mandatory for availing partial Credit on Capital Goods and to 
Claim the balance later.

Item should be classified as Excisable, Modvatable and Item class should be CGIN or 
CGEX.

After creating the Receipt, Excise Document details need to be provided in Receipt 
localized window. These values can also be filled in at the Receipts Line level. If "Claim 
CENVAT on Receipt" is checked, RG 23 C Part II Register Entries would be created for 
50% of CENVAT applicable to the Receipt Line. else, if you don't check will defer the 
claim of CENVAT. In such cases, you need to follow the "Claim CENVAT on Receipts" 
process (as specified in the previous section of this Chapter).

Remaining 50% of CENVAT Credit arising from the Capital Purchase can be claimed 
during the following year

• In case of Return of the Capital Goods to Supplier, you can create a 
Return only after claiming the remaining 50%. This can be claimed 
in the same Financial Year. Hence, you should ensure that the total 
CENVAT is claimed before saving an RTV Transaction.

• You can find the CENVAT Credit he can avail by running India 
CENVAT report. This report is available in India Local Purchasing 
Responsibility. 

• In the Additional Organization. Information Screen, the user need 
to key in an account to which all pending CENVAT Credit need to 
be posted and it will be tracked. This account is being identified as "
CENVAT Receivable Account" 

Unclaim CENVAT
CENVAT can be claimed only on Receipt of documentary evidence indicating the 
Excise Duty Liability incurred by the Shipping Organization. There would be situations 
where the Organization might not receive such documentary evidence. In such cases 
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the Excise Duty amount has to be included the Item Cost and the record should be 
eliminated from the list of records that have to be processed for CENVAT Claim.

In case the Item is Inventory Item then, such CENVAT Amount should be added to 
Item Cost if the costing method is 'Average'. The same should be accounted as Purchase
Price Variance, where the costing method is STANDARD. If the item is EXPENSE then 
the CENVAT amount needs to be added to Expense Account.

An option has been provided in the 'Claim CENVAT on Receipts' screen, where the 
user can identify the Receipt lines that have to be eliminated from the CENVAT Claim 
processing. Such records would be eliminated from CENVAT Claim processing & 
excise duty related to such records would be included in the Item Cost.

Navigate to India Purchasing > India Localization > Receipts > Claim CENVAT on 
Receipts

Through the above find Receipts Form you can find the Receipt for which you will like 
to unclaim CENVAT. After entering the required fields the "find" button has to be 
clicked to fetch the existing records for the criteria entered.

In the Claim CENVAT on India Local Receipts screen you can select all lines that you 
would like to Unclaim and eliminate them from further process of CENVAT Claim.

You can select lines one at a time by Clicking on 'Unclaim CENVAT' checkbox on the 
line. Else, you can check the 'Unclaim All' checkbox on the header.

All selected lines are processed for Unclaim on clicking on the 'Unclaim' button.

Returns to Vendor
A Return to Vendor transaction has to be created by the user Navigate from Return to 
Vendor India screen

When you create a return for material that has CENVAT applicability then you need to 
select Generate from process action LOV. This would ensure appropriate accounting for
CENVAT taxes.

A Batch Number will be generated based on which 'India - Return to Vendor' Report 
can be taken.

Navigate to India Local Purchasing > India Localization > Receipts > Return to Vendor 
(India) > Return.

As soon as you open the form the query screen pops up. After entering the required 
criteria the "find" button should be pressed which will fetch the records depending 
upon the criteria entered.

Quantity (Required)

The Quantity to be returned is entered in this field.

UOM (Required)

The Unit of Measure of the Item to be returned.
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Return to (Required) 

Destination of the Item to be returned whether to receiving or to Supplier

Supplier/Location (Conditionally Required )

Enter Location if the return to is receiving and if it is Supplier field will display name of 
the Supplier.

Return type to Reason (Optional) 

This is available from the Details tab of the Receiving Returns of the base form.

After entering all the required fields save record. After saving the transaction navigate 
back to Return to Vendor-India to default the details.

Select Process action from the LOV and click on default button to default the action 
details to shipment lines.

On saving record Accounting Entries and Entries in RG23A-Part I & II or RG23C-Part I 
& II and PLA are created depending on the Item Class and Type of Organization

In case of Manufacturing Organizations, the Duty Registers selected depends upon the 
preferences set up done in the Additional Organization Info screen. If PLA is set as the 
last preference and the item returned is a capital good (CGIN Item) then, balance in RG 
23C Part II would be considered first. PLA would be updated only if there no adequate 
balance in RG 23C Part II. However, balance in RG 23A Part II registers will not be 
considered.

RG 23D Register would be updated for Trading Organizations.

On completion of RTV transaction, the relevant excise registers will be updated and the 
print of the duty-paying document can be taken.

Return to Vendor in the Case of a Trading Item
Return to Vendor of a Trading will be done in the Standard Application form itself and 
the respective Issue entries will be passed in the RG23D Register and the same can be 
viewed through Transaction type Return to Vendor.

Return to SSI Vendor
Return to Vendor of a SSI would require a change in the rate of CENVAT Duty. To 
enter the revised Duty applicable to the Return, you can query an Existing Return 
transaction using Return to Vendor (India) screen. Here you have an option to specify 
the Revised Rate / Amount. Only Excise and Education CESS taxes will be displayed

Navigate to India Local Purchasing > India Localization > Receipts > Return to Vendor 
(India) > Inquiry.
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Inquiry

Requisition Summary (Localized)
Use this View Requisition Summary to review a particular Requisition (Localized) by 
specifying its Number. All the Requisitions will be viewed if the user does not specify a 
single Requisition PO Number. By pressing the New Requisition button the user can 
create a new Requisition also.

Viewing Requisition Summary
In Oracle Financials for India, navigate to the India Local Requisitions Summary 
window from India Local Purchasing > India Localization > Requisitions > Requisition 
Summary (Localized).

Field Description Type Action Description

Requisition Number     The user need to specify the
Requisition Number which he
wants to review through this
View Requisition Summary form
otherwise all the Requisition will
appear in the summary.

Preparer     The user need to review all the
requisition prepared by a person,
then by specifying the Name of
the Preparer in this column he
can get a summarized report on
all Requisition raised by that
Preparer.

Approval Status     If the user wants view all the
Requisitions with a particular
Approval Status (the Quick field
for Approval Status are Rejected,
Require Re-approval, Returned
then he can specify that and view
the summary report.

Order Number     The user can view the Requisition
summary report for a particular
purchase order by specifying the
Order Number here.
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Field Description Type Action Description

Type (Optional)   By specifying the Requisition
type like Purchase or Internal, he
can view the reports of all
Requisitions raised for a
particular Type.

Requester (Optional)   By specifying a particular
Requester Name, the user can
view all the requisitions raised by
that Requester.

Item (Optional)   By specifying a particular Item,
the user can view all the
requisitions raised for that Item.

Supplier (Optional)   By specifying a particular
Supplier Name, the user can view
all the requisitions raised for that
Supplier.

If the user wants to view all the Requisitions then he need not to specify any of the 
above field for querying and can blind query through the Find button.

Quote Analysis (Localized)
You can use this feature to analyze your quotations. By navigating through Quote 
Analysis (Localized) you can view the Per Landed Unit Cost (for the item) including 
Localization Taxes.

Through this form the user can view the Quotations (Localized) raised by a specific 
query or a blind query.

Viewing Quotations 
In Oracle Financials for India, navigate to India Local Purchasing > India Localization > 
Quotations > Quote Analysis (Localized).

Click Find without supplying values for any field to view all Local Quotations. You can 
further sort the results by specifying particular fields in the form like RFQ, Supplier, 
Quotation and respective quotations can be viewed.

Note: Only Non-recoverable portion of the taxes will be considered for 
calculation of per landed unit cost.
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Purchase Order Summary
Use this View Purchase Order Summary to view a particular Purchase by specifying its 
Number and all the Purchase Orders will be viewed if the user does not specify any of 
the field. The user can do new release for a PO through New Release button and the 
user can create a new Purchase Order through the New PO button.

Viewing Purchase Orders
In Oracle Financials for India, navigate to India Local Purchasing > India Localization > 
Purchase Orders > PO Summary (Localized).

Field Description Description

Purchase Order Number The user need to specify the Purchase Order Number
for which he wants to review through this View
Purchase Order Summary Form.

Release Number The user need to the review all the Purchase Order
Released under a Blanket Agreement, then by
specifying the Release Number in this column he can
get a summarized report on all Purchase Orders raised.

Supplier By specifying a particular Supplier, the user can view
all Purchase Orders raised for that particular Supplier.

Ship To-Org By specifying a particular Ship To Inventory
Organization Name, the user can view the entire PO
raised for that Inventory Organization.

Bill To By specifying a particular Bill To Site Name of an
Inventory Organization, the user can view all the PO
raised for that Bill to Location

Type By specifying the Purchase Order Type like Standard,
Blanket Order or Contract Agreement, he can view the
report of all Purchase Order raised for a particular
Type.

Item By specifying a particular Item, the user can view all
the purchase orders raised for that Item.
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Field Description Description

Ship To By specifying a particular Ship To Site Name of an
Inventory Organization, the user can view all the PO's
raised for that Ship To Location.

Buyer By specifying a particular Buyer Name, the user can
view all the PO raised for that Buyer

Important: On Clicking Open Button in the PO Summary (Localized) 
window, Purchase Orders, Base Applications window would be 
opened.

The following column will be displayed in this Summary screen. The field wise 
description of the form is given below for ready reference.

Field Description Description

PO Number Purchase Order Number will be displayed

Release Number The Release Number for the Purchase Order will be
displayed.

Line Number of the PO Line Number of the Purchase Order will be displayed.

Shipment Number of the PO Shipment Number of the Purchase Order is displayed.

Type of the PO Type of the Purchase Order will be displayed in this field.

Item Item Code of the Item is displayed.

Item Description Item description is displayed

UOM Unit of the Measurement is displayed in this field.

Quantity Quantity transacted will be displayed in this field.

Currency The Currency in which the transaction got recorded will
be displayed.

Price Transaction Price is displayed in this field.
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Field Description Description

Amount Quantity multiplied by Price will be displayed.

Tax Amount Tax Amount will be displayed in this field.

Line Total Total of the Line Amount will be displayed in this field.

Ship To Location This field displays the Location to which the goods will be
shipped.

Supplier Name Name of the Supplier will be displayed in this field.

Supplier site Supplier Site with which the transactions are to be made
will be displayed.

Authorization Status This field displays the Authorization Status of the
document.

Need by Date Need by Date for the item will be displayed in this field.

Buyer Name Name of the Buyer will be displayed in this field.

Reports
This section provides overview and detailed descriptions of these reports: 

• India - Purchase Register Report 

• India Receiving Accounts

• India - Purchases Report - This report lists Purchases made Outside state, 
unregistered dealer or within state. Report can be submitted using Parameter, "
Report For". Based on the selection report is generated.

• PLA Register Report 

• RG 23A Part - I Report 

• RG 23A Part - II Report 

• RG 23C Part - I Report 

• RG 23C Part - II Report 
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• India-CENVAT Monthly Return - Inputs 

• India-CENVAT Monthly Return - Capital Goods 

• India-CENVAT Monthly Return - Abstract 

• OSP Pending Dispatch Report 

• OSP Pending Receipt Report 

• OSP Stock Register 

• Outside Processing Challan 

India - Purchase Register Report
This Reports provides details of all Purchase made for a Vendor or for all the Vendors 
for a given period. This report is based on the AP Invoices created for the Purchases. 

Report Submission

Use the Submit Requests (India Local AP & PO Module Only) form and enter 
India-Purchase Register Report in the Name field to submit the report.

Report Parameters

The User wants purchases for a specific Vendor, then he can enter the name otherwise 
purchase for all the Vendors will be reported. 

If Vendor Name is specified in the above parameter, then the respective Vendor 
Number will be defaulted. 

Period of Report (Required)

Enter the period for which you wish to take the Purchase Report for. 

Report Headings 

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name and Operating unit information based on User parameter 
input.

Column Headings 

Sl No 

Serial Number of the Line details will be reported. 

Voucher No 

Purchase Invoice Voucher Number will be reported 

Vendor Name 

Name of the Vendor will be reported.
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Bill No & date 

Supplier Bill No & Date will be reported 

PO Number. & Date

Purchase Order Number matched to the Invoice.

Remarks

Remarks appearing in the Purchase Voucher will be reported 

Currency 

Transaction Currency will be reported.

Net Amount

Purchase Invoice Line Amount will be reported. 

The following taxes in a purchase invoice will be reported 

Excise Duty

Excise Duty amount associated in the transaction.

Customs Duty

Custom Duty Amount associated in the transaction. 

LST (Local Sales Tax)

Sales Tax Amount associated in the transaction.

Insurance

Insurance Tax Amount associated in the transaction.

Freight

Freight Tax Amount associated in the transaction.

Octroi

Octroi Tax Amount associated in the transaction.

VAT Tax

Value Added Tax Amount associated in the transaction.

Service Tax

Service Tax Amount associated in the transaction.

Other (Other taxes if any )

Other Tax Amount associated in the transaction.

Total Amount

Total of the Purchase Invoice will be reported 
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India Receiving Accounts
Report Submission

Use the Submit Requests (India Local PO Module) form and enter

India - Receiving Accountsin the Name field to submit the report.

Report Parameters

Organization Code (Optional) PICK

Organization Code, for which you wish to take the Receiving Accounts report for. 

Receipt Number (Optional)

Receipt Number of the above Organization, you wish to display the transaction details 
or to display all Receipt Numbers. 

Line Number (Optional ) PICK

This parameter is specific to the above parameter. Line Number of the above Receipt , 
you wish to view the transaction details or all Line Numbers of the above Receipt will 
be displayed.

Account Type (Optional) PICK

Account Type , you wish to display transaction details of particular Account Type or to 
display all Account Types details 

Transaction Type (Optional) PICK 

Select the Transaction for which you want to generate the report type or to display all 
Transaction Type details.

From Date (Optional)

Date to print all the transaction details starting with the entered Date.

To date (Optional)

End Date to restrict the transactions till this Date.

Report Headings:

Report Headings: provide you with general information about the contents of the 
report. Oracle lists Organization information based on User parameter input.

Column Headings 

Organization Code

Code of the Organization will be reported 

Receipt Number 

Receipt Numbers will be reported 

Line Number.
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Line Numbers of each transaction will be reported 

Item Description

Item details on which transactions has done will be reported 

Transaction type

A specific Transaction Type for which the report is printed.

UOM

Unit of Measure used in transaction will be reported

Quantity

Quantity received in each transaction will be reported.

Account Type

Account Type used in each transaction will be reported.

Account Mode

Account Mode used in each transaction will be reported.

Account

General Ledger Account to track the accounting entries for a specific Account.

Amount (Dr)

Column representing amount Debited

Amount (Cr)

Column representing amount Credited

Currency Code (Dr)

Currency used in transaction will be reported.

Currency Conversion Rate 

Currency Conversion Rate used in the transaction will be reported if MRC is used.

Period

Period in a financial year will be reported

Creation Date

Date on which the transaction was created.

Report Summary

This section of the report lists the Net activity of all accounts according to the 
transaction type. 

Account

General Ledger Account to track the accounting entries for a specific Account.
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Transaction Type

Transaction Type of particular type will be reported.

Total Amount (Dr)

Total Amount debited for one particular transaction of the account 

Total Amount (Cr)

Total Amount credited for one particular transaction of the account 

Net Activity

Total of amount Dr, amount Cr for a particular account 

Total Net Activity for All Accounts 

Total of amount Dr, amount Cr for all accounts

Report Order

Report is printed in the order of Receipt Number, Line Number and Transaction Type 
for the selected Organization.

India - Purchases Report
Use India Purchases Report to generate transaction details for Purchases made Outside 
the State, Within the State and Unregistered Dealers.

Report Submission : Use the Submit Requests (India Local PO Module) form and enter

India - Purchases Report in the Name field to submit the report.

Report Parameters:

Report For (Required, Default) PICK

Single Report can generate transactions carried Outside the State, Within the State and 
Unregistered Dealers based on this parameter.

Organization (Required) PICK

Select the Organization for which you wish to print the Report.

Location (Optional) PICK

Select the location for which you wish to print the report.

Supplier

Select the supplier if you wish to generate the report for a specific supplier.

Supplier Site

Select the Supplier if you wish to generate the report for a specific Supplier Site.

Start Date

Date Range to specify from which date these transactions needs to be picked
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End Date

Date Range to specify till which date these transactions needs to be picked

Report Headings:

Provide you with general information about the contents of the report. Oracle lists 
Organization information based on User parameter input.

Columns Headings:

Name of Vendor

Name of Vendor from whom the purchase was made

Sales Tax Registration No. of Vendor

Sales Tax Registration No. of Vendor as entered in vendor entry form

Invoice Number

Invoice Number of the purchase.

Invoice Date 

Invoice Date of the Purchase

Invoice Amount

Gross Amount as entered in Invoice.

Sales / VAT Tax Rate

Sales Tax Rate for the particular Invoice Line.

Sales / VAT tax Amount

Total Sales Tax Amount for the ST rate for the Invoice.

Report Totals

Invoice Total & Sales Tax total for the chosen period.

Report Summary

This section of the report lists the summary (Tax summary) of Rate wise total for Sales 
Tax.

Total for <Tax type> @ rate % 

Total for the Sales Tax Rate for the chosen period. 

Tax Total

Total Tax for the chosen period.

Report Order

Report is printed in the order of Vendor Name, Invoice Date and Tax Rate for the 
selected Organization.
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India PLA Register Report
This report gives you complete details of Personal Ledger Account as per prescribed 
format Specified by Central Excise Act. Format and columns of this Report is same as 
specified by the Central Excise Act.

Use the Request Transaction Reports form and enter India PLA Register Reportin the 
Name field to submit the report.

Organization (Required) PICK HELP

Enter A Organization, you wish to take the PLA Report for.

Location (Required) PICK HELP

Enter a Location, you wish to take the PLA Report for.

Transaction From/To Date (Required) PICK HELPOracle Financials for India allows 
the user to print selectively the transactions from a given date on wards. 

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists information as given in the report format of PLA Register.

Column Headings

Sl.no 

Serial Number of the Register maintained in the order of transactions.

Date 

Transactions Date. 

Document No 

Localization prints TR6 challan No

Document Date

Localization prints TR6 challan No

Basic Excise Duty 

Localization prints cr_other_ed for Excise Duty

Special Excise Duty

Localization prints cr_other_ed

Additional Excise Duty

Localization prints cr_additional_ed 

Invoice No.

Localization prints dr_invoice_id 

Invoice Date
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Localization prints dr_invoice_date

Debit Excise Duty Amount

Derived as dr_basic_ed + dr_additional_ed + dr_other_ed 

Balance

Derived as cr_basic_ed + cr_additional_ed + cr_other_ed - dr_basic_ed - 
dr_additional_ed - dr_other_ed 

Central Excise Reports
All these Reports related Central Excise Act will be available in India Local INV, PO, 
AP, OE & AR Modules in the respective Report requests.

India RG 23A Part-I Report
This Report gives you the Stock Account of 'Inputs' for use in or in relation to the 
manufacture of 'Final Products' and complete Quantitative Details as per Format 
Specified by Central Excise Act for a Inventory Organization and its Location. Format 
and columns of this Report is as same as specified by the Central Excise Act.

Report Submission

Use the Request Transaction Reports form and enter India RG23A Part I Report in the 
Name field to submit the report.

Report Parameters

Organization (Optional) PICK HELP

Enter A Organization, you wish to take the RG 23A Part I Report for. 

Location (Optional) PICK HELP

Enter a Location, you wish to take the RG Report for.

Transaction From / To Date (Required, Default) PICK HELP

If the user wants to take report for a specific period then he has to specify the period.

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists information as given in the report format of RG Registers.

Column Headings

SlNo 

Serial Number of the Register for the Organization and Location, selected.

Date

Date of the Transaction seen in the Register 

Description of Inputs received.
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Item Description for the Transaction will be seen in the Register.

Quantity Received 

Quantity Received for the Transaction will be seen in the Register.

Bill of Entry No. & Date

Fields Receipt Number and Receipt Date are concatenated and printed.

Name & address of manufacturer

PO Vendor's Name and Address

Range and Division 

Taken from the master data for the particular Vendor. 

Issued for use in - Chit no. and date

Blank 

Issued for use in - quantity

Issues for Clearance - AR-1 / GP-1 No. & Date

Issues for Clearance - Quantity

Sales Invoice quantity

Otherwise - Document Id and Date

Otherwise - Quantity

Balance Quantity

Derived as sum (Received quantity - Goods issue quantity - sales invoice quantity - oth. 
document quantity)

Officer's Initials

Blank

Remarks

India RG23 Part-II Report
This Report provides you with the information that would be required to meet the Duty
Register requirements specified under the CENVAT Credit Rules 2004.

This report can be submitted both for Raw Material and Capital Goods. You can also 
generate the report for a given date range. 

Report Submission

Use the Request Transaction Reports form and enter India RG23A Part II Report in the 
Name field to submit the report.

Report Parameters

Organization (Required, Default) PICK HELP



India Local Purchasing    2-85

Enter Organization, you wish to take the RG Report for.

Location (Required, Default) PICK HELP

Enter a Location, you wish to take the RG Report for.

Register Type (Required, Default) PICK HELP

Select the Register Type here. Select 'A' for Raw Material and 'C' for Capital Goods

Transaction From Date (Required, Default

Enter the begin Date for the Report

Transaction To Date (Required, Default)

Enter the end Date for the Report

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists information as given in the report format of RG Registers

Column Headings

Sl No

Serial Number is dynamically generated when the reported is submitted.

Date

Date of the Transaction seen in the Register

Opening Balance

Opening balance for Excise Duty Amount

Opening Balance Edu. Excise

Opening balance for Education Cess Duty Amount

Opening Balance Edu. CVD

Opening balance for CVD Education Cess

ECC Code No of the Supplier

This field displays the ECC Number of the Supplier Site from where the inputs are 
received.

Range & Division

Duty Credited - Additional Duty 

Total Credit Available - 

Derived as opening Balance + cr_basic_ed + cr_additional_ed + cr_other_ed 

Debit - Document No. & Date

Debit - (Basic + Additional)

Officer's Initials
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Blank

Receipt Number

This field displays the corresponding Receipt Number.

Closing Balance

Opening Balance + (cr_basic_ed + cr_additional_ed) - (dr_basic_ed + dr_additional_ed) 
+ (cr_other_ed - dr_other_ed )

Important: It is necessary that to run 'India - RG Period Balances 
Calculation' program with the last day of the month preceding the 
report dates. This program should be scheduled once for every month 
with the last of the month. If this is not done, the report would end with
an error. 

India RG23C Part-I Report
This Report gives you the Stock Account of 'Capital Goods' to be used in the 
manufacture of 'Final Products' and complete Quantitative Details as per Format 
Specified by Central Excise Act for an Inventory Organization and its Location. Format 
and columns of this Report is same as specified by the Central Excise Act.

Report Submission

Use the Request Transaction Reports form and enter India RG23C Part I Report in the 
Name field to submit the Report

Report Parameters

Organization (Optional) PICK HELP

Enter A Organization, you wish to take the RG Report for.

Location Optional) PICK HELP

Enter a Location, you wish to take the RG Report for.

Transaction From/To Date (Required)

If the user wants to take report for a specific period then he has to specify the periods. 

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists information as given in the report format of RG Registers.

SlNo

Serial Number of the Register for the Organization and Location, selected.

Date of Receipt 

Date on which the Capital Goods were received is reported.
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Description of Capital goods received. 

Description of the Capital Goods received is reported.

Quantity received

Quantity of the goods of the Goods Received against the transaction is reported.

Range and Division

The Range and Division of the Organization where the goods have been received.

Date of Verification

The date on which the Capital Goods were issued to the production and verified.

Issued for Installation - Chit no. and date

Chit Number / Issue slip details through which the Capital Goods are issued along with
the date.

Place of Installation

Place of Installation where the Capital Goods were installed in the factory premises.

Date of Installation

The Date on which the Capital Goods were installed.

Date of starting of use

Date on which the Capital Goods are put to use.

Removal of Capital goods - Quantity

Otherwise - Document Id and Date

Otherwise - Quantity

Balance Quantity

Derived as sum (received_quantity - goods_issue_quantity - sales_invoice_quantity - 
oth_document_quantity)

Officer's Initials

Blank

Folio and Entry No. in part II

Remarks

Remarks as listed in the RG Registers

India-CENVAT Monthly Return
This Report in accordance with the format specified under Rule 7 (5) of CENVAT Credit
Rules 2002. This Report along with 'India - CENVAT Monthly Abstract' Report gives 
you complete information as required under the rule.

This report can be submitted either for CENVAT credits availed on purchase of Raw 
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Material or on Capital Goods.

Report Submission

Use the Request Transaction Reports form and enter India-CENVAT Monthly return in 
the Name field to submit the report. 

Report Parameters

Organization (Mandatory, Required) PICK HELP

Oracle Financials for India displays the Default Organization (default). Enter A 
Organization, you wish to take the RG Report for.

Location (Required, Default) PICK HELP

Oracle Financials for India displays the Default Location (default). Enter a Location, you
wish to take the RG Report for.

Register Type (Required, Default) PICK HELP

Select Register Type to print the report for Raw Materials or Capital Goods.

Transaction From Date (Required, Default)

Enter the Begin Date for the report

Transaction To Date (Required, Default)

Enter the End Date for the report

Report Details :

Sl No

Serial Number of the credit taken. This will start with Sl. No. 1 at the beginning of the 
financial year and jump by one for each transaction.

Type of Document

System will default the Type of document that has been attached to the concerned 
Supplier Site. The type of the document is a new field attached to the Additional 
Supplier Information screen. For each Supplier Site, it is mandatory that the user needs 
to enter this information. The standard Document Type that is being widely used in the 
industry are Invoice, Delivery Challan, Bill of Entry, Excise Challan etc. 

Number and Date of the Document

This field displays the Identification Number of the Supplier document and date on 
which CENVAT credit has been taken on the Capital Goods

Name of the Supplier

This field displays the name of the Supplier from whom the Capital Goods on which 
CENVAT was claimed was received. 

Type of Supplier

An additional field is provided in the Supplier Additional Information screen to capture
the type of the Supplier. Standard Supplier Types used in the industry are 
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Manufacturer, Dealer, and Importer etc.

ECC Number of the Supplier

This field displays the ECC Number of the Supplier Site from where the inputs are 
received.

Date on which Input/Capital Goods Received

This field displays the Date of Receipt of Goods / Input

Details of Credit taken

These fields displays the amount of CENVAT credit taken against the transaction

Description

This field displays the description of the goods received 

Sub heading

This field displays the Tariff heading of the Goods received.

Quantity

This field displays the Quantity of the goods received.

Important: The value is derived by back working from the taxes. 
Because the taxes are rounded off, this back working might lead to a 
marginal difference 

India-CENVAT Monthly abstract
This Report forms the second part of the CENVAT Monthly Return Report in the format
specified under Rule 7 (5) of CENVAT Credit Rules 2002. This report along with 'India -
CENVAT Monthly Return' Report gives you complete information as required under 
the rule.

Report Submission

Use the Request Transaction Reports form and enter India-CENVAT Monthly return - 
Capital Goods in the Name field to submit the Report.

Report Parameters

Organization

The user need to enter an Organization, you wish to take the India-CENVAT Monthly 
return - Capital Goods.

Location

The user need to enter the Organization Location, for which he need to run the 
India-CENVAT Monthly Return - Capital Goods / Inputs.

Transaction From/To Date
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The user need to give the range of the dates for which he wants to run India-CENVAT 
Monthly Return - Inputs reports.

Material Type

The user need to select from the LOV whether he need to run the abstract for Inputs or 
Capital Goods.

Column Headings

Opening Balance

This field shows the Opening Balances based on the report parameter.

Credit taken during the month

This field takes into consideration the Total Amount of Credit availed during the period
specified in the report parameter

This field takes into consideration the total amount utilized for payment/debit of duty 
that is being adjusted to CENVAT credit on inputs/capital goods based on the report 
parameter

Closing Balance

This field shows the total of unutilized amount of Credit availed as on a particular date 
for Inputs/Capital Goods based on the report parameter.

India RG-I Report
This report gives you the Daily Stock Account for Finished Goods, Scrap, Intermediate 
Products and By-products as per Format Specified by Central Excise Act. Report is same
as specified by the Central Excise Act.

Use the Request Transaction Reports form and enter India RG I Report in the Name 
field to submit the Report.

Report Parameters

Organization (Required, Default) PICK HELP 

Oracle Financials for India displays the Default Organization (default). Enter a 
Organization , you wish to take the RG Report for.

Location (Required, Default) PICK HELP 

Oracle Financials for India displays the Default Location (default). Enter a Location, you
wish to take the RG Report for. 

Transaction From/To Date PICK HELP

Oracle Financials for India allows the user to print selectively the transactions from a 
given Date on wards. 

Show All Items Stock (Default) PICK HELP

Gives flexibility for the user to print all Items transacted during the period or in stock.
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Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists information as given in the report format of RG Registers.

Column Headings

Date

Transaction date 

Opening Balance 

Derived as Sum (balance packed + balance loose) 

Quantity Manufactured 

Will be populated when Finished Good is received.

Total

Derived as Opening Balance + Manufactured Qty 

Removal from factory - on payment of duty - Home Use

Removal from factory - on payment of duty - For export under claim 

Removal from factory - without duty - For export under bond 

Removal from factory - without duty - To other factories 

For Other Purpose - Purpose

For Other Purpose - Quantity

Duty Rate

Excise Duty Rate 

Duty Amount

Excise Duty Amount 

Balance Quantity - In Finishing Room

Derived as Total - for_home_use_pay_ed_qty - for_export_pay_ed_qty - 
for_export_n_pay_ed_qty - to_other_factory_n_pay_ed_qty - 
other_purpose_n_pay_ed_qty 

Balance Quantity - In Bonded Store

Closing Balance available in bonded store.

Signature of the Assessee / his agent Blank 

Report is printed in the order of Transaction Date applicable for that Location and for 
that Organization.

India OSP Pending Dispatch Report
Report Submission
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Use the Submit Requests (INV & PO Modules) form and enter IndiaOSP Pending 
Dispatch Report in the Name field to submit the report.

Organization(Required)PICK

Enter the Organization for which you wish to take the Unapproved OSP Dispatches 
Report for.

Location (optional) PICK 

Enter the Location for which you wish to take the Unapproved OSP dispatches Report 
for.

Vendor Name (Skip for all) (Optional) PICK 

Oracle Financials for India prints the 57F3 forms for this Vendor only, if you enter a 
value for this parameter.

Oracle Financials for India prints all the OSP items Unapproved starting with the date 
you enter for this parameter.

From Date (optional)

Oracle Financials for India prints all the OSP items Unapproved starting with the Date 
you enter for this parameter

To Date (optional)

Oracle Financials for India prints all the OSP items Unapproved up to the Date you 
enter for this parameter.

Report Headings

Report Headings provide you with general information about the contents of the report.
Oracle Financials for India prints Organization related information, Report date and 
Sheet number on all pages, along with report heading on all pages.

Column Headings

Vendor Name

Name of Vendor to whom the item was sent for further processing.

Work Order Number

Work Order Number of WIP Operation.

Nature of Work

Nature of OSP work to be performed on OSP Item.

57F3 Form Date

Date on which 57F3 form was created.

Item

Name of Item sent out for further processing. 

Item description
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Description of Item sent out for further processing. 

Dispatch Quantity

Quantity of items sent out for further processing. 

Excise Duty

Estimated Excise Duty (based on Assessable Value of Item) to be paid for OSP item.

Total

Excise Duty Totals for Vendor, Location and Organization.

Report is printed in the order of Vendor name, Due date, Form number and Item 
description.

India OSP Pending Receipt Report
This Report gives you the unapproved 57F4 Receipts in an Organization, Location, for a
given period of time and a given Vendor. The output is listed Work Order Number 
wise

Report Submission

Use the Submit Requests (INV & PO Modules) form and enter India OSP Pending 
Receipts Report in the Name field to submit the report. 

Report Parameters

Organization (Mandatory) PICK HELP

Enter the Organization for which you wish to take the Unapproved OSP Receipts 
Report for.

Location (optional)

Enter the Location for which you wish to take the Unapproved OSP Receipts Report for.

Vendor Name (Skip for all)

Oracle Financials for India prints the 57F3 Forms for this Vendor only, if you enter a 
value for this parameter.

From Date

Oracle Financials for India prints all the OSP items Unapproved starting with the Date 
you enter for this parameter.

To Date

Oracle Financials for India prints all the OSP items Unapproved upto the date you enter
for this parameter.

Report Heading

Provides you with general information about the contents of the report. Oracle 
Financials for India prints Organization related Information, Report Date and Sheet 
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Number on all pages, along with report heading on all pages. Column Heading

Vendor Name

Name of the Vendor to whom the item was sent for further processing.

57F3 Form Number

57F3 Form Number on which the Items were sent.

Form Date

Date of 57F3 Form. 

Item Description

Description of Items sent out for further processing. 

Despatch Quantity

Quantity of Items sent out for further processing. 

Return Quantity

Quantity of Items returned till date.

Pending Quantity

Pending Quantity of Items not yet returned till date.

Duty Amount

Amount of Duty paid on Items sent out.

Due Date

Due Date calculated as ( From date + Expected duration of Processing/Mfg. )

Vendor Total Duty Amount 

Vendor wise Total Duty Amount. 

Location Total Duty

Location wise Total Duty Amount. 

Organization Duty Total

Report's Total Duty Amount for the Organization Chosen.

Report is printed in the order of Vendor Name, Due date, Form Number and Item 
Description. 

India OSP Stock Register
This Report is an extract of all 57F4 transactions in an Inventory Organization, Location 
for a given period of time and the format of the Report is as specified by the Central 
Excise Act.

Report Submission
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Use the Submit Requests (INV and PO Modules) form and enter India OSP Stock 
Register in the Name field to submit the report. 

Report Parameters

Organization (Required) PICK

Enter the Organization for which you wish to take the 57F3 Register Report for.

Location (optional) PICK

Enter the Location for which you wish to take the 57F3 Register Report for.

From Date (optional)

Oracle Financials for India prints all entries in the register starting with the date you 
enter for this parameter.

To Date (optional)

Oracle Financials for India prints all entries in the register up to the date you enter for 
this parameter.

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Organization Information based on user input.

Column Headings 

Description of Goods

Description of OSP Item.

Tariff Classification

Excise Item Tariff Classification.

Dispatch Quantity

Quantity of Item dispatched.

Identification marks, if any

Identification marks of OSP item, if any.

Premises/Factory to which removed

Premises/Factory to which OSP items were sent

Challan No./Challan date

Date and Number of 57F4 Challan.

Nature of Processing required

Nature of Processing required for the OSP Item.

Rate and Amount of Credit Reversal

Rate and Amount of Excise Duty paid on removal of OSP items.
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Reg. Name, Sl.no., & Date of Dr./Initials of Mfr./Supplier

Reg. Name, Sl Number . and date of Debit entry in the Excise Register.

Receipt date / Clearance date from Processor 

Date of Receipt of Items in the factory.

Received Quantity/Unit of Measure

Quantity of Items Received till date.

Pending Quantity

Pending quantity of OSP item

RG23A Sl.No., Credit Date and Re-credit Amount taken

Serial Number . No. , Date and Amount of Re-credit taken on Receipt of items.

Report Order

Report is printed in the order of date of Issue for the selected Organization.

India Outside Processing Challan
This report gives you the challan required under rule 4 (5) of The Central Excise Rules. 
The output is listed Challan number wise. 

Use OSP Form Report to print Challan for material sent for outside processing. The 
report, is divided into three parts. Data for PART I is populated by the system, during 
printing, while PART II and PART III data are to be manually filled up as and when 
required.

Report Submission

Use the Submit Requests (INV & PO Modules) form and enter India Outside Processing
Challan in the Name field to submit the report.

Report Parameters :

Organization Name (Mandatory)

Oracle Financials for India displays the 57F4 Forms for the Organization you enter for 
this parameter

Location (Mandatory)

Oracle Financials for India displays the 57F4 Forms for the Organization Location you 
enter for this parameter

Fin Year (Mandatory)

Oracle Financials for India displays the 57F4 Forms for the Fin Year you enter for this 
parameter

Issue Date From (Optional)

Oracle Financials for India prints all the 57F3 Forms starting from the date you enter for 
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this parameter.

Issue Date to (Optional)

Oracle Financials for India prints all the 57F4 Forms up to the date you enter for this 
parameter.

Form Nos. From (Optional) PICK

Oracle Financials for India prints all the 57F4 Forms starting with the Number you enter
for this parameter.

Form Nos. To (Optional) PICK

Oracle Financials for India prints all the 57F4 Forms up to the Number you enter for this
parameter.

Vendor (Optional) PICK

Oracle Financials for India prints the 57F4 Forms for this Vendor only, if you enter a 
value for this parameter.

Place (Optional)

Oracle Financials for India prints this name in Place field of 57F4 Forms.

Name of the Signee (Optional)

Oracle Financials for India prints this name in Signature of Manufacturer/Authorized 
Signatory field of 57F4 Forms.

Report Headings:

Report headings provide you with general information about the contents of the report. 
Oracle Financials for India prints OSP Challan Number, Vendor Name and Sheet 
Number of Certificate on all pages, along with Report Heading.

Column Headings:

Description

Description of Item being dispatched for outside processing.

Identification marks and No. if any

Identification marks and No. if any for the item.

Tariff Classification

Tariff Classification of the item.

Quantity

Quantity and Unit of Measure of item being dispatched.

Unit assessable value

Assessable Value of item 

Excise Duty Reversal Rate
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Excise Duty Reversal Rate applicable to item .

Excise duty reversal amount

Excise Duty Reversal Amount that can be claimed for the item.

Nature of Processing / Manufacturing

Nature of Processing / Manufacturing to be done on the item outside the factory.

Serial Number of Debit Entry in PLA and Date

Serial Number of Debit Entry in PLA and Date for Excise Amount Payment for the 
Form.

Factory/Place of Processing/manufacturing

Factory/Place where the items are being sent for further Processing / Manufacturing

Date and Time of Issue

Date and Time of Issue of Items for outside processing. 

Expected Duration of Processing/Mfg

Expected Duration of Processing/Mfg. 

Report Order 

Report is printed in the order of 57F4 Challan Forms
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3
India Local Payables

This chapter covers the following topics:

• eTDS Returns

• Bill of Entry (BOE)

• Capture Personal Ledger Account (PLA) Payment

• Tracking of Sales Tax Forms Issues

• Third Party Taxes - Additions to Fixed Assets

• Defining TCS Authority

• Setting Up India Local Payables

• Managing TDS Transactions

• Service Type Review

• BOE Invoices

• PLA Invoices/Payment

• Using Sales Tax Declaration Forms - Issue Tracking

• India - FA Mass Additions

• Define Invoice Tolerance Limits

• View / Resubmit / Delete Error Tax Lines

• Reports

eTDS Returns
This feature is in accordance with the requirements of Income Tax Act. The Act 
mandates reporting of non-salary deductions through eTDS Returns. These certificates 
replace the existing Return in the Form 26.
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Basic Business Needs
The feature enables generation of eTDS Certificates considering the following 
information:

• TDS deducted on Prepayment Invoices

• TDS deducted on Standard Invoices

• Payments against Invoices generated for TDS Authorities

• Data Generated for Form 16A Certificates

This feature considers TDS Calculations in following situations:

• Invoice Validation.

• Application of Prepayment Invoice to the Standard Invoice

• Unapply of Prepayment Invoice to the Standard Invoice

• Invoice Payments

• Invoice Cancellation

• TDS Deductions under Lower Rates

• Users can generate eTDS returns flat file by using the concurrent program 'India - 
Program to Generate eTDS Quarterly Certificates'.

Bill of Entry (BOE)
Customs Duty Liability arises on import of material. Customs Duty has to be paid in 
advance i.e., before the material is received in stores. The clearance of goods imported 
would be possible only after submission of the Bill of Entry in the specified format. This
document details the goods imported in the consignment and the amount of Customs 
Duty liability for each commodity included in the consignment. Bill of Entry in Oracle 
Financials for India helps you manage the documentation process and account for the 
liability arising from the transaction.

Bill of Entry helps you manage the import process. Using BOE you can perform the 
following tasks:

• Capture the vital information required for the creation of the Bill of Entry in the 
format specified by the Bill of Entry (forms) regulation.

• Record the Total Customs Duty liability arising form the transaction.
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• Create an AP Invoice for the total Customs Duty liability arising from the 
transaction.

• Maintain account for the Customs Duty Liability.

• Control receiving transactions until the Customs Type of taxes arising from the 
transaction are matched to the corresponding Bill of Entry.

• Enables write-off of the disputed amount and amount that could not be applied 
fully to the transaction. 

Bill of Entry (BOE)
You must use this feature to capture the information required for the Bill of Entry report
to be submitted to the Customs Authority.

While creating a Bill of Entry, you can now enter the Additional CVD percentage. This 
percentage is applied on the Total of all preceding taxes.

Calculation of Customs Duty
This feature helps you in calculation of the Customs Duty, Additional Duty and 
Surcharge based on the Assessable price entered for the transaction.

Creation of AP Invoice
An Approved AP Invoice would be automatically created for the Customs Authority 
with the Total Customs Duty liability arising from the transaction.

Control over Receipt Transactions
For the goods receipts that are created through India Local Receipts screen, which have 
Customs Duty of Tax, attached to it, a control would be placed, where you cannot quit 
the form until an appropriate BOE is attached to the receipt line. This would set-off the 
Customs liability arising from the transaction.

BOE Amount Write-Off
You have a facility to write off the Un-applied BOE amount in a BOE Invoice which no 
longer to be applied against any Receipts. If the Customs Duty paid need to be written 
off for any reasons, you can make use of this functionality. For example, the Customs 
Duty is paid through a BOE Invoice and during transit of goods from the port to the 
Organization; the duty paid goods were lost in transit. In such cases, the duty paid on 
such goods cannot be applied to the inventory receipt transaction and the duty paid 
need to be Written Off.
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Reports
Payables generates the following reports applicable to India:

BOE Written off Report - Lists Bill of Entry (BOE) records written-off during the 
selected period.

Capture Personal Ledger Account (PLA) Payment
The Excise liability arising from the removal transactions needs to be settled within 5 
days from the end of the Month / Period. The Duty can be discharged on debiting a 
current account, referred to as Personal Ledger Account (PLA). PLA credit is taken by 
depositing money in the banks on T.R.6 Challan. Capture PLA feature helps you 
capturing the information required for the PLA Report to be submitted to the Excise 
Authorities. This feature helps you in raising Invoice to capture and maintain account 
for the liability arising from the transaction.

Basic Business Needs
The Capture PLA Payments feature in Payables helps you manage the Excise Duty 
liability settlement process. Using this feature, you can:

Capture the information required to update the PLA Register

Account for the liability arising from the transaction

Control on updation of PLA Register

Important: An AP Invoice would be generated on saving the Capture 
PLA Payment transaction.

Major Features
Major features of PLA are mentioned below

PLA Payment
The net Excise Duty liability arising during the Month / Period has to be settled by a 
payment made through TR 6 Challan. The PLA Register would be hit when the 
payment is actually made to the Excise Authority and the user acknowledges this 
payment from the 'PLA Invoices' Screen. The Capture PLA Payment feature captures 
the information required for the updation of the PLA Register.

Creation of AP Invoice
An AP Invoice with status 'Validated' would be automatically created for the Total 
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Amount on the Capture PLA Payment lines. This would take care of accounting the 
liability arising from the transaction.

Acknowledging PLA Payment
The PLA Register would be updated only when the PLA Payment is acknowledged. 
The Acknowledgment is allowed only when the AP Invoice created for this transaction 
is fully paid.

Tracking of Sales Tax Forms Issues

Overview
The reduced rates of Sales Tax are applicable based on issue of declaration forms to the 
Supplier. These forms would be as specified in the applicable Sales Tax Regime. For this
you will have to keep track of the transactions that would qualify for concessional rate 
of Sales Tax. Further, you will have to keep track of details of Forms Issued and the 
Invoices included in each of the Forms.

Basic Business Needs
Sales Tax Issue tracking helps you manage the issue of Issue of declaration forms in 
order to avail concessional rate for Sales Tax. Using this feature you can perform the 
following tasks:

• Setup Declaration Form names that have to be issued to avail the concessional rate 
of Sales Tax. 

• Assigning Form Names to appropriate Tax Codes while defining these Taxes.

• Keep track of Purchase Invoices against which Sales Tax Declaration forms have to 
be issued to the Supplier.

• Facilitate recording details of Forms Issued and the Invoices included in issue of 
form.

• Provides with a facility to query Issued Forms and view Form details and the 
Invoices included in these Forms.

Third Party Taxes - Additions to Fixed Assets

Overview
Taxes and charges that are incurred on a transaction but are not paid to the Supplier of 
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Goods are defined as Third Party Taxes in Oracle Financials for India. Third Party Taxes
applicable to a transaction would depend on the Shipment terms. The terms used 
commonly are Ex-works and FOB. In cases where the terms of Shipment is Ex-works, 
the Seller delivers the goods at his premises. All costs incurred after this stage has to be 
borne by the Buyer. In case of Inland purchases, the cost components would be Freight, 
Insurance, Octroi and Entry Tax. In case of Imports the Third Party Taxes would be 
Freight, Insurance, Landing Charges, Inland Freight, Installation Charges and would 
also involve Basic Customs Duty, CVD and Customs Clearance Charges. On such 
transactions there is a good possibility of having multiple Third Party Vendors and Tax 
Authorities. Also, the amount paid would be consolidated by Third Party Vendor and 
Vendor Site.

Of these Tax Types, except for the Countervailing Duty, all others are Non-Recoverable 
Taxes. These have to be added to the Item Cost. In case of the Raw Material Purchases, 
the Average Cost has to be updated and in case of Capital Goods, the amount should be
added to the Asset Cost.

Oracle Financials for India automates transfer of Third Party Taxes to Fixed Assets.

This feature automates transfer of following taxes/expenses to Fixed Asset Cost:

Third Party Taxes: Costs that are not billed to the PO Supplier but are incurred in the 
course of the transaction.

Non-Recoverable Customs Duty: Customs Duties that are paid to the Customs 
Authorities through Bill of Entry (BOE).

Defining TCS Authority
TCS Authority needs to be defined for settlement of TCS Taxes and payments. You can 
identify a TCS authority by assigning the Supplier Type as India TCS Authority. To 
classify a supplier as a TCS Authority, access Supplier window from India Local 
Payable > Supply Base > Suppliers.

Setting Up India Local Payables
This section describes the setup procedures for Oracle Financials for India Payables. 
You must enter the following information:

• Setup Information for your Company before you create Invoices (with TDS Taxes 
attached).

• BOE and PLA Invoices or run any of the Payables Reports.

Defining Organization TDS Information
Use the Regime Registration screen to capture the Permanent Account Number (PAN) 
and TDS Account Number (TAN) and the Ward Number applicable to the 
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Organization. Payables uses this information to enable calculation of TDS for the 
Invoices created from the Organization, calculate Threshold Limits and generate TDS 
Certificate Numbers.

User should enter the values for the field 'Registration Value' against respective 
attributes i.e. TAN No, PAN No. Etc.

Navigate to India Local Payables > India Localization > India VAT/Service Tax > Setup >
Regime Registration.

Click Organization to display the screen that lets you associate different Operating 
Units for the TAN value.

• The value entered in the TAN No. field would be of great 
importance to you. This would be the basis on which the TDS 
Threshold limits would be calculated. If the TAN No. is defined 
only for the Legal Entity, then Invoices generated for all Supplier 
Sites defined under different Organizations would be totaled for 
the considered for the calculation of Threshold limits. If TAN No. is
defined for an Operating Unit, then the only the Invoices defined 
for this Organization would be considered for the calculation of the
Threshold Limits. Unless the TAN No. for two Operating Units is 
the same. For Operating Units with no TAN No, the TAN No. of 
the Legal Entity would be considered and the Invoices of all such 
Operating Units would be added to considered for the calculation 
of Threshold Limits.

• TAN No. once saved should not be updated.

Prerequisites
Before you enter the Additional Organization Units Details, you must:

• Define Organizations

• Define Locations

See also: Define Organizations, Oracle Payables User Guide.

Defining Income Tax Authority
You need to define a Supplier and classify the same as Income Tax Authority. While 
defining a 'Tax Deduction at Source' Type of Tax, only such Supplier would be listed in 
the Vendor LOV of the Tax Definition window. Such Vendor would be used by the 
system while auto-generating the Invoices for Income Tax Authority.
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Prerequisites
Before you create the Income Tax Authority, you need to:

• Define Organizations

• Define Locations

• Define Payable Options

• Define Financial Options

Creating Income Authority
To create Income Tax Authority:

Navigate to India Local Payables - Oracle Payables - Suppliers - Entry Window.

Create a New Supplier.

Select India TDS Authority in the Type field.

Defining TDS Sections
TDS Sections would be a part of the seed information. However, in situations where 
you use the TDS feature to deduct tax governed by other enactments, you can also add 
to the existing list of sections. You can define Effective periods during which the Code 
would be valid.

Prerequisites
Before you enter the TDS Sections, you must:

• Define Organizations

• Define Locations

• Define Payable Options

• Define Financial Options

In Oracle Financials for India, navigate to India Local Payables > India Localization > 
Asia/Pacific Lookups.

Creating TDS Sections
To create TDS Sections:

Query for 'JAI_TDS_SECTION' Type.
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Enter up to 25 characters as a unique code you want to add to the lookup codes 
provided.

Enter the text with which you would like to identify the code.

Enter the validity period in the EffectiveDates fields. 

Enable the sections that you would like to be used.

Defining TDS Taxes
Taxes of Type Tax Deduction at Source have to be defined before you start using the 
TDS functionality. You can assign appropriate rate with an optional surcharge for each 
of the Codes. These codes, on application to an Invoice would automate the deduction 
process.

Prerequisites
Before you enter the TDS Tax Codes, you must:

• Define Organizations

• Define Locations

• Define Tax Authorities

• Define TDS Sections

• Define Concessional Form Types

In Oracle Financials for India, navigate to India Local Payables > India Localization > 
Setup > Tax Setup > Taxes.

Creating TDS Tax Codes
To create TDS Tax Codes:

• Enter the Tax Name.

• Choose 'Tax Deduction at Source' in the Type field.

• Enter the TDSAccount in the Account field. This would be credited when TDS
Amount against the debit to the Liability Account of the Supplier. This account 
would be debited with the TDS Amount against the credit passed to the Tax 
Authority.

• Specify in the Percentage field, a rate at which the TDS would be deducted.

• Choose a value in the Certificate field, only when you would like to use this code 
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for the suppliers who can avail concession on TDS amount to be deducted.

• Choose the value 'TDS Sections' for the field Section Type.

• You need to select the value from the List of Values for the field Section Type. The 
possible values *

• You need to select the value from the List of Values for the field 'Section Code'. User
can select this value only for the Section Type 'TDS Sections'.

• You need to enter a value in the 'Original Tax Percent' field only when you have 
chosen a concessional certificate for this code.

• You can enter a SurchargeRate in the 'Surcharge% age' field'. The percentage at 
which tax is deducted would be in addition to the Surcharge%age to the Tax Rate.

• Specify the Effective Period for the TaxCode. Specifying the StartDate and the End
Date can do this. The StartDate cannot be before the date on which you are 
defining the Tax Code.

* TDS Sections: This value should be selected when you define any TDS taxes.

WCT Sections: This value should be selected when you want to define a WCT Tax. The 
tax type for this tax also should be 'Tax Deduction at Source'.

ESI Sections: This value should be selected when you want to define any tax (of type 
TDS) other than WCT and TDS taxes. The tax type for this tax also should be 'Tax 
Deduction at Source'.

Defining TDS Year
You need to define a TDS Year before using the TDS functionality. The TDS Year 
represents the reporting period and would be basis for the TDS Certificate Numbering 
and evaluating Threshold Limits. The TDS year can be different from the Accounting 
Calendar Year defined in the standard applications and also from the Tax Calendar 
Defined for the Inventory transactions.

Prerequisites
Before you enter the TDS Year, you need to:

• Define Organizations

• Define Locations

• Define Organization TDS Information

In Oracle Financials for India, navigate to India Local Payables > India Localization > 
Setup > Others > TDS Year Info.
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Creating a TDS Year
To create TDS Tax Codes:

• Select the TAN Number Value.

• Select the Organization Value.

• Enter a Year code in the FinancialYear with which you would identify this period.

• Enter the Period identified by the StartDate and EndDate. This period should be 
the Financial Year defined under the Income Tax Act.

If you require the TDS being Deducted to be rounded off to Ten Rupees instead of 
rounding the same to the nearest rupee, enter the current financial year and set 
Rounded To 'Ten'. All Credit Memos and Invoices on TDS Authorities generated will be
rounded off to Ten Rupees.

Note: This is a one time setup and cannot be changed.

Defining TDS Thresholds Setup
You can define TDS Threshold for a Vendor Type and TDS Section Code combination. 
You can define Thresholds for Single Invoice as well as Cumulative Invoice Thresholds. 
You can setup TDS Threshold Limits for a combination of:

• Vendor Type

• Section Type

The above setup can be used as a default setup across Vendor Types. If you wish to 
setup different Threshold Limits for certain Vendors, you can do the same by setting up
"Exception Setup". You can define as many "Exception Setups" as desired.

Using this setup screen you can define Thresholds for the Section Type 'TDS Section'.

You can define following Threshold Types:

• Single

• Cumulative

Single Threshold applies to a certain transaction only. If this Threshold is setup with a 
monetary limit, TDS will be deducted every time the current Invoice Amount exceeds 
the Threshold Amount. Those Invoices, which are lower than the Threshold Amount, 
will be ignored for TDS Calculation.

Cumulative Threshold applies to aggregate of all Invoices for the Financial Year. If this 
Threshold is setup with a monetary limit, TDS will be deducted on all the Invoices after 
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this monetary limit is reached. In case of the Invoice, due to which the Threshold Limit 
is reached, TDS will be calculated on all the earlier Invoices also (that were ignored TDS
Calculation).

In case both TDS Thresholds are setup with a monetary limit, Single Invoice Threshold 
will operate only if the Cumulative Invoice Threshold is not reached. Once Cumulative 
Invoice Threshold is reached, Single Invoice Threshold will be ignored.

You have a flexibility to specify Effective Dates for each TDS Thresholds. These 
Effective Dates are validated / compared against the accounting date of the Invoice 
distributions and TDS Thresholds will operate only between these Effective Dates. Once
an end date has been put a particular TDS Threshold, you can define a New TDS 
Threshold for that particular Threshold Type. Using this flexibility you can take care of 
the Threshold modifications happening from time to time without modifying any setup 
at the individual Vendor level.

Vendor Setup
You will have to specify the "TDS Vendor Type" and "Default TDS Section" for a Vendor
in the Supplier Additional Information screen. Based on this information, TDS 
Thresholds for the combination of the two will be derived and further TDS calculation 
of TDS will be made. These 2 are important setups as part of the TDS Calculation.

At a Supplier Site level, you can attach a "Tax Name" also. TDS calculation will happen 
based on the Threshold setup linked to the default "Tax Name" specified in the TDS 
Thresholds Setup screen.

If a TDS Tax Code is specifically selected in the Invoice distributions GDF, this TDS Tax 
Code will override any default TDS Section / TDS Tax Code. The overridden TDS Tax 
Code will also follow the TDS Threshold defined for that TDS Section which is derived 
from the Tax Code attached to the Section.

TDS Amount slabs:

For Single Invoice Threshold, you should enter the Amount Limit in the 'From Amount'
field. The system will not generate any TDS if the Invoice Amount is lower than the 
Amount mentioned in 'From Amount' field. For Invoices more than this Amount, TDS 
will be deducted.

For e.g. in case of section 194 (C) you should deduct TDS if a Single Invoice exceeds Rs. 
20,000. In this case you should give Rs. 20,000 in "From Amount" field.

For Cumulative Invoice Threshold, you should enter the Lower Limit and Upper Limit 
in "From Amount" and "To Amount" fields respectively. You can create Multiple 
Cumulative Thresholds.

For e.g. in case of Section 194 (C) for Individuals you should deduct TDS from Rs. 
50,000 to 849,999 at 2% and from 850,000 and above at 2.20% (including 10% Surcharge).
To map this requirement, you should setup as follows:
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From Amount To Amount Tax Rate

50,000 850,000 2

850,001 * 2.2

If there is no Upper Limit to be specified for this Threshold, you may leave this field 
blank or give any amount (such as 999,999,999)

The above is a recommended setup.

Navigate to India Local Payables > India Localization > Set Up > Tax Set Up > Tax > 
India-Threshold Setup.

Field Description Type Action Description

Header Section     The Header Section gives the
mandatory combination of

• Vendor Type

• Section Type

• Section Code (Numbering)

Vendor Type (Required) PICK

HELP

EDIT

You should specify the Vendor
Type here. LOV contains Vendor
Types seeded:

• Individual

• HUF

• Company

You can also define a user defined
value for the Look up Type 'TDS
VENDOR TYPE' (Numbering)

Section Type (Required) PICK

HELP

EDIT

You should specify the Section Type
here. User has to select the value
'TDS_SECTION' from the LOV.
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Field Description Type Action Description

Section Code (Required) PICK

HELP

EDIT

You should select Section Code
here. LOV contains Sections Codes
seeded:

• 194 (C)

• 194 (H)

• 194 (I)

• 194 (J).

User can also define a user-defined
value for the Lookup Type
'TDS_SECTION'.

Section Description   DISPLAY This field displays Description of
the Section Code.

Setup Name   PICK

HELP

EDIT

You should specify a Setup Name.
Though this is not a mandatory
field, it will help in identification

Exception Setup   CHECKBOX You should check this box if the
setup is being made is an Exception
Setup that is applicable only to
specific Suppliers. When this check
box is checked, indicates Exception
Setup.

Description   PICK

HELP

EDIT

You can give a Description of the
Setup that is being performed.

Threshold Types
Block

    In this block Threshold Types along
with the effective dates can be
captured
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Field Description Type Action Description

Threshold Type (Required) PICK

HELP

EDIT

Select Threshold Type here. LOV
contains:

Single

Cumulative

Start Date   PICK

HELP

EDIT

You should specify a Start Date.

End Date   PICK

HELP

EDIT

You can select an End Date here.
Once an End Date is put to a
Threshold Type, it becomes inactive
and you need to define a new
Threshold Setup for that particular
Threshold Type.

Amount Slabs Block      

From Amount (Required) PICK

HELP

EDIT

You will have to give Lower Limit
Amount here. Please refer
illustrations above for more details

To Amount (Required) PICK

HELP

EDIT

You will have to enter Upper Limit
Amount here. This field applies
only to Cumulative Threshold
Limit. Please refer illustrations
above for more details

Tax Rate (Required) PICK

HELP

EDIT

You should enter the applicable Tax
Rate for the Threshold.

Taxes block      

Operating Unit (Required) PICK

HELP

EDIT

You should pick the Operating Unit
here
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Field Description Type Action Description

Name     You should pick the Tax Code here
that applies to the particular
Threshold slab. Additional
Information: It is mandatory to
attach the tax name for each
Operating Unit, if the user wants
the TDS to be deducted
automatically by the system based
on the TDS Threshold setups.
Additional Information: Tax Rate
for the Tax code defined should be
same as that of the tax rate specified
in the slabs block

Defining TDS Thresholds Exception Setup
On clicking the "Assign Vendors" button you can create Exception setup for particular 
Vendor. Users can use this functionality only when the checkbox 'Exception Setup' is 
enabled.

This will take you to the following screen that displays the current assignments.

Navigate to India Local Payables > India Localization > Set Up > Tax Set Up > Tax - 
India-Threshold Setup > Assign the Vendor.

Cick New Assignment to create new assignments and select Remove checkbox to 
remove the assignments made currently.

Field Description Type Action Description

Vendor   DISPLAY This field displays Vendor that is
currently assigned to this
Exception Setup

Pan No   DISPLAY This field displays the PAN.

Org Tan No   DISPLAY This field displays the
Organization TAN

Remove   CHECKBOX Use this Check Box to remove the
assignment of the Vendor from the
Threshold Setup.
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On clicking "New Assignment" button, following screen will be displayed:

This window will show all the Vendors with the Vendor Type for which exception 
setup is being made. You should click on assign check box to select the Vendor(s).

Field Description Type Action Description

Vendor   DISPLAY This field displays Vendor that is
currently assigned to this
Exception Setup

Pan No   DISPLAY This field displays the PAN.

Org Tan No   DISPLAY This field displays the
Organization TAN

Assign   CHECKBOX Use this check box to assign the
Vendor to the Threshold Setup.

Supplier Additional Information
The existing screen has been modified to capture Additional TDS Information.

New behavior of this screen:

• You will have to capture TDS Vendor Type value for the vendor at the NULL Site 
Level.

• Giving PAN for the Vendor is mandatory when "TDS Details" screen is opened.

• You will have to Confirm PAN by checking the checkbox, "Confirm Pan". Once this 
checkbox is checked and the record is saved, you cannot modify the PAN for the 
Vendor.

• You should give default TDS Section Code value in the "Default TDS Section" field. 
Giving Tax Name is not mandatory. The Tax Name value can be given only for the 
Site Level record. Even though the Tax Name is attached here, system will not 
generate any TDS until the first TDS Threshold slab is crossed. At any point of time,
total TDS deducted would be as per the TDS Threshold setup slab amounts.

• Based on the TDS Threshold setup, Section Type, Section Code and Threshold 
Setup Name will be defaulted. Whether this is an exception setup or not will also be
indicated.

Steps to be followed in defining Additional Vendor Information:

• Open the Additional Vendor Information Screen.
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• Select the value of the Vendor from the List Of Values. Don't select any value for the
field 'Site'.

• Save the record.

• Click the 'TDS Details' Button.

• Select the value for the field 'TDS Vendor Type'.

• Enter the value for the field 'PAN No'. This should be a 10 digit valid alphanumeric 
value. Enough care should be taken while entering this value, as the user will not be
able to update this value once it is saved.

• The fields 'TAN No', 'Ward No' and 'Create Pre-Approved TDS Invoice Credit 
Memo' are optional fields. Before saving the record, the user should enable the 
check box 'Confirm Pan' and then only save the record.

• Once the Null Site record is saved, the user should requery the record and can then 
select the value for the field 'Default TDS Section' and save the record. The user can 
also observe that the TDS Thresholds setup details are getting queried in the 
Vendor Additional Information screen at the Null Site level.

• For creating a Site level record, the user should select the site value from the List of 
Values of the 'Site' field. Save the record. Then, click the 'TDS Details' button and 
save all the values defaulted from the NULL Site record.

• Once the Site Level record is saved, the user should requery the record and then 
attach the values for the fields 'Default TDS Section' and 'Tax Name'.

Importance of PAN:

TDS Threshold is maintained by Vendor PAN. Hence process of entering and 
confirming PAN has been made mandatory. Enough care should be taken by the users 
to enter the correct value for this field.

Importance of TDS Vendor Type:

TDS Thresholds are for a combination of TDS Section Code and Vendor Type. Vendor 
Type seeded as part of this solution are:

• Company-IND

• Individual-IND

• Other Persons-IND

• Hindu Undivided Family-IND

You can create more TDS Vendor Types in the TDS_VENDOR_TYPE purchasing 
lookup and create more TDS Threshold based on the new TDS Vendor Types.
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India Local Payables - India Localization - Suppliers - Additional Information.

Field Description Type Action Description

Header block      

Name   DISPLAY This field displays name of the
Vendor defaulted from Supplier
Additional Information screen

Number   DISPLAY This field displays Vendor Number
defaulted from Supplier Additional
Information screen.

Site   DISPLAY This field displays name of the
Vendor Site defaulted from Supplier
Additional Information screen

Vendor Type     This field displays Vendor Type
defaulted from Supplier Additional
Information screen. This is not
applicable for the TDS Functionality.

Invoice Approval
section

     

Create Pre-Approved
TDS Invoice Credit
Memo

(Optional) CHECKBO
X

You can check this box to generate
pre-validated TDS Invoices and
Credit Memos

TDS Information
Section

     

TDS Vendor Type (Required) PICK

HELP

EDIT

Capture TDS Vendor Type here.
Please refer discussion above for
more details

PAN No (Required) PICK

HELP

EDIT

Capture PAN of the Vendor in this
field
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Field Description Type Action Description

TAN No (Required) PICK

HELP

EDIT

Capture TAN of the Vendor in this
field

Ward No (Required) PICK

HELP

EDIT

Capture Ward of the Vendor in this
field

Confirm Pan (Required) CHECKBO
X

Check this box to confirm PAN of
the Vendor

TDS Details block      

Default TDS Section (Required) PICK

HELP

EDIT

Select a default TDS Section for this
Vendor. TDS will be deducted based
on checking the Threshold for this
section.

Tax Name (Optional) PICK

HELP

EDIT

You can select a default Tax Code
here. You can select the value for this
field only for the Vendor Site level
record. Even though the Tax Name
is attached here, system will not
generate any TDS until the first TDS
Threshold slab is crossed. At any
point of time, total TDS deducted
would be as per the TDS Threshold
setup slab amounts. If the user wants
the TDS to be deducted based on the
TDS Thresholds setup, then the user
need not attach any TDS Tax Code
value here. The value of the TDS Tax
Code will be picked up from the
TDS Thresholds setup for a specific
Operating Unit.

Section Type   DISPLAY Displays the Section Type under
which Threshold setup has been
made
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Field Description Type Action Description

Section Code   DISPLAY Displays the Section Code under
which Threshold setup has been
made

Threshold Setup
Name

  DISPLAY Displays the Threshold Name that
has been setup for this Vendor

Exception Setup   DISPLAY Indicates whether this Threshold is
an Exception setup or not.

• There can be scenarios, wherein the Suppliers have applied for 
PAN, but are yet to get the PAN Number value. In those cases, user
has got the option to change the value of PAN Number for the 
suppliers. User has to follow the steps mentioned below:

• Run the concurrent program 'India - Pan number Update'.

The Concurrent program takes the values for the following parameters:

Parameters:

Vendor Name: Select the Vendor Name for which, the user wants to modify the value of
PAN Number.

Old PAN Number: Select the value of Old PAN Number.

New PAN Number: Enter the value of New PAN Number. Debug: Takes the values Yes
/ No. This should be used for any debugging purposes. Expected TDS behavior

The following is the behavior of TDS in different scenarios.

Sr. No. Case Behavior

1 Invoice created that does not reach
the Threshold (Single /
Cumulative)

No TDS Invoice will be generated

2 Invoice created that reaches Single
Invoice Threshold

TDS will be deducted based on the Tax Code
applicable for Single Invoice Threshold
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Sr. No. Case Behavior

3 Invoice created that reaches
Cumulative Invoice Threshold

TDS will be deducted based on the Tax Code
applicable for Cumulative Invoice Threshold.
Adjustment Invoice will be generated based
on tax already deducted, if any.

4 Create Invoice with 2 distribution
lines and for each line, TDS Tax
belonging to a different section is
attached.

System will generate the TDS Invoices, based
on the Threshold setups of that particular
Section and Vendor Type

5 Standard Invoice is created. In the
'Invoice Distributions GDF',
TDS/WCT/ESI taxes are attached
in all the segments (3 segments).

System will generate 3 TDS Invoices on
validation of Standard Invoice for each of the
segment.

6 Standard Invoice having
TDS/WCT/ESI Invoice is cancelled

TDS/WCT/ESI Invoice will be cancelled.

7 Standard Invoice with one
negative distribution line and one
Positive Distribution line, and the
same TDS Tax is attached to both
the distributions

System will generate the TDS Invoice for
both the lines.

8 Create a Standard Invoice in
foreign currency and validate the
same.

System will generate the TDS Invoice and
Credit Memo in functional currency.

9 TDS calculation based on Type of
Vendor - Surcharge applicable to
Vendor Type above Threshold
Limit.

When Threshold Limit for surcharge is
reached, Tax Code that includes the
Surcharge will apply to all the Invoices
generated during the year.

10 TDS Threshold calculations by
manually updating the Total
Threshold Invoice amounts in the
Manual 'Thresholds' Screen.

System will update the Threshold amount
and further TDS Invoice generation will be
based on the modified Threshold.

11 A PO matched Invoice for 2 item
lines.

System will generate the TDS Invoices based
on the current Thresholds.

12 A Receipt matched Invoice for 2
item lines.

System will generate the TDS Invoices based
on the current Thresholds
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Sr. No. Case Behavior

13 Creation and validation of a
prepayment Invoice

 System will generate the TDS Invoices based
on the current Thresholds

14 Application of Prepayment
Invoice to a 'Never Validated'
Standard Invoice.

The 'Standard Invoice' is validated
after prepayment application and
if any TDS tax code is applicable to
the standard invoice and if the
corresponding prepayment
invoice (which is applied on the
standard invoice) is already
having any TDS generated.

System will generate TDS invoice for Vendor
and CM for the TDS Authority for the TDS
tax code attached to the standard Invoice and
also an RTN invoice for the vendor and CM
for the TDS Authority will be generated by
the system in lieu of the TDS generated for
the Prepayment Invoices. So, there will be
adjustment / reversal entries generated by
the system for the TDS deducted on the
Prepayment.

15 Unapply the prepayment invoice
on the standard invoice

When prepayment invoice was
applied to a NEVER VALIDATED
standard Invoice.

Reversal of the above point (point no. 14).

16 Apply the Prepayment invoice
having the TDS invoice to the
'Validated' standard invoice
having the TDS Invoice.

System will generate RTN invoice for Vendor
and CM for the TDS Authority.

17 Unapplication of prepayment of
invoice on to a VALIDATED
Standard Invoice

System will generate a RETURN Invoice for
the TDS Authority and Credit Memo for the
Vendor.

Please note that support for Works Contract Tax (WCT) and Employee State Insurance 
(ESI) deductions are implemented only as a workaround. There is no support for any 
reporting for these taxes.

Viewing Invoices included in the TDS Threshold
This is an additional screen through which you can view the Invoices that has been 
included in calculation and tracking of the TDS Thresholds. This information is 
available by Organization TAN and PAN of the Organization.

You can also view the PAN of the Vendor by each Site and whether the PAN was 
Confirmed or not.

This screen is a view screen only.
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Navigation:

India Local Payables - India Localization - Setup - Tax Setup - India - Vendor Threshold 
Grouping

This gives you a query find window in which you can query by TDS Vendor Type or 
TDS Vendor Name, you should query on at least one of the criteria.

Field Description Type Action Description

Vendor Type   DISPLAY This field displays the TDS Vendor
Type that you have queried

Vendor Name   DISPLAY This field displays the Vendor Name
that you have queried

Org Tan No   DISPLAY This field displays Organization TAN

Pan No   DISPLAY This field displays Organization PAN

Thresholds   BUTTON Pressing this button will take you to
the "Transaction Details". Please refer
discussion below.

Vendor Site   DISPLAY This field will display the Vendor
Site(s).

Pan Confirmed   CHECKBOX This checkbox will indicate whether
the PAN has been confirmed for this
Vendor.

On clicking the "Thresholds" button, Transactions Details form will open.

Transaction Details Form
This form displays all the transactions that have been included in the TDS Threshold.

This form allows you to modify the Threshold Amount for the Vendor (for the 
combination of Organization TAN, Vendor PAN and Vendor).

This form allows the user to modify the TDS Threshold that has been accumulated for 
the particular year. The need for this may arise on incorrect calculation of TDS 
Threshold for some transactions. You can adjust the threshold amount upwards or 
downwards. You can also adjust the Tax paid amount till date.

TDS Threshold is calculated as follows:

Total Invoice Amount
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(-) Invoice Cancel Amount

(+) Invoice Apply Amount

(-) Invoice Unapply Amount

Tax paid till date is considered for the purpose of deducting tax on invoices after 
reaching the threshold.

Following illustration will give more details:

Case details: Threshold limits are as follows:

Single Invoice - Rs. 20,000.

Aggregate of all Invoices - Rs. 50,000.

TDS Rate - 2%

Tax will be deducted as following:

Invoice No.

Sr. No.

Invoice 1 Invoice 2 Invoice 3 TDS on
amount

At invoice
No.

Case 1 17,000 17,000 17,000 All 3

Case 2 17,000 21,000 12,000 2 / All 2 / 3

Case 3 17,000 21,000 11,000 2 2

Case 4 17,000 17,000 20,000 All 3

In case of Case 2, TDS will be first deducted on Invoice 2 on Rs. 21,000 @ 2% i.e. Rs. 420 
will be deducted. Later at Invoice 3, TDS would be deducted on full Rs. 50,000 @ 2% i.e. 
Rs. 1,000, but in this case Rs. 420 is already deducted. Now TDS of Rs. 580 will be 
deducted. Rs. 420 is considered as "Tax Paid Till Date".

• These adjustments, upward / downward revision of TDS Threshold
and tax paid amount will not have any effect on the existing TDS 
transactions that are created.

• Modifications to thresholds once made cannot be reverted.

TDS Transaction Details Screen field wise description
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Field Description Type Action Description

Threshold Details for
block

     

Vendor   DISPLAY This field displays the Vendor
Name

Org TAN No.   DISPLAY This field displays the Organization
TAN.

Vendor PAN No.   DISPLAY This field displays Vendor PAN

Threshold Details
block

     

Fin Year   DISPLAY This field displays the Financial
Year

Section Type   DISPLAY This field displays the Section
Type(s)

Section Code   DISPLAY This field displays the Section
Code(s)

Total Invoice Amt.   DISPLAY This field displays the Total Invoice
Amount.

Invoice Cancel Amt.   DISPLAY This field displays the Total Invoices
cancelled.

Invoice Apply Amt.   DISPLAY This field displays the Invoice
Apply Amount.

Invoice Unapply
Amt.

  DISPLAY This field displays the Invoice
Unapply Amount.

Tax Paid Amt.   DISPLAY This field displays the Tax Paid
Amount till date.

Monthly Threshold
Amounts
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Field Description Type Action Description

Fin Year (Optional) PICK

HELP

EDIT

You can select the Financial Year for
which you wish to modify the
Threshold

Section Code (Optional) PICK

HELP

EDIT

You should select the Section Code
here for which you wish to modify
the Threshold

Total Invoice Amount (Optional) PICK

HELP

EDIT

You should specify the Amount by
which you want to modify the
Threshold, this Amount can be
positive or negative.

Invoice Cancel
Amount

(Optional) PICK

HELP

EDIT

You should specify the Amount by
which you want to modify the
Threshold, this amount can be
positive or negative.

Invoice Apply
Amount

(Optional) PICK

HELP

EDIT

You should specify the amount by
which you want to modify the
threshold, this amount can be
positive or negative.

Invoice Unapply
Amount

(Optional) PICK

HELP

EDIT

You should specify the amount by
which you want to modify the
threshold, this amount can be
positive or negative.

Tax Paid Amount (Optional) PICK

HELP

EDIT

You should specify the amount by
which you want to modify the tax
paid till date amount, this amount
can be positive or negative.

Remarks (Optional) PICK

HELP

EDIT

You can enter remarks, if any.
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Field Description Type Action Description

Apply   BUTTON You should press this button to
confirm the modifications made to
the thresholds.

Defining Customs Authority
You need to define a Supplier and classify the Supplier as Customs Authority. While 
creating a Bill of Entry Transaction, the Supplier would be listed in the LOV of the 
Customs Authority field. Such Suppliers would be used by the system while 
auto-generating the Invoices for Customs Duty liability arising on saving the Bill of 
Entry.

Prerequisites

Before you create the Customs Authority, you need to:

• Define Organizations

• Define Locations

• Define Payable Options

• Define Financial Options

Navigation Details:

India Local Payables - Oracle Payables - Suppliers - Entry

Creating Customs Authority
To create Customs Authority:

Create a new supplier.

Select India Customs Authority in the Type field.

Defining BOE Agent
You need to define a BOE Agent before you start using the Bill of Entry functionality. 
While creating a Bill of Entry transaction, the BOE Agent would be listed in the LOV of 
the Agent Code field. You can use this information for the Bill of Entry report, which 
you might be submitting to the Customs Authorities.
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Prerequisites
Before you create a BOE Agent, you need to:

• Define Organizations

• Define Locations

• Define Payable Options

• Define Financial Options

India Local Payables - India Localization - Setup - Others - BOE Agent.

Enter the details of the BOE Agent.

Defining Excise Authority
You need to define a Supplier and classify the same as Excise Authority. While creating 
a PLA Payment Transaction, the Supplier would be listed in the LOV of the Authority 
field. Such Suppliers would be used by the system while auto-generating the Invoices 
for Excise Duty liability arising on saving the PLA Payment.

Prerequisites
Before you create the Excise Authority, you must:

• Define Organizations

• Define Locations

• Define Payable Options

• Define Financial Options

Creating Excise Authority
To create Excise Authority:

• Create a New Supplier

• Select India Excise Authority as the Type

Setting Up Concurrent Programs
The Concurrent attached under India Local Payables will help the user in meeting the 
Local Requirements.



3-30    Oracle Financials for India User Guide

Setting Up 'India - To insert taxes for Pay On Receipt'
A New concurrent program 'India - To insert taxes for Pay On Receipt' has been added 
to Oracle Payable - India Localization. This has been introduced to handle localization 
tax flow from Purchasing to Payables. This program captures localization taxes in 
Receipts and inserts Tax lines in Invoice Distributions, for the ERS Invoice created from 
Purchasing. You have to schedule the concurrent to fire the request at suitable intervals.

The exiting concurrent 'India - To Insert Tax Distributions' would run to Insert Tax lines
in Invoice Distributions, on matching Invoice to PO or Receipt.

India Local Payables - Concurrents Submit Requests Select 'India - To insert taxes for 
Pay On Receipt' Schedule

Setting Incompatibilities:

This program should be set incompatible to Payables Open Interface Import

Itself

Note: You have an option to submit this concurrent to process records 
relating to the current Operating Unit or for All Operating Units. You 
can process records for all Operating Units by selecting 'Yes' in ' Process
For All Operating Units' parameter.

Setting Incompatibilities to Concurrents in India Localizations - Payables

Approval of TDS and Credit Memo
Set this program Incompatible to

• Itself

• Payables Open Interface Import

Managing TDS Transactions
This Section elaborates on the effect of TDS setup on Actions applied to an Invoice. You 
can see the impact on the Supplier Liability, Accounting and generation of TDS 
Certificates.

Invoices with TDS Codes
When you create an AP Invoice, the TDS gets calculated based on the TDS Threshold 
Setup done.
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India Distributions Global Descriptive Flexfield
Usage of earlier Invoice Distributions Descriptive Flexfield has been discontinued and 
the same functionality has been implemented through India Distributions Global 
Descriptive Flexfield.

The users should ensure that at least one segment of this India Distributions Global 
Descriptive Flexfield is marked as 'Enabled'. The users should not make any of the 
segments as 'Required'.

Following are the details of the Global Descriptive Flexfield:

Application: Regional Localizations

Title: JG_AP_INVOICE_DISTRIBUTIONS

Context Field Values:

Code: JA.IN.APXINWKB.DISTRIBUTIONS

Name: Invoice Distributions

Description: Asia/Pacific Invoice Distributions Information

Apart from the above, there are no changes from a user perspective in the TDS 
functionality due to migration of the Descriptive Flexfield to Global Descriptive 
Flexfield.

Prerequisites
Before you can use the TDS feature on Invoices, you should have completed the 
mandatory setup defined in the Setup Documentation.

1. TDS On AP Invoices and Prepayments
The TDS calculation and creation of the TDS related Invoices would take effect, during 
the Validation of an AP Invoice, with either TDS Code attached in Invoice Distributions 
or with a TDS Tax Name attached in the TDS Thresholds Setup

2. On Validation of a Standard Invoice or a Prepayment Invoice
When you validate a Standard Invoice or a Prepayment, the Supplier would be debited 
to the extent of Tax Deducted by means of a Credit Memo, while the Balance of Tax 
Authority would be increased by means of a Standard Invoice.

Thus, balance due to the Supplier would be net of the Credit Memo created on 
Validation. You should take adequate care to consider such Credit Memos while 
making the Payment to the Supplier.
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3. On Application of Prepayment Invoice to Standard Invoice
When you apply a Prepayment to a Standard Invoice, both are subject to Tax 
Deduction, Invoices would be created for the reversal of the TDS deducted on the 
Prepayment. This is done by creating:

• Standard Invoice for the Supplier

• Credit Memo for the Tax Authority

You need to ensure that Prepayment with multiple distributions, each having a 
different TDS Section applicable, should not be applied to a Standard Invoice. To deal 
with such cases, you have to create a Separate Prepayment Invoice for each of such 
Payments.

4. Amount considered for reversal on Prepayment Application
The following are

• On applying a Prepayment to a 'Validated' Standard Invoice, considering both have
TDS, the TDS calculated on Standard Invoice is reversed.

• When the Standard Invoice has multiple lines each with a different TDS Codes and 
it is partially applied to a prepayment then, the lines considered for TDS reversed 
will be on a FIFO basis.

• Where some of the lines have to be reversed, you have to ensure that the 
Prepayment is applied only after you have reversed the lines that you wish to 
reverse.

• Reversed lines, Reversal lines and Prepayment lines are not considered for TDS 
Calculation.

5. On Un-Applying Prepayment Invoice applied to a Standard Invoice
When you un-apply a Prepayment to Standard Invoice, both of these subject to Tax 
Deduction, Invoices would be created to reverse the effect of the Invoices created on 
application of the prepayment. Standard Invoice would be created for the TDS 
Authority and a Credit Memo would be created for a Supplier.

6. On Canceling Standard Invoice
On canceling a Standard Invoice for which Tax has been deducted, the Invoice created 
for the Tax Authority would be canceled and a Standard Invoice to the extent of the Tax
Deducted an Standard Invoice would be created for the Supplier.

However, there would not be any effect on these Invoices if the Invoice for the Tax 
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Authority is already paid. 

You have an option to cancel the Supplier Invoice while you are voiding the Payment 
for the Invoice. In such cases, Invoices to Tax Authority would also be cancelled. 
However, it is necessary that the Tax Authority Invoice is not yet paid.

TDS Invoice Payments
Navigation: India Local Payables - India Localization - Others - India TDS Challan

In this screen, the user can capture the information of TDS payment details. This screen 
would list all Payments made to TDS Authorities where the Challan information has 
not been entered. The user would then be able to enter the attribute information for 
these payments.

The user will create an AP Invoice in the base application for payments to be made to 
the TDS Authorities. After creating the AP Invoice, the user will query this Invoice in 
the India Local TDS Payments screen and update the Additional Information here.

Find TDS Parameters field wise description.

Field Description Type Action Description

Tax Authority   EDIT, PICK User needs to select the Tax
Authority Name from the LOV.

Tax Authority Site   EDIT, PICK User needs to select the Tax
Authority Site Name from the LOV

From Date   EDIT, PICK Enter the date range

To Date   EDIT, PICK Enter the date range

Clear   BUTTON Pressing this button will clear the
screen.

New   BUTTON Pressing this button will take the
user to the next screen wherein the
user can select different TDS Invoice
payments and enter the Challan
Number details.

Find   BUTTON Pressing this Button, system will
find all the TDS Challan Details,
which are created earlier.

Field wise details of TDS Challan Details Screen
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Field Description Type Action Description

Tax Authority   EDIT, PICK User needs to select the Tax
Authority Name from the LOV.

Tax Authority
Site

  EDIT, PICK User needs to select the Tax
Authority Site Name from the LOV

Check Number   DISPLAY System will query the existing data.

Check Date   DISPLAY System will query the existing data.

Currency Code   DISPLAY System will query the existing data.

Amount   DISPLAY System will query the existing data.

Check Deposit
Date

  EDIT The Date on which the Check has
been deposited into government
treasury needs to be entered for TDS
Payments being made & printed on
the TDS Certificates / Returns

Challan Number   EDIT User should enter the value of
Challan issued by the Income Tax
Department that has to be submitted
along with the remittances of TDS
Amounts. This information is used
in TDS Certificates issued to the
Vendor and at time of Tax Returns

Bank Name   EDIT, PICK Enter the value of Bank in which,
the TDS payment / Challan is
deposited.

TDS Certificate Generation
You can generate TDS Certificate to be issued as per the Income Tax Act. Based on the 
TDS Section and Tax Authority, you should first generate the TDS Certificate. One TDS 
Certificate can be issued for all the TDS deductions for a Vendor based on the 
transaction range or individual TDS Certificates can be generated for each TDS 
Deduction.

Navigation: India Local Payables - India Localization - Others - Generate TDS 
Certificates
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Field Name Type Action Description

TAN Number (Required)   The user should pick the value from
the LOV.

Operating Unit     Select the appropriate value from the
LOV

Certificate
Period

(Required)   You need to specify the period the
period for which he wants to
generate the TDS Certificate.

These dates will be compared
against the Invoice Dates of the
Invoices generated for TDS
Authority.

Section (Required) EDIT HELP
PICK

You need to specify the TDS Section
for which he wants to generate the
TDS Certificate.

Tax Authority (Optional) ENTER You can specify a particular Tax
Authority Name for whom he wants
to generate the TDS Certificate.

Vendor Name (Required) ENTER You need to specify a particular
Vendor Name for whom he wants to
generate the TDS Certificate.

• It is a pre-requisite to run the 'Generate TDS Certificates' to view 
the data in 'India - TDS Prescribed Rates Report' and ;India - TDS 
Lower Rates Report'.

• TDS Certificates would be generated only for those Invoices where 
TDS deducted has been remitted to the Tax Authority. Payments to 
the Tax Authorities can be done either by paying the TDS Invoices 
(generated on validation of Supplier Invoice) or by applying a 
Prepayment Invoice to the TDS Invoice. 

Generating eTDS Returns
You can generate eTDS Returns using 'India - Program to Generate eTDS Certificates' 
Concurrent program. Prior to that you should completed validating Supplier Invoices 
and made payments to Invoices generated for TDS Authorities.
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The concurrent program should be run for a Particular TAN Number for a given 
Financial Year.

As the output would be flat file, the users would be provided with an option to 
generate the file with separators and Headers. The file can be generated in this format 
by checking 'Generate Headers' parameter of the Concurrent request. Using this file 
user can check the records and the appropriate values. On finding that the data is 
correct, you can choose select the file with same parameters, without headers. The file 
would be saved at the path specified in the 'utl_file_dir' parameter of the Database.

To generate eTDS Returns, navigate to 'India - Program to Generate eTDS Certificates' 
as follow: 

India Local Payables - View Requests (M) - Submit New Requests.

This request facilitates

• Specifying Query Criteria

• Entering Information that would be included in the Report.

• Generating the Return in a readable format for the user to decipher and verify the 
information

• Specifying the File Name

The user should specify following information in the following parameters

1. TAN Number: User should select the value from the LOV. The User should select 
the TAN Number value for which, the return is to be generated.

2. Financial Year: User has to select the Financial Year value for which, the returns 
have to be generated.

3. Organization: Select the value of Organization for which, the returns have to be 
generated.

4. Tax Authority: Select the Income Tax Authority for which the TDS Invoices have 
been generated and paid.

5. Tax Authority Site: Select the Vendor Site code of the Income Tax Authority.

6. Deductor Name: Enter the Name of the Deductor.

7. Deductor State: Select the appropriate value for the State from the LOV.

8. Address Changed Since Last Return? : Select the value 'Yes/No' from the LOV.

9. Deductor Status: Select the appropriate value from LOV.

10. Person Responsible for Deduction: Enter the Name of the Person Responsible.
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11. Designation of Person Responsible: Enter the Designation of Person Responsible for
deduction.

12. Challan Start Date: Enter the From date range .

13. Challan End Date: Enter the To Date Range

14. File Path: Select the Default value from the LOV. This value will be selected based 
on the util_file_dir parameter value of the database.

15. File Name: Enter the Name of the flat file name and the eTDS returns flat file will be
generated with this name.

16. Generate Headers: Select the values 'Yes/No' from the LOV.

17. If the value 'Yes' is selected, then system will generate a flat file including Headers 
(columns).

18. If the value 'No' is selected, system will generate a flat file which can be validated 
against the file validation utility of NSDL.

Service Type Review
Service Type Review lets you capture the Service Type for those transactions where it 
was either not captured during the transactions or could not be captured for some 
reason. We recommend you to carry out this review before carrying out settlement. You
also have an option of querying existing records to view and change he captured 
Service Type for any existing Transaction.

Navigate to India Local Payables > India TCS/VAT/Service Tax > Period End > Service 
Tax Repository Review.

Field Description Type Action Description

Source PICK The source from 
which the Repository 
entry has been carried
out and would give 
LOV values of 
Payables, Receivables,
Manual and 
Distribution.
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Field Description Type Action Description

Organization This lists the 
Inventory 
Organizations for 
which you need to 
find the transactions

Location Lists Locations based 
on the Organization 
selected.

Transaction Dates: 
From

This is to enter a date 
range from which the 
repository records 
needs to be 
displayed.

Transaction Dates: To This is to enter a date 
range to which the 
repository records 
needs to be 
displayed.

Include Settled 
Transactions

Optional Checkbox Checking this will 
enable query of 
already settled 
transactions.

Query Read Only Optional Checkbox Checking this will 
enable query in read 
only mode i.e. view 
mode.

Query Only records 
with Null Service 
Type

Optional Checkbox Checking this will 
enable query of 
records where Service
Type is null & hence 
requiring update.

This search lists all the Service Tax Repository Transactions for the given find criteria. 
You have an option of Defaulting Service Type from setup. Alternatively, use a Service 
Type specified in this search results. The Service Type can then be defaulted only to 
those records where Service Type is null.
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Note: Settlement cannot be carried out till you ensure that the Service 
Tax balance is transferred from Operating Unit to Inventory 
Organizations. Also, you need to ensure that all the transactions are 
classified by the right Service Type.

Service Type Review also lets you view accounting entries made against Service Tax. 
Navigate to India Local Payables > India TCS/VAT/Service Tax > Period End > Service 
Tax Repository Review. Click View Accounting to view the accounting entries for a 
particular Service Tax repository entry.

BOE Invoices

Generating BOE Invoices
You can create the BOE Invoices for all the import purchases and the liability will be 
recognized to the Customs Authority and any Advance Payment can be made before 
the actual receipts of material.

To enter BOE Invoices, navigate to the India Local Bill Of Entry window.

Field Name Type Action Description

BOE Number (Display only)   Select from the LOV depending
upon the BOE for which the Invoice
is to be generated.

BOE Type (Required) EDIT HELP
PICK

Select from the LOV depending
upon the nature of transaction.

Customs Authority (Required) HELP PICK Select the respective Vendor Name
or Customs Authority Supplier from
the LOV.

Site (Required) EDIT HELP
PICK

Defaulted Site for a respective
Vendor or Customs

Authority Supplier from the LOV.

Agent Code (Optional) EDIT HELP
PICK

Enter the Agent Code who is dealing
this particular Import Shipment.
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Field Name Type Action Description

Inventory
Organization

(Required) EDIT HELP
PICK

The user defined Inventory 
Organization 

need to be picked up from LOV 
where this import is going to be 
accounted.

Location (Required) EDIT HELP
PICK

Location for that Inventory
Organization is

to be picked from LOV where this
import is

going to be accounted.

Bill of Lading Date (Optional)   The user can enter the Bill of Lading
date.

Port Type (Optional)   Select the Port Type like Sea, Air and
Land from the LOV.

Import Dept. Block

Sl.No (Optional)   The user can enter the Serial
Number allotted by the Import
Dept.

Date (Mandatory)   The user can enter the BOE date as
specified in the BOE Document.

Rotation Block

Rotation No/date (Optional)   The user can enter the Rotation
Number and the Date allotted by the
Import Dept.

Amounts (Defaulted)   The BOE Amount and Applied
Amount will be defaulted from BOE
Details form.
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Field Name Type Action Description

Shipment

Information

Block

    The following fields (ie) Vessel
Name,

Consignment Country, Port Name,
Origin

Country are optional and the user
can enter

relevant details for his reference.

BOE Item

Independent

Flag

(Optional)   You can use this option to create an
Item Independent BOE. You can
define a BOE for a Dummy Item and
this can be used to match the
Customs liability on any Item.

BOE Line Details
Filed wise description of BOE Line Details is given below

Field Description Type Action Description

Number   ENTER The Number of packages will be
mentioned here.

Description (Optional) ENTER The Description of the packages can
be mentioned here.

Serial Number (Optional) ENTER Serial Number of the Item packed
with the Description of the packages
can be mentioned here.

Quantity (Required) ENTER The total Quantity imported and for
which the Customs Duty is to be
paid.

UOM (Required) ENTER UOM of the Item.

Item Name (Required) ENTER Item Name need to be specified for
calculating Customs Duty Item wise.
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Field Description Type Action Description

Customs Tariff (Optional) ENTER Customs Tariff Number under
which the duty will be assessed.

Duty Code (Optional) ENTER The Customs Duty under which the
duty will be calculated.

Assessable value (Required/Opt
ional)

ENTER The total Assessable Value of the
goods on which the duty will be
calculated.

For Basic Customs
duty Rate (%)

(Required) ENTER The Rate of Basic Customs Duty as
applicable on the goods as per duty
code of the Customs Tariff.

Amount     Basic Duty Amount calculated on
the Assessable Value of the goods
and defaulted.

Exemption
Notification

(Optional)   If the goods are exempted from
duty, then the user can mention the
Exemption Notification under which
the goods are exempted

For Additional
Duty

(Displayed

/ Optional)

   

Additional Value (Optional)   This displayed amount is the total of
Assessable Value plus Basic Duty
Amount and on this amount the
Additional Duty will be calculated.

Rate (%) (Required) ENTER The Rate of Additional Customs
Duty as applicable on the goods as
per duty code of the Customs Tariff.

Amount     Additional Duty Amount can be
calculated on the Additional Value
and displayed.

For CVD

Cess

(Displayed/Op
tional)
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Field Description Type Action Description

Assessable

Value

    This is the Additional Duty Amount
based on which, the CVD Cess %
would be calculated.

Rate (%) (Required)   CVD Cess % Rate as applicable on
the goods as per the duty code of the
Customs Tariff

Amount     CVD Cess amount

For

Surcharge

Duty

(Required/Opt
ional)

   

For

Surcharge

     

Cumulative

Value

    Amount on which Surcharge duty is
calculated

Rate (%) (Required) ENTER The Rate of Surcharge as applicable
on the goods as per duty code of the
Customs Tariff.

Amount (Displayed)   Amount of Surcharge calculated.

For Customs Cess      

Assessable Value (Display)   This value is the sum of Basic Duty
Amount, Additional Duty Amount,
CVD Cess amount and Surcharge
Amount. This is the Amount based
on which, the Customs Cess %
would be calculated.

Rate (%) (Required) ENTER Customs Cess Rate
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Field Description Type Action Description

Amount (Optional)   Customs Cess Amount, which gets
calculated on the Customs Cess
Assessable value for the Rate
specified for the Customs Cess

Total Customs
Duty

(Displayed) ENTER This indicates the total liability on
account of Customs Duty payable to
the Customs Authority Vendor.

      On saving the transaction, an
Invoice will automatically get
generated, validated and ready for
payment. The payment may be
made through regular Oracles
Payables functionality.

BOE Write Off
You have a facility to Write Off the Un-applied BOE amount in a BOE Invoice which no 
longer to be applied against any Receipts.

You have to query for the BOE Number and activating the BOE Write Off button would
display the BOE Write Off screen.

The added column to this BOE Invoice form in the Amount Block.

Filed wise description for BOE Write Off is given below

Field Name Type Action Description

Amount to
Write off

(Displayed/Req
uired)

  The User has to enter the Write Off
Amount, which no longer required.
By default the Balance remaining in a
BOE Invoice will be displayed here
but the User can override and change
the Amount.

Write off date (Required)   The User has to enter the Date on
which he is Writing Off a BOE
Invoice.

Write off Reason (Optional)   The User has to enter the reason for
the Write Off in this optional field.
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Once the User saves this screen the entered amount will be written from BOE Invoice 
and the Written Off column in the Amount Block of the BOE Invoice form will be 
updated.

PLA Invoices/Payment
Navigation

India Local Payable - India Localization - Invoice Entry - PLA Invoices

Field wise details for the PLA Invoice / Payment is given below

Field
Description

Type Action Description

Payment_Id (Defaulted)   This is the system generated
Payment_Id after entering data and
save this form.

TR6 Challan
No/Date

(Required) ENTER The user can enter TR6 Challan
Number and Date through which the
PLA Payment will be made.

Inventory
Organization

(Required) EDIT HELP
PICK

The user defined Inventory
Organization need to be picked up
here from LOV.

Location (Required) EDIT HELP
PICK

Location for that Inventory
Organization is to be picked up from
LOV.

Acknowledgment
Block

    The Acknowledgment Flag will be
enabled after the PLA Payment is
made and the user can update the
Acknowledgment Date. Only after
Acknowledgment is received and the
Acknowledgment Flag is enabled the
PLA Register will be updated.

PLA Amount (Displayed)   This is the displayed total line
amount of Excise Duty proposed to
pay.

Authority (Required) EDIT HELP

PICK

Select the respective Vendor Name or
Commissioner of Excise from the
LOV.
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Field
Description

Type Action Description

Site (Required) EDIT HELP

PICK

Select the Site for the above selected
Vendor from the LOV.

PLA Details Block (Required)    

Item Tariff   ENTER Enter Item Tariff under which this
PLA payment will be made.

Item Sub Heading     This is defaulted field as per the Item
Tariff.

Basic
Amount/Addition
al Amount/Other
Excise

(Required) ENTER The user has to specify how he wants
to pay in Basic, Additional, and
Other Excise Duty through this TR6
Challan.

On saving the transaction, a PLA Invoice will be automatically generated, validated and
ready for payment. This Invoice Number has a prefix of 'PLA'. The payment for this 
Invoice may be made through regular Oracle Payables functionality.

Only after entering the Acknowledgment Date, PLA Register balance will be updated.

• Acknowledgment for a PLA Payment is not received and Flag is 
not enabled, then there will be difference between GL Balance and 
PLA Register till such time of receipt of Acknowledgment. The 
Acknowledgment Flag needs to be enabled by Opening the PLA 
Invoice screen itself. 

Using Sales Tax Declaration Forms - Issue Tracking

Overview
Purchases made by Registered Dealers, from Registered Dealer would be eligible for 
Concessional Rate of Sales Tax. This would require identification of transactions that are
eligible for such rates. Also, the Declaration Form to be issued in order to avail such rate
has to be tracked.

You can issue Sales Tax declaration forms for each of the transactions. Oracle Financials 
for India provides you with a feature to define Form Names, Define Taxes with 
Declaration Forms attached, Tracking Invoices for which these Forms have to be issued,
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Record details of Forms issued and query and view the Form details.

Prerequisites

Before creating the Transactions with Concessional Rates of Sales Tax, following setup 
needs to be done: 

• Define Form Names

• Define Taxes with Form Names attached

• Define Supplier Additional Information

• Define Tax Categories with this Tax Code

• Define Item Categories with this Tax Categories

Before recording details of Concessional Forms to be issued to Supplier, following 
needs to be done:

• Complete Purchase Orders/Receipts with Sales Taxes with Form Names attached

• Create Invoices for these PO's / Receipts

• Ensure that Invoice Distributions are created to account for Localization Taxes.

• Validated the Invoice.

• Submit 'India - ST Forms Issue Processing'

Recording details of Sales Tax Declaration Forms
To record details of Sales Tax Declaration forms, navigate to 'Define Sales Tax Form 
Details' window as follows

India Local Payables - India Localization - Suppliers - Issue ST Forms

In 'Find ST Form Details' screen, enter the Supplier Name, Supplier Site and Form Type 
in order to query for Invoices against which Forms are not yet issued. You can enter 
other query criteria to find specific invoices

Details you enter in each of the fields would form criteria for the records fetched.
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Field Description Type Action Description

Issue/Receipt (Display 
only)

  This field gets populated as Issue / 
Receipt based upon the Application 
chosen.

Issue in case of Payables and Receipt 
in case of Receivables.

Party Name     Party Name as defined in the ST 
form related data. Compared against 
the Party Name as available in the 
Invoices to which Sales Tax Forms is 
applicable.

Party Site     Party Site as available in the Invoices 
to which Sales Tax Forms is 
applicable.

Form Type     Form Type's which are applicable to 
the Sales Tax attached to the Invoices

Invoice from Date     Invoices having Invoice Date starting
from this date onwards would form a
part of the query criteria for 
matching. Viewing matched records. 
Should be a valid date in 
'DD-MON-YYYY' format 

Invoice To Date     Invoices having Invoice Date till this 
date would form a part of the query 
criteria for matching. Viewing 
matched records Should be a valid 
date in 'DD-MON-YYYY' format 

Fin Year     Financial Year as applicable to the ST
Form related data.

Form Number     Form Numbers that are issued to the 
Supplier, Supplier Site and Form 
Type.

Issue/Receipt Date     Enter a Date, which might match 
with the Issued Form's Transaction 
Date. 
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Field Description Type Action Description

View Forms 
Button

    Button, which upon being clicked 
invokes the 'View Sales Tax form 
Details' Screen

Issue/Receive 
Forms Button

    Button, which upon being clicked 
invokes the 'Define Sales Tax form 
Details' Screen

On clicking the 'Issue/Receive Forms' button, the system fetches the Invoices to be 
matched. This information would be displayed in 'Define Sales Tax Forms Details' 
screen.

This screen has Header and Detail Sections

Header Section
This section allows you to record Form details such as Financial Year, Form Number 
Form Amount, Form Date and Transaction Date. These details can be entered for a 
combination of Supplier Name, Supplier Site, Form Type and Operating Unit.

The Supplier Name, Supplier Site and Form Type are populated as the context 
information from the Query Find Screen.

Its mandatory to enter Financial Year, Form Number Form Date and Transaction date 
fields before proceed to the detail section to select Invoices.

You may choose to key in the Form Amount and proceed to the detail section for 
selecting Invoices to match the Form Amount. Else, you can leave the form amount to 
be automatically populated upon save, based on the sum of all Invoice level Form 
Amounts.

Match All
On checking Match All field, the system Automates matching based on the header form
amount.

The Match all Checkbox is unchecked, by default.

Un-checking the checkbox causes the detailed Invoice level form amount to be set to 
zero.

Queried Amount
Queried Form Amount fields displays the total Form Amount that can be matched 
across all unmatched Invoices. 
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This is a display only field and cannot be modified.

Detail Section
This section displays unmatched Invoices in Issue Tab Page. The records would be 
grouped based on the combination of Invoice and Purchase Order

The sum of all invoices level Form Amounts entered is displayed at the bottom in the 
Total Form Amount display field.

• It is mandatory that the sum of detail level Invoice Form Amounts 
match with header Form Amount. This is applicable only when you
enter the Form Amount.

• In case of Invoices with negative tax target amounts the form 
amount entered should exactly be equal to that of the Tax target 
amount.

On saving the entered details, the Header Block is refreshed and the Form details are set
to blank. Also, the Detail block is refreshed and only unmatched and partially matched 
records are fetched. The cursor returns to the header.

Issued Forms can be viewed through the 'View Sales Tax Form Detail' Screen. This is 
invoked by clicking on the 'View Forms' option in 'Finds ST Form Detail' window.

Field Description Type Action Description 

Define Sales Tax Form Header Block (Matching Header)

Party Name (Display only)   Context Information carried over 
from Query Find Screen

Party Site (Display only)   Context Information carried over 
from Query Find Screen

Form Type (Display only)   Context Information carried over 
from Query Find Screen

Fin Year Required   User defined Financial Year Value to 
be selected from list of values as 
defined in the Tax Year Setup 
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Field Description Type Action Description 

Form Number Required   Sales Tax Form Number to be 
defined by the user.

This needs to be unique for Form 
Type and Fin year combination

Form Amount Required   The form Amount needs to exactly 
match with the sum of all Invoice 
level detailed form amounts.

Form Date Required   Should be a valid date in 
'DD-MON-YYYY' format

Transaction Date Required   Should be a valid date in 
'DD-MON-YYYY' format

Match All Default Value 'N'   Requires a valid value for Fin Year, 
Form Number, Form Amount, Form 
Date and Transaction Date when 
checked. Matches the entire Invoice 
level records based on the form 
amount value.

When unchecked, sets all detail level 
Invoice form amount to 0.

Queried Form 
Amount

(Display only)   Displays Total Form Amount that 
can be matched across all unmatched
Invoices

This amount would be Sum of 
Matched Amounts reduced from 
Sum of Tax Target Amounts. 

Sales Tax Form Detail Block (Matching Detail) - Issue Side

Invoice Number (Display only)   To be filled

Invoice date (Display only)   To be filled

Po/Requisition 
Num 

(Display only)   To be filled

Document Type (Display only)   To be filled
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Field Description Type Action Description 

Tax Target Amt (Display only)   To be filled

Matched Amt (Display only)   To be filled

Form Amount     In case of + ve invoices sum of 
invoice level form amount and 
Matched amount cannot be greater 
than Tax target amount.

In case of - ve invoices the form 
amount needs to be exactly same as 
that of tax target amount. 

Total Form 
Amount 

(Display only)   Sum of all invoice level Form 
amounts.

Viewing Issued Forms
You can view the Sales Tax Forms Issued by clicking on the 'View Forms' button on the 
'Find ST Forms Details' window. This would open 'View Sales Tax Form Details' 
window.

You will have to enter Supplier, Supplier Site and Form Type Details before you query 
for the Issued Forms.

This window has three sections Header, Details and Sub-Details.

Header Section
The section shows Supplier Name, Supplier Site and Form Type. These details are 
populated as the context information from the Query Find Screen.

Sales Tax Form Details
This section displays Form details based on the query criteria specified in the Query 
Find screen.

Sales Tax Form Sub-Details
This section displays all matched Invoices grouped by combination of Invoice Number 
and Purchase Order.

For each Invoice the Tax Target amount verses the Matched Amount is displayed based 
on the above grouping.
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Field Description Type Action Description

View Sales Tax 
Form Header Block

     

Party Name (Display only)   Context Information carried over 
from Query Find Screen

Party Site (Display only)   Context Information carried over 
from Query Find Screen

Form Type (Display only)   Context Information carried over 
from Query Find Screen

View Sales Tax Form Detail Block

Fin Year (Display only)   Fin Year as created from the match 
detail screen.

Form Number (Display only)   Form Number as created from the 
match detail screen.

Form Date (Display only)   Form Date as created from the 
match detail screen.

Transaction Date (Display only)   Transaction Date as created from 
the match detail screen. 

Form Amount (Display only)   Form Amount as created from the 
match detail screen.

View Sales Tax Form Sub Detail Block - Issue Block

Invoice Number (Display only)   This is the Transaction Number

PO / Requisition 
Amount

(Display only)   This field displays the Purchase 
Order Number

Document Type (Display only)   This field displays the Document 
Type.

Tax Target Amt (Display only)   This field displays Tax target 
amount.
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Field Description Type Action Description

Matched Amount (Display only)   This field displays Matched 
Amount

Generating Records for Sales Tax Issue Tracking
Invoice Details required for issuing Sales Tax Forms would be generated by submitting 
'India - ST Forms Issue Processing' concurrent program.

This concurrent program is available in India Local Payables Responsibility. This 
request would check for all Invoices that have Sales Tax with concessional Form 
applicability. Only validated Invoices would be considered for processing. The Invoice 
would be considered for Processing only if it was not processed earlier. Processed 
Invoices would be considered conditionally based on the changes to the document.

You can submit this request from India Local Payables Submit Requests 'India - ST 
Forms Issue Processing'.

Field Description Type Action Description

Operating Unit (Display only)   Value determined from the Profile 
values 

Process for All 
Operating Units?

    If you select 'Yes' in this field, then, 
the program would process 
Invoices corresponding to all 
Operating Units defined in the 
system. Else, only those related to 
the Operating Unit determined 
from Profile would be processed.

From Date Mandatory   Low Value of Invoice Date to filter 
the Invoices.

To Date Mandatory   High Value of Invoice Date to filter 
the Invoices.

Supplier     If you would like to process records
for a specific Supplier then, select a 
Supplier Name in this field.
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Field Description Type Action Description

Supplier Site     This will be used to filter the data 
related to given Supplier Site, 
otherwise all Supplier Site's related 
data is processed.

Re Process not 
issued invoices

    This would consider all Invoices in 
the selected date range for 
processing. Also, those Invoices 
that have been processed earlier 
would be re-processed. Hence, all 
revised actions and status on 
Invoices would be considered for 
re-processing.

Invoices for which Forms are 
already issued would be left 
unprocessed.

Enable Trace     On selecting 'Yes' in this field, a 
Raw Trace File would be generated 
for this request.

It is a pre-requisite to have 'Enable 
Trace' checked for 'India - ST Forms
Issue Processing' Concurrent 
Program.

India - FA Mass Additions
After creation of Receipts, user should submit request for creation of Payables Invoices 
for the Third Party taxes that are included in the receipts. Meanwhile, user would create
the Payables Invoices for the PO Vendor (Base Invoice). These Invoices would be either 
created manually or automated by submitting 'Pay on Receipt Auto Invoice' program 
for the receipt.

Once a Receipt matched AP Invoice is validated, approved and accounted, they would 
qualify for FA Mass Additions. User can schedule Mass Additions Create program to 
carry these lines to Fixed Assets. This program would only process base Invoices. As 
soon as this program completes successfully, 'India - Mass Additions Creation' program
would be submitted automatically. This request would scan for all Third Party Taxes 
and Customs Duties applicable to the purchase. In cases where the Receipt includes any
such Tax, this program would create one line per Receipt Tax line in Fixed Assets Mass 
Additions.

The user can view these requests in 'Prepare Mass Additions window. These lines will 
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carry the Invoice and PO Numbers of the First Party Invoice. The user can either create 
New Assets or Add these lines to an existing Asset or Merge them to another line.

'India - Mass Additions Creation' program can also be submitted explicitly. This can be 
used in exceptional scenarios where the third party tax lines are not transferred to FA.

This request can be invoked from 'India Local Payables View Submit Requests - India 
Mass Additions Create'.

Define Invoice Tolerance Limits

Overview
As per Indian Central Excise Act and Income Tax Act, the Excise duty and TDS amount 
will be rounded off to the nearest Rupee and in effect the AP Invoices, the Header 
Amount and the Distribution Amount will have minor difference. Base Applications 
Invoices feature places an hold on Invoices that have difference between Header 
Amount and Distribution Amount.

Invoice Tolerance feature provided by Oracle Financials for India allows you to setup 
the Tolerance Percentages and Amounts. Wherever a hold is placed on Invoices due to 
difference in Distributions Total and the Invoice Header, then, the system would check 
for the tolerance limits setup for Organization. If the difference Amount falls within the 
specified limit, then this inserts an Additional Invoice Distribution line for the 
Difference Amount and the Invoice is Approved. This line would have the line type as ' 
Miscellaneous' and the charge Account would be as specified in the Invoice Tolerance 
Setup for the Organization.

In cases where you are Re-Approving the Invoices, the system would check for the 
existence of an Distribution line for Rounding Amount. If one exists, then the amount of
this line would be updated with the revised difference. 

India Local Payables - India Localization - Setup - Others - Invoice Tolerance

Field Description
Operating Unit

User can select the Operating Unit value from the LOV.

Enable Percent Tolerance Flag

You need to enable this Flag if you want to allow Percentage based Tolerance limits. 
This Percentage would be applied on the Header Amount. On activating this flag, you 
will have to specify the Upper Percentage Value and Lower Percentage Value.

Enable Amount Tolerance Flag

You need to enable this Flag if you want to allow Amount based Tolerance Limits. On 
activating this flag, you will have to specify the Upper and Lower Value.
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Important: Where you have specified both Percentage and Amount 
Tolerances then both will be applied on the Invoice and the Minimum 
of the two is considered as the Tolerance Limit. 

Tolerance Charge account _ Id

You need to specify the GL Account to which the Rounding amount should be 
debited/credited.

View / Resubmit / Delete Error Tax Lines

Overview
The concurrent 'To insert tax distributions for pay on receipt' for processing of tax Lines 
for ERS Invoices created based on Purchase Receipts runs in batch mode. Whenever, 
some of the tax lines remain unprocessed due to some error, the error message is 
captured by localization. This feature provides with an option to view these error 
records and corresponding messages and mark them eligible for Reprocess. You would 
also have an option to delete these records.

To view the error records, navigate to India Local Payables - India Localization - Other -
India - Resubmit Taxes for Pay on Receipt.

The form shows Invoice Number, Number of distribution Lines, Invoice Date, Error 
Date, Invoice Amount, Vendor Name, Vendor Site Code and Error Message for all Tax 
Lines (grouped by Invoice Number) that have ended in an error during 'India - To 
Insert Taxes For Pay On Receipt' program.

The user can check the records for resubmission either one or all at a time. If you would 
like to resubmit only one record then, you have to check the Re-Submit checkbox on the
line. In you wish to resubmit all records, and then check the 'Re-Submit All' checkbox.

For Resubmission of the Error Invoices
• Check 'Re-Submit' for the Invoices that need to be resubmitted. Alternatively, 

Re-Submit All can be checked to resubmit all error Invoices.

• Click on 'Submit' button.

• Submit the concurrent 'India - To Insert Taxes For Pay On Receipt' for these 
Invoices to get processed.

For Deletion of the Error Invoices
Check 'Delete' for the Invoices that need to be deleted.

Click on Submit button.
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• The form would merely make the Invoices eligible for reprocessing.
You have to explicitly run the concurrent 'India - To Insert Taxes 
For Pay On Receipt' for these Invoices to get processed.

Reports
This section provides overview and detailed descriptions of the following reports:

• Form 16A Report

• TDS at Prescribed Rate Report

• India Cash/Bank Book Report

• India-Creditors Ledger Report

• India-Creditors Trial Balance Report

• India-Statement of Account for Suppliers

• India - BOE Write Off Report

• India - TDS Related Invoices Report

• India VAT Returns Template

Form 16A Report
Use Form 16A Report to print Form 16A (As per Statutory Format) for sending it to 
Vendors. 'ORIGINAL' is printed on the Form when printed for the first time and '
DUPLICATE' will be printed for subsequent prints of same Certificate.

If some problem occurs during printing of Certificate for first time (e.g. Printer Paper 
jam etc.), then navigate to 'View TDS Certificate - India Localization ' Form in AP 
Module and set the 'PRINT FLAG' of corresponding certificate to 'N', then the next 
Print will print 'ORIGINAL' on the Certificate.

Report Submission

Use the Submit Requests (India Local Payable Module only) form and enter India TDS
Certificates in the Name field to submit the report.

Report Parameters

TAN Number (Mandatory)

Select the value from the LOV.

Financial Year (Mandatory)
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System will display all the Financial Years from the LOV Based on the transactions will 
be processed.

Organization (Optional)

Select the value from the LOV. System will use this Organization details for printing the
address on the report.

Certificate Nos. From (Optional)

India Localization prints all the Certificates starting with the Number you enter for this 
parameter.

Certificate Nos. To (Optional)

India Localization prints all the Certificates up to the Number you enter for this 
parameter.

Certificate From date (Optional)

India Localization prints all the Certificates starting From the Date you enter for this 
parameter.

Certificates To date (Optional)

India Localization prints all the Certificates up to the Date you enter for this parameter.

Vendor (Optional)

India Localization prints the Certificates for this Vendor only, if you enter a value for 
this parameter.

Name of the Signee (Optional)

India Localization prints this Name in Full Name field of Certificates

Designation (Optional )

India Localization prints the Designation of the Signee on the report.

Place (Optional)

India Localization prints this Name in Place field of Certificates

Report Headings

Report Headings provide you with general information about the contents of the report.
India Localization prints Certificate Number and Sheet Number of certificate on all 
pages, along with report heading.

Also on the first page of the Certificate Name & Address of the Company Deducting the
Tax, Tax Deduction A/c No. of the Deductor, PAN / GIR No. of the deductor, TDS circle 
where Annual returns are filed u/s 206, Name & Address of the Person in whose a/c it is
credited, PAN / GIR no. of Payee & the period are printed.

Also at the end of each certificate Total amount of tax deducted for the particular 
vendor (for the period) is printed in Words.

Column Headings
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Invoice Date

Date of Invoice.

Amount Paid or credited (Rs.)

Invoice amount.

Amount of Income tax

Amount of Tax Deducted at source.

Challan Number and Date

Challan Number and Date on which tax was deposited to Central Govt. A/c.

Name of bank where tax is deposited

Name of bank where tax was deposited.

Report Order

Report is printed in the order of Invoice date for a certificate.

TDS at prescribed rate Report
Use TDS at prescribed rate Report to calculate Tax deducted at source for a company 
or others for various TDS categories like Rent, Technical / Professional Services, and 
Payments to Contractors/Subcontractors etc.

Report Submission

Use the Submit Requests (India Local Payable Module Only) form and enter India 
TDS at prescribed rate Report in the Name field to submit the report.

Report Parameters

Organization TAN Number (Required) PICK 

Select the value from the LOV.

FIN Year (Required) PICK

Select the value from the LOV.

Organization (Optional) PICK

Select the value from the LOV.

TDS Payment type (Required) PICK

Enter a TDS Payment type, you wish to take the TDS at prescribed rate Report for.

Supplier Organization Type (Required) PICK

Enter a Supplier Organization type (Company or others), you wish to take the TDS at 
prescribed rate Report for. 

Period of Report (Optional)

Report Headings
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Report headings provide you with general information about the contents of the report. 
Oracle lists Organization information based on User parameter input.

Column Headings

PAN Number of the Company 

PAN Number of Company for which TDS has been deducted.

Name of the Company

Name of Company for which TDS has been deducted.

Address of the Company

Address of Company for which TDS has been deducted

Amount Credited or Paid

(Invoice) Amount paid or credited whichever is earlier.

Date on which Amount Credited or Paid whichever is earlier

(Invoice) Date on which Amount paid or credited whichever is earlier.

Amount of Tax Deducted

Amount of Tax Deducted for the Invoice

Date of Deposit

Date on which Tax was deducted for the Invoice.

Date on which Tax was paid to the Credit of the Central Government

Date on which Tax was paid to the credit of the Central Government.

Tax Deduction Certificate Number 

TDS Certificate Number which was sent to the Supplier informing him the TDS details.

Date of furnishing of TDS Certificate to Company

Date on which TDS Certificate was sent to the Supplier Company.

Report Totals

Invoice Amount Total and TDS Amount Total for the report.

Report Order

Report is printed in the order of Vendor Name, Certificate Number and Invoice 
Number for the selected Organization.

India - Cash / Bank Book Report
The Cash/Bank Book can be printed as per user requirement for a range of period.

Report Submission 

Use the Submit Requests (India Local Payable & India Local Receivables Module) 
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form and enter India-Cash/Bank Book Report in the Name field to submit the report.

Report Parameters 

Bank Name (Required) PICK

Account Number (Required) PICK

Account Number of the Above Bank for which the User wants to take the Bank Book for
a given period.

Book Type (Required)

Either 'B' meant for Bank Book or 'C' meant for Cash Book can be selected by the User 
from the LOV 

Start Date (Required)

End Date (Required)

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input.

Column Headings

GL Date 

GL Date for the transaction will be reported.

Voucher No & Date

Voucher Number and Date will be reported

Check Number & Date

Check Number and Check Date will be reported

Supplier Bill Number and Date

Supplier Bill No & Date will be reported

Vendor Name/Customer Name

In the Case of Payments, the Vendor Name will be reported. In the Case of Receipts, the
Customer Name will be reported. For charges in the Bank Book , this field won't be 
having any details.

PO Number. & Date

PO Number for the respective purchase will be reported 

Remarks/Narration

Remarks / Narration appearing in the Receipts and Payments Vouchers will be reported

Account Code

GL Account for the respective Receipts and Payments will be reported

Description
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Description of the GL Account for the respective Receipts and Payments will be 
reported. 

Receipts

Receipts Amount will be reported into this column

Payments

Payments Amount will be reported into this column.

Balance

Balance Amount in the Cash/Bank will be reported into this column.

India-Creditors Ledger Report
Use this Report to get Creditors Sub-Ledger with complete details of Invoices, Debit 
Memos and Payments.

Use the Submit Requests (India Local Payable modules Only) form and enter 
India-Creditors Ledger Report in the Name field to submit the report.

Report Parameters

Vendor Name (Optional) PICK

If the User wants Creditor Ledger for a specific Vendor, then he need to enter Vendor 
Name here otherwise Sub Ledger for all the Vendors for a given period will be 
reported.

Vendor Number (Defaulted) PICK

Vendor Number of the above Vendor will be defaulted here. 

Vendor Type (Optional)

If the User wants Creditor Ledger for a specific Vendor Type, then he need to enter 
Vendor Type in this field otherwise Sub Ledger for all the Vendors for a given period 
will be reported 

From Date (Required)

To Date (Required)

Vendor Site (Optional) PICK

Report Headings 

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input.

Column Headings 

GL Date 

GL Date for the transaction will be reported. 

PO No
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PO Number will be reported

Organization Name

Name of the Organization Location where in the transaction taken place will be 
reported.

Batch Number

Batch Number for the transaction will be reported.

Invoice Type

Invoice Type will be reported

AP Invoice No / Date

AP Invoice Voucher No and Date will be reported

Supplier Bill No / Date 

Supplier Bill Number will be reported

Payment voucher No / Date

Payment Voucher / Invoice No and Date will be reported

Check No and Date will be reported

Description

Description appearing in the Invoice or Payment Voucher will be reported

Account Code

GL Account for the respective transaction will be reported

Currency

Transaction currency will be reported

Exchange

Foreign Currency Dr

Debit amount in a foreign currency transaction will be reported.

Foreign Currency Cr 

Credit amount in a foreign currency transaction will be reported.

Rupee Equivalent Dr

Rupee equivalent for the Debit amount will be reported.

Foreign Currency Cr

Rupee equivalent for the Credit amount will be reported.

India-Creditors Trial Balance Report
Use the Submit Requests (India Local AP modules Only) form and enter India- 
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Creditors Trial Balance in the Name field to submit the report

Report Parameters

If the User wants Creditor Trial Balance for a specific vendor, then he need to enter 
vendor name here otherwise Trial Balance for all the vendors for a given period will be 
reported.

Vendor Number of the above Vendor will be defaulted here.

Vendor Type (Optional)

Vendor Type will be shown in this column.

Account Code (Optional)

CL Account code will be printed here

As of Date (Required)

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input.

Column Headings 

Sl.No 

Serial Number of the Trial Balance will be reported.

Vendor Type

Vendor Type will be reported

Vendor Name 

Vendor Name will be reported.

Vendor Code

Vendor Code (Number) will be reported

Currency

The Transaction currency will be reported.

Entered Amount

Closing Balance of a vendor in Foreign currency will be reported.

Rupee Amount

Rupee equivalent of a vendor will be reported 

Total : Total Vendor Balances in INR 

Total for the Vendor is shown in RS

Order by : Liability Account wise
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India-Statement of Account for Suppliers
This statement of account of Creditors shows Invoice wise outstanding to a Vendor

Report Submission

Use the Submit Requests (India Local Payable modules Only) form and enter India- 
Statement of Accounts for Suppliers in the Name field to submit the report.

Report Parameters

Vendor Name (Optional) PICK

If the User this Report for a specific Vendor , then he need to enter Vendor Name here 
otherwise Statement of accounts for all the Vendors for a given period will be reported.

AS on Date (Required) PICK

Up to a Specific Date

Aging interval like 30 days or 15 days can be entered by the User 

Number of Interval (Optional)

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input

Column Headings

AP Voucher No

AP Voucher No will shown here

Bill no 

Supplier Bill Number

Bill date

Supplier Bill No

Vendor Name

Vendor Name will be reported. 

Amount 

Amount of the Bill

Remarks

Remarks will be shown here

India - BOE Write Off Report
This Reports gives the Details of Written off Bill of Entry for a given period
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Report Submission

Report Parameters

BOE Number (Optional) PICK

BOLE Number will be shown here

BOE Type (Optional) PICK

BOE Type will be shown here

Vendor Number of the above Vendor will be defaulted here. 

Start Date (Required)

Start Date will be shown here

End Date (Required)

End date will be shown here

Report Headings

Column Headings

The following field will be reported

Bill no

Supplier Bill Number

Bill date

Vendor Name will be reported.

Amount

Outstanding Invoice Amount will be reported.

Remarks

Remarks like 'Partly Paid' will appear for Partly paid Invoice.

India-TDS Related Invoices Report
This Report provides with the list of All Invoices for which TDS has been calculated. For
each such Invoice, all TDS Related Invoices generated for the Invoice are shown.

Event

Invoices shown

On Validating a Standard/Prepayment Invoice

Credit Memo generated for the Supplier

On Applying Prepayment Invoice to a Standard Invoice

Invoice generated for the Supplier

On UnApply Prepayment Invoice to a Standard Invoice
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Credit Memo generated for the Supplier

On Cancellation of Standard Invoice 

Standard Invoice generated for the Supplier

Report Submission

Report Parameters

Operating Unit defaults from the one specified for the Responsibility

From Date (Defaulted) PICK

Enter a Date here. This date is compared against the Invoice Date of the Invoices for 
which Tax is Deducted at Source.

To Date (Optional)

Enter a Date here. This date is compared against the Invoice Date of the Invoices for 
which Tax is deducted at Source

Report Headings

Report headings displays name of the Report and the Period for which this Report is 
generated.

The Report Details Section has two parts. One that shows the details of the Base Invoice 
for which TDS is calculated and the next, which lists out all TDS Invoices, related to the 
Base Invoice.

Column Headings

Invoice Name

This field displays the Type of Invoice and the Invoice for which this is generated.

Invoice Number

This field displays the Invoice Number 

Invoice Amount

This field displays the Invoice Amount.

Invoice Currency

This field displays the currency applicable to the Invoice

Vendor Name

This field displays the Vendor Name.

Vendor Site

This field displays the Vendor Name.

TDS Section

This field displays the Income Tax Section under which TDS is calculated

TDS Tax Name 
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This field displays the Name of the TDS Tax.

TDS Tax Rate

This field displays the Rate.

India - VAT Returns Report
India – VAT Returns Report provides data related to sales and purchases, which can be 
used to fill state-specific VAT return forms. Use the Submit Requests / Other Reports 
form (India Accounts Payable / India Accounts Receivable) and enter India VAT 
Returns Report in the Name field to submit the report.

Report Parameters

Field Description Type Action Description

Registration Number Required PICK The Registration 
number for which the
report is being 
generated.

Organization 
Number

Optional PICK The Inventory 
organization for 
which the report is 
being generated.

Location Optional PICK The Inventory 
Location for which 
the report is being 
generated. This needs
to be left blank if all 
locations are to be 
printed. This gets 
enabled only if the 
Inventory 
Organization is 
selected.

From Date and To 
Date

Required Start Date and End 
Date for which the 
report is being run.
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4
India Local Order Management

This chapter covers the following topics:

• Sales Order India Localized

• Ship Confirm India Localized

• Sales Order Returns India Localized

• AR3A Form Receipt Tracking

• Concurrents

• Setting Up India Local Order Management

• Managing Order Management Transactions

• Reports

Sales Order India Localized
You can create a Sales Order by navigating through the India Local Sales Order 
window. This enables defaulting and calculation of Localization Taxes. The defaulting 
is based on the three-way defaulting logic followed for India Localization i.e., based on 
Customer, Customer Site or Item Class. Alternatively, you can create a Sales Order from
Internal Requisitions, using Import Orders feature. The localization taxes will flow to 
Ship Confirm India Localization. For the Deliveries created from India Local Sales 
Orders, taxes will flow to the same.

The Localization Tax information flows into Shipping Localized screen on completion 
of the packing, shipping and Inventory and Order Management Interface. This 
information flows to AR Transactions created based on such deliveries. The same 
information flows to Transactions after running the Auto Invoice program.

The Sales Order India Localized functionality caters to your tax calculation needs 
required for a Sales Order Transaction. You can:

• Define Item category lists and attach the same to Customer and Customer Sites. 
Alternatively, an Item Class can be attached to a Tax Category. This would enable 
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third level of Tax defaulting, which would apply only when the Tax Information 
does not default from Customer and Customer Site. This would be the basis for 
taxes defaulting to Transactions.

• Assign Assessable Prices to Items. This price would be the basis for Excise Duty / 
VAT Taxes Calculation. The Assessable Price Lists can be attached selectively to 
Customer Sites.

• Create Sales Orders by navigating through India Local Sales Orders window. This 
would automate tax defaulting and calculation.

• Modify defaulted tax lines and add to the existing list.

• Get overview information for Sales Order Lines, without localization taxes.

• Create Sales Order for Excise exempted sales e.g., CT2, CT3. Relevant Certificate 
information can be recorded.

• Create Sales Order for VAT Exempted Sales Order like Vat Exemption Item, Export,
Inter State Sale, Sale to Specified parties, Transfer.

• Automate calculation, recording and accounting of CENVAT Recovery (as specified
under Rule 6 of The CENVAT Credit Rules 2002) for excise-exempted sale.

• The Sales Order displays Assessable Value, which forms the base for calculation of 
Excise Duty.

• The Sales Order also displays the VAT Assessable Value, which forms the base for 
calculation of VAT taxes.

Major Features of Sales Order India Localized
Defaulting Taxes to India Local Sales Orders

You can use Localization taxes while creating a Sales Order in the Order Management. 
These taxes can be defaulted based on the Tax Defaulting Rules. The automatic Tax 
Defaulting is based on Item Category assigned to the Customer, Customer Site or based 
on the Item Class assigned to the Tax Category.

Tax Base Amount

You can define precedence logic to calculate Tax Base Amount on which the Tax Rate is 
applied. The Tax Base Amount can either be the line amount or line amount including 
other taxes calculated for the transaction.

Important: No precedence logic and tax rates are available for adhoc 
taxes.
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Defaulting Assessable Value to India Local Sales Orders

You can use an Assessable Value that is different from the Sales Price while creating a 
Sales Order in the Order Management. This Assessable Price can be defaulted based on 
the Tax Defaulting Rules. The automatic defaulting is based on Price List assigned to 
the Customer, Customer Site or null Site.

Important: The Assessable Value is a display only field and cannot be 
edited by user on Sales Order. It is only controlled through Price List 
setups and Price List attachments.

Manual Changes to Defaulted Taxes to India Local Sales Orders

The Taxes defaulted can be changed manually, if required.

• Tax Line can be deleted only when there is no dependent tax line.

• You must Apply and Save after deleting defaulted taxes and before 
attaching New Taxes.

Record Excise Exemptions

You can choose the Exemption Type applicable to the Sales Order by selecting the 
Excise Exempted check box provided at the line level. This changes the Excise Value of 
that line to zero.

Record VAT Exemptions

You can choose the VAT Exemption Type applicable to the Sales Order. To do this, you 
need to select VAT Exemption Type, Date and Ref No at Header. This gets defaulted on 
all lines and changes the VAT value of all lines to zero.

If you require partial VAT Exemption viz., on some lines only, you need to deselect the 
VAT Exemption flag. You can also have a different type of VAT Exemption at line level.

CENVAT Recovery against Excise Exemptions

You can set up CENVAT Recovery % in the Organization Additional Information 
Screen in CENVAT Recovery % field using India Local Inventory Responsibility which 
will ensure CENVAT Recovery under Rule 6 of The CENVAT Credit Rules 2002 for the 
above Excise Exempted Transactions.

Splitting of Sales Order Lines

Any Splitting lines in the base Sales Order also split lines in India Local Sales Order. 
The Tax lines are then recalculated based on the revised line quantity.

Changes in Sales Order Lines

Changes made to Quantity in Base Sales Orders are automatically reflected in the Sales 
Order India Localization. Lines deleted from base order also get deleted from India 
Local Sales Order.
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Cancellation in Sales Order Lines

A line cancelled in the base Sales Order changes the Quantity in Localization screen to 
zero.

Copying of Sales Orders

A Sales Order created by navigating through India Local Sales Order screen can be 
copied using the Copy Order feature. This will result in taxes flowing to Localization 
for the copied Order. While coping Order, if there is any change in the Assessable Price 
with respect to source Order line, then it results in recalculation of the taxes.

Important: Copy Sales Order feature can be used to create a RMA 
Order. An RMA Order taxes is based on shipping taxes and hence to 
avoid data inconsistency issues in localization tables, Copying of Sales 
Order is not possible unless such Order is already shipped & data is 
available in Localization shipping tables.

Localization does not currently allow copy of RMA Order to standard 
Order or existing RMA Order to new RMA Order.

Assessable Price Recalculation

Excise duties attached to the Order lines can be recalculated whenever there are 
changes in assessable price of items. This is helpful at the time of Budget/changes in 
Excise statutes. For further details refer Assessable price recalculation provided under 
reports.

Line Level Query in India Local Sales Order

You can now query for lines in Sales Orders India Localization screen once the Sales 
Order is queried. This feature would be helpful to find the lines in case where the item 
name is above 25 characters long or Sales Order has large number of lines.

Auto Query of India Local Sales Order

Clicking the Open Button on the India Local Sales Order displays the Base Sales Order 
Form to create an Order.

When you fill the base Sales Order form and save it, the details of the transaction are 
auto queried and displayed in the India Local Sales Order form. To view the details, 
navigate to the India Local Sales Order form. You can also query an existing Order in 
the Localized Sales Order form.

If you navigated away to multiple forms, Auto query does not work and you must click 
refresh to view the localization screen with requisite details.
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Ship Confirm India Localized

Overview
You can make changes to localized freight in the Order Management Module. You will 
also have a facility to add Localization Freight manually at this stage.

This information flows into Shipping Localized screen on completion of the Picking, 
Shipping and Inventory and Order Management Interface. Taxes entered in Sales Order
cannot be changed at this stage. However, you can change or add freight details at this 
stage. The same information flows to AR Transactions after running the Auto Invoice 
program.

The Ship Confirm India Localized functionality lets you satisfy all your needs related to 
Freight addition required for a Shipment Transaction. You can:

• Query a ship confirmed Transaction using Delivery Name, Order Number, 
Customer etc to find localization related details.

• Add or change Freight type of Tax at this stage.

• Enter Pre printed Excise Invoice Numbers.

• View Tax lines attached to each line of delivery.

• On Completion of the 'India - Excise Invoice Generation' you can also view the 
Excise Invoice Number that has been generated against this delivery.

• Query based on the Excise Invoice Number generated.

• Query based on items. Option to view all Items in the delivery or only Items whose 
name has been entered in the query.

• View details of the Duty paying Register that has been hit by the delivery 
transaction.

• Enter AR3A Form Number and Date for Excise Exempted transactions.

Major Features of Ship Confirm India Localized
Facility to Add Freight in Ship confirm India localized

You have an option to change or add new freight lines using the Ship Confirm 
Localized screen.

Important: All the features mentioned here involving changes to 
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transaction has to be completed before Auto Invoice happens, else the 
same will not flow to the AR Transaction.

Pre Printed Excise Invoice Numbers

You can enter your pre printed Excise Invoice Numbers against each delivery. Such 
numbers can be alpha numeric in nature. It is also possible that a delivery may be 
printed on more than one pre printed Invoice. For such cases, option has been provided 
to enter from and to numbers so that the same is recorded in the system for future 
reference.

Record AR3A Form Number and Date

You can record AR3A form Number and Date against individual shipment line for 
Excise-Exempted transactions for the purpose for tracking.

Reports

Receivables generates these reports for India:

India - Debtors Ledger Report - Lists all the transactions with the Customer to arrive at 
the net liability for the Customer. You can use this report to get Debtors Sub-Ledger. 

India - Commercial Invoice for OM Report - This Report gives you the Commercial 
Invoice with Excise Invoice Number, Excise Details for a Sales Order against each 
delivery.

India - Forecast Excise Amount in RG Registers - Gives the Forecast for CENVAT and 
PLA Payments for a given Organization, Location Combination from As of Date to 
Entered Date.

Sales Order Returns India Localized
Users can create RMA Orders with localized taxes in the Order Management. The taxes 
would be calculated for the RMA lines, based on the Original Sales Order.

The RMA Order India Localized functionality allows the user to satisfy all requirements
related to Tax calculation required for a RMA Transaction. Users can create an RMA 
Order by giving:

• Reference to the Original Sales Order

• Reference to the Invoice

• Without giving any reference.

• Return Orders without Excise Component.

• Reference to the delivery line shipped
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Major Features of Sales Order Returns India Localized
Defaulting Taxes to India Local RMA Orders

You have an option to use Localization taxes while creating a return sale Order in the 
Order Management. These taxes can either be defaulted based on the Tax Defaulting 
Rules or can be attached manually. The automatic tax defaulting would be based Item 
Category assigned to the Customer, Customer Site or based on the Item Class assigned 
to the Tax Category. This is only applicable for the RMA Order created without 
reference and the reference is filled as 'Legacy'. For a RMA Order created with reference
taxes are defaulted based on the original delivery and cannot be changed.

Auto picking of Delivery Detail ID in India Local RMA Orders

Whenever a RMA Sales Order is created with reference, Localization taxes would be 
based on the shipment taxes and hence required entry of Delivery Detail ID. There is no
need to search this delivery detail id, which would make the process tedious. On 
navigating to Localization Screen, the same gets automatically populated if the Sales 
Order reference is given.

Returns without Excise

Whenever a return takes place beyond the stipulated period by Excise Authorities, you 
are prevented from claiming CENVAT benefit on the returned goods viz., when returns
are made beyond 180 days. Under such circumstances, many a times, it is necessary that
the Credit Memo that is raised for such return be raised for the base amount without 
passing on the benefit of Excise Duty. For such kind of transactions, the days within 
which if return is made, the Excise to be allowed has to be mentioned in the 
Organization Additional Information in Excise Return Days field. This ensures that 
when any RMA is made beyond such stipulated period, the Credit Memo raised will be 
net of Excise.

RMA without Sales Tax

Whenever a return takes place beyond the stipulated period by Sales Tax Authorities, 
you are prevented from claiming the same in your Sales Tax Returns. Under such 
circumstances, many a times, it is necessary that the Credit Memo that is raised for such
return be raised for the base amount without passing on the benefit of Sales Tax. For 
such kind of transactions, the days within which if RMA is made, the Sales Tax to be 
allowed has to be mentioned in the Organization Additional Information Sales Tax 
Return Days field. This ensures that when any RMA is made beyond such stipulated 
period, the Credit Memo raised will be net of Sales Tax.

AR3A Form Receipt Tracking
Material Clearance without payment of duty under AR3A needs to be tracked for 
receipt of Re-warehousing Certificate. AR3A Receipt Tracking feature of Oracle 
Financials for India can be used to meet this requirement. All clearances under Excise 
Exemptions is recorded and on receipt of the authenticated document; the Receipt Date 
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can be recorded. The data thus collected can be used to monitor the Rewarehousing 
Certificates that need to be received from Customers at any point of time.

The AR3A Receipt Tracking functionality allows user AR3A forms due from 
Customers. Users can:

• Track AR3A Forms to be received from the Customers. You can enter the Date on 
which the Form is received.

• Generate a Report to view the AR3A forms pending from each Customer.

Reports
India - AR3A Status Report lists all exempted sales transactions, while an 
Acknowledged AR3A form is pending from Customer.

Concurrents
India Local Order Management requires the following concurrent programs to be run:

India - Excise Invoice Generation
This is a mandatory concurrent program, if you are using Excise Type of localization 
taxes, which generates Excise invoice Number against delivery and also hits Excise 
registers based on the Delivery ID (optional). You must schedule it to run after 
Inventory Interface and Order Management Interface and prior to AutoInvoice. This 
report does not generate any printable output.

• This concurrent needs to be setup as incompatible to itself. If the 
same is not done and multiple users run it with blank Delivery_id, 
it would result in skipping Excise Invoice Numbers or alternatively 
hitting the Excise Register multiple times for the same delivery.

• This concurrent is expected to be scheduled with blank Delivery id,
which would pick and process all available deliveries. This is to be 
run with Delivery_id for specific cases where debug log is required 
for any problem reporting.

• In case the users run it with delivery_id as a part of the process, 
then the concurrent needs to be scheduled to run atleast once a day 
without Delivery_id to ensure that any records skipped get Excise 
Invoice Numbers for the same day. Not doing this will result in 
sequencing issues when compared to Excise Invoice Dates.

• The concurrent will process only those deliveries, which are OM 
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interfaced and Inventory Interfaced.

• This concurrent is for generating Excise Invoice Number and 
Accounting thereof. There is no rdf attached to the same and hence 
this is not supposed to generate any output.

• This concurrent needs to be run prior to Auto Invoice import if the 
Excise Invoice Number is required to be seen in Localization AR 
tables.

India - Excise Duty Recalculation
This is an optional concurrent program that enables you to recalculate Excise Duty 
attached to Unshipped Orders, if there is a change in the assessable value of items. 
Excise Duty recalculation is done for those Unshipped Orders that satisfy the input 
criteria. This report does not generate any printable output. You can use this program to
recalculate the Excise Duty and all dependent taxes on Open Sales Orders. The Excise 
Duty is recalculated to reflect the latest Assessable Prices applicable to the items 
included in the transaction. Using this feature, you can eliminate manual effort required
to update all Open Sales Orders to reflect changes in Assessable Prices.

This concurrent can be invoked through India Local Order Management > Reports, 
Request > Single Request > India > Excise Duty Recalculation

Field Description Type Action Description

Start Order Required PICK Enter the Sales Order
from which you
would like to effect
Tax Changes

End Order Required PICK Enter the Sales Order
which you would like
to take as the last
document on which
the change has to be
effected.

Order Type Required PICK Choose one of the
Order Types from the
list
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Field Description Type Action Description

Organization Id Required PICK Choose one of the
Organizations from
the list.

Important: On completion of the request the selected Sales Orders, provided they are open
and have an Assessable Price applicable, are updated with the revised Tax Amounts

India - Service Tax Processing
All Accounting events will be accounted when the Base transaction line is being 
accounted. The 'India Service Tax Processing' Concurrent program processes the 
recovery Accounting events. This program must be scheduled at regular intervals. At 
each run, the program would create Accounting and Service Tax Repository entries for 
all eligible transactions.

This concurrent can be invoked through India Local Receivables > Reports, Request > 
Single Request > India > Service Tax Processing.

Field Description Type Action Description

Regime (Required) PICK

HELP

EDIT

Select the Regime you
have defined for
Service Tax.

Tax Registration
Number

(Required) PICK

HELP

EDIT

Select the Registration
Number here.

Organizations are
logically grouped by
Tax Registration
Number. On selecting
a Registration
Number, all eligible
transactions created
in the related group
of Organizations
would be processed.
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Field Description Type Action Description

Transaction From
Date

(Required) PICK

HELP

EDIT

Specify Transaction
From Date here.

Organization Name (Required) PICK

HELP

EDIT

Specify Inventory 
Organization here.

India - VAT Invoice Generation
A new concurrent program 'India - VAT Invoice Generation / Accounting ' has been 
added to Oracle Order Management - India Localization. This has been introduced to 
handle generation of VAT Invoice and pass requisite VAT Accounting entries for VAT 
type of taxes from Order Management. This program captures Value Added Tax 
localization taxes in Shipments and inserts VAT Invoice Number in India Local 
Shipment Table and Entries in GL interface. You have to schedule the concurrent to 
submit the request at suitable intervals.

Important: Please make it mandatory to Schedule this concurrent program.

This concurrent can be invoked through India Local Order Management > Reports, 
Request > Single Request > Select 'India - VAT Invoice Generation / Accounting > 
Schedule

The field wise detail description of the screen and its feature are described below for 
ready reference.

Field Description Type Action Description

Regime (Required) PICK

EDIT

You will have to pick
the Regime here.
Currently only 'VAT'
(Value Added Tax) is
available here.
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Field Description Type Action Description

Tax Registration No. (Required) PICK

EDIT

You will have to pick
the Tax Registration
Number that has been
defined for VAT
Regime here. This
LOV will display all
Registration Numbers
defined by you for
VAT Regime.

Organization (Optional) PICK

EDIT

You can choose the
Organization here if
you want to run the
program for a specific
Organization.

Location (Optional) PICK

EDIT

This will be enabled
only if you select an
Organization and you
can choose the
Location here if you
want to run the
program for a specific
Location.

Delivery From (Optional) PICK

EDIT

This will be enabled
only if you select an
Organization and
Location and you can
choose the from
Delivery id here if
you want to run the
program for a specific
range of delivery id's.

Delivery To (Optional) PICK

EDIT

This will be enabled
only if you select an
Organization and
Location and you can
choose the end
Delivery id here if
you want to run the
program for a specific
range of delivery id's.
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Field Description Type Action Description

Transactions from
Date

(Required) EDIT Enter Transaction
Date Range here. All
transactions having
transaction date
between this range
will be picked up for
processing.

Transactions to Date (Required) EDIT Enter Transaction
Date range here. All
transactions having
transaction date
between this range
will be picked up for
processing

Action (Required) PICK

EDIT

This is the type of
action, which is
expected. The
program has three
options

1) "GENERATE
INVOICE NO" which
will only generate
VAT invoices for the
selected Regime,

2) "PROCESS
ACCOUNTING"
which will make
repository entries and
pass GL entries for
the selected Regime.

3) "PROCESS ALL"
which will result in
both generation of
VAT Invoice and pass
GL entries.
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Field Description Type Action Description

Generate Single
Invoice

(Optional) PICK

EDIT

You have an option of
running the
concurrent with "Yes"
for this parameter
which will then
group delivery ids for
each Customer and
create a single VAT
Invoice for each
Customer instead of
one VAT Invoice per
delivery.

Default Invoice Date (Optional) EDIT Using this option you
can enter a Date for
which you want the
VAT Invoice Date
and Accounting to
happen. This is useful
mainly for cases
where shipment
happens as say 11:45
pm on Month end &
you are running the
concurrent during the
next month but want
the accounting to
happen on a date
different from current
date. This will
however not impact
the number series &
hence care should be
taken to process all
pending invoices
prior to running the
concurrent for the
next period.

Debug Switch (Required) PICK

EDIT

Default value of this
parameter is "No" but
the same can be
changed to "Yes" to
see the debug
messages when
required.
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• This program is a mandatory program to be run for generating 
VAT Invoice Number and generation of Accounting Entries. 

• This concurrent will show the following error "Excise Invoice 
generation program has not been run for various reasons" or "
Excise Invoice Generation is not generated yet for this Delivery. 
Please run the Excise Invoice Number generation Number for 
delivery: " when you have setup 'Same Invoice No for Excise and 
VAT Regimes' as 'Y' for this Registration Number and try to run 
this program prior to running Excise Invoice generation or if the 
Excise Invoice Generation has errored out for this delivery.

• This concurrent will show the following error "Document 
sequencing setup not done at Registration number level" if you try 
to run the same without defining the Document sequencing for the 
given Registration Number.

• This concurrent will show the following error "Document Numbers
are exhausted. Please set the End Number to a larger value" when 
the last Number as setup in document sequencing has been reached
& hence cannot generate a VAT Invoice Number. 

• When VAT Invoice Number generation happens after the AR 
Invoice is created, localization AR table does not have VAT Invoice 
Number imported from localized shipping tables. Hence care 
should be taken to run the VAT Invoice Generation program prior 
to creation of AR Invoice.

• When this concurrent is run with parameter of 'GENERATE 
INVOICE NO' Accounting Entries are not passed.

Setting Up India Local Order Management
This section describes the setup procedures for India Local Order Management. You 
must complete setups detailed in this section before you start using Sales Orders 
(Localized) and the other features in Order Management - India Localization.

Defining Allow Negative Balance in PLA - Organization Additional Information
The latest Excise Rules allowed settlement of Excise Liability on a Monthly basis. With 
this system, you will not have to hold shipments for non-availability of funds. The 
'Allow Negative Balance in PLA' Flag setup for the Organization/Location, allows you 
to over draw from the PLA balance available with you.

Prerequisites
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Before you enter the Allow Negative Balance in PLA - Organization Additional 
Information, you must:

• Define Organizations

• Define Locations

• Organization Additional Information

See also: Define Organizations, Oracle Inventory User Guide

Creating Allow Negative Balance in PLA - Organization Additional Information Details
To enter Allow Negative Balance in PLA - Organization Additional Information Details:

In Oracle Financials for India, navigate to the India Local Organization Tax Information 
from India Local Inventory > Organization > Additional Information.

Query for the Organization Location fro which you wish to make the setup. Switch to 
Accounts Info Tab.

Check the -Ve Balance in PLA field.

Important: The Organization Defined should be either a 'Master 
Organization' or attached to a Master Organization for Generation of 
Excise Invoice Numbers.

Excise Invoice Generation - Organization Additional Information
You might prefer to use a different Excise Invoice for a Transaction Source or a 
combination of Transaction Sources. On completing this Setup Step, you can generate 
Excise Invoice Numbers in a sequence and with the alphanumeric prefix that you 
prefer.

You can skip this setup. On doing this, the system will generate only two series of 
Excise Invoices, one for Domestic Clearances and another for Exports . These would be 
numeric values, incremented by one and would be without any prefixes.

Prerequisites

Before you enter the Organization Additional Information Details, you must:

• Define Organizations

• Define Locations

• Organization Additional Information

• Tax Calendar
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The following information can be entered by user to generate multiple Excise Invoice 
Serial numbers based Order / Invoice Type/Excise Register Codes.

The field wise description for the screen is given below.
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Field Description Type Action Description

Transaction Type (Required) PICK HELP Choose one of the options from the LOV.
The options would be

Order:

On selecting this option in combination
with the Order Type, the Excise Invoice
Number generated on shipping the
delivery created with this Order Type
would be based on the definition
specified for this record.

Return To Vendor:

The document sequence defined here
would be applicable to Excise Invoice
Numbers generated for a Return to
Vendor Transaction.

Domestic:

The document sequence defined here
would be applicable to Excise Invoice
Numbers generated for a Domestic
Transaction.

This would be applicable to all the
Order/Invoice Types that are

Define Bond Register: Chosen for the
Organization / Location with the Register
Type as 'Domestic with Excise' AND

This Order Type is not chosen in the India
Local Excise creation screen for the
Organization, Location.

Invoice:

On selecting this option in combination
with the Invoice Type, the Excise Invoice
Number generated on saving an AR
Invoice would be based on the definition
specified for this record.

Export:

The document sequence defined here
would be applicable to Excise Invoice
Numbers generated for a Export
Transaction.
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Field Description Type Action Description

This would be applicable to all the
Order/Invoice Types that are

Define Bond Register: Chosen for the
Organization / Location with the Register
Type as 'Export with Excise' and this
Order Type is not chosen in the India
Local Excise creation screen for the
Organization, Location.

Order/Invoice Type (Required) PICK HELP The relevant Order Type/Invoice type
related for a Inventory Organization
Location have to be selected here from the
LOV.

Register Code (Required) PICK HELP The appropriate Register Code for a
Order/Invoice Type have to be selected
here from the LOV.

Prefix (Optional)   Any alpha-numeric code that would be
prefixed to the Excise Invoice Number.

Start No (Required)   You can specify the Start Number for a
specific Excise Invoice Serials which are
to be generated from a particular
Inventory Organization Location for a
specific Order/Invoice Type

Jump by (Required)   You can decide chronological series for
Excise Invoice Numbers by specifying
Jump by Number.

End No     The User can specify the End Number for
a specific Excise Invoice Serials, which are
to be generated from a particular
Inventory Organization Location for a
specific Order/Invoice Type & Register
Code.

• Before defining user prefixes and Excise Invoice Numbers, 
appropriate setups need to be done in define Bond Register to 
associate an Order Type for all Transactions Order Management 
Module. In addition, Transaction source for all transactions from 
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Accounts Receivable Module needs to be defined. The Order Type 
and Transaction Source will be associated with different type of 
Excise removals (like domestic with excise, Bond, Export with 
excise etc.). Only after associating an Order Type/Transaction 
source with an excise related Transaction Type, user should define 
the user definable prefixes and Excise Invoice Numbers in this 
region. 

• It is not mandatory for the user to define Excise Invoice Generation 
Serial Number. If the User does not define the Excise Invoice 
Generation Screen, then auto generated system numbers will be 
allotted to the Excise Invoice as stipulated under Rule 52 A of the 
Central Excise Rules (one sequence for domestic transactions and 
another for exports). 

Defining Sub Inventory Locations
Before you start using India Local Order Management, the Sub-inventories have to be 
associated with Organization/Location combination. Excise related transactions and 
records would be updated only for those Sub inventories, which are identified as 
bonded for Manufacturing Organizations and as Trading for Trading Organizations. By
considering the transactions of a Sub inventory, the check box for bonded/traded needs 
to be enabled. Sub-inventories that are not defined here are considered as non-bonded.

Prerequisites

Before you enter the Sub inventory Locations, you must:

• Define Organizations

• Define Locations

• Organization Additional Information

• Define Sub Inventories

In Oracle Financials for India, navigate to the Assign Sub inventories to Location India 
Localization window as follows: India Local Order Management > Setup > Organization
> Sub-Inventory Locations

Field Description Type Action Description

Header Level      
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Field Description Type Action Description

Organization
Name/Location

(Required) PICK HELP Inventory Organization's Name and
Location to be selected by the user
from the LOV.

Line Level      

Sub-Inventory (Required) PICK HELP You can select the Sub-inventory
name from the LOV

Description (Displayed)   The Description for the selected
Sub-Inventory will be displayed here.

Bonded (Flag) (Optional) CHECK BOX You need to specify whether a Sub
inventory belonging to the specified
Organization and Location is Excise
Bonded or Duty Paid. When this Flag
is enabled the Sub inventory is
considered as Bonded.

Trading (Flag) (Optional ) CHECK BOX This Flag is enabled for all the
Sub-inventory attached to a Trading
Organization. If the Organization
Location has a Manufacturing setup,
this field is disabled.

• The above Sub Inventory setup is mandatory in nature & missing 
the same will result in Shipping getting stopped with the following 
message:

• " ORA-20406 - Mandatory India Local Sub-inventory Setup not 
done for this Location from where Shipment is made" 

• The Sub inventory can be either 'Bonded' or 'Non-Bonded' in 
Manufacturing Organization. 'Non-Bonded' Sub inventory is where
the Bonded flag is unchecked and does not result in Excise Register 
updates for any shipments made.

• For Trading Organization the Trading flag would be auto checked 
and the same is not updatable for unchecking.
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Customer Additional Information
You will have to complete this setup step before using the Receivables Localization 
functionality. The information setup in Customer Additional Information would be the 
basis for Tax defaulting. You can also record the Registration details of the Customer 
with Excise, Sales Tax, Value Added Tax, Service Tax and Income Tax. This information
at site level would be used in the Localization Reports and hence is mandatory if 
Localization reports are to be used.

Customer Additional Information must be updated to enable defaulting of Service Type
on the Sales Orders and manually created Receivable Transactions. If this update is not 
performed, you will need to manually enter Service Type for each transaction 
pertaining to such Customer.

Prerequisites

Before you enter the Organization Additional Information Details, you must:

• Define Organizations

• Define Locations

• Define Organization Additional Information

• Define Taxes

• Define Tax Categories

• Define Item Categories

• Define Assessable Price Lists

• Define Customer, Customer Sites

Defining Customer Additional Information
In Oracle Financials for India, navigate to the Enter Transaction India Localization 
window from India Local Order Management > Customers > Additional Information.

Alternatively, navigate to India Local Receivables > Customer > Additional Information.

Field Description Type Action Description

Operating Unit (Required)   The Operating Unit for which
Customer Additional Information is
entered.
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Field Description Type Action Description

Customer Name/Site (Required) HELP EDIT
PICK

You can select the Customer Name
from LOV for whom the Additional
Information regarding tax is to be
defined. The Customer Number will
default. The Customer Site will be
selected from LOV for which the
information will relate. The Customer
Additional Information can be defined
for no specific location also and this
will be treated as location NULL.

Important: Additional Customer
Information can be recorded in the
system only on saving the Customer
Information in the Customer Master
of the standard application.

Exempt CHECK BOX   If the Customer is exempted from
Excise, then you need to enable this
Check Box.

Excise Block (Optional) ENTER You can enter all these fields which are
relevant to identify the Excise Duty
information for a Customer for a
Location.

Sales tax Block (Optional) ENTER Information regarding Sales Tax like
CST No and LST No which are relevant
to identify the Sales Tax information
for a Customer for a Location.

VAT Block      

Reg No (Optional) EDIT Specify the VAT Registration Number
applicable to the Customer, Customer
Site

Assessable Value (Optional) PICK

EDIT

You can select from the list of Price
Lists. The price specified in the list here
would replace the Line Amount while
calculating VAT Taxes

Service Tax block      
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Field Description Type Action Description

Service Tax Reg No (Required) PICK

HELP

EDIT

Customer Service Tax Registration
Number will be captured in this field.

Income Tax Block (Optional) ENTER information regarding Income Tax like
PAN No and TAN No which are
relevant to identify the Income Tax
information for a Customer for a
Location.

Item Category List (Optional) EDIT HELP
PICK

You can select from the LOV the Item
Category List. The selection of the Item
Category List will affect the default
status of the taxes defined within the
Tax Categories associated to the Items
within this Item Category list. This is
an optional field.

Assessable
Value/Transaction
value

(Optional) EDIT HELP
PICK

There will be cases where the price
charged for the transaction is not the
sole consideration and the Customer
relationships will have an impact on
the sale consideration. Section 4 of the
Central Excise Act, specifies that if
there is any other consideration built
up in the price, Excise Duty needs to be
worked out on the normal transaction
value of the goods.

There are cases, where Excise Duty or VAT Tax needs to be calculated on some other 
price. This requirement is addressed through the functionality of Assessable Value. You
can create a simple Price List (Without use of pricing Attributes that are available in 
Advanced Pricing Module) as the Assessable Value/Transaction value Price List and the
same can be attached to any Customer/Customer Sites.

While performing a transaction for a Customer/Customer Site, first system will check 
whether any Assessable Value list is attached for the Customer for the Item under 
transaction. If there is any Assessable Value attached to the Customer for the Item, 
Excise Duty will be calculated on the Assessable Price List and not based on the line 
price.

If no Assessable Value is defined for a Customer/Item, Excise Duty will be calculated on
the line price amount.



India Local Order Management    4-25

When Customer relationships have been defined, the List of addresses will show LOV 
of related Customers also. However, the LOV will not show all values based on Profile 
setup for Customer relationship.

• Whenever the price charged is not the sole consideration and a 
different price needs to be considered for calculating Excise Duty, 
you must attach the price as Assessable Value. The price that needs 
to be considered for calculating Excise Duty / VAT needs to be 
defined in the Price List.

• All the columns have been not described. Do we need to describe 
for all the values. If yes we can pick and paste it from AR.

Defining Bond Register
The calculation of Excise Duty and updation of Excise Registers are based on the setups 
made in the define Bond Register. Before making this set up you need to define the 
Order Types and Transaction Sources. Excise Transactions are classified into the 
following categories:

• Domestic with Excise

• Domestic without Excise

• Export with Excise

• Bond Register (Export under Bond)

Excise Transactions need to be identified based on the Organization/Location 
combination and against each Excise Transaction multiple Order Types and Transaction
Sources can be assigned. Order Type need to be assigned to Excise Related Transactions
from Order Management Module and Transaction source need to be assigned for all 
Excise Related Transactions through the stand Receivable Module. If the 
Organization/Location is of Manufacturing Type, Excise related Transactions for 
Manufacturing set up need to be associated. Like wise, if the Organization/Location is 
'trading' excise related transactions for trading need to be associated.

By associating the Order Types to the Excise Transactions for an Inventory 
Organization and Location, the related Excise Record entries will be passed based on 
the nature of goods cleared.

Generating Excise Invoice Numbers

For generating user definable prefixes for Excise Invoices, the Excise Transaction Type 
association needs to be mapped in the Excise Generation Region of Additional 
Organization Information screen.

Oracle Financials for India provides for maintenance of Multiple Bond Registers for 



4-26    Oracle Financials for India User Guide

Exports.

Recording Export under Bond
Rule 19 of The Central Excise Rules, 2002 provides for Export without payment of duty 
subject to the conditions and procedures specified by the notifications by the Central 
Board of Excise and Customs. In exercise of the powers conferred under these rules, the 
Central Board of Excise and Customs has notified through Central Excise (N.T.) 
Notification No.42/2001 and Notification No.44/2001 the conditions and procedures for 
export of all excisable goods. These notifications provide for taking on a Bond/Letter of 
Undertaking (LUT) for the export made to all countries other than Nepal and Bhutan 
and another Bond/LUT for the exports made to Nepal and Bhutan. To comply with the 
procedures specified under these notifications, an Organization will have to maintain 
multiple Bond Registers in order to keep track of exports under bond to all countries 
other than Nepal & Bhutan, exports to Nepal and Bhutan and exports under Letter of 
Undertaking. Under each of these categories, there would also be a possibility for taking
multiple bonds where total of Export made, without proof of exports, is greater than the
Bond Amount.

Using Bond Registers in Oracle Financials for India, you can maintain multiple Bond 
Registers for a combination of Organization and Location.

On taking a Bond for export you will have to create the required setup before you start 
creating export transactions against the Bond. The only setup step would be to record 
the Bond details. To do this, navigate to 'Define Bond Register' window. Select 
organization, Location for which the Bond would be applicable, pick up the Type 'Bond 
Register', and enter Bond Number, Expiry Date and the Bond Amount. On the lines, 
select the Order Types that would be used for export transactions.

In case export is made against the Letter of Undertaking (LUT), there would not be a 
Bond Amount. Hence, you can leave the Bond Amount field blank. However, it would 
be mandatory for you to capture the details of the Bond Number (LUT No.) and the 
Bond Expiry Date. In addition to this, check the LUT checkbox to indicate that the Bond 
Type is LUT.

Details of exports made under bond would be recorded. This information would be 
used to track Bond utilization. 

Prerequisites

Before you enter the Bond Register Details, you must:

• Define Organizations

• Define Locations

• Define Organization Additional Information

• Define Transaction Types
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In Oracle Financials for India, navigate to the India Local Associate Register Types from
India Local Order Management > Setup > Registers > Define Bond Register.

The field wise description for the screen is given below. From the look-ups you need to 
select the appropriate Excise Transactions. Options in Manufacturing Organization are:

• Domestic with Excise

• Domestic without Excise,

• Export with Excise

• Bond Register (For Exports)

Options in Trading Organization are:

• Trading Domestic with Excise

• Trading Domestic without Excise

• Trading Export with Excise

• Trading Bond Register (For Exports)

Important: You need to specify the Bond Credit available in his running
Bond account maintained for export purposes.

Field Description Type Action Description

Organization/Locatio
n

(Required) EDIT HELP
PICK

You can select Organization and its
Location from LOV for which the
Register setup is to be made.

Order/Invoice
Information

(Required) EDIT HELP
PICK

 

Bond Number (Optional /
Required)

  This would be an enterable field. User
can enter Bond Number here. This
number can be alphanumeric.

Bond Expiry Date (Optional /
Required)

  The User can enter the Bond Expiry
Date here. The system would raise
application error where the Shipment
Date is greater than the Bond Expiry
Date.



4-28    Oracle Financials for India User Guide

Field Description Type Action Description

Letter of Undertaking (Optional) Check Box This field would be checked
whenever the Bond Type is a LUT
(Letter of Undertaking).

Bond Amount (Optional /
Required)

  Enter the Bond Amount here. The
value in this field can be entered only
while creating a New Bond. Once the
Bond details are saved, these values
cannot be updated.

Additional Amount (Optional)   If the Bond Amount is to be
increased, then, enter the Additional
Amount here. Once, the record is
saved, value in this field would be
erased and the Bond Amount and
Balance would be increased to this
extent.

Balance Amount (Display)   This field would reflect current
Balance available in the Bond
Register.

Additional Bond Button   Use this button to capture additional
bond amount. On clicking this button
you will be allowed to enter value in
Addition Amount field. On saving
this value will be added to the Bond
Amount and the Balance Amount

For Excise related transactions from the Order Management Module, you need to 
specify the Order Type intended to be associated with the selected Excise related 
transaction. Any number of Order Types can be associated to one single Excise related 
transaction.

For Excise related transactions mapped through the transaction - Localized Menu of the 
Receivable Module, you need to associate the Excise related transaction to the 
Transaction Source. Any number of Transaction Sources can be associated to one Single 
excise related transaction. The transaction batch source is selected against the option of 
Invoice in this field.

• Same Order Type/Transaction source cannot be mapped to 
different Excise related transactions. You need to map your 
business requirements by considering the localization setup that 
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needs to be carried out for mapping the Excise Related 
Transactions.

• Attachment of Order type to 'Domestic without Excise', or 'Trading 
without Excise' would mean that Excise Invoice Number for such 
transaction is not required. This Setup was mandatory for Tracking 
ST Forms earlier and is no longer mandatory for form tracking.

• When Using Master Organization setup for generating Excise 
Invoice Numbers at Master Organization level, It is mandatory to 
setup the Order Type at both Child Organization and at Master 
Organization for getting the Correct Excise Invoice Number.

Managing Order Management Transactions
This Section elaborates on the transactions for which you can default and calculate the 
Localization taxes. This would be possible only when you create the transactions 
navigating through the localization windows.

Transactions Sales Order (Localized)
In Oracle Financials for India, the Sales Orders are designed handle tax impacts on Sales
Orders and Sales Returns.

In order to use India Local taxes, you need to navigate to the open standard application 
Sales Order screen by navigating through Sales Order (Localized) screen. You need to 
complete Standard Applications Order form. On saving the Sales Order in the standard 
applications, data required for the localized Sales Order will get created. Based on the 
tax defaulting set ups, the localization taxes will get calculated automatically. For 
defaulting the taxes are depended on the tax defaulting set up hierarchy mapped for 
localization taxes. Taxes can get defaulted based on the association of Item Category to 
the Customer Sites or based on the Tax Category set up. You have an option to Delete 
or Add localization taxes if you need to modify the defaulted taxes. Deletion of taxes 
will be restricted if the taxes intended for deletion has an impact on the tax precedence 
calculation.

The India Local Sales Order is a view form, shows the Item, UOM, Quantity Ordered, 
Item Category List, Unit Price, Order Line amount, which are defaulted from Standard 
Apps Sales Order form. However, you can change the defaulted Service Type before 
closing or shipment of the order.

Tax Amount, Line Amount and Assessable Value will be defaulted and are also 
displayed but you can modify that in the India Local Tax Details form through Taxes.

You need to use the same screen for creating Sales Orders and RMA Orders.

If the Customer has a Letter of Credit and shipment against such Order is to be matched
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against a Letter of Credit, then the Order must be marked as LC enabled by ticking on 
the LC Flag.

Creating Sales Order and RMA Orders
In Oracle Financials for India, navigate to the India Local Sales Order window from 
India Local Order Management > Orders , Returns > Orders/returns (Localized)

Field Description Type Action Description

Header level      

Customer
Name/Number

(Displayed)   The Customer Name and the
Number will be displayed here
from Standard Apps Sales Order
Form.

Order Type (Displayed)   The Order Type selected in the
Standard Apps Sales Order Form
will be displayed here.

Order Number (Displayed)   The Order Number allotted in the
Standard Apps Sales Order Form
will be displayed here.

Order Date (Displayed)   The Order Date of the Standard
Apps Sales Order Form will be
displayed here.

Ship To Location (Displayed)   Ship To Location Id of the
Customer will be displayed here
from Standard Apps Sales Order
Form.

Order Line total (Displayed)   The Order Line Amount
appearing in the Standard Apps
Sales Order Form in will be
displayed here.

Tax total (Displayed)   This field shows the total of the
Localization taxes worked out for
the Sales Order/Sales Returns
Order.
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Field Description Type Action Description

Excise Exempt Type (Optional)   If you need to carry out an
exempted transaction, the
Exemption Type needs to be
picked up in this field. For
transactions on payment of duty,
this field need to be left as null.
Whenever you pick for an
Excise-Exempted Transaction you
need to enable the
Excise-Exempted Flag in the line
level. The excise exemption
options are:

CT2 IND

This option needs to be mapped
to the requirements under Rule 20
of the Central Excise Rules. This
Amount will not be accounted in
the Receivable.

CT2 OTH IND

In case the Customer needs to be
Debited for the Excise Duty under
of the Central Excise Rules, this
option need to be used. As per the
provisions of the above rule, Duty
debited should not be debited to
the Customer.

CT3 IND.

This option needs to be picked up
for clearance of goods to 100%
Export Oriented Units without
payment of Duty against CT 3
Certificate.

Excise Exempted Certificate IND /
Excise Exempted Certificate -
Others - IND

This option may be used for
transactions without payment of
duty
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Field Description Type Action Description

LC Flag (Optional) CHECK BOX This field should be ticked for
marking the Order as a LC
enabled Order.

Field Description Type Action Description

Exemption Ref. No. (Required/Opti
onal)

  You can use this field to input the
details of the
Document/Transaction on which
Exemption is claimed from
payment of Duty.

Excise Exempt date (Required/Opti
onal)

  You need to enter date CT2 Form,
CT3 Form, Excise Exemption
Certificate respectively.

VAT Exemption Type (Optional)   If you need to carry out an VAT
Exempted Transaction, the
Exemption Type needs to be
picked up in this field. For
Transactions where VAT is
payable, this field need to be left
as null. Whenever you pick for an
VAT Exempted transaction, all
the lines get the VAT exempted
flag and the VAT Exemption type
defaulted. If for any line, VAT
Exemption is not applicable, then
you can uncheck the VAT
Exemption for such line. The VAT
Exemption types are:

• VAT Exemption Item

• Export

• Inter State Sale

• Sale to Specified parties,
Transfer
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Field Description Type Action Description

VAT Exemption Date (Required/Opti
onal)

  This field becomes required when
VAT Exemption Type is selected.

VAT Exemption
Refno

(Required/Opti
onal)

  This field becomes required when
VAT Exemption Type is selected.

Order Total (Displayed)   The Total Order Amount
including Order Line Amount
and the Tax Amount for all the
Items in an Order will be
displayed here.

Line level      

Line Number (Displayed)   The Line Number appearing in
the Standard Apps Sales Order
Form will be displayed here.

Shipment Line
Number

(Displayed)   The Shipment Line Number
appearing in the Standard Apps
Sales Order Form in will be
displayed here.

Item (Displayed)   The Item selected in the Standard
Apps Sales Order Form for a line
will be displayed here.

UOM (Displayed)   The UOM for the above Item
appearing in the Standard Apps
Sales Order Form in will be
displayed here.

Quantity (Displayed)   The Quantity entered in the
Standard Apps Sales Order Form
for a line in will be displayed
here.

Tax Category (Displayed)   The Tax Category associated to
the above item in the Item
Category List will be displayed
here.
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Field Description Type Action Description

Assessable Value (Displayed)   The Assessable Price as defined in
the system for this Item will be
displayed here.

Unit Price (Displayed)   The Unit Price of the Item will be
displayed here.

Extended Price (Displayed)   Extended Amount is the
multiplication of Quantity and
Unit price for a item appearing in
a line.

Tax Amount (Displayed)   Tax Amount for a item in a line is
displayed here. If you modify the
tax lines, then the modified Tax
Amount for a item from the India
Local Tax details form will be
displayed here.

Line Amount (Displayed)   The Line Amount is the total of
Extended Amount and the Tax
Amount for a line.

Excise Exempted   CHECK BOX If a Line Item is exempted from
Excise Duty, then you need to
enable this Flag. This is enabled
only if you select an Excise
Exempted Transaction.

VAT Exemption Flag   CHECK BOX Once at header level a Order is
marked as VAT Exempt, this
check box will get checked. If any
particular line is not supposed to
be VAT Exempt, the box should
be unchecked.
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Field Description Type Action Description

VAT Exemption Type (Optional)   If you need to carry out an VAT
Exempted Transaction, the
Exemption Type needs to be
picked up in this field. For
Transactions where VAT is
payable, this field need to be left
as null. Whenever you pick for an
VAT exempted transaction, all the
lines get the VAT Exempted flag
and the VAT Exemption type
defaulted. If for any line, VAT
Exemption is not applicable, then
you can uncheck the VAT
exemption for such line. The VAT
Exemption types are:

• Vat Exemption Item

• Export

• Inter State Sale

• Sale to Specified parties

• Transfer

VAT Exemption Date (Required/Opti
onal)

  This field becomes required when
VAT Exemption Type is selected.

VAT Exemption
Refno

(Required/Opti
onal)

  This field becomes required when
VAT Exemption Type is selected.

Important: The Sales Order will display following message when for 
any line the Tax Setup is not made and as a result does not have taxes. 
This is useful mainly to ensure that all the items entered in the Sales 
Order have appropriate tax setup.

India Local Tax Details - Sales Order
India Local Tax Details screen displays Taxes for the current line in the Sales Order- 
Localized screen. All the Taxes related to that Sales Order line could be viewed by 
clicking the Taxes Button. You can view the Taxes defaulted for the Item and have an 
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option to Update/Add/Delete the taxes defaulted. If you make some changes in the 
defaulted taxes, you need to click the apply button to make the tax modifications 
effective. After applying the Tax modifications, you need to save the record.

You can check the Tax Name, Tax Type, Tax Rates, Unit of Measurement, Precedence 
logic for calculation of taxes and the taxes calculated for each line item. No precedence 
logic and tax rates will be available for an adhoc type of tax.

Specifying Tax Details
In Oracle Financials for India, navigate to the India Local Tax Details window from 
India Local Order Management > Orders > Returns > Sales Order (Localized) > Taxes

All the above fields are displayed as per the taxes defined in the window for an item 
associated with a respective customer.

Important: System will show the following message & open the tax 
window in display mode based on status of the Sales Order line. 

Similarly Taxes will be shown in a display mode when a Sales Order line status is 
reflected as 'SHIPPED'. Please refer the Alert.

• In any event of data inconsistency where the taxes in the above tax 
window do not match with the taxes as displayed in the India Local
Sales Order the base shipment will be stopped with the following 
message:

• " ORA-20405 - Taxes are not matching in JA_IN_SO_LINES and 
JA_IN_SO_TAX_LINE FOR LINE_ID"

• Under this condition, Query the Sale Order & open the above tax 
window. Correct the tax lines & then carry out Shipment.

• When deleting defaulted taxes, you need to click on Apply and 
Save to save the deletions prior to adding new taxes. No doing so 
will result in deletion of newly added taxes as well.

Returns (Localized)
In Oracle Financials for India, the localized information of the Sales Return Order can be
viewed from the India Local Sales Order screen and the fields are discussed in earlier. 
You need to click the return tab region to view the tax related information/localized 
item information pertaining to a Sales Return Order.

Taxes on Sales Return Order appears as default and displayed in read only mode when 
the Return corresponds to a delivery detail id. The Tax details are opened in editable 
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mode only when such Return is made without reference and taxes are based on the 
setup definitions.

The Screen can be invoked through India Local Order Management > Orders, Returns > 
Sales Order (Localized) > Return Tab

Line Level Details :

Field Description Type Action Description

Line (Displayed)   The Line Number appearing in the
Standard Apps Sales Order Form will
be displayed here.

Delivery Detail id (Required)   The Delivery Detail id against which
this RMA Line is being entered. Taxes
from Shipment are supposed to be
based on the delivery Detail id entered
here.

Item (Displayed)   The Item selected in the Standard Apps
Sales Order Form for a line will be
displayed here.

UOM (Displayed)   The UOM for the above Item appearing
in the Standard Apps Sales Order Form
in will be displayed here.

Quantity (Displayed)   The Quantity entered in the Standard
Apps Sales Order Form for a line in will
be displayed here.

Unit Price (Displayed)   The Unit Price of the Item will be
displayed here.

Assessable Value (Displayed)   The Assessable Price as defined in the
system for this Item will be displayed
here.

Line Amount (Displayed)   Line Amount is the multiplication of
Quantity and Unit Price for a Item
appearing in a line.
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Field Description Type Action Description

Tax Amount (Displayed)   Tax Amount for a Item in a line is
displayed here. If you modify the tax
lines (for RMA without reference), then
the modified Tax Amount for a Item
from the India Local Tax details form
will be displayed here.

Total Amount (Displayed)   Total Amount is the sum of Line
Amount and Tax Amount for a Item
appearing in a line.

Excise Duty Rate (Required)   The Excise Duty Rate at which Excise
has been charged for a Trading Scenario

Rate per Unit (Required)   The Rate per unit at which Excise has
been charged for a Trading Scenario

Recd. Flag   CHECK
BOX

This indicates that the Item has been
received.

Allow Excise Tax   CHECK
BOX

Unchecking this would mean that the
Credit Note generated against such
RMA Order should be without Excise
Duty

Allow Sales Tax   CHECK
BOX

Unchecking this would mean that the
Credit Note generated against such
RMA Order should be without Sales
Tax

RMA Return/Receipt (Localized)
RMA Receipts should be created using the new screen (common for PO Receipts and 
RMA Receipts). You should navigate from this screen to the base receiving screen and 
complete the RMA receipt transaction. You should capture additional details related to 
the receipt, such as RMA Type, Excise Invoice details etc. in the India Localization 
screen.

The user has the facility to use the "Populate Defaults" feature. This feature allows the 
users to populate same Excise Invoice number and date for multiple lines.

Localization will create entries depending on Return Type.
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Return Type Effect in RG Registers and accounting

Production Input Update Register for Quantity depending on Item
Class. Update RG 23 A part II information CENVAT
Flag Is Checked and corresponding accounting are
passed

This Type need to be used by units who will be using
the Sales Returns as their Raw Materials. For e.g.,
Foundry Units, where a casting is returned as
defective due to air crack, the defect cannot be cured,
but the defective casting can be recycled. For this type
of transactions, the Organization needs to file
declarations and get the consent/acknowledgment
from the Local Excise Authorities.

Return Under 173L This Option is no Longer valid due to changes in
Excise Laws.

Scrapped No RG Register update will be made.

Excise Expenses account will be debited for Excise
Amount.

FG Return No RG Register update will be made.

Excise Expenses account will be debited for Excise
Amount.

Following are the Accounting entries passed based on the Return type.

RMA Receipts considered as 'Production Input'

CENVAT Credit For Excise and CVD Taxes

Account Debit Credit

CENVAT A/c Tax Amount  

Excise Paid Payable Account   Tax Amount

RMA Receipts considered as 'Finished Goods Return'

Localization accounting entry for Excise Tax treatment 
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Account Debit Credit

Excise Expense a/c Excise Amount  

Excise Paid Payable Account   Excise Amount

Excise duty paid will be written off as Excise expense Account. 

RMA Receipts considered as 'Scrap'

Account Debit Credit

Scrap Cost a/c Item cost  

Sub Inventory a/c   Item cost

Localization accounting entry for Excise Tax treatment

Account Debit Credit

Excise Expense a/c Excise Amount  

Excise Paid Payable Account   Excise Amount

(Excise Duty Paid will be written off as an expense account)

RMA Return/Receipt - Trading Item
The following are the possible scenario in the case of Customer Return for a Trading 
Item in a Trading Organization

Transaction/Description

RMA Receipts - The goods are totally damaged and the Customer is not looking for any
replacement. RG23D- Receipts entry will be passed for the Rejected Qty. Ref. Document:
The Customer Invoice for returning the goods.

RMA Receipts - Customer is looking for Replacement. No RG23D Entry RMA Receipts 
as well return to Customer will be handed through separate D.C or valid documents.

RMA Return - For the above RMA Receipts No RG23D Entry RMA return to Customer 
will be handed through separate D.C or valid documents.
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Important: The Dealers need to inform to the Range Superintendent 
regarding the Goods Returns.

Use of LC Functionality
Oracle Financials for India also provides the LC functionality. The following are the 
details how the user can use the LC Functionality.

Create LC Master
LC Master holds the Master Information. You can record the details of the Letter of 
Credits received by the Organization. He should be able to make amendments, view the
transactions against each LC and the Balance available at any point of time.

Navigation: India Local Order management - Letters of Credit - Letters of Credit - 
Master

Field
Description

Type Action Description

LC Number (Displayed)   The LC Number is system generated,
once the details are entered and saved
to create an LC.

Reference
Number

(Required /
Protected)

EDIT Reference Number is required to be
entered while creating a new LC.

LC Type (Required /
Protected)

PICK The LC Type has to be chosen from
available LOVs. This enables you to
record the type of LC as one of
'Revolving', 'Revocable', 'Irrevocable'
and 'Confirmed Revocable'. There is no
change in behavior based on LC Type.

Customer
Name/Number

(Required) EDIT You can pickup a valid Customer for
whom Localization setup exists and his
Number.

Description (Required) EDIT Description of the LC is entered. This is
not protected from updation and can be
edited latter on.

Original
Amount

(Required) EDIT LC is opened with an Initial Amount.
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Field
Description

Type Action Description

Balance Amount (Displayed)   This Balance Amount is defaulted after
each matching against the LC.

Start Date (Required /
Protected)

EDIT Start Date From which the entered LC is
effective.

End Date (Required /
Protected)

EDIT End Date till which the entered LC is
effective

Negotiation
Days

(Required /
Protected)

EDIT Negotiation Days as per the LC

Last Negotiation
Date

(Required /
Protected)

EDIT Last Negotiation Date of the LC

Credit Period (Required /
Protected)

EDIT Credit Period for the LC

Last Ship Date (Required /
Protected)

EDIT Last Date until which Shipment can be
carried out against this LC

Issue Bank
Name / Issue
branch Name /
Issue Bank
Address

(Required /
Protected)

EDIT Issue Bank Details of the LC

Negotiation
Bank Name /
Negotiation
branch Name /
Negotiation
Bank Address

(Required /
Protected)

EDIT Negotiation Bank Details of the LC

Remarks (Optional) EDIT Remarks of the LC can be entered. Not
Protected from updation.

Qty.
Amendment

Button   This screen has been provided to amend
Quantity matched, for any possible user
mistake.
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Field
Description

Type Action Description

Amendments Button   This screen has been provided to amend
LC Values and details, for any possible
user mistake.

View
Transactions

Button   This screen has been provided to view
all transaction done against the specific
LC.

Quantity Amendment
To refer the Screen Navigate through : India Local Order Management - Letters of 
Credit - Letters of Credit - Master - Qty Amendment Button.

Field Description Type Action Description

Order Header (Optional) EDIT Order Number

Order Line (Optional) EDIT Order Line id

Qty Released (Optional) EDIT Quantity Received against the Order.

Qty Matched (Optional) EDIT Quantity Matched against the LC

LC Type (Optional) EDIT The LC Type against which matching is
done

LC Number (Optional) EDIT The LC Number for which the record is
being displayed

Amount (Optional) EDIT The Amount matched against the
particular LC

Amendments
To refer the Screen Navigate through : India Local Order Management - Letters of 
Credit - Letters of Credit - Master - Amendment Button.
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Field Description Type Action Description

SL / No (Required) EDIT SL No of the Amendment

LC Number (Optional) EDIT LC Number against which Amendment
is to be entered

Amd Date (Optional) EDIT Date of Amendment

Amd Amount (Optional) EDIT Revised / New LC Amount

Negotiation Date (Optional) EDIT New Negotiation Date as per
Amendment.

Shipment Date (Optional) EDIT Revised Last Shipment Date as per
Amendment

Description (Optional) EDIT Description for the Amendment.

View Transactions
To refer the Screen Navigate through : India Local Order Management - Letters of 
Credit - Letters of Credit - Master - View Transactions Button.

Field Description Type Action Description

SL / No (Display)   SL No of the Transaction

Customer Id (Display)   Customer Number against which LC
pertains

Order Header (Display)   Order Number

Order Line Num (Display)   Line Number of the Order

Qty Released (Display)   Quantity Released against the Order

Qty Matched (Display)   Quantity Matched against this LC

LC Type (Display)   LC Type for the given LC
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Field Description Type Action Description

LC Number (Display)   LC Number to which the Order line is
matched

Amount (Display)   Amount of the Order Line for this LC

LC Matching
Navigation: India Local Order management - Letters of Credit - Letters of Credit - 
Matching

This will be displayed as entered in the Base Apps Sales Order Screen. LOV's are 
available.

At Line Level

Field Description Type Action Description

Customer Name Required   Name of the Customer will be
entered for the LC
transactions to be matched.

Customer Number     Number of the Customer will
be entered for the LC
transactions to be matched.

SL / No (Display)   SL No of the Transaction

Order Number (Required) LOV Order Number which needs
to be Matched

Order Line Number (Required) LOV Order Line Number which
needs to be Matched

Delivery Detail ID (Required) LOV Delivery Detail ID which
needs to be Matched

Item Name (Display)   Item Name

Qty Released (Display)   Quantity Released against the
Order
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Field Description Type Action Description

Qty Matched (Required)   Quantity to be Matched
against this LC

LC Type (Display)   LC Type for the given LC

LC Number (Display)   LC Number to which the
Order line is matched

Important: If an Order is LC enabled, the Delivery needs to be matched 
fully with a LC for the Customer prior to Ship Confirming, else system 
will prevent the Shipment from taking place, till such Matching is 
completed.

If the Matched Quantity is not equal to the quantity being shipped, the 
base shipment will be stopped with the following message:

' ORA-20401 LC Matched Quantity - X should be equal to Shipped 
Quantity - Y for LC enabled Orders'

In the given case match the balance quantity & then try shipping.

If the Order is Attached to Bond Register / LUT (Letter of Undertaking) 
Excise Duty and Excise Cess will not be considered for LC Matching.

LC Matching can be carried out provided the LC Balance is equal or 
more than the Order Amount.

Shipment Confirmation (Localized)
You can enter any one of the following fields, such as Departure Name, Customer, 
Order Number, Batch Name, Ship date, Delivery Name, Warehouse, Order type, 
Waybill to help in specific query of records in the Ship Confirmation Screen.

Before dispatching the goods, the Sales Order needs to be released and the shipping 
need to be Confirmed through the standard application. . You need to take enough care 
to ensure that the correct taxes are defaulted in the Sales Order before 
Releasing/Confirming the shipment of the Order.

Warning:  The localization taxes cannot be modified once the Order is 
Released/Shipped

Immediately on Ship Confirmation, Excise related records would get updated. You can 
view the Excise and Other Tax Information related to the Shipment using Ship Confirm 
- Localized screen. You can query for an existing Shipment based on the Order 
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Number/Delivery Number.

You have an option to add any taxes of tax type Freight in the tax region of the Ship 
Confirm localized screen. The freight added in this screen will be considered while 
running the Auto Invoice program and the same will get accounted in the Receivables 
Module.

Confirming Shipment
In Oracle Financials for India, navigate to the Shipment Confirmation India Localization
window as follows:

Shipping > Confirm Shipments > Ship Confirm (Localized) > Find

Field Description Type Action Description

Operating Unit (Required) (Pick) The Operating Unit for which the
Shipment needs to be queried.

Header level (Display
only)

  Relevant Shipping Information like
Delivery Number, Order Number,
Customer Name, Order Type, Ship
To, Excise Exemption Type, Way Bill
Number, Line Total, Excise
Exemption Reference Number,
Excise Exemption Date, Tax Total
and Order Total Amount are
displayed.

Fields discussed below pertains to the localized information.

Field Description Type Action Description

Excise Exemption
Type

(Display
only)

  Excise Exemption Type will be
displayed if an Order is against
CT2,CT3 and Exemption Certificate.

Excise Exemption Ref
No

(Display
only)

  Excise Exemption Reference
Number of CT2,CT3 and Exemption
Certificate will displayed if an Order
is against CT2,CT3 and Exemption
Certificate.
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Field Description Type Action Description

Excise Exemption
Date

(Display
only)

  Date of CT2,CT3 and Exemption
Certificate will displayed if an Order
is against CT2,CT3 and Exemption
Certificate.

Tax amount (Display
only)

  Total Tax for the Shipment will be
displayed .

Total amount (Display
only)

  Total Amount (Total Line Amount +
Total Tax Amount) for the Shipment
will be displayed.

Item Name (Display
only)

  You can use this field to query in all
Orders with the Item entered here.
On executing this query the system
would fetch all Shipments that have
the specified item in the lines.

Matching Items Only (Display
only)

  You can use this field in combination
with 'Item Name' field. On executing
a query with this field checked in
combination with Item Name, the
system would fetch all shipments
that contain this Item. The lines
would be restricted to the queried
Item.

Excise Invoice No (Display
only)

  You can use this field query on all
shipments. On querying on the
Excise Invoice No. all shipments
with this Excise Invoice Number
would be retrieved.

Line Level

Line number     Line Number of the Item displayed
against the delivery will be
displayed

Item Name     Item Code of the Item shipped
against the line covered under the
delivery will be displayed.
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Field Description Type Action Description

Description     Description of the Item shipped
against the line covered under the
delivery will be displayed.

UOM     The Unit of Measurement of the
Item covered under the delivery will
be displayed.

Shipped     Quantity shipped against the line
covered under the delivery will be
displayed.

Warehouse     The Organization from where the
goods were delivered will be
displayed in this field.

Location     The Excise Location from where the
goods are delivered will be
displayed in this field

Excise Invoice
Number

(Display
only)

  Excise Invoice Number for the
Shipment will be displayed.

Preprinted Invoice
Number

    This Field can be used by clicking on
the Pre Print Invoice Nos which will
take From and To Numbers and
populate all lines with the value.

Register     The Duty paying Register selected
for debiting the payment of duty
will be displayed. Duty will be
debited to any of the duty paying
Registers based on the priority
specified in the Additional
Organization Information screen.

Tax Category (Display
only)

  Name of the Tax Category used for
this line will be displayed.

Tax Amount (Display
only)

  Line Tax Amount will be displayed.
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Field Description Type Action Description

Line Amount     Line Amount of the Item against the
line delivered will be displayed in
this field.

Total Line amount (Display
only)

  Total Amount for a Line will be
displayed.

AR3A Form Number
/ AR3 A Date

    If you dispatch goods based on CT-3
clearances/Excise Exempted
Transaction the AR-3 Number/other
document reference and date can be
entered in this field.

Important: If tax details do not get populated in the above screen, (even
due to invalid / disabled triggers) the same is treated, as Shipment 
without taxes and taxes will not flow to Accounts Receivable Module. 
In such cases, User has to raise a Debit Note for Tax Amounts in 
Receivables & pass Manual Entries in Excise Registers. The Excise entry
number can be recorded in pre-printed Excise Invoice Number for 
tracking purposes. 

Bond Register

In the Sales Order if you select an Order Type associated with the 'Bond Register' Excise
Transaction Type, duty will not be debited in any of the duty paying registers. Instead, 
the duty will be debited to the running bond account balance.

Shipment created based on these Order Types would be considered for the update to 
Bond Register. A record would be created in the Bond Register on running the 'Excise 
Invoice Generation' program. The Bond Amount would be reduced by the Amount of 
Transaction.

The system would raise an application error and interface trip stop would complete 
with an error, whenever, the amount of Bond Credit is lesser than the Excise Duty 
applicable to the Export Transaction. The same would not be applicable to the Bonds 
that have been checked as LUT's.

The system would also raise application error where the Shipment Date is greater than 
the Bond Expiry Date. 

You can view the Transactions under Bond through the View Bond Register screen. The
duty amount debited in the Bond Register can be credited on admission of the proof of 
export by the Excise Authority.

To view the transactions related to the Bond, select the Organization, Location and 
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Bond Number. The lines would reflect the transactions related to the Bond. Bond 
Amount entered in the Define Bond Register screen would be shown as the Bond 
Credit. This would be the first transaction. A record would be created for every 
shipment transaction with the Transaction Name as 'Bond Sales'. Register Balance 
would be reduced to the extent of this Excise Duty on the transaction.

India Local Order Management - Setup - Registers - Bond Register Summary

Field Description Type Action Description

Operating Unit (Required) (Pick) The Operating Unit for which the
Bond Register is being queried.

Organization Name (Enter)   The Inventory Organization for which
you want to check the Bond Register

Location (Enter)   The Inventory Location for which you
want to check the Bond Register

Bond Number (Enter)   User can select appropriate Bond
Number from the list of LOV's. User
can select a value in this field only
after selecting the Organization and
Location.

Bond Expiry Date (Displayed)   Value in this field would be displayed
on selecting the Bond Number.

Letter of
Undertaking.

(Displayed) Check box This would be a display field and
would indicate whether the Bond is a
Letter of Undertaking.

Transaction Name (Displayed)   The Transaction Name will be
displayed here for the transaction
line.

Transaction Amount (Displayed)   The Transaction Amount will be
displayed here for the transaction
line.

Register Balance (Displayed)   The Register Balance post the given
transaction

Order / Invoice (Displayed)   Wether the transaction has come from
an Order or a Manual Invoice from
AR Module.
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Field Description Type Action Description

Order Invoice
Number

(Displayed)   The Order / Invoice Number will be
displayed here for the transaction
line.

Transaction Type (Displayed)   The Transaction Type will be
displayed here for the transaction
line.

Excise Invoice
Number

(Displayed)   The Excise Invoice Number will be
displayed here for the transaction
line.

Export Approval No (Displayed)   The Export Approval Number will be
displayed here for the transaction line
under which the proof of export is
admitted.

On receipt of proof of export for a particular transaction, you can take credit of the Bond
amount in the view Bond Register. This you can do by navigating to Tools, Enter 
Approval Number. This would display a sub window where you can record the 
Approval Number. On saving the record, the duty amount will get credited in the 
running Bond Account.

Tools - Enter Approval Number.

This displays the sub window where the user can record the Approval Number. On 
saving the record, the duty amount will get credited in the running bond account.

Running Bond Register
In Oracle Financials for India, navigate to the Bond Register Summary India 
Localization window as follows:

India Local Order Management > Setup > Registers > Bond Register Summary > Tools > 
Enter approval No

Field Description Type Action Description

Organization/Locatio
n

(Displayed)   The Inventory Organization and its
Location will be displayed here from
the transaction line.
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Field Description Type Action Description

Transaction Type (Displayed)   The Transaction Type will be
displayed here from the transaction
line.

Order Invoice
Number

(Displayed)   The Invoice Number will be displayed
here from the transaction line.

Transaction Amount (Displayed)   The Transaction Amount will be
displayed here from the transaction
line.

Export Approval No (Required) ENTER You can record the AR4 Number and
the document reference under which
the proof of export is admitted.

Important: The Number once entered is not allowed to be changed and 
due care needs to be taken while entering the same to enter the correct 
value.

The facility provided is to enter the number against each invoice only 
and group entry features are not possible.

Excise Exempted Sales Orders 

By selecting an Excise Exemption Type from the Localized Sales Order, you clear 
excisable goods without payment of duty under specific conditions. Excisable goods 
can be cleared from the factory without payment of duty to a 100% Export Oriented 
Unit against CT 3 Certificates under the cover of AR3. Excise Exemption options 
available for the users.

See Also: The features of excise exemption are discussed in detail under the topic Sale 
Order - Localized.

AR3 A Form Receipts
Clearance without payment of Duty under AR-3A needs to be tracked for Receipt of 
Re-warehousing Certificate. This legal requirement can be mapped through this 
functionality. All clearances under Excise Exemptions will be recorded in this screen 
and on Receipt of the Authenticated Document, the receipt date can be recorded. By 
viewing this screen, you can monitor the Re-warehousing certificates that need to be 
received from the Customers at any point of time.

Through the find query form you can view the AR3A forms to be received for a 
particular Customer or all Customers.
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Tracking AR3 Form Receipts
In Oracle Financials for India, navigate to the India Local AR3 Form Receipt Tracking 
window as follows:

India Local Order Management > Customers > AR3 A form Receipts Tracking

Field Description Type Action Description

Customer Block     Details regarding the Customer will
be displayed.

Customer Name (Displayed)   Customer Name will be displayed.

Customer Number (Displayed)   Customer Number of the above
Customer will be displayed.

Customer Site (Displayed)   Customer Site (Ship to) will be
displayed.

Transaction Block (Displayed)   Details regarding the transaction will
be displayed.

Type     Type of transaction either Order or
Invoice will be displayed.

Source (Displayed)   Source for the above type of
transaction will be displayed.

Number (Displayed)   Number of the transaction will be
displayed.

Form Block     Details regarding CT2, CT3 and
Excise Exemption Certificate will be
displayed.

Form (Displayed)   Form Type like CT2,CT3 and Excise
Exemption will be displayed.

Number (Displayed)   Number of CT2,CT3 and Excise
Exemption Certificate will be
displayed.
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Field Description Type Action Description

Date (Displayed)   Date of the CT2, CT3 and Excise
Exemption Certificate will be
displayed

AR3A details block     Details of AR3A Forms for a
transaction will be displayed here
and once the AR3A forms is received
back from a Customer, the same can
be entered in this block in received
date column.

Delivery Number (Displayed)   Delivery Number will be displayed.

Delivery Name (Displayed)   Delivery Name will be displayed

Delivery Date (Displayed)   Delivery Date will be displayed

AR3A Form Number (Displayed)   AR3A Form Number will be
displayed.

Date (Displayed)   AR3A Form Date will be displayed.

Received Date (Enterable)   The Date on which the AR3A forms
were received back from the
Customer. After receipt of an AR3A
form, it will be removed from the
outstanding list of AR-3A form to be
received from a Customer.

Important: Delivery Number, Name and Date will be visible only for 
Order Management transactions and will not show any value for 
Manually entered Receivable transactions.

In the Find window, Order/Invoice refers to query option of querying 
for an Order entered through Order Management or Invoice entered 
through Transactions (Localized) in Receivables. Invoice does not list 
Imported Invoices against Order Management.

Reports
This section provides overview and detailed descriptions of these reports:
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• Commercial Invoice

• India - Excise/VAT Invoice Template

Commercial Invoice
This report gives you the Commercial Invoice that covered "ISSUE OF INVOICE 
UNDER CENTRAL EXCISE RULE 57G OR 57T". This section is no longer valid, 
however the report is not dropped so that the fields appearing in the report can be used 
as an example or base for client required output to generate and print Invoices.

Report Submission

Use the Submit Requests (India Local AR and OM Modules) form and enter India-
Commercial Invoice Report in the Name field to submit the report.

Report Parameters

Parameter Description Required/Optional Action

Organization Enter the 
organization from 
which delivery of 
goods is made.

Optional Pick

Location Enter the location of 
the organization.

Optional Pick

Customer Enter the customer 
name.

Optional Pick

Order/Invoice Quick field for this 
field are Order and 
Invoice.

Optional

Invoice Commercial Invoices 
that the user wants to 
print.

Required

India - Excise/VAT Invoice Template
This report gives you the Invoice Template, provided as an example of the Excise/VAT 
Invoice that is to be generated. Fields appearing in the report can be used as an example
or base for Customer required output to generate and print Invoices. You can use this 
template to customize your requirement of invoice printing as appropriate.
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Note: The format of the actual invoice is left to the manufacturer to 
decide and hence only a generic template is provided.

This report is primarily based on Shipping data, and will not handle the following:

• Standalone AR Invoices (entered through Transactions Localized)

• Invoices for Bill Only Workflow

• Excise Invoice generated for RTV

• Excise Invoice generated for Manual PLA and RG23A/C, RG1 entry

Report Submission

Use the Run Reports from India Order Management module to be invoked from the 
order management reports request group and enter India Excise/VAT Invoice Template 
in the Name field to submit the report.

Report Parameters

Report Parameter Type Action Description

Organization Name Required PICK The Inventory 
organization for 
which the report is 
being generated. This 
allows all Inventory 
organizations and 
does not restrict 
based on Operating 
Units attached to the 
user.

Location Optional PICK The Inventory 
Location for which 
the report is being 
generated. This needs
to be left blank if all 
locations are to be 
printed. This gets 
enabled only if the 
Inventory 
Organization is 
selected.
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Report Parameter Type Action Description

From Date and To 
Date

Required Start Date and End 
Date for which the 
report is being run. 
This can be used 
leaving the number 
blank in case you 
want to generate the 
report for a range of 
transactions. This 
field is however 
required to restrict 
printing of invoices to
a specific year when 
there are same 
numbers across 
various years in the 
given organization 
location combination.

Delivery Optional PICK LOV shows list of all 
available Deliveries 
based on From Date 
and To Date entered. 
Selecting a value in 
this field indicates 
user wants to print a 
single document for 
which he already has 
the number.

Note: When a Single Delivery has both excisable and non-excisable 
material to be shipped together, the same would display in a single 
invoice split into two. This is because the Excise Invoice number is a 
header level field in the report but stored at line level in the current 
product architecture, when a invoice which has both excisable and non 
excisable items being shipped together, the report will show All 
excisable lines as one invoice with Excise Invoice number in header and
will show all non-excisable lines as a separate invoice with Excise 
Invoice number appearing as blank.
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5
India Local Receivables

This chapter covers the following topics:

• Transactions (Localized) Overview

• Managing TCS Trasactions

• TCS Settlement

• Tracking of ST Forms Receipts

• AR 3A Form Receipt Tracking Overview

• RG Consolidation

• Supplementary Transactions Overview

• Duty Drawback Processing

• TDS Certificates Received Overview

• Setting Up India Local Receivables

• Setting Up Concurrent Programs

• Managing Receivables Transactions

• Using Sales Tax Declaration Forms - Receipt Tracking

• Reports

Transactions (Localized) Overview
You can create transactions with localized taxes in the Receivables module. The taxes 
would be calculated for the item, based on Tax defaulting setup. You will also have a 
facility to add localization taxes manually.

Where information flows into Transactions while running the auto invoice program, the
localization taxes defined in order management module would flow into Transactions 
(localized) window.

The Transactions (Localized) functionality lets you satisfy all your needs related to Tax 
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calculation required for an Accounts Receivables Transaction. You can:

• Define Item categories to Customer and Customer sites. This would be the basis for 
taxes defaulting to Transactions.

• Assign assessable prices to items. This price would be the basis for excise duty 
calculation. The Assessable Price lists can be attached selectively to Customer Sites.

• Create Transactions from Localization window. This would automate tax defaulting
and calculation.

• Taxes so defaulted can be changed by the user.

• Payment Register is defaulted based on the precedence logic and can be changed 
manually if required.

• User has an option to enter pre-printed Excise Invoice Number against such Invoice
generated for the sake of printing or future reference.

• Import transactions by running auto invoice program. This would default taxes 
defined for a Sales Order to Transactions (Localized).

• Match Receipts in case of Trading Organization, to pass on the Excise Duty Credit 
to the transaction

• Generate sequential Excise Invoice number

• Update the excise registers. Based on the set up in Bond register, excise transactions 
will get recorded in the respective excise records and excise Invoices can be created.

• VAT taxes can be attached if the Invoice has lines with Inventory item, which has 
been defined as VAT attribute 'Applicable'.

• Completion of the Invoice would result in generation of VAT Invoice number based
on the setup carried out.

• Option of calculation of VAT taxes based on VAT Assessable value is possible 
based on setup at Customer Additional Site level setup.

• An Invoice can be marked as VAT Exempt from the seeded types of exemption.

• Service Tax type of Taxes can be attached to a Transaction being created.

Major Features
Defaulting Taxes to Receivables Invoice

You have an option to use Localization taxes while creating an invoice in the 
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Receivables module. These taxes can either be defaulted based on the Tax Defaulting 
Rules or can be attached manually. The automatic Tax Defaulting would be based Item 
Category assigned to the Customer, Customer Site or based on the Item Class assigned 
to the Tax Category.

Manual Changes to Defaulted Taxes to Receivables Invoice

The Taxes defaulted can be changed manually, if required. You can also change the 
defaulted Service Type before completing the transaction.

Note: In case the transactions are imported from Order Management, 
Service Type cannot be changed using this form.

Generation of Excise Invoice

If the Invoice that you have created has excise type of taxes, you can generate an Excise 
Invoice for the transaction. All excise related registers will get updated on completion of
the transaction.

Generation of VAT Invoice

If the Invoice that you have created has VAT type of taxes, and the item is marked as 
VAT able you can generate an VAT Invoice for the transaction. The tax repository will 
get updated on completion of the transaction. 

Update of Excise Registers

Update of Excise Registers would be based on the set up of Bond registers. Based on the
Bond Register that is attached to the Transaction Type (in the Bond Register Setup) used
for the transaction, corresponding excise records would be updated.

Tax Base Amount

You can define precedence logic for calculation of Tax Base Amount on which the Tax 
Rate would be applied. The Tax Base Amount can either be the line amount or line 
amount including other taxes calculated for the transaction.

Match Receipts

If the creating the Invoice for a trading organization, you can match the Invoice line to a
Receipt. On doing this the excise amount would be proportionately passed on to the 
Invoice line.

Taxes on Credit / Debit Memo created against a Receivable Invoice

When the receivables Invoice created has the taxes applicable, and if the Credit Memo 
or Debit Memo is created against the given Invoice, then it will also consider all the 
taxes applicable for the Invoice (proportional to the quantity or percentage as specified).

Record Excise Exemptions

You can choose the Exemption Type applicable to the transaction. The effect on the 
Accounting entries and excise registers would vary based on the option chosen in this 
field.
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Record VAT Exemptions

You can choose the Exemption Type applicable to the transaction. The VAT tax will be 
changed to Zero if the same is marked as VAT Exempt.

Choose Update of RG Registers

You have an option to update the Payment Registers selectively. This you can do by 
un-checking the Update RG Flag.

Choose Register Preferences

By default, the duty will get debited in the register based on the register preference set 
up in the Additional Organization Information. User has an option to change the duty 
paying register for each transaction.

Enter Pre-Printed Excise Invoice Number

By default, the pre-printed Excise Invoice Number will be stored as Null. User has an 
option to change the same for each transaction. The numbers can be alpha numeric in 
nature and an option is provided to enter from and to numbers in cases where the 
Invoice is consuming multiple sheets of pre printed stationary.

Reports
Receivables generates these reports for India:

India- Debtors Ledger Report - Lists all the transactions with the Customer to arrive at 
the net liability for the Customer. You can use this report to get Debtors Sub-Ledger.

India-Debtors Trial Balance Report - Lists the closing balance for Customers as on 
date.

Total Sales Report - Lists the Sales transactions made from an Inventory Organization 
during the selected period.

Managing TCS Trasactions

Order to Cash Cycle
1. Enter a normal sales order with TCS Taxes. Save and Book it.

Note: If the customer billing exceeds Threshold limits, the Order 
will not show the Surcharge. This is because Order entry or 
booking is not a financial transaction and the event, when 
surcharge is applicable, is Shipping and invoicing only. Also, as 
Surcharge needs to be reversed when the total Threshold decreases,
such surcharge is not displayed in the order even after shipping or 
closure of order line.
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2. Pick Release and Ship Confirm the order. When you Ship Confirm with Surcharge 
limit exceeded, the Surcharge and Cess get auto-assigned.

3. Run Autoinvoice for this Order, which will import the Invoice into Receivables. 
Run the India Local Concurrent for Processing Order Lines to AR, which will 
populate these taxes in Oracle Receivables. You can query the AR invoice from the 
IL screen using the transaction number.

Bill Only Cycle
1. Enter a normal 'Bill Only' sales order with TCS Taxes. Save and Book it.

Note: If the customer billing exceeds Threshold limits, the Order 
will not show the Surcharge. Book this order. In bill only cycle, 
surcharge and cess on surcharge get included and computed on 
running the AutoInvoice.

2. Run Autoinvoice for this Order, which will import the Invoice into Receivables. 
Run the India Local Concurrent for Processing Order Lines to AR, which will 
populate these taxes in Base Receivables.

Standalone Receivables Invoice
1. Navigate to Transactions Localized , Open and create the transaction.

2. Then?

Advance Receipts
1. Create a normal receipt with Payment Method as Receipt for TCS.

2. Navigate to View > Zoom before saving the receipt. This will open the India Local 
Cash Receipts window.

Field Description Type Action Description

Customer Name Display The customer for 
whom the receipt is 
being entered.



5-6    Oracle Financials for India User Guide

Field Description Type Action Description

Customer Number Display The customer 
number for which 
the receipt is being 
entered.

Customer Site Display The customer site for
which the receipt is 
being entered.

Receipt Number Display The receipt number 
that is being entered.

Receipt Amount Display The receipt amount 
that is being entered.

Organization Required PICK The Inventory 
Organization against
which this receipt is 
being entered.

Item Classification Required PICK The Item class for 
which this 
concurrent is being 
run.

Tax Category Required PICK The Tax Category 
for this receipt based
on which Taxes will 
be deducted.

Note: Only Tax 
Categories with 
TCS Tax Type 
will be displayed 
in the LOV.

TCS Document No. Display The TCS document 
that gets generated 
for this receipt.
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Field Description Type Action Description

Total Tax Amount Display The Total TCS Tax 
amount that got 
charged to this 
receipt.

3. Enter Organization, Item Classification and Tax Category and click on Taxes. If the 
taxes are found in order, click Confirm and close the taxes window.

Note: For a confirmed Receipt, taxes will be view only and cannot 
be modified.

TCS is charged only when you Confirm the Taxes. If you do not confirm the 
receipts, the same will be shown in the TCS Exception Report. You must navigate to
the Receipt and Confirm the taxes, else these receipts will be nullified during 
settlement.

Note: Once the Settlement Process is carried out, the Receipt cannot
be cancelled.

4. Run the AutoInvoice program for TCS Debit Memo.

Note: The Debit memo created will only be visible in Transactions 
and not in the Transactions Localized screen.

TCS Settlement
1. Run TCS Settlement Report

2. TCS Settlement

3. Validate and pay AP invoice

4. Update Payment Additional Information

5. Finalize Settlement

6. Run India - Generate TCS Certificates
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Run TCS Settlement Report
You must run the TCS Settlement Report before carrying out the actual settlement 
process. Navigate to View > Request > Submit a New Request from India Local 
Receivables or India Local Payables responsibility.

Field Description Type Action Description

TAN No Required PICK The TAN No. for 
which this concurrent
is being run.

Organization Name Optional PICK The Inventory 
organization for 
which TCS Settlement
is being run.

Settlement Date Required Settlement date for 
which this concurrent
is being run.

Item Classification Required PICK The Item class for 
which this concurrent
is being run.

Running the TCS Settlement report can give you the following information to be 
verified:

• Exception: Cash Receipts where TCS is applicable but taxes have not been 
confirmed.

Note: TCS applicability of these receipts will be nullified if you 
proceed with settlement without confirming the taxes.

You can ignore this exception only if you specifically intend to remove TCS 
applicability for the receipts listed. This exception will not be reported again as the 
second run will assume you intend to remove the TCS applicability for such receipt.

• Warning: Cash Receipts where TCS is applicable and taxes have been confirmed but
have not been fully applied.

• Warning: Invoices with TCS applicability are not complete.

• List of transactions in the settlement period.



India Local Receivables    5-9

• List of documents for surcharge adjustment at Threshold change.

• Exception: Documents generated for TCS not yet imported.

Any document generated for TCS but not yet imported i.e. present in interface 
tables will be shown here. You must import such documents before initiating TCS 
Settlement.

TCS Settlement
After verifying the India TCS Settlement Report output, perform the TCS settlement by 
navigating to India Local Receivables > Period End > Settlement.

Settlement Date can be entered only upto sysdate-1 i.e. yesterday's date. A settlement 
cannot be carried out on current date as there can be some transactions carried out in 
current date after settlement, which will then remain pending in the system.

The Process button will be active only when the Net Balance Amount (Payable amount) 
is shown Negative. If the Credits are more than the Debits and there is no payment due,
then you cannot process a settlement. In such cases the Process button will appear 
disabled.

Note: When the TCS Settlement process is carried on the TCS 
repository, feeding any new data to the repository will result in data 
inconsistency. TCS Settlement carried out once cannot be reversed.

Clicking Process will invoke a concurrent of Localization Payables Open Interface 
Import (Payables Open Interface Import), which will create an AP Invoice on the TCS 
authority selected.

Validate and Pay AP Invoice
Login with Payables responsibility and validate and pay the AP invoice in Oracle 
Payables.

Updating Payment Additional Information
To update payment additional information, navigate to India Local Receivables > India 
TCS/VAT/Service Tax > Period End > Additional Payment Information.

Note: Clicking New will let you enter details for new Payment to be 
made. Find let's you search for existing payment details.
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Field Description Type Action Description

Header information      

Tax Authority Type Display This needs to be set to
'India TCS Authority' 
for TCS settlement.

Tax Authority Display The Vendor name 
which was used for 
making the TCS 
Challan at time of 
TCS Settlement.

Tax Authority Site Display The Vendor site 
which was used for 
making the TCS 
Challan at time of 
TCS Settlement.

Item Classification Display The TCS Item class 
for which TCS 
Settlement was 
carried out.

Line Information

Settlement Date Display The Date when TCS 
Settlement was 
carried out

TAN Number Display The Organization 
TAN Number for 
which Settlement was
carried out.

TCS Amount Display The basic TCS 
Amount that was 
settled.

Surcharge Amount Display The Sucharge on TCS 
Amount that was 
settled.
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Field Description Type Action Description

Education Cess 
Amount

Display The Education Cess 
on the TCS and the 
Surcharge amount 
that was settled.

Total TCS Amount Display The Total TCS 
amount that got 
settled. This is sum of
the TCS Amount, 
surcharge amount 
and Education Cess 
amount shown in the 
preceding three 
columns.

Check Date Display The Check date with 
which this settlement 
was paid.

Check Number Display The Payment 
Document number 
using which the TCS 
settled amount was 
paid.

BSR Code Required This is a seven digit 
numeric code that is 
required to be printed
on the TCS Certificate
and in eTCS returns

Check Deposit Date Required PICK The date when the 
Check was deposited 
with TCS Authority

Bank Name Required PICK The Bank Name that 
would get printed on 
the TCS Certificate.
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Field Description Type Action Description

Challan Number Required The five digit 
numeric challan 
number with which 
the TCS was paid. 
This would be 
printed on the TCS 
Certificate.

Finalize Settlement
To finalize the TCs settlement, navigate to India Local Receivables > India 
TCS/VAT/Service Tax > Period End > Settlement Payment Details.

Run India - Generate TCS Certificates
Run the India - Generate TCS Certificates from View > Requests > Submit a new 
Request, from India Local Receivables or India Local Payables responsibility. Running 
this request will generate TCS Certificate numbers against each customer for the 
settlement. If you want to issue certificates quarterly and settlement is carried out 
monthly, then run this request every quarter and not after each settlement.

Field Description Type Action Description

From Date Required From Date for which 
TCS Certificates that 
needs to be 
generated.

To Date Required   To Date for which 
TCS Certificates that 
needs to be 
generated.

TAN Number Required PICK TAN Number for 
which TCS 
Certificates that needs
to be generated.
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Field Description Type Action Description

Tax Authority Required PICK Tax Authority under 
whose jurisdiction 
TCS Certificates 
needs to be 
generated.

Tax Authority Site Required PICK Tax Authority site 
under whose 
jurisdiction TCS 
Certificates needs to 
be generated.

Customer Name Optional PICK Customer for whom 
TCS Certificates that 
needs to be 
generated.

Customer Site Optional PICK Customer Site for 
which TCS 
Certificates that needs
to be generated.

Tracking of ST Forms Receipts

Introduction
You can use this feature to track sales tax concessional forms to be received from the 
customers. On receipt of the form, the details of the concessional forms received can be 
recorded in this window.

This form can be effectively used to monitor and track the Sales tax Forms that need to 
be received from Customers.

Basic Business Needs
The ST Forms Receipt Tracking functionality lets you track the Concessional forms due 
from Customers. You can:

• Setup Declaration Form names that have to be issued to avail the concessional rate 
of Sales Tax.

• Assigning Form Names to appropriate Tax Codes while defining these Taxes.
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• Keep track of Invoices to against which Sales Tax Declaration forms have to be 
issued to the Supplier

• Facilitates recording details of Forms received from Customer and the Invoices 
included in each form receipt

• Provides you with a facility to query Received Forms and view Form details and 
the Invoices included in these Forms

• Generates Report to view the Invoices for which Concessional forms have been 
received and also are yet to be received.

• Form Tracking can also be carried out for 0% Sales Tax codes based on attachment 
to Transaction.

Reports
Receivables generates this report for India:

India - ST Form Customer Report - Use Sales Tax Form Customer Report to track 
customers for whom you have given Sales Tax discount and you have not yet received 
the ST Forms for an Invoice. Where the Form has been fully or partially received against
Invoices.

AR 3A Form Receipt Tracking Overview
Material Clearance without payment of duty under AR-3A needs to be tracked for 
receipt of re-warehousing certificate. AR-3A Receipt Tracking feature of Oracle 
Financials for India can be used to meet this requirement. All clearances under excise 
exemptions will be recorded in this screen and on receipt of the authenticated 
document; the receipt date can be recorded. By viewing the contents of this screen, 
users can monitor the re-warehousing certificates that need to be obtained from 
customers at any given point of time.

The AR-3A Receipt Tracking functionality enables you to keep track of the AR-3A 
forms due from Customers. Using this functionality, you can:

• Track AR-3A forms to be received from Customers.

• You can also enter the date on which the form was received.

• Generate a report to view the AR-3A forms pending from each Customer.

Using the find query form, the User can view the AR3A forms to be received for a 
particular customer or all customers.

Navigate to India Local Receivables > Customers > AR3 A form Receipts Tracking

The field wise description of the screen is given below.
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Field Description Type Action Description

Customer Name (Optional/Requ
ired)

  The User can enter Customer
Name from whom the AR3A
Forms are to be received. If
nothing is specified here, then all
the outstanding AR3A form for
all the Customer will be shown /
displayed.

Customer Number (Displayed)   Customer Number of the above
Customer will be displayed here.

Customer Site (Optional)   If the User wants to view the
outstanding AR3A for a specific
Customer Site (Ship to), then he
can specify this field.

Order/Invoice (Optional)   Quick field are Order or Invoice

Order/Invoice No (Optional)   A specific Order / Invoice
Number can be specified for
which the User wants to view the
outstanding AR3A.

Excise Exemption
Type

(Optional)   CT2, CT2 others, CT3 can be
specified

AR-3A form (Optional)   AR-3A form number can be
specified

Through AR-3A form, India
Local Receipts Tracking the user
can enter the receipt of AR3A
form from a Customer.

Customer Block      

Details regarding the
customer will be
displayed.

(Displayed)    

Customer Name     Customer Name will be
displayed.
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Field Description Type Action Description

Customer Number (Displayed)   Customer Number of the above
Customer will be displayed.

Customer Site (Displayed)   Customer Site (Ship To) will be
displayed.

Transaction Block     Details regarding the transaction
will be displayed.

Type (Displayed)   Type of transaction either Order
or Invoice will be displayed.

Source (Displayed)   Source for the above type of
transaction will be displayed.

Number (Displayed)   Number of the transaction will be
displayed.

Form Block     Details regarding CT2,CT3 &
Excise Exemption Certificate will
be displayed.

Form (Displayed)   Form Type like CT2,CT3 &
Excise Exemption will be
displayed.

Number (Displayed)   Number of CT2,CT3 & Excise
Exemption Certificate will be
displayed

Date (Displayed)   Date of the CT2,CT3 & Excise
Exemption Certificate will be
displayed.

AR3A details block     Details of AR3A forms for a
transaction will be displayed
here and once the AR3A forms is
received back from a Customer,
the same can be entered in this
block in received date column.

Delivery Number (Displayed)   Delivery number will be
displayed.*
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Field Description Type Action Description

Delivery Name (Displayed)   Delivery Name will be
displayed*

Delivery Date (Displayed)   Delivery Date will be displayed*

AR3A Form Number (Displayed)   AR3A Form Number will be
displayed

Date (Displayed)   AR3A Form Date will be
displayed

Received Date (Enterable)   The Date on which the User
received back the AR3A form
from the Customer. After receipt
of a AR3A form , the same will be
removed from the outstanding
list of AR-3A form to be received
from a customer.

Delivery Number, Name & Date are visible only for Transactions, which are imported 
from Order Management Responsibility and not applicable to Manual Transactions 
entered in Receivables using Transactions (Localized) Form. 

Reports
Receivables generate this report for India:

India - AR3A Status Report - Lists all the exempted sales transactions against while an 
Acknowledged AR-3A form is pending from customer.

RG Consolidation
The excise rules allow monthly settlement of liabilities arising during the period. Oracle
Financials for India provides a feature 'Allow Negative Balance', using which you are 
allowed to complete a sales transaction; even-though the register balances are not 
adequate. The PLA Register will be updated irrespective of a negative balance.

To calculate the net liability during monthly settlement, you can use the RG 
Consolidation feature. The RG Consolidation window:

• Displays the balance in each register for a selected organization.

• Allows you to transfer the credit available in CENVAT accounts to PLA.
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• Creates a PLA Payment and AP Invoice for the net liability to change the negative 
amount to zero.

You can also transfer a part of the available credit to offset negative PLA balance. To do 
this, specify the amount that needs to be maintained in the CENVAT accounts on 
completion of the transaction. Accordingly, the system will make Debit entries in the 
CENVAT registers and credit entries will be generated in the PLA register. For the 
balance amount, system will create a PLA Invoice.

The RG Consolidation feature lets you completes sales transactions in spite of 
inadequate credit balance. You can:

• Settle Excise Liability Quarterly

• Automate creation of PLA Payment and AP Invoice based on the intended PLA 
balance .

Major Features of RG Consolidation
Allow Negative Balance

You can enable update of PLA with debit transactions even when the PLA balance is 
negative.

Track Register balances for each Organization, Location combination

RG Consolidation window provides you an overview of the balances of Excise Registers
and PLA. You can try a combination of transfers and see its corresponding effect on 
PLA balance.

Create PLA Payment and AP Invoice

On saving the changes in RG Consolidation, based on the intended balance of PLA a 
PLA Payment and AP Invoice are created. However, the PLA Register will not be 
updated with this transaction until the Invoice is paid and the PLA Payment is 
acknowledged.

Enabling the 'Allow negative balances in PLA' checkbox in the Additional Organization 
Information screen allows you to run his PLA Account with negative balances. The 
Excise Duty liability needs to be adjusted on fortnightly basis and an RG Consolidation 
screen is provided to adjust the Credit Balance available in CENVAT Accounts while 
working out the actual amount that needs to be paid on account of Excise Liability. You 
can specify the amount that needs to be maintained in the CENVAT Accounts and PLA 
Account on completion of the transaction. Accordingly, the system will make Debit 
Entries in the CENVAT registers and Credit entries will be generated in the PLA 
Register. For the balance amount, system will create a PLA Invoice.

Important:  The RG Consolidation functionality is not supposed to be 
used for creation of Positive balance in PLA.
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This is to be only used to make the Negative PLA Balance to Zero by consolidating the 
Positive Balances available in RG 23A & C Registers or making a payment for the 
Negative PLA Balance after consolidation.

The backdated RG Consolidation feature lets you specify a Consolidation Date and will 
only return those transactions or balances that were created till the supplied date. To be 
able to do this, you must have enabled the '-Ve Balance in PLA' checkbox for the 
Organization Location combination by navigating to the Accounting Info tab under 
India Local Inventory ->Setup ->Organizations ->Additional Information. In the Register
Preferences tab, set up PLA as preference 1. While it is possible to do a backdated RG 
Consolidation without the mandatory setup but skipping it will result in negative RG 
Register balances post consolidation and the same cannot be rectified as it has cascading
effect on balances, registers and accounting.

Once the PLA Invoice is generated by the RG Consolidation transaction, you must make
the payment before submitting fresh transactions. The system will disallow any 
subsequent RG Consolidation transaction till payment is made for the Invoice 
generated by the previous transaction.

Navigate to India Local Receivables >- India Localization > Registers > RG 
Consolidation Screen. The field wise description for this screen is given below.

Field Description Type Action Description

Operating Unit (Required) (Pick) Operating unit for which the RG
Consolidation is being carried out.

Organization
Name/Location Name

(Required) (Pick) Select Organization and Location
name.

Consolidation Date     The Date on Consolidation needs to
be recorded

Previous
consolidation date

    System will display the Previous
Consolidation Date

Closing balance as on
date

    The closing balance of different
duty paying registers as on date
will be displayed in this field

Closing balance as on
consolidation date

    The closing balance of different
duty paying registers as on
consolidation date will be
displayed
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Field Description Type Action Description

Desired closing
balance

    User needs to input the desired
values on completion of the
transaction

Net Debit     Debit from each register for the
transaction will be displayed

Remarks     This field displays the remarks for
set off entries

User remarks     User can enter the transaction text
in this column

Authority/Location     Name and Site of the Excise
Authority needs to be picked in this
field

TR6 Challan Number
/ TR-6 Date

    User needs to record the TR6
Challan Number and date through
PLA amount is being credited

Payment id     On saving the record, a batch id
will be created and the same will be
displayed.

Important: On completion of the transaction Debit Entries will be generated in the
CENVAT Registers and corresponding Credit Entries will be generated in the PLA Register.
Apart from that PLA will be credited with the amount of PLA Invoice generated through the
transaction. Users need to ensure that payment towards this Credit is made on the same
day.

For Creating a positive PLA Balance please use the PLA Invoice.

Supplementary Transactions Overview
There would be instances in your business where the customer balances are affected by 
price and tax rate changes for a retrospective period. For all such changes you can use 
the Supplementary Transactions feature of Oracle Financials for India. Using this 
feature, you can identify the source documents affected by these changes, calculate the 
amount for which an Invoice or a Credit Memo has to be raised and automate creation 
of such Invoice or Credit Memos.
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The Supplementary Transactions feature of Oracle Financials for India helps you in 
tracking and accounting the price and tax changes. You can:

• Identify the transaction for which Supplementary Invoice or Credit Memos are to be
raised on account of Price/Tax/Assessable Price changes.

• Verify the calculation and the method followed to arrive the amount for which 
Supplementary Invoice or Credit Memo will be raised.

• Have an Option to raise/not to raise a Supplementary Invoice or Credit Memos.

• Have an Option to raise manual Supplementary Invoice or Credit Memo.

Major Features
• Track Price and Tax Changes: You can use the Mapping screen to track the 

previous Price List and Tax Codes. You can initiate the program to identify the 
transactions for which the Supplementary Invoice or Credit Memo can be raised. 
You can generate a report to list such transactions.

• Raise Supplementary Invoice / Credit Memo: You have the option to raise a 
Supplementary Invoice, for the identified transactions. The option of not raising the 
Invoices would be useful in scenarios where you would not be raising 
Supplementary Invoice for some customer transactions. You also have an option of 
creating Manual Invoices and Credit Memos for price revisions and tax rate 
changes.

• Foreign Currency Fluctuations: This feature includes the provision to add daily 
exchange rate on the processing date for raising Supplementary Invoice or Credit 
Memo. This is required in a scenario where you have used Foreign Currency Price 
list for raising Invoices.

• Revised Price List : In the case of Standalone AR, you must enter a Separate 
Revised Price List into the System through Price List Menu.

Supplementary Transactions can be raised on account of the following

• Price Change for a retrospective period

• Change in Tax Rate for retrospective period

In both cases either a Supplementary Invoice or Credit Memo will be raised based on 
the retrospective changes. The transactions, which will have an effect on account of 
Price changes, will be listed through the following Mapping Type. 

• Price List (where OE and AR instances are available).

• Invoice Price List (where standalone AR is available).
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• Assessable value/transaction value Price List where there is change in the 
Assessable value.

Cases Handled
Consider the following products and the following cases:

Product Name Original Price (In rupees) Revised Price (In rupees)

Prod.A 100.00 120.00

Prod.B 100.00 90.00

Also, consider the following:

Tax code Original Rate Revised Rate

Tax Code - Excise 10% 12%

Tax Code - LST 8% 2%

Tax Code - Sales tax 5% 3%

Tax Code - Octroi 3% 5%

The following are the possible scenarios and treatment on the above cases.

Case I

Only Price Revision (Increase) but no change in Tax rate.

Invoice with original price for 100 Quantity of Prod.A raised on March 20, 1999 and a 
revised price list has been introduced with retrospective effect from March 15, 1999 and 
the user need to raise a Supplementary Invoice.

Parameter Original Price (in 
rupees)

Revised Price (in 
rupees)

Supplementary 
Invoice

Net sales (100 x 100 ) 10000.00 12000.00 2000.00

Add : Taxes 1000.00 1200.00 200.00
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Parameter Original Price (in 
rupees)

Revised Price (in 
rupees)

Supplementary 
Invoice

Tax code - Excise (10
%)

550.00 660.00 110.00

Tax code- Sales tax
(5%)

     

Tax code - Octroi 3%) 346.50 415.80 69.30

Total 11896.50 14275.80 2379.30

Supplementary Invoice may be raised for RS. 2379.30

If the user decides to raise a Supplementary Invoice, then the following accounting 
entry will be passed in this case.

Dr. Receivable a/c 2379.30

Cr. Revenue a/c 2000.00

Cr. Excise duty a/c 200.00

Cr. Sales Tax a/c 110.00

Cr. Octroi duty a/c 69.30

Case II

Only Price Revision (Decrease) but no change in Tax Rate.

Invoice with original price for 100 Quantity of Prod.B raised on March 20, 1999 and a 
revised price list has been introduced with retrospective effect from March 15, 1999 and 
the user need to raise a Credit Memo.

Parameter Original Price (in 
rupees)

Revised Price (in 
rupees)

Credit Memo

Net sales (100 x 100 ) 10000.00 9000.00 1000.00

Add : Taxes      

Tax code - Excise (10
%)

1000.00 900.00 100.00
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Parameter Original Price (in 
rupees)

Revised Price (in 
rupees)

Credit Memo

Tax code- Sales tax
(5%)

550.00 495.00 55.00

Tax code - Octroi
(3%)

346.50 311.85 34.65

Total 11896.50 10706.85 1189.65

Credit Memo may be raised for Rs. 1189.65

If the user decides to raise a Credit Memo, then the following accounting entry will be 
passed in this case.

Dr. Revenue a/c 1000.00

Dr. Excise Duty a/c 100.00

Dr. Sales Tax a/c 55.00

Dr. Octroi duty a/c 34.65

Cr. Receivable a/c 1189.65

Case III

Change in Tax Rate but no Change in Price.

Invoice with original price for 100 Quantity of Prod.A raised on March 20, 1999 with 
Original Tax Rate and revised Tax Rate has been put into use w.e.f from March 15th 
1999 and the user need to raise a Supplementary Invoice.

Parameter With Original Tax
Rate

Revised Tax Rate Supplementary
Invoice

Net sales (100 x 100 ) 10000.00 10000.00 0.00

Add : Taxes      

Tax code - Excise (10
%)

1000.00 (12%) 1200.00 200.00

Tax code- Sales tax
(5%)

550.00 (3%) 336.00 -214.00
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Parameter With Original Tax
Rate

Revised Tax Rate Supplementary
Invoice

Tax code - Octroi
(3%)

346.50 (5%) 576.80 230.30

Total 11896.50 12112.80 216.30

Supplementary Invoice may be raised for Rs. 430.30

Credit Memo may be raised for Rs. 214.00

Case IV

Change in Tax Rate but no Change in Price. 

Invoice with original price for 100 Quantity of Prod.A raised on March 20, 1999 with 
Original Tax Rate and Revised Tax Rate has been put into use w.e.f from March 15th 
1999 and the user needs to raise a Credit Memo.

Parameter With Original Tax 
Rate

Revised Tax Rate Credit Memo

Net sales (100 x 100 ) 10000.00 10000.00 0.00

Add : Taxes      

Tax code - Excise (10
%)

1000.00 (12%) 1200.00 200.00

Tax code- Sales tax
(8%)

880.00 (2%) 224.00 -656.00

Tax code - Octroi
(3%)

356.40 (5%) 571.20 214.80

Total 12236.40 11995.20 241.20

Credit Memo may be raised for Rs. 656.00

Supplementary Invoice may be raised RS. 414.80.

Case V

Change in Price and also change in Tax Rate.

Invoice with original price for 100 Quantity of Prod.A raised on March 20, 1999 with 
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Original tax rate . The Revised Price and Revised Tax Rate has been put into use w.e.f 
from March 15, 1999 and the User need to raise the Supplementary Invoice.

Parameter With Original Tax 
Rate

Revised Price or
Tax Rate

Credit Memo

Net sales (100 x 100 ) 10000.00 (120%) 12000.00 2000.00

Add : Taxes      

Tax code - Excise (10
%)

1000.00 (12%) 1440.00 440.00

Tax code- Sales tax
(8%)

880.00 (2%) 268.80 -611.20

Tax code - Octroi
(3%)

356.40 (5%) 685.44 329.04

Total 12236.40 14394.24 2157.84

Supplementary Invoice may be raised for Rs. 2769.04.

Credit Memo may be raised for RS. 611.20.

Price / Tax changes 
The user can decide and execute the kind of mapping he likes to do to identify the 
transaction which are having impact on account of Price / Tax changes this screen

In Oracle Financials for India, navigate to India Local Receivables > Transactions > 
Supplementary Transactions > Price/Tax Changes.

Field Description Type Action Description

Ledger (Required) PICK HELP Ledger name needs to be entered
by the user from LOV to view the
transaction.
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Field Description Type Action Description

Organization (Optional) PICK HELP The Organization name can to be
entered / selected by the user from
LOV to view the transaction. If this
is left blank then the transaction for
all the Organization will be
displayed.

Customer Name (Optional) PICK HELP The Customer name can be entered
by the user from LOV to view the
transaction related to a particular
Customer. If this is left blank then
the transaction for all the Customer
will be displayed.

Customer site (Optional)   The Customer Site can be entered
by the user from LOV to view the
transaction related to a particular
Customer Site . If this is left blank
then the transaction for all the
Customer will be displayed.

Batch Id (Optional)   The User can specify the Batch Id to
view the Supplementary
Transactions corresponding to the
Batch Id

By invoking the new button, the user can perform the desired mapping:

In Oracle Financials for India, navigate to India Local Receivables > Transactions > 
Supplementary Transactions > Price/Tax Changes > New/Find.

Field
Description

Type Action Description

Header Level      

Ledger (Required) PICK HELP The Ledger name needs to be
entered by the user from LOV
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Field
Description

Type Action Description

Organization (Optional) PICK HELP The Organization name can to be
entered by the user from LOV. If
this is left blank then the
transaction for all the Organization
will be considered.

Functional
Currency

(Displayed)   Functional Currency in a Set of
Book will be displayed here.

Customer Name (Optional) PICK HELP Users can select Customer Name
from LOV. If Customer Name is
left blank then the transaction for
all Customers will be considered in
the mapping.

Customer Site (Optional) PICK HELP Users can select Customer Site from
LOV. If Customer Site is left blank
then the transaction for all
Customers will be considered in
the mapping.

Batch Id (Displayed)   Generates Batch Id for set of
mapping and displayed in these
fields. Based on this Batch Id, the
user can run the concurrent
program to raise Supplementary
Transactions.

Line Level (Required) PICK HELP The Quick fields available for
Mapping Type are Price List,
Assessable Price List, Invoice Price
List, and Tax.

Mapping Type: The Usability of the Quick fields.

Field Description

Price List used for mapping between Price Lists: OE and
AR instances
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Field Description

Assessable Price List used for mapping between Assessable Price 
Lists: case OE and AR instances

Invoice Price List used for mapping to identify Invoices due to 
price changes in the case of standalone AR 
instances

Tax This will used to do mapping between Tax 
Codes.

Field Description Type Action Description

Existing Name (Required) PICK HELP This can be an Existing Price List
or Tax Codes depending upon the
Mapping type selected by the
user.

New Name (Required) PICK HELP This can be a New (Revised) Price
List or Tax Codes depending
upon the Mapping type selected
by the user.

Conversion Rate (Optional) ENTER If any foreign currency Price List
is considered for mapping, then
the user needs to specify the
Conversion rate here.

Effective from Date (Required) ENTER This meant for the retrospective
date from this the tax / Price list
has been changed.

Effective to Date (Required) ENTER This meant for the end date up to
which the mapping will be done.

After entering the proper details the User needs to save this screen and system will 
generate a batch id.

Concurrent Request
After entering mapping details, user has to run a concurrent request to identify the 
transactions, which are to be considered for raising Supplementary Invoices, Credit 
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Memo & Debit Memo by specifying the respective Batch_Id.

In Oracle Financials for India, navigate to India Local Enter Transaction from India 
Local Receivables > Reports > Other > Run > Single Request > India > Generate 
Suggestive Supplementary Transactions.

Choose Batch ID. This should be number generated in the 'Batch id' field of 
Price/Tax/Assessable Value changes window.

Generate / Memos / Invoices
After running the concurrent request, you can find the Supplementary Transaction for 
which the Supplementary Debit Memos and Credit Memos will be raised.

In Oracle Receivables - India Localization, navigate to the Supplementary transactions 
window as follows:

India Local Receivables > Transactions > Supplementary Transaction > Generate DR/CR 
Memos/Invoices

Field Description Type Action Description

Ledger (Required) PICK HELP Ledger name needs to be entered
by the user from the LOV in which
the user wants to view the
Supplementary Transaction.

Customer Name (Optional) PICK HELP If the User wants to view the
supplementary transactions, which
are related to a particular
Customer, then he can specify that
Customer name here by selecting
from the LOV.

Customer Site (Optional) PICK HELP If the User wants to view the
Supplementary Transactions that
are related to a particular Customer
Site, then he can specify that
Customer Site here by selecting
from the LOV.

Organization (Optional) PICK HELP If the User wants to view the
Supplementary Transactions which
are related to a particular
Organization, then he can specify
that Organization here by selecting
from the LOV.
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Field Description Type Action Description

Invoice No (Optional) PICK HELP If the User wants to view the
Supplementary Transactions which
are related to a particular Invoice,
then he can specify that Invoice
Number here by selecting from the
LOV.

Invoice Date (Optional) PICK HELP If the User wants to view the
Supplementary Transactions for
specific Invoice Date, then he can
specify that Invoice Date.

Status (Optional) PICK HELP This represents the status of the
Supplementary Transactions. The
quick fields available are 'Invoice
Raised' and 'Invoice not raised'

Processed Date (Optional) PICK HELP If the User wants to view the
Supplementary Transactions for
specific Process Date, then he can
specify that Date.

Supplementary
transactions

(Optional) PICK HELP This represents type of
Supplementary Transactions. The
quick fields available are
'Supplementary Invoice ', 'Credit
Memo' and 'Debit Memo'.

Suppl. Inv. Type      

Batch Id (Optional) PICK HELP This represents Batch Id for which
the Supplementary Transactions
are processed.

The User can view the calculated Supplementary Invoices and Credit Memos through 
this screen and generate Supplementary Invoice and Credit Memos.

In Oracle Financials for India, navigate to the India Local Supplementary Transaction 
from India Local Receivables > Transactions > Supplementary Transaction > Generate 
DR/CR Memos/Invoices 

The following facilities are available in this screen for the user:

• View Line details and Tax details for a particular transaction.
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• View details for Existing Invoice as well Revised Invoice Amount

• The user can modify Tax line only in the following manner by:

• Deleting a particular tax line to be excluded from being charged for a specific case.

• Updating the tax amount by inserting a calculated figure in the Tax Amount 
column.

The User can select all the transaction or an individual transaction for which 
Supplementary Invoice/Credit Memo will be raised. In addition, the user can 
consolidate two or more transaction and raise a single Supplementary Invoice/Credit 
Memo. After the user confirms a Supplementary Transaction, that transaction can be 
exported to AR transactions form.

Field Description Type Action Description

Supplementary
transaction block

     

Raise Invoice (Required) CHECK Once the User confirms a
Supplementary Transaction, then he
can enable this check box to export
that transaction to AR transactions

Supplementary
Invoice Type

(Displayed)   The supplementary transactions
type like 'Supplementary Invoice',
'Credit Memo' and 'Debit Memo' will
be displayed here.

Invoice Number (Displayed)   The Original Invoice Number will be
displayed here.

Invoice Date (Displayed)   The Original Invoice Date will be
displayed here.

Customer Number (Displayed)   Customer Number for whom the
Original Invoice was raised will be
displayed here.

Customer Name (Displayed)   Customer Name for whom the
Original Invoice was raised will be
displayed here.
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Field Description Type Action Description

Existing Amount (Displayed)   Original Invoice Line Amount + Tax
line amount of the Original Invoice
will be displayed here.

Important: The details for this
Existing amount can be seen in
the Existing Amount details
Block.

Revised Amount (Displayed)   Revised Amount + Revised Tax
amount on account of
Price/Tax/Assessable Price changes
will be displayed here.

Important: The details for this
Revised amount can be seen in
the Revised Amount details
Block.

Line Difference (Displayed)   Line Amount Difference on account
of Price changes will only be
displayed here.

Excise Difference (Displayed)   Excise amount Difference on account
of Price/Tax/Assessable Price
changes will only be displayed here.

Other Tax Difference (Displayed)   Taxes other than Excise amount
Difference on account of
Price/Tax/Assessable Price changes
will only be displayed here.

Suppl Inv.Status (Displayed)   The Status like 'Invoice Raised' and
'Not Raised' will be displayed here.

Set of Book Name (Displayed)   Set of Book Name will be displayed
here.

Customer Site (Displayed)   Customer Site (Bill to) will be
displayed here.
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Field Description Type Action Description

Functional Currency (Displayed)   Functional currency for a Set of Book
will be displayed here.

Field Description Type Action Description

Organization (Displayed)   Organization Name
will be displayed
here.

Process date (Displayed)   Process date will be
displayed here.

Existing amount
Block

     

Existing Net Sales (Displayed)   The Original Invoice
Line amount will be
displayed here.

Existing Excise
Amount

(Displayed)   The Original Invoice
Tax amount of excise
type alone displayed
here.

Existing other taxes (Displayed)   The Original Invoice
Taxes amount other
than of Excise Type
will be displayed
here.

New amount Block      

New Net Sales (Displayed)   The New Invoice Line
amount will be
displayed here.

New Excise Amount (Displayed)   The New Invoice Tax
amount of excise type
alone displayed here.
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Field Description Type Action Description

New other taxes (Displayed)   The New Invoice
Taxes amount other
than of Excise Type
will be displayed
here.

Select All Button     After verifying the
Supplementary
transaction , if the
user wants to mark
all the transaction
which are to be
exported to AP
Invoices, then he can
use this button.

Consolidate   CHECK BOX If the User wants to
consolidate two or
more supplementary
Invoices or Credit
Memos, then he
needs to enable
consolidate check box
after marking the
respective transaction
lines.

Export Button     The marked
transaction will be
exported into AR
transaction table
through this button.

Line Details button     Users can view the
Lines details form

Field Description Type Action Description

Header Details block      

Invoice Number (Displayed)   Original Invoice Number will be
displayed here.
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Field Description Type Action Description

Supplementary
Invoice Type

(Displayed)   The corresponding Supplementary
Invoice Type will be displayed here.

Existing Amount (Displayed)   Original Invoice Line Amount + Tax
line amount of the Original Invoice
will be displayed here.

Revised Amount (Displayed)   Revised Amount + Revised Tax
Amount on account of
Price/Tax/Assessable Price changes
will be displayed here.

Line Details block      

Line No (Displayed)   Line No of an Original Invoice will
be displayed here.

Item (Displayed)   Item in a line of original Invoice will
be displayed here.

Description (Displayed)   Description of an Item in a line of
the original Invoice will be
displayed here.

Quantity (Displayed)   Number quantity of an Item in a line
of the original Invoice will be
displayed here.

UOM (Displayed)   UOM of the above item will be
displayed here.

Old Selling Price (Displayed)   Existing selling price as appearing in
the original Invoice will be
displayed here.

New selling price (Displayed)   New selling price as per the Revised
Price List for an item will be
displayed here.

Difference Amount (Displayed)   Line Amount Difference on account
of Price changes will only be
displayed here.
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Field Description Type Action Description

Difference Excise
Amount

(Displayed)   Excise amount Difference on
account of Price/Tax/Assessable
Price changes will only be displayed
here.

Difference other Tax (Displayed)   Taxes other than Excise amount
Difference on account of
Price/Tax/Assessable Price changes
will only be displayed here.

Tax Details button     User can view the Tax details for a
Line by invoking the Tax Details
button as well as modify the tax line
amount and delete unwanted Tax
lines.

Field Description Type Action Description

Line No (Displayed)   The respective Line No of the Tax
screen will be displayed here.

Existing Tax (Displayed)   The Existing Tax Code will be
displayed here.

Existing Tax Type (Displayed)   The Existing Tax type will be
displayed here.

Existing Tax Rate (Displayed)   The Existing Tax rate will be
displayed here.

Qty Rate (Displayed)   In the case UOM type of tax, Tax
Rate per UOM will be displayed
here.

UOM (Displayed)   UOM for a Existing Tax will be
displayed here.

New Tax (Displayed)   The Revised (new) Tax Code will be
displayed here.

New Tax Type (Displayed)    
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The Revised Tax type will be displayed here.

Field Description Type Action Description

New Tax Rate (Displayed)   The Revised Tax rate will be
displayed here.

New Qty Rate (Displayed)    

      In the case UOM type of tax,
Revised Tax Rate per UOM will
be displayed here.

New UOM (Displayed)   UOM for a Revised Tax will be
displayed here.

Existing Tax Amount (Displayed)   Existing Tax amount as per the
Original Invoice tax lines will be
displayed here.

New Tax Amount (Displayed)   Revised Tax amount as per the
Revised Invoice tax line will be
displayed here.

Difference Amount (Displayed/Editabl
e)

  Difference amount in the Tax
lines will be displayed here.

You can modify the Tax line only in the following manner:

• Delete a particular tax line, which you do want to charge for a specific case, or

• Update the tax amount by inserting a calculated figure in the Tax Amount column.

In addition, the user needs to save the tax screen after verifying the Tax calculation.

By using the Export Button, a user can transfer the supplementary Invoices to the AR 
transaction screen and needs to run the Auto Invoice Program to raise the 
Supplementary Invoice/Credit Memo.

Proper transaction sources needs to be defined in receivables for supplementary 
transactions. For set up, please refer to the post installation setups.

If you wish to consolidate two or more supplementary Invoices or Credit Memos, you 
must enable the consolidate checkbox after marking the respective transaction lines.

The transactions to be consolidated should have the same transaction currency; 
otherwise the consolidated Invoice will be incorrect.
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Reports
Receivables generates these reports for India:

Supplementary Transaction Details Report  - Lists Supplementary Invoices and Credit 
Memos raised or to be raised for the Original Invoice.

Supplementary Invoice Consolidation Report - Lists the Consolidated Supplementary 
Invoice raised for the period.

Duty Drawback Processing
Drawback means the rebate on duty chargeable on any imported material or excisable 
material used in manufacture or processing of goods that are manufactured in India 
and exported out of India. The duty drawback is equal to sum of

Custom Duty paid on Imported Inputs.

Excise Duty paid on Indigenous Inputs.

No Duty Drawback is allowed if 

The input is obtained without payment of any Custom Duty under various exemptions 
schemes, OR

CENVAT credit is claimed on the indigenous inputs OR

If there is a negative value addition to the goods i.e. the value of exported goods is less 
than the imported goods. 

Basic Business Needs
In your Business you should be able to:

Associate Proof of Export (POE) details for export type of Sales Invoice, Calculate Duty 
drawback by, identifying the lowest level components used in production of finished 
goods and then trace the receipt of each component and corresponding document of 
payment of duty.

Ensure that an Invoice is considered only once for claim.

Ensure that a receipt is considered only to the extent not claimed.

Reverse the CENVAT claimed if duty drawback is to be claimed.

Print duty drawback claim report giving Invoice wise details of input component, 
details of Excise/Customs Duty payment document and claim amount.

Major Features
Maintenance of Proof of Export (POE)

For export type of removals, you are able to associate POE details.
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Maintenance of Duty Drawback claimable

You are provided with option to capture duty drawback claimable with each tax name 
of type 'Customs' or 'CVD'. 

Submission of Duty Drawback claims

You are provided with facilities for Generation of Duty drawback claims (Automatic) 
this will give you choice of receipt selection method, i.e. FIFO or LIFO Generation of 
Duty drawback claims (Manual) in addition to choice of receipt selection this will give 
you choice of selection of individual Receipt.

Report to help tracking duty draw back.

Duty drawback processing will:

Ensure that an Invoice is considered only once for claim.

Ensure that a receipt is considered only to the extent not claimed.

Reverse the CENVAT claimed if duty drawback is to be claimed.

TDS Certificates Received Overview
For certain sales where Tax Deduction at Source is applicable, the customer would 
make provision for such deduction and issue a Certificate in Form 16A. You can use the 
TDS Certificates feature of Oracle Financials for India to record the details of the 
Certificate received and the deduction details. In addition, the user can create Credit 
Memo through Auto Invoice in the Interface menu by specifying Request name as Auto 
Invoice Master Program, Invoice source as TDS Credit Memo, From / to Customer for 
whom he wants to create the Credit Memo and default date. It is imperative that 
'Customer Additional Information' is setup along with Transaction source & 
Transaction Type as specified in this document to successfully import the TDS Credit 
Memo. The feature is only for recording of TDS Certificates received from Customers 
and is not for any issue of TDS Certificates to Customers for deducting TDS against 
Discounts/Schemes/Credit Memo etc.

The TDS Certificates feature lets you track the TDS Certificates received from the 
customer. You can:

• Record details of TDS Certificates received

• Generate Credit Memos based on the Certificate information. This would reflect the
appropriate Customer balance.

In Oracle Financials for India, navigate to India Local Receivables > India Localization > 
Collections > TDS Certificates.
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Field Description Type Action Description

Customer Name (Required) EDIT HELP
PICK

The used needs to select
Customer Name from the LOV.
Only those Customers who have
Localization setup are shown
here

Customer Number (Defaulted)   This will be a default value or
the user can select from LOV.
Only those Customers who have
Localization setup are shown
here

Location (Required) EDIT HELP
PICK

The user needs to specify the
Location of the customer from
LOV. Only those Customer
Locations having Invoices are
shown here.

Memo Line (Optional) EDIT PICK The user needs to specify the
Memo line from LOV which
help in determination of
Accounting segments when auto
accounting is used.

Name Required EDIT TDS Certificate Name can be
entered in this field

Number Required EDIT An alpha numeric value can be
entered for recording TDS
Certificate number

Certificate Date Required EDIT PICK The TDS Certificate Date is to be
entered here

Received Date Required EDIT PICK The Date of receipt of TDS
Certificate is to be entered here

Amount Required EDIT The Amount of TDS Certificate
that has been received

Description Required EDIT The narration / user enterable
details against this TDS
Certificate.
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Reports
Receivables generates this report for India:

India - Receivable Tracking Report  - This report lists the certificates received from the 
customers and its corresponding details.

Setting Up India Local Receivables
This section describes the setup procedures for India Local Receivables. You must enter 
the setup information for your company before you use Transactions (Localized), RG 
Consolidation and Supplementary Invoices. 

Defining Bond Register
The calculation of Excise Duty and updates of Excise Registers are based on the setup 
made in the define bond register. Before making this set up you need to define the 
Order Types and Transaction Sources. Excise transactions are classified into the 
following categories:

• Domestic with Excise 

• Domestic without Excise

• Export with Excise

• Bond Register (Export under Bond)

Excise transactions need to be identified based on the Organization/Location 
combination and against each Excise Transaction multiple Order Types and Transaction
Sources can be assigned. Order Type need to be assigned to Excise related transactions 
from Order Management Module and Transaction Source need to be assigned for all 
Excise related transactions through the Stand Receivable Module. If the 
Organization/Location is of 'Manufacturing' type, excise related transactions for 
manufacturing set up need to be associated. Like wise, if the Organization/Location is 
'Trading' excise related transactions for trading need to be associated.

By associating the Order Types to the excise transactions for an Inventory Organization 
and Location, the related Excise Record entries will be passed based on the nature of 
goods cleared. 

Generating Excise Invoice Numbers 

For generating user defined prefixes for Excise Invoices, the Excise transaction type 
association needs to be mapped in the "Excise Generation" region of Additional 
Organization Information screen.

India Localization provides maintenance of multiple Bond Registers for exports.
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Recording Export under Bond

Rule 19 of The Central Excise Rules, 2002 provides for Export without payment of duty 
subject to the conditions and procedures specified by the notifications by the Central 
Board of Excise and Customs. In exercise of the powers conferred under these rules, the 
Central Board of Excise and Customs has notified through Central Excise (N.T.) 
Notification No.42/2001 and Notification No.44/2001 the conditions and procedures for 
export of all excisable goods. These notifications provide for taking on a Bond/Letter of 
Undertaking (LUT) for the export made to all countries other than Nepal and Bhutan 
and another Bond/LUT for the exports made to Nepal and Bhutan. To comply with the 
procedures specified under these notifications, an organization will have to maintain 
multiple Bond Registers in order to keep track of exports under bond to all countries 
other than Nepal & Bhutan, exports to Nepal and Bhutan and exports under Letter of 
Undertaking. Under each of these categories, there would also be a possibility for taking
multiple bonds where total of Export made, without proof of exports, is greater than the
Bond Amount.

Using Bond Registers in Oracle Financials for India, you can maintain multiple Bond 
Registers for a combination of Organization and Location.

On taking a Bond for export you will have to create the required setup before you start 
creating export transactions against the Bond. The only setup step would be to record 
the Bond details. To do this, navigate to 'Define Bond Register' window. Select 
organization, Location for which the Bond would be applicable, pick up the Type 'Bond 
Register', and enter Bond Number, Expiry Date and the Bond Amount. On the lines, 
select the Order Types that would be used for export transactions.

In case export is made against the Letter of Undertaking (LUT), there would not be a 
Bond Amount. Hence, you can leave the Bond Amount field blank. However, it would 
be mandatory for you to capture the details of the Bond Number (LUT No.) and the 
Bond Expiry Date. In addition to this, check the LUT checkbox to indicate that the Bond 
Type is LUT.

Details of exports made under bond would be recorded. This information would be 
used to track Bond utilization. 

Prerequisites
Before you enter the Bond Register Details, you must:

• Define Organizations

• Define Locations

• Define Organization Additional Information

• Define Transaction Types

In Oracle Financials for India, navigate to India Local Order Management > Setup > 
Registers > Define Bond Register.
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From the look-ups you need to select the appropriate excise transactions. Options for 
Manufacturing Organization are:

• Domestic with Excise 

• Domestic without Excise,

• Export with Excise

• Bond Register (For Exports)

Options for Trading Organization are:

• Trading Domestic with excise

• Trading Domestic without Excise

• Trading Export with Excise

• Trading Bond Register (For Exports)

Important:  You need to specify the Bond credit available in his running
Bond account maintained for export purposes.

Field Description Type Action Description

Operating Unit (Required) (Pick) The Operating Unit for which the
Bond Register is being entered.

Organization/Locatio
n

(Required) EDIT HELP
PICK

You can select Organization and its
Location from LOV for which the
Register setup is to be made.

Order/Invoice
Information

(Required) EDIT HELP
PICK

 

Bond Number (Optional /
Required)

  This would be an enterable field. User
can enter Bond Number here. This
number can be alpha-numeric.

Bond Expiry Date (Optional /
Required)

  The User can enter the Bond Expiry
Date here. The system would raise
application error where the Shipment
date is greater than the Bond Expiry
Date.
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Field Description Type Action Description

Letter of Undertaking (Optional) Check Box This field would be checked whenever
the Bond Type is a LUT (Letter of
Undertaking).

Bond Amount (Optional /
Required)

  Enter the Bond Amount here. The
value in this field can be entered only
while creating a new Bond. Once the
Bond details are saved, these values
cannot be updated.

Additional Amount (Optional)   If the Bond Amount is to be increased,
then, enter the Additional Amount
here. Once, the record is saved, value
in this field would be erased and the
Bond Amount and Balance would be
increased to this extent.

Balance Amount (Display)   This field would reflect current
Balance available in the Bond Register.

For excise related transactions from the Order Management Module, you need to 
specify the Order Type intended to be associated with the selected Excise related 
transaction. Any number of Order Types can be associated to one single Excise related 
transaction.

For Excise related transactions mapped through the Transaction - Localized menu of the
Receivable Module, you need to associate the excise related transaction to the 
Transaction Source. Any number of Transaction Sources can be associated to one Single 
Excise Related Transaction. The transaction batch source is selected against the option 
of Invoice in this field.

• Same Order Type/Transaction source cannot be mapped to 
different Excise Related Transactions. You need to map your 
business requirements by considering the localization setup that 
needs to be carried out for mapping the Excise Related 
Transactions.

• Attachment of Order Type to 'Domestic without Excise', or 'Trading
without Excise' would mean that Excise Invoice Number for such 
transaction is not required. This Setup was mandatory for Tracking 
ST Forms earlier and is no longer mandatory for form tracking.
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• When using Master Organization setup for generating Excise 
Invoice Numbers at Master Org level, it is mandatory to setup the 
order type at both Child Organization and at Master Organization 
for generating the Correct Excise Invoice Number.

Negative Balance in PLA - Organization Additional Information
The latest Excise Rules allow settlement of Excise liability on a monthly basis. With this 
system, you will not have to hold shipments for non-availability of funds. The 'Allow 
Negative Balance in PLA' Flag setup for the Organization/Location, allows you to over 
draw from the PLA balance available with you.

Prerequisites
Before you enter the Allow Negative Balance in PLA - Organization Additional 
Information, you must:

• Define Organizations

• Define Locations

• Organization Additional Information

See also: Creating an Organization, Setting Up Site Locations, Oracle Human Resource 
Management Systems User's Guide.

To enter Allow Negative Balance in PLA - Organization Additional Information Details:

Navigate to India Local Inventory > India Localization > Organization > Organization 
Additional Information.

Query for the Organization Location for which you wish to make the setup. Switch to 
Accounts Info Tab

Check the '- Ve Balance in PLA' field.>Negative?<

Excise Invoice Generation - Organization Additional Information
You may prefer to use a different Excise Invoice for a Transaction Source or a 
combination of Transaction Sources. On completing this setup step, you can generate 
Excise Invoice numbers in a sequence and with the alphanumeric prefix that you prefer.

You can skip this setup. On doing this, the system will generate only two series of 
Excise Invoices, one for Domestic Clearances and another for Export Clearances. These 
would be numeric values, incremented by one and would be without any prefixes.



India Local Receivables    5-47

Prerequisites
Before you enter the Organization Additional Information Details, you must:

• Define Organizations

• Define Locations

• Organization Additional Information

• Tax Calendar

SeeAlso: Creating an Organization, Setting Up Site Locations, Oracle Human Resource 
Management Systems User's Guide

To enter Excise Invoice Generation - Organization Additional Information Details:

Navigate to India Local Inventory, Organization Additional Information

Query for the Organization Location for which you wish to make the setup. Switch to 
Accounts Info Tab

Click on Tax Calendar and then on Excise Generation. Follow the information in the 
table in completing the setup.

The following information can be entered by user to generate multiple Excise Invoice 
Serial numbers based Order / Invoice Type/Excise Register codes.

The field wise description for the screen is given below.



5-48    Oracle Financials for India User Guide

Field Description Type Action Description

Transaction Type (Required) PICK HELP Choose one of the options from the
LOV. The options would be

Order:

On selecting this option in
combination with the Order Type,
the Excise Invoice number
generated on shipping the delivery
created with this Order Type
would be based on the definition
specified for this record.

Return To Vendor:

The document sequence defined
here would be applicable to Excise
Invoice Numbers generated for a
Return to Vendor Transaction.

Domestic:

The document sequence defined
here would be applicable to Excise
Invoice Numbers generated for a
Domestic Transaction.

This would be applicable to all the
Order/Invoice Types that are

Define Bond Register chosen for
the Organization and Location
with the Register Type as
'Domestic with Excise' AND

This Order Type is not chosen in
the India Local Excise creation
screen for the Organization and
Location.

Invoice:

On selecting this option in
combination with the Invoice
Type, the Excise Invoice number
generated on saving an AR Invoice
would be based on the definition
specified for this record.

Export:
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Field Description Type Action Description

The document sequence defined
here would be applicable to Excise
Invoice numbers generated for an
Export Transaction.

This would be applicable to all the
Order/Invoice Types that are

Define Bond Register: Chosen for
the Organization / Location with
the Register Type as 'Export with
Excise' and this Order Type is not
chosen in the India Local Excise
creation screen for the
Organization, Location.

Order/Invoice Type (Required) PICK HELP The relevant Order Type/Invoice
type related for a Inventory
Organization Location have to be
selected here from the LOV.

Register Code (Required) PICK HELP The appropriate Register Code for
a Order/Invoice Type have to be
selected here from the LOV.

Prefix (Optional)   Any alpha-numeric code that
would be prefixed to the Excise
Invoice Number.

Start No (Required)   You can specify the Start Number
for a specific Excise Invoice Series
which are to be generated from a
particular Inventory Organization
Location for a specific
Order/Invoice Type

Jump by (Required)   You can decide chronological
series for Excise Invoice Numbers
by specifying Jump by Number.
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Field Description Type Action Description

End No     The User can specify the End
Number for a specific Excise
Invoice Serials, which are to be
generated from a particular
Inventory Organization Location
for a specific Order/Invoice Type
& Register Code.

Important: Before defining User Prefixes and Excise Invoice numbers, 
appropriate setups need to be done in Define Bond register to associate 
an Order type for all Transactions from Order Management Module. In 
addition, Transaction source for all transactions from Accounts 
Receivable Module needs to be defined. The Order Type and 
Transaction Source will be associated with different type of excise 
removals (like domestic with excise, Bond, Export with excise etc.). 
Only after associating an Order Type/Transaction source with an excise 
related transaction type, user should define the user definable prefixes 
and Excise Invoice Numbers in this region.

It is not mandatory for the user to define Excise Invoice Generation 
Serial Number. If the User does not define the Excise Invoice 
Generation Screen, then auto generated system numbers will be 
allotted to the Excise Invoice as stipulated under Rule 52 A of the 
Central Excise Rules (one sequence for domestic transactions and 
another for exports).

Customer Additional Information
For detailed information, refer to Customer Additional Information, page 4-22.

Setting Up Transaction Types
To generate a Supplementary Invoice and TDS Credit Memo, it is mandatory to setup 
certain Transaction Types. Supplementary Invoices are imported with these transaction 
types.

Supplementary Invoice

A Transaction Type must be setup. Transaction name has to be 'Supplement Invoice'. 
The Name is case sensitive. It has to match the Text given.
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Supplementary Credit Memo
A Transaction Type has to be setup. The Transaction name has to be 'Supplement CM'. 
The Name is case sensitive. It has to match the Text given.

TDS Credit Memo
A Transaction Type has to be setup. The Transaction name has to be 'TDS Credit 
Memo'. The Name is case sensitive. It has to match the Text given.

Setting Up Transaction Sources
Supplement Invoice

In the above Batch Source Tab, Additional Information: The Automatic Transaction 
Numbering is unchecked & the Standard Transaction Type has been entered as 
'Supplement Invoice'.

Above Auto Invoice Options setup screen. Additional Information: 'Allow Sales Credit' 
has been unchecked. If this is not done, Auto Invoice will error out with messages that 
Sales Representative is not valid & Sales Credit type is not valid.

Supplement Credit Memo
The Supplement Credit Memo has to be set on a similar fashion except for Batch Source 
Tab. Navigate to the screen through the following path, India Local Receivables - Oracle
Receivables - Setups - Transactions - Sources. 

TDS Credit Memo
The TDS Credit Memo has to be set on a similar fashion except for Batch Source Tab. 
Navigate to India Local Receivables > Oracle Receivables > Setups > Transactions > 
Sources.

Setting Up Concurrent Programs
• India - Local Concurrent for processing order lines to AR

• India - Importing Excise Invoice Numbers to AR

• India - ST Forms Receipt Processing

• India - Program to Generate eTCS Quarterly Returns

• India - Program to Generate eTCS Annual Returns
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India - Local Concurrent for processing order lines to AR
The India - Local Concurrent for processing order lines to AR program handles 
localization tax flow from Order Management to Receivables. This program captures 
localization taxes in Shipments and inserts Tax lines in AR Invoices and Credit Memos 
imported from Order Management. You have to schedule the concurrent to submit the 
request at suitable intervals. Please make it mandatory to Schedule this concurrent 
program.

The concurrent 'AR Tax and Freight Defaultation' would automatically run to Insert Tax
lines in AR Invoices created manually.

India Local Receivables - Reports - Other - Submit Requests - Select 'India Local 
Concurrent For Processing Order Lines to AR' - Schedule

Important: You can schedule this concurrent either for the current 
Operating Unit or for all Operating Units. In order to run this for all 
Operating Units, enter 'Yes' in 'Process for All Operating Units' 
parameter.

If the Concurrent is being run / scheduled for all Operating Units, the 
Parameter for Process for All Organizations has to be set as "No" else it 
will result in datainconsistency.

This Request will not process Records that are revenue recognized / GL 
Posted and hence it is imperative that this Request be run prior to 
revenue recognition & GL Posting. Any errors should be cleared prior 
to GL Posting. 

Setting Incompatibilities

• This program should be set incompatible to

• Auto Invoice Import

• Itself

India - Importing Excise Invoice Numbers to AR
From ONT Patchset 'H', when interface trip stop happens, first Order Management 
Interface occurs and then the Inventory Interface occurs. This is reverse to what was 
happening prior to ONT patchset 'H'.

Due to this reason when shipment is done, interface trip stop gets executed and in case 
the inventory interface goes into warning due to reasons unknown, the delivery id of 
the shipment does not feature in the excise Invoice generation programs parameter.

As the Order Management interface is completed, this order is interfaced to AR and an 
AR Invoice is created. 
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When Excise Invoice number generation happens after the AR Invoice is created, 
localization AR tables do not have Excise Invoice number imported from Localization 
Shipping Tables. In short, Excise Invoice Number present in shipment localized screen 
is not imported to AR localization tables.

This program is encapsulated as a stored procedure and takes the Start Date, End Date 
and Invoice number as the parameter. This parameter shows a list of all Invoice 
numbers where Excise Invoice number is generated in shipment but is not present in 
the AR tables.

The concurrent program can be invoked by submitting a single request from the Other 
Reports request group in India Local Receivables Responsibility. You can also schedule 
this concurrent request in case these issues are frequent in your instance.

India - ST Forms Receipt Processing
Submitting 'India - ST Forms Receipt Processing' concurrent program would generate 
Invoice details required for Receiving Sales Tax Forms.

This concurrent program is available in India Local Receivables Responsibility. This 
request would check for all Invoices that have Sales Tax with concessional Form 
applicability. Only validated Invoices would be considered for processing. The Invoice 
would be considered for Processing only if it was not processed earlier. Processed 
Invoices would be considered conditionally based on the changes to the document. This
concurrent is for processing data and does not result in any printable output.

You can submit this request from:

India Local Receivables - Reports - Other Reports - 'India - ST Forms Receipt processing'

Field Description Type Action Description

Operating Unit (Display
Only)

  Value determined from the Profile
values

From Date Mandatory   Low Value of Invoice Date to filter the
Invoices

To Date Mandatory   High Value of Invoice Date to filter the
Invoices
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Field Description Type Action Description

Process for All
Operating Units?

    If you select 'Yes' in this field, then, the
program would process Invoices
corresponding to all Operating Units
defined in the system. Else, only those
related to the Operating Unit
determined from Profile would be
processed.

Customer     This will be used to filter the data
related to given Customer, otherwise
all Customer's related data is
processed.

Customer Site     This will be used to filter the data
related to given Customer site,
otherwise all Customer Site's related
data is processed.

Enable Trace     On selecting 'Yes' in this field, a Raw
Trace File would be generated for this
request.

It is a prerequisite to have 'Enable
Trace' checked for 'India - ST Forms
Issue Processing' Concurrent Program.

India - Program to Generate eTCS Quarterly Returns
Use the Submit Requests from India Local Receivables and enter India - Program to 
Generate eTCS Quarterly Returns in the Name field to submit the concurrent request.

Concurrent Parameters

Field Description Type Action Description

Legal Entity Required PICK The Legal Entity for 
which the report is 
being generated.
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Field Description Type Action Description

Org TAN Number Required PICK The Organization 
TAN Number for 
which the report is 
being generated.

Organization Required PICK The Inventory 
Organization for 
which the report is 
being generated.

Financial Year Required PICK The Financial year for
which the report is 
being generated.

Quarter of the Fiscal 
Year

Required PICK The Quarter of the 
Fiscal year for which 
the report is being 
generated.
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Field Description Type Action Description

Collection Code Required PICK The Collection code 
for which the report 
is being generated. 
This can be any of the
following values:

• Alcoholic liquor 
for human 
consumption

• Timber obtained 
under a forest 
lease

• Timber obtained 
under any mode 
other than forest 
lease

• Any other forest 
product not 
being timber or 
tendu leave

• Scrap

• Parking Lot

• Toll Plaza

• Mining and 
Quarrying

• Tendu Leaves

Tax Authority Required PICK The Tax authority for 
which the report is 
being generated.

Tax Authority Site Optional PICK The Tax authority site
for which the report 
is being generated.



India Local Receivables    5-57

Field Description Type Action Description

Seller Name Required The Seller Name that 
needs to appear on 
the report.

Seller State Required PICK The Seller State that 
needs to appear on 
the report.

Address Changed 
since Last Return?

Required PICK Enter 'Yes' or 'No' to 
the question of 
'Address Changed 
since last return'.

Collector Status Required PICK The Collector Status 
of 'Central 
Government' or 
'Others' that needs to 
appear on the report.

Person Responsible 
for Collection

Required The Name of Person 
responsible which 
needs to be printed 
on the report.

Designation of Person
Responsible

Required The Designation of 
Person responsible 
which needs to be 
printed on the report.

Address of the Person
Responsible

Required The Address of 
Person responsible 
which needs to be 
printed on the report.

State of the Person 
Responsible

Required The State of Person 
responsible which 
needs to be printed 
on the report.

PIN of the Person 
Responsible

Required The PIN Code (Postal 
Code) of Person 
responsible which 
needs to be printed 
on the report.
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Field Description Type Action Description

Responsible Person's 
Address Changed 
since Last Return ?

Required Enter 'Yes' or 'No' to 
the question of 
'Responsible Person's 
address changed 
since last return'.

Start Date Optional The start date from 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.

End Date Optional The end date till 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.

Provisional Receipt 
Number

Optional PICK The Provisional 
Receipt Number in 
case the return has 
been filed earlier.

File Path Required PICK The file Path where 
the Flat file needs to 
be located. Ensure 
that write permission 
exists for the given 
file path.

File Name Required PICK The name of the Flat 
file that is generated.
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Field Description Type Action Description

Action Event Required PICK The Concurrent can 
be run with any one 
of the following three 
parameters :

• F – Generate the 
Flat File

• H - Generate the 
Flat File with 
Headers

• V – Validate the 
Data

This concurrent will not generate a report output but would generate a flat file at you 
specified location, which can be used to file eTCS Quarterly returns.

India - Program to Generate eTCS Yearly Returns
Use the Submit Requests from India Local Receivables and enter India - Program to 
Generate eTCS Yearly Returns in the Name field to submit the concurrent request.

Concurrent Parameters

Field Description Type Action Description

Legal Entity Required PICK The Legal Entity for 
which the report is 
being generated.

Org TAN Number Required PICK The Organization 
TAN Number for 
which the report is 
being generated.

Organization Required PICK The Inventory 
Organization for 
which the report is 
being generated.
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Field Description Type Action Description

Financial Year Required PICK The Financial year for
which the report is 
being generated.

Collection Code Required PICK The Collection code 
for which the report 
is being generated. 
This can be any of the
following values:

• Alcoholic liquor 
for human 
consumption

• Timber obtained 
under a forest 
lease

• Timber obtained 
under any mode 
other than forest 
lease

• Any other forest 
product not 
being timber or 
tendu leave

• Scrap

• Parking Lot

• Toll Plaza

• Mining and 
Quarrying

• Tendu Leaves

Tax Authority Required PICK The Tax authority for 
which the report is 
being generated.
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Field Description Type Action Description

Tax Authority Site Optional PICK The Tax authority site
for which the report 
is being generated.

Seller Name Required The Seller Name that 
needs to appear on 
the report.

Seller State Required PICK The Seller State that 
needs to appear on 
the report.

Address Changed 
since Last Return?

Required PICK Enter 'Yes' or 'No' to 
the question of 
'Address Changed 
since last return'.

Collector Status Required PICK The Collector Status 
of 'Central 
Government' or 
'Others' that needs to 
appear on the report.

Person Responsible 
for Collection

Required The Name of Person 
responsible which 
needs to be printed 
on the report.

Designation of Person
Responsible

Required The Designation of 
Person responsible 
which needs to be 
printed on the report.

Address of the Person
Responsible

Required The Address of 
Person responsible 
which needs to be 
printed on the report.

State of the Person 
Responsible

Required The State of Person 
responsible which 
needs to be printed 
on the report.
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Field Description Type Action Description

PIN of the Person 
Responsible

Required The PIN Code (Postal 
Code) of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person's 
Address Changed 
since Last Return ?

Required Enter 'Yes' or 'No' to 
the question of 
'Responsible Person's 
address changed 
since last return'.

Start Date Optional The start date from 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.

End Date Optional The end date till 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.

Provisional Receipt 
Number

Optional PICK The Provisional 
Receipt Number in 
case the return has 
been filed earlier.

File Path Required PICK The file Path where 
the Flat file needs to 
be located. Ensure 
that write permission 
exists for the given 
file path.

File Name Required PICK The name of the Flat 
file that is generated.
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Field Description Type Action Description

Generate Headers Required PICK The Concurrent can 
be run with any one 
of the following two 
parameters:

• No – Generate 
the Flat File

• Yes - Generate 
the Flat File with 
Headers

This concurrent will not generate a report output but will generate a flat file at your 
specified location, which can be used to file eTCS Annual returns.

Managing Receivables Transactions
This Section elaborates Transaction cycles in India Localization Accounts Receivables 
Module. This section gives further details on using Transactions (Localized), AR-3A 
Form Tracking, Supplementary Invoices and TDS Certificates Received.

Transactions (Localized)
Transactions with localized taxes can be created in the Receivables Module. The taxes 
will get calculated for the item based on the tax defaulting set ups or taxes can be added
to the transactions manually.

Transactions in AR with can be created through the Auto Invoicing where the 
transactions done in Order Management Module will get interfaced to the Receivables 
Module. The taxes from the Order Management Module will be interfaced to AR while 
running the Auto Invoice Program.

The other option is to create stand-alone AR transactions in AR with localization taxes. 
Based on the tax defaulting set up the localization taxes and freight will get calculated 
for the transaction. Based on the set up in Bond Register, Excise transactions will get 
recorded in the respective Excise Records and Excise Invoices can be created. User 
needs to select appropriate transaction sources which are associated wit bond register 
for updating the excise related registers and records. If the user selects a transaction 
source that is not associated with the Bond Register no updates will be done in the 
Excise Registers and no Excise Invoice will get generated for the transaction.

Important: If a transaction is created with Excise Duty and completed 
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by clicking the complete button, user should not un apply the 
transactions. If the user un applies the transaction, the excise taxes 
debited in the Excise Registers will not be reversed and this might lead 
to further complications in adhering to the Excise Rules and 
Procedures.

Also note that base applications recalculates taxes on the event of Incompletion and 
Completion. Thus localization taxes would be replaced with ZERO if user Incompletes 
and Completes a once Completed Invoice. The Incompletion feature should not be used for 
making corrections to Invoice imported from Order Management else the taxes would get 
replaced with zero in the base applications screen.

In India Localization, navigate to the Enter Transactions window as follows: 

India Local Receivable - India Localization - Transactions - Transactions (Localized)

The User can navigate through the Select Receipts button to perform the Matching of 
Receipts quantity. Once the user saves the Matching Screen, Excise Tax Amount will be 
replaced by the Excise Amount from the Receipt Tax Line for the proportionate 
quantity.

Field
Description

Type Action Description

Operating Unit (Required) (Pick) The Operating Unit for which the
Transaction is being entered.

Organization (Required) EDIT HELP
PICK

The user needs to specify the
Inventory Organization name from
LOV in which the transactions is
going to be accounted

Location (Required) EDIT HELP
PICK

The user needs to specify the Location
of an Inventory Organization from
LOV in which the transaction is going
to be accounted.

After entering the above information the user can navigate to Enter Invoice Standard 
Apps form where the transaction Number, Customer details and Item details will be 
entered to create a transaction, save and complete the Standard Apps transaction. 
Depending upon the Tax category attached to the item for the customer, the tax lines 
will be defaulted. 

Important:  If the user enters a Transaction using Transactions screen 
directly without navigating through Transactions (Localized) screen, 
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the above Organization & Location are not captured for the mentioned 
transaction. This would result in such transaction not being query 
enabled on the Transactions (Localized) Screen even at a latter date.

Field Description Type Action Description

Customer Name (Defaulted)   The Customer name will be defaulted
here after the Transaction has been
entered in Standard Applications
form.

Customer Number (Defaulted)   This will be the defaulted Customer
Number.

Transaction Number (Displayed)   The Transaction number will be
displayed here once the user has
entered and saved the data in the
Standard Apps Form.

Transaction Type (Displayed)   This will be displayed depending
upon the transaction type selected in
the Standard Apps Form.

Source (Displayed)   This will be displayed depending
upon the source selected in the
Standard Apps Form.

Exemption Type (Required/Opti
onal)

  If the user needs to carry out an
exempted transaction, the exemption
type needs to be selected from this
field. For transactions on payment of
duty, this field needs to be left as null.
Whenever the user picks for an Excise
Exempted Transaction the user needs
to enable the excise exempted flag in
the line level.

Excise exemption
options

CT2 IND   This option needs to be mapped to the
requirements under Rule 6 of The
CENVAT Credit Rules 2002. This
amount will not be Accounted in the
Receivable.
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Field Description Type Action Description

  CT2 OTH IND   In case the customer needs to be
debited for the Excise Duty Debited
under Rule 6 of The CENVAT Credit
Rules 2002, this option needs to be
used. As per the provisions of the
above rule, Duty debited should not
be debited to the Customer.

  CT3 IND.   This option needs to be picked up for
clearance of goods to 100% Export
Oriented Units without payment of
Duty against CT 3 Certificate.

Excise exempted
certificate IND /
Excise exempted
certificate - Others -
IND

    This option may be used for
transactions without payment of duty

Exemption Ref. No. (Required/Opti
onal)

  The user can enter CT2 Form No , CT3
Form No, Excise Exemption
Certificate Number based on the
above Exemption type he selected.

Exemption date (Required/Opti
onal)

  The user needs to enter date CT2
form, CT3 form , Excise Exemption
Certificate respectively.
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Field Description Type Action Description

VAT Exemption Type (Optional)   If you need to carry out an VAT
Exempted Transaction, the exemption
type needs to be picked up in this
field. For transactions where VAT is
payable, this field need to be left as
null. Whenever you pick for an VAT
Exempted Transaction, all the lines
get the VAT Exempted Flag and the
VAT Exemption type defaulted. If for
any line, VAT exemption is not
applicable, then you can uncheck the
VAT exemption for such line. The
VAT Exemption types are:

Vat Exemption Item

Export

Inter State Sale

Sale to Specified parties

Transfer

VAT Exemption Date (Required/Opti
onal)

  This field is required when VAT
Exemption Type is selected.

VAT Exemption
Refno

(Required/Opti
onal)

  This field is required when VAT
Exemption Type is selected.

Tax Amount Block      

Tax (Displayed)   Tax amount of the Standard Apps
Form will be displayed here.

Total (Displayed)   Total amount of the transaction
including tax for a line will be
displayed here.
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Field Description Type Action Description

Update RG Flag (Displayed)   This will be enabled only when the
transaction batch source is having an
association with any of the Four
Register Types being Bond Register
(For Exports), Domestic with Excise,
Domestic without Excise, Export with
Excise for that Organization and
Location. The user can update the flag
when the check box is checked to
make it unchecked. The vice versa is
not possible.

Important: By default, the duty will get debited in the register based on the register
preference set up in the Additional Supplier Information. User has an option to change the
duty paying register for each transaction.

Field Description Type Action Description

Line block (Conditionally
Required)

  In the case of CT2 and CT3 Transaction,
Form AR3A needs to be accompanied
with the shipment, then the User needs
to specify the AR3A form Number in
this field. AR3A form tracking will be
done for Customer wise which will be
useful to the User to follow up the
outstanding AR3A form from his
Customer in order to submit to the
Excise Dept.

AR 3 A form No     AR3A form Number needs to be entered
here by the User.

AR 3 A form Date (Conditionally
Required)

  AR3A form date needs to be entered
here by the User.

Exempted Flag (Conditionally
Required)

CHECK
BOX

The user needs to enable this Flag to do
a transaction under any of the above
exempted type for a line item.
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Field Description Type Action Description

Complete Flag     Once the transaction in the Standard
Apps Form has been completed then
this flag will be checked automatically.
The Excise Registers will get updated
immediately on completing the
transactions by clicking the Complete
Button in the Standard Applications.

VAT Exemption Flag   CHECK
BOX

Once at header level a Invoice is marked
as VAT Exempt, this check box will get
checked. If any particular line is not
supposed to be VAT Exempt, the box
should be unchecked.

VAT Exemption Type (Optional)   If you need to carry out an VAT
Exempted Transaction, the exemption
type needs to be picked up in this field.
For transactions where VAT is payable,
this field need to be left as null.
Whenever you pick for an VAT
Exempted Transaction, all the lines get
the VAT exempted flag and the VAT
Exemption type defaulted. If for any
line, VAT Exemption is not applicable,
then you can uncheck the VAT
exemption for such line. The VAT
exemption types are:

• Vat Exemption item

• Export

• Inter State Sale

• Sale to Specified parties

• Transfer

VAT Exemption Date (Required/Optio
nal)

  This field is required when VAT
Exemption Type is selected.

VAT Exemption
Refno

(Required/Optio
nal)

  This field is required when VAT
Exemption Type is selected.

List of Buttons and Description
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The following buttons are available in the Enter Transaction India Localization form 
and their features.

Button name Description Purpose

Open Button For creating transactions in
stand alone AR with
localization taxes, user needs to
navigates to the Standard
Application transaction screen
only through the Transaction -
Localized Screen. Before
opening the Standard
Application Transaction
Screen, user needs to specify
the Organization and Location
in the Localization Screen.

The user can open Standard Apps
Transaction form through this
button.

Select Register User needs to open the select
register button only if he needs
to change the Duty Paying
Registers, which are being
defaulted.

The user can select Excise Register,
which is to be for a transaction. The

Register will be defaulted as per the
preference set in Organization
Additional Information but the user
is empowered to change the Register
by using this button. Such change
can only be made if It is a inventory
item and the balance in register is
sufficient to cover the Excise Duty
Payment

Taxes User needs to verify the taxes
that are being defaulted based
on the tax defaulting set ups.
He can modify the taxes if
required.

This can be done by clicking
the taxes button.

The user can view tax lines and
modify the tax lines for a transaction.

Pre Print Inv Nos User can enter Pre-Printed
Excise Invoice Number against
a transaction

Such entry can be in alpha numeric
giving from & to numbers that will
be stored for reference against all
lines of the Invoice.

After entering the above information, the user can navigate to Enter Invoice Standard 
Apps form through that the Transaction Number, Customer details and Item details 
will be entered. Save and Complete the Standard Apps form and depending upon the 
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Tax Category attached to the Item for a Customers, the tax lines will be defaulted.

If the Tax lines has Excise Type of Tax then the System by itself will default the Excise 
Record to be used for the transaction depending upon the Order of Reference defined 
for Excise Record in the Organization Accounts Information however the user can 
change the Register and Excise Invoice Number will be allotted once the transaction is 
completed in the Enter Transaction India Localization Form. After Save and Close the 
above Standard Apps Form. 

If the 'Taxes' Button is clicked for a once completed Transaction, System will show the 
following message:

It is imperative that Taxes are available on the Invoice prior to completion. Hence On 
trying to complete a Invoice when the concurrent 'AR Tax and Freight Defaultation' is 
running, System will show the following message :

In the above case, you need to allow the concurrent to complete, requery the Invoice 
and then complete.

On similar lines, it is required that the Localization taxes get processed prior to GL 
Posting. Hence if you try to Post a record to GL when the Taxes for the same are not yet 
processed, GL Posting will result in the following error:

'AR-ARGLTP: -20131 ORA-20131: India Taxes found in ja_in_temp_lines_insert table. " 

This is as per intended behavior of the product to stop you from GL Posting AR 
Transactions where India Localization Tax processing is pending. The above error is 
applicable for both Manually entered transactions as well as Imported transactions from
Order Management. You can find details of such transaction by running the following 
query for the month where you are trying to GL Post:

Select * from ja_in_temp_lines_insert;

Reprocessing Errored OM Tax Records
The concurrent 'India Local Concurrent for processing Tax Lines to AR' for processing 
of Tax Lines for Invoices created through Order Management runs in batch mode. 
Whenever, some of the Tax Lines remain unprocessed due to some error, the error 
message is captured by localization. This feature provides with an option to view these 
error records and corresponding messages and mark them eligible for Reprocess. You 
would also have an option to delete these records.

To view the error records, navigate to 

India Local Receivables - Control - India - Resubmit AR Tax and Freight

The form shows Invoice Number, Number of distribution Lines, Customer Id, 
Customer Name, Total Tax Amount, Last Updated Date and Error Message for all Tax 
Lines (grouped by Invoice Number) that have ended in an error during 'India Local 
Concurrent for processing Tax lines to AR' program.

The user can check the records for resubmitting only one at a time
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For Resubmission of the Error Invoices

Check 'Re-Submit' for the Invoices that need to be resubmitted Click on 'Submit' button.

Submit the concurrent 'India Local Concurrent for processing Tax lines to AR' for these 
Invoices to get processed.

For Deletion of the Error Invoices

Check 'Delete' for the Invoices that need to be deleted.

Click on Submit button.

The above delete option is mainly useful in cases where the Debit Memo for Taxes has 
already been raised for the Tax Amount & the Tax Line is no longer required to be 
processed. This marks the line as deleted & does not show the record next time as 
eligible for reprocessing.

Important: The form would merely show / display the Invoices eligible 
for reprocessing. You have to explicitly run the concurrent 'India Local 
Concurrent for processing Tax lines to AR' for these Invoices to get 
processed.

Caution: It is advisable to check this Form Prior to Running GL Posting 
and clear all the records from this Form. Base Applications Revenue 
Recognition Program does not post a tax line if it does not have a 
revenue attached and hence if resubmission option is used for a record 
post GL Posting then such record remains as an unposted tax line & 
interferes with period closing. In case of such event happening, the only
option is to mark such tax line as posted with a data fix & pass manual 
entries for the tax amount in GL.

Resubmission of a record post GL Posting will not result in processing of the record & 
will remain stuck in the form. The only option post GL posting is to delete the record 
using this Form & pass manual Debit Memo for the tax portion to rectify the receivable 
amount.

With the current architecture, GL Posting is stopped for a transaction if the taxes are 
found to be stuck in the above form. GL Posting would show the following error:

"AR-ARGLTP: -20131 ORA-20131: India Taxes found in ja_in_temp_lines_insert table. "

You need to either get the taxes processed or deleted (post necessary correction of 
receivable amount) prior to GL Posting such stuck records.

Using Sales Tax Declaration Forms - Receipt Tracking
Sales by Registered Dealers, to Registered Dealer would be eligible for Concessional 
Rate of Sales Tax. This would require identification of transactions that are eligible for 
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such rates. Also, the Declaration Form to be issued by the Buyer in order to avail such 
rate.

You can record details of Sales Tax declaration forms for each of the Sales Invoice. India 
Localization provides you with a feature to define Form Names, Define Taxes with 
Declaration Forms attached, Tracking Invoices for which these Forms have to be 
received, Record details of Forms received and query and view the Received Form 
details.

Prerequisites

Before creating the Transactions with Concessional Rates of Sales Tax, following setups 
need to be done:

• Define Form Names

• Define Taxes with Form Names attached

• Define Customer Additional Information

• Define Tax Categories with this Tax Code

• Define Item Categories with this Tax Categories

Before you record details of Concessional Forms to be issued to Supplier, following 
need to be done: 

• Complete Shipment with Sales Taxes with Form Names attached 

• Create AR Transactions for these Orders

• Ensure that Transaction lines are created to account for Localization Taxes.

• Complete the Invoice.

• Submit 'India - ST Forms Receipt Processing'

Recording details of Sales Tax Declaration Forms:
To record details of Sales Tax Declaration forms, navigate to 'Define Sales Tax Form 
Details' window as follows

India Local Receivables - Customers - Receipt ST Forms

In 'Find ST Form Details' screen, enter the Customer Name, Customer Site and Form 
Type in order to query for Invoices against which Forms are not yet received. You can 
enter other query criteria to find specific Invoice.

Details to enter in each of the fields would form criteria for the records fetched.

You can fetch specific records based on the values entered in the query criteria.
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The field wise description for the screen "Find Sales Tax Form Details" to receive the ST 
Forms is given below

Field Description Type Action Description

Find ST form Details

Issue/Receipt (Display only)   This field gets populated as Issue /
Receipt based upon the Responsibility
Selected.

Issue in case of Payables and Receipt
in case of Receivables.

Party Name     Party Name as defined in the ST form
related data. Compared against the
Party Name as available in the
Invoices to which Sales Tax Forms is
applicable.

Party Site     Party Site as available in the Invoices
to which Sales Tax Forms is
applicable.

Form Type     Form Type's which are applicable to
the Sales Tax attached to the Invoices.

Invoice from Date     Invoices having Invoice Date starting
from this date onwards would form a
part of the query criteria for matching.
Viewing matched records. Should be
a valid date in 'DD-MON-YYYY'
format

Invoice To Date     Invoices having Invoice Date till this
date would form a part of the query
criteria for matching. Viewing
matched records Should be a valid
date in 'DD-MON-YYYY' format

Fin Year     Fin year as applicable to the ST Form
related data for querying already
entered Forms.
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Field Description Type Action Description

Form Number     Form Numbers that are issued to the
Supplier, Supplier Site and Form Type
that was earlier entered in system.

Issue/Receipt Date     Enter a Date, which might match with
the Receipt Form's Transaction Date.

View Forms Button     Button, which upon being clicked
invokes the 'View Sales Tax form
Details' Screen

Issue/Receive Forms     Button, which upon being clicked
invokes the 'Define Sales Tax form
Details' Screen

Based on the query criteria, the system fetches the Invoices to be matched. This 
information would be displayed in 'Define Sales Tax Forms Details' screen.

The find window serves the dual purpose of entry of new forms by querying of 
Transactions where form entry is pending and the purpose of querying already entered 
forms to check details.

This screen has Header and Detail sections

Header Section

This section allows you to create form detail like Fin year, Form Number Form Amount,
Form Date and Transaction date. These details can be entered for a combination of 
Customer Name, Customer Site, Form Type and Operating Unit.

The Customer Name, Customer Site and Form Type are populated as the context 
information from the Query Find Screen.

Its mandatory to enter Fin Year, Form Number Form Date and Transaction date fields 
before proceed to the detail section to select Invoices.

You may choose to key in the Form Amount and proceed to the detail section for 
selecting Invoices to match the Form Amount. Else, you can leave the form amount to 
be automatically populated upon save, based on the sum of all Invoice level Form 
Amounts.

Match All

On checking Match All field, the system automates matching based on the header form 
amount.

To use this feature, it would be a pre-requisite to enter Fin Year, Form Number, Form 
Amount, and Form Date and Transaction Date fields. 
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The Match all Checkbox is unchecked, by default.

Un-checking the checkbox causes the detailed Invoice level form amount to be set to 
zero.

Queried Amount

Queried Form Amount fields displays the total Form Amount that can be matched 
across all unmatched Invoices.

This is a display only field and cannot be modified.

Detail Section

This section displays unmatched Invoices in Receipt Tab Page. The records would be 
grouped based on the combination of Invoice and Transaction Id.

The sum of all Invoices level Form Amounts entered is displayed at the bottom in the 
Total Form Amount display field.

Important: It is mandatory that the sum of detail level Invoice Form 
Amounts match with header Form Amount. This is applicable only 
when you enter the Form Amount.

In case of Invoices with negative tax target amounts the form amount 
entered should exactly be equal to that of the Tax target amount.

The amount to be tracked (Tax Target amount) reflects the base amount
on which Sales Tax is calculated and does not include the sales tax 
amount. Viz., the amount will be net of sales tax amount and not the 
Invoice value.

On saving the entered details, the Header Block is refreshed and the Form details are set
to blank. Also, the Detail block is refreshed and only unmatched and partially matched 
records are fetched. The cursor returns to the header.

Issued Forms can be viewed through the 'View Sales Tax Form Detail' Screen 

The field wise description for the screen 'View Sales Tax Form Detail' to receive the ST 
Forms is given below

Field
Description

Type Action Description

Define Sales
Tax Form
Header Block
(Matching
Header)
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Field
Description

Type Action Description

Party Name (Display only)   Context Information carried over
from Query Find Screen

Party Site (Display only)   Context Information carried over
from Query Find Screen

Form Type (Display only)   Context Information carried over
from Query Find Screen

Fin Year Required   User defined Fin Year Value to be
selected from list of values as defined
in the Tax Year Setup

Form Number Required   Sales Tax Form Number to be defined
by the user. This needs to be unique
for a Party Name , Party Site, Org ID,
Form Type , Party Type and Fin year
combination

Form Amount     The form Amount needs to exactly
match with the sum of all Invoice
level detailed form amounts.

Form Date Required   Should be a valid date in
'DD-MON-YYYY' format

Transaction
Date

Required   Should be a valid date in
'DD-MON-YYYY' format

Match All Default Value 'N'   Requires a valid value for Fin Year ,
Form Number, Form Amount, Form
Date and Transaction Date when
checked. Matches all the Invoice level
records based on the form amount
value.

When unchecked , sets all detail level
Invoice form amount to 0.

Queried Form
Amount

(Display only)   Displays Total Form Amount that can
be matched across all unmatched
Invoices
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Field Description Type Action Description

Sales Tax Form Detail
Block (Matching
Detail) - Receipt Side

     

Order/Invoice (Display
only)

  Indicates whether the record is an
Order or an Invoice. Values are
'ORDER', 'INVOICE'.

Invoice Number (Display
only)

  This is the Invoice Number

Source Type (Display
only)

  This field displays the Transaction
Type related to the record.

Order Number (Display
only)

  This field displays the Order
Number. This would not be
displayed for Manual AR Invoices.

Tax Target Amt (Display
only)

  This field displays the Taxable Basis
for used for calculating Sales Tax.

Matched Amount (Display
only)

  This field displays the Matched
Amount based on the previous
matches.

Form Amount for each record cannot
be greater than Matched Amount
reduced from Tax Target amount for
that record.

Form Amount     In case of Invoices sum of Invoice
level form amount and Matched
amount cannot be greater than Tax
target amount.

In case of Invoices with Negative Tax
Target Amounts the form amount
needs to be exactly same as that of tax
target amount.

Total Form Amount (Display
only)

  Sum of all Invoice level Form
amounts.
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Viewing Received Forms
You can view the Sales Tax Forms Received by clicking on the 'View Forms' button on 
the 'Find ST Forms Details' window. This would open 'View Sales Tax Form Details' 
window. 

You will have to enter Customer, Customer Site and Form Type Details before you 
query for the Issued Forms. 

This window has three sections Header, Details and Sub-Details.

Header Section

The section shows Customer Name, Customer Site and Form Type. These details are 
populated as the context information from the Query Find Screen.

Sales Tax Form Details

This section displays Form details based on the query criteria specified in the Query 
Find screen.

Sales Tax Form Sub-Details

This section displays all matched Invoice grouped by combination of Invoice Number 
and Transaction Number.

For each Invoice the Tax Target amount verses the Matched Amount is displayed based 
on the above grouping.

The field wise description for the screen 'View Sales Tax Form Details' form is given 
below.

Field Description Type Action Description

View Sales Tax Form
Header Block

     

Party Name (Display only)   Context Information
carried over from
Query Find Screen

Party Site (Display only)   Context Information
carried over from
Query Find Screen

Form Type (Display only)   Context Information
carried over from
Query Find Screen
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Field Description Type Action Description

View Sales Tax Form Detail Block

Fin Year (Display only)   Fin Year as created
from the Match Detail
Screen.

Form Number (Display only)   Form Number as
created from the
Match Detail Screen.

Form Date (Display only)   Form Date as created
from the Match Detail
Screen.

Transaction Date (Display only)   Transaction Date as
created from the
Match Detail Screen.

Form Amount (Display only)   Form Amount as
created from the
Match Detail Screen.

View Sales Tax Form Sub Detail Block - Receipt Side

Order/Invoice (Display only)   Indicates whether the
record is an Order or
an Invoice. Values are
'ORDER' , 'INVOICE'.

Invoice Number (Display only)   This is the Invoice
Number

Source Type (Display only)   This field displays the
Transaction Type
related to the record.

Order Number (Display only)   This field displays the
Order Number. This
would not be
displayed for Manual
AR Invoices.
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Field Description Type Action Description

Tax Target Amt (Display only)   This field displays the
Taxable Basis for
used for calculating
Sales Tax.

Reports
This section provides overview and detailed descriptions of these reports:

• Commercial Invoice

• ST Form Customer Report

• Total Sales Report

• India - Debtors Ledger Report

• Debtors Trial Balance Report

• Supplementary Transaction Details Report (AR)

• Supplementary Invoice Consolidation Report (AR)

• Status of AR3 A form Report

• Duty Draw Back Report

• India - Cash/Bank Book Report

• India - Service Tax Pending Liability Report

• India - Service Tax Pending Recovery Report

• India - Service Tax ST3 Report

• India ER1 Report

• India TCS Certificate

• India - TCS Form 27B

• India - TCS Quarterly Report
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• India - TCS Annual Report

Commercial Invoice
This Report gives you the Commercial Invoice's generated.

PCDATA cannot be inserted: This report was for "ISSUE OF INVOICE UNDER 
CENTRAL EXCISE RULE 57G OR 57T ". This section is no longer Valid, however the 
report is not dropped so that the fields appearing in the report can be used as an 
example / base for Client required output to generate and print Invoices. This is 
applicable for Trading Invoice only and not for Invoice under Manufacturing 
Organization.

Report Submission

Use the Other Reports in India Local Receivables form and enter India-Commercial 
Invoice Report in the Name field to submit the report.

Report Parameters

Organization (Optional) PICK

Enter the Organization from which delivery of goods is made

Location (optional) PICK

Enter the Location of the Organization.

Customer (Optional) PICK

Enter the Customer Name

Order/Invoice (optional) 

Invoice (Required)

Commercial Invoice the user wants to take

Report Headings

Report headings provide you with general information about the contents of the report 
and the user entered parameters.

Column Headings

This reports provides following information

Item

Item Classification

Quantity

Total Amount

Duty Amount

Duty Per Unit
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ST Form Customer Report
Use Sales Tax Forms due from the Customers to track Customers for whom you have 
given Sales tax discount and you have not yet received the ST Forms for an 
Order/Invoice.

Report Submission 

Use the Submit Requests (India Local Receivables Module) form and enter India ST 
Forms Customer Report in the Name field to submit the report.

Report Parameters

From Date (Required)

Enter a date from which you wish to take the Sales Tax Forms Report. The date is based 
on the transaction date of the Invoice.

To Date (Required)

Enter an end date till which you wish to take the Sales Tax Forms Report. The date is 
based on the transaction date of the Invoice.

Matching Info ? (Required) PICK

This decides the type of report output

Following are the options available :

M - Matched Amount (Partial & Fully Matched) (When Matched Amount is not Zero)

P - Partially Matched (When Tax Target Amount is not equal Matched Amount)

F - Fully Matched (When Tax Target Amount not equal Matched Amount)

U - Unmatched ST forms details (When Matched Amount is 0).

Party (Optional ) PICK

Enter the party for which you wish to take the Sales Tax Forms Customer Report. It 
displays a list of Customer Names for those Customers for whom Localization setup is 
done. If not entered it will result in picking of all Customers where details are available.

Party Site (Optional) PICK 

Enter the party site for which you wish to take the Sales Tax Forms Customer Report. It 
displays a list of Customer Sites for which Localization setup is done. If not entered it 
will result in picking of all sites pertaining to the Customer based on details available.

Organization (Optional ) PICK

Enter the Organization for which you wish to take the Sales Tax Forms Customer 
Report. It displays a list of Organizations for which Localization setup is done. If not 
entered it will result in picking of all Organizations based on details available.

Location (Optional ) PICK

Enter the Location for which you wish to take the Sales Tax Forms Customer Report. It 
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displays a list of Locations for which Localization setup is done for the Organization 
selected earlier. If not entered it will result in picking of all locations based on details 
available.

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Organization Information based on User parameter input. Organization 
Name, Address on the Top left Corner Organization's LST Registration Number and 
CST Registration Number on the Top Right Corner

Column Headings

Party No.

Customer Number to whom the Sale was made.

Name of Customer 

Name of Customer to whom the Sale was made.

Customer site

Name of Customer Site.

Order Number

The Sales Order Number is displayed in this column for a Auto Invoiced Invoice. For a 
manual AR Invoice , it displays "N/A"

Order Date

The Sales Order Date for the Sales Order associated with the Invoice is displayed in this 
column for a Auto Invoiced Invoice. For a manual AR Invoice , it displays "N/A"

Invoice Number

Invoice Number of the Invoice is displayed here. This is same as the Transaction 
number available in AR.

Invoice Date 

Invoice date of the Invoice is displayed here. This is same as the Transaction date 
available in AR.

Excise Invoice Number

Excise Invoice Number for the Invoice is displayed here. This is based on the Excise 
Invoice Number available in AR.

Excise Invoice Date

Excise Invoice Date for the Invoice is displayed here. This is based on the Excise Invoice 
Date available in AR.

Invoice Amount

Displays the Total Invoice Amount of the Invoice. It includes Line amount and tax 
amount.
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Item 

Description of Item sold.

Form Type

Displays the Sales Tax Form type attached to the tax.

Tax Rate

Sales tax rate for the particular Invoice Line. 

Taxable Amount

Displays the amount based on which the sales tax is calculated.

In addition to the above, the following columns are displayed in case of Matched ST 
Forms.

Matched Amount 

This column displays the amount matched.

Form Number

This column displays the form number, which was matched.

Form Date

This column displays the form date of the form the matching was done. 

Form Amount

This column displays the form amount, which was matched.

Report Order

Report is printed in the order of Inventory Organization, Customer, Customer Sales Tax
Registration Number, Form type and Invoice Date for the selected parameters.

India Total Sales Report
This report gives you the total sales made from a Inventory Organization for a given 
period with tax details.

Report Submission

Use the Other Reports India Local Receivables form and enter India - TotalSales 
Report in the Name field to submit the report.

Report Parameters

Organization (Required) PICK

India Localization displays the Default Organization (default). Enter an Organization, 
you wish to take the Total Sales Report for.

Location (Optional) PICK

Enter a Location ( Skip for all) , you wish to take the Total Sales Report for.



5-86    Oracle Financials for India User Guide

Period of report (Optional ) 

Enter the period for which you wish to take the Total Sales report for. If From & To 
dates are not entered then all Sales till date will be reported. 

Report Style (Optional) PICK

Following options are available 'Show Both Detail and Summary', 'Show only Detail' 
and 'Show only Summary'

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Organization information based on User parameter input.

Column Headings

Sales Invoice No. & Date

Invoice Number and Date of Sales. 

Sales Tax Registration No. of Customer 

Central Sales Tax Registration No. of Customer as entered in Customer Entry Form.

Name of Customer

Name of the Customer to whom the sale was made.

Gross Amount

Gross Amount as entered in Invoice. 

Line Amount

Line Amount for a line for which LST or CST exists.

Sales Tax Rate

Sales tax rate for the particular Invoice Line.

Sales tax Amount

Total sales tax amount for the ST rate for the particular Invoice Line.

Certificate Type & Number

ST Form Type & Number, if any, for the particular Invoice Line.

Report Totals 

Invoice Total & Sales Tax total for the chosen period.

Report Summary

This section of the report lists the summary (Tax summary) of Rate wise total for Sales 
Taxes for Total Sales.

Total for <Tax type> @ rate %

Total for the Sales Tax Rate for the chosen period.
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Tax Total 

Total Tax for the chosen period.

Report Order

Report is printed in the order of Invoice Date and Tax Type for the selected 
Organization.

Important: It is mandatory to have Ship to Address for a Invoice to 
appear as a Transaction in this report. The Customer should have setup
of Customer Additional Information at site level.

The Invoice Created should have Sales Tax / CST or VAT type of Tax. If
such type of tax is not chargeable, a Tax with 0% needs to be attached 
to the transaction for the same to appear in this report.

India - Debtors Ledger Report 
Use this Report to get Debtor Ledger with complete details of Invoices, Debit Memos & 
Receipts.

Report Submission

Use the Other Reports (India Local Receivable module Only) form and enter India - 
Debtors Ledger Report in the Name field to submit the report.

Report Parameters

Customer Name (Optional) PICK

If the User wants Debtor Ledger for a specific Customer, then he need to enter 
Customer Name here otherwise Ledger for all the Customers for a given period will be 
reported.

Customer Number (Defaulted) PICK

Customer Number of the above Customer will be defaulted here.

Customer Type (Optional)

If the User wants Debtor Ledger for a specific Customer Type, then he need to enter 
Customer Type in this field otherwise Ledger for all the Customers for a given period 
will be reported

Start Date (Required) 

End Date (Required) 

Org ID (Optional) PICK 

If the User wants Debtor Ledger for a specific Inventory Organization, then he needs to 
enter Org ID in this field otherwise Ledger for all the Organizations for a given period 
will be reported
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Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input.

Column Headings

The Opening Balance for a Customer Multiple Currency wise will be sorted first 

and the Transaction for the period will be considered and the Closing Balance will be 
arrived in Multiple Currency. 

GL Date

GL Date for the transaction will be reported.

Order No 

Sales Order Number will be reported

Trx Number

Trx Number is meant for the respective Invoice, Debit Memo, Credit Memo Numbers.

Trx Date 

Transaction date will be reported.

Receipt Number 

Receipt Number will be reported

Receipt Date

Receipt Date will be reported

Remarks

Remarks in the respective transaction will be reported

Account Code

Respective account code of a transaction will be reported

Description 

Account Code Description will be reported 

Currency 

Transaction currency will be reported

Exchange Rate

Payment Voucher Invoice No and Date will be reported 

Transaction Dr Amt

Debit Amount in a foreign currency transaction will be reported.

Transaction Cr Amt

Credit amount in a foreign currency transaction will be reported.
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Functional Dr Amt

Rupee equivalent for the Debit amount will be reported.

Functional Cr Amt

Rupee equivalent for the Credit amount will be reported.

Debtors Trial Balance Report
Report Submission

Use the Submit Requests (India Local AR modules Only) form and enter India-
Debtors Trial Balance in the Name field to submit the report.

Report Parameters

Customer Name (Optional) PICK

If the User wants Debtor Trial Balance for a specific Customer, then he need to enter 
Customer Name here otherwise Trial Balance for all the Customers for a given period 
will be reported.

Customer Number (Defaulted) PICK

Customer Number of the above Customer will be defaulted here.

Customer Type (Optional) 

If the User wants Debtor Trial Balance for a specific Customer Type , then he need to 
enter Customer Type in this field otherwise Debtor Trail balance for all the Customers 
for a given period will be reported

Start Date (Required)

End Date (Required)

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input.

Column Headings

Sl.No

Serial Number of the Trial Balance will be reported.

Customer Type

Customer Type will be reported

Customer Name 

Customer Name will be reported.

Customer Code 

Customer Code (Number) will be reported.
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Currency

The Transaction currency will be reported.

Entered Amount

Closing Balance of a Customer in Foreign currency will be reported.

Rupee Amount

Rupee equivalent of a Customer will be reported

Supplementary Transaction Details Report (AR)
This Report gives the Supplementary Invoices, Credit Memos raised/to be raised for the 
Original Invoice

Report Submission

Use the Submit Requests (India Local AR modules Only) form and enter 
India-Supplementary Transactions Details Report in the Name field to submit the 
Report.

Report Parameters

Customer Name (Optional) PICK

If the User wants this Report for a specific Customer, then he need to enter Customer 
Name here otherwise this report give details for all the Customers for a given period 
will be reported.

Customer Number (Defaulted) PICK

Customer Number of the above Customer will be defaulted here.

Invoice Number (Optional)

If the User wants to see Supplementary Transaction for a specific Invoice, then he, need 
to enter that here.

Process Date (Optional)

For a Process date , the user can take the Report.

Supplementary Invoice Type (Optional)

Quick code are : Supplementary. Invoice, Credit Memo, Debit Memo 

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input. 

Column Headings

Sl. No

Serial Number of the Trial Balance will be reported.
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Invoice 

Original Invoice will be reported

Date 

Date of the Original Invoice will be reported.

Amount 

Amount of the Invoice will be reported.

Supplementary Invoice Type

Type like Supplementary Invoice, Credit Memo and Debit Memo will be reported. 
Amount of the Invoice will be reported.

Net Sales

Net Sales amount of the Supplementary Transaction will be reported.

Excise

Excise duty of the Supplementary Transaction will be reported.

Sales Tax

Sales Tax of the Supplementary Transaction will be reported.

CST

CST of the Supplementary Transaction will be reported. 

Others

Others taxes of the Supplementary transaction will be reported.

Effective Amount

This is the amount for which the Sup.Inv, Credit Memo, debit Memo is raised.

Order By

Original Invoice Number

Supplementary Invoice Consolidation Report (AR)
This report gives you the Consolidated Supplementary Invoice raised for a period

Report Submission

Use the Submit Requests (India Local AR modules Only) form and enter 
India-Supplementary Invoices Consolidation Report in the Name field to submit the 
Report.

Report Parameters

Customer Name (Optional) PICK

If the User wants this Report for a specific Customer, then he need to enter Customer 
Name here otherwise this report give details for all the Customers for a given period 
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will be reported.

Customer Number (Defaulted) PICK

Customer Number of the above Customer will be defaulted here.

Process Date (Optional)

For a Process date , the user can take the Report.

Supplementary Invoice Date (Optional)

For a particular Supplementary date, this report can be requested

Supplementary Invoice No (Optional)

For a particular Supplementary Number, this report can be requested

Supplementary Invoice Type (Optional)

For a particular Supplementary Type of Invoices, this report can be requested

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input.

Column Headings

Sl. No

Serial Number of the Line will be reported.

Item 

Item name will be reported

Description 

Description of the Item name will be reported

Line Amount 

Excise

Excise duty of the Supplementary Invoice (Consolidated) will be reported.

Sales Tax

Sales Tax of the Supplementary Invoice (Consolidated) will be reported.

CST 

CST of the Supplementary Invoice will be reported.

Others

Others taxes of the Supplementary Invoice will be reported.

Total Amount 

This is the amount for which the Sup. Inv, Credit Memo, Debit Memo is raised.
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Status of AR3 A form Report
This Report gives you the details about the AR 3A forms to be received from Customer.

Report Submission

Use the Submit Requests (India Local AR modules Only) form and enter India-AR3A 
Status Report in the Name field to submit the Report

Report Parameters

Organization/Location (Optional) PICK

If the User wants this Report for a specific Organization/Location, then he need to enter 
Organization Name here otherwise this report give details of AR3 A for dispatches 
made from all the Org/Location.

Customer Name (Optional) PICK

If the User wants this Report for a specific Customer, then he need to enter Customer 
Name here otherwise this report give details for all the Vendors for a given period will 
be reported.

Customer Number (Defaulted) PICK

Customer Number of the above Customer will be defaulted here.

Transaction Type (Optional )

Invoice / Order can be selected by the User.

Process Date (Optional) 

For a Process date , the user can take the Report.

Invoice Number (Optional)

For Specific Invoice this report can be taken.

Excise Exemption Type (Optional)

CT2 or CT3

Status (Optional)

Quick fields are ALL, RECEIVED & NOT RECEIVED

Order

To be filled

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input.

Column Headings

Customer Name
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Customer site 

Transaction Type 

Transaction Number

Transaction Date

Delivery Name

Delivery Number

Delivery Date 

Excise Exempt Type

Excise Exempt Date

AR3 A Form No

AR3 A Form Date

Received Date

Date on which the AR3A form received back from the Customer.

Others

Others taxes of the Supplementary Invoice will be reported.

Total Amount

This is the amount for which the Sup. Inv, Credit Memo, debit Memo is raised.

Duty Draw Back Report
Report Submission

Use the Submit Requests (OE & AR Modules) form and enter India - Duty Drawback 
Report in the Name field to submit the Report.

Report Parameters 

Organization (Required) PICK

Enter the Organization for which you wish to take the Duty Drawback Report for.

Location (Required) PICK

Enter the Location for which you wish to take the Duty Drawback Report for. 

From date (Optional)

India Localization prints all claims for Duty drawback for the selected Organization 
starting with the date you enter for this parameter. 

To date (Optional)

India Localization prints all claims for Duty drawback for the selected Organization up 
to the date you enter for this parameter.
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Report Headings

Report headings provide you with general information about the contents of the report. 
India Localization prints Organization related information, Report date and Sheet 
number on all pages, along with report heading on all pages. 

Column Headings

AR4 No.

Number of Proof if export certificate (AR4).

Date of Removal

Date of removal of Export Goods from the Factory.

Item Description

Description of Item being exported.

Destination

Destination for the goods being exported.

Quantity

Quantity of items being exported.

UoM

Unit of Measure of items being exported. 

Value

Value of Goods being exported.

Item code

Imported Item code.

CET Code

CET Code of Imported Item.

Item description

Description of Item that was imported for Manufacturing export item.

Rev

Revision No./name of Imported Item. 

Quantity

Quantity of Items Imported. 

UoM

Primary Unit of Measure of Items Imported. 

BoE No.

Bill of Entry Number of Imported Item. 
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BoE date

Date of BoE of Imported Item.

Item code

Imported Item code.

Duty Drawback Amount

Amount of Duty paid on Imported Item that is being claimed back.

Total Duty Drawback Amount

AR4 number wise Total duty drawback amount.

Grand Total

Report's Total duty drawback amount.

Report Order

Report is printed in the order of Shipment Date of Exported Items and Imported Item 
Description.

Journal Voucher Report
This reports provided the Listing of Journals created for a given period with the 
respective sources

Report Submission

Use the Submit Requests form(India AP and AR modules) and enter India - Journal 
Voucher in the Name field to submit the Report.

Report Parameters

Source (Optional) PICK

The user wants to take journals of a particular source, then he can specify that name 

JV No (optional) PICK

Specific Journal Number , the user wants to take a report, otherwise left blank. 

Period Order/Invoice (Required) 

Start Date and End Date

Report Headings

Report headings provide you with general information about the contents of the report 
and the user entered parameters.

Column Headings

GL Date 

JV Number 

JV Date/GL Date
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Narration

Source

AC Code

Description of the Account

Dr Amount

Cr Number 

India - Cash / Bank Book Report
The user takes Cash/Bank Book as per his requirement for a range of period.

Report Submission

Use the Submit Requests (India Local AP & AR Module Only) form and enter 
India-Cash/Bank Book Report in the Name field to submit the Report.

Report Parameters

Bank Name (Required) PICK

Bank Name for which the User wants to take the Bankbook for a given period.

Account Number (Required) PICK

Account Number of the Above bank for which the User wants to take the Bank book for
a given period.

Book Type (Required)

Either 'B' meant for Bank Book or 'C' meant for Cash book can be selected by the User 
from the LOV. This does not have an impact on the printout other than changing of the 
heading of the report. 

Start Date (Required)

End Date (Required)

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists Company Name based on User parameter input.

Column Headings

GL Date

GL Date for the transaction will be reported.

Voucher No & Date

Voucher Number and Date will be reported

Check Number & Date

Check Number and Check Date will be reported
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Bill No & date

Supplier Bill No & Date will be reported

Vendor Name/Customer Name

In the Case of Payments , the vendor Name will be reported. In the Case of Receipts, the
Customer Name will be reported. For charges in the Bank Book , this field won't be 
having any details. 

PO Number. & Date

PO Number for the respective purchase will be reported

Remarks/Narration

Remarks / Narration appearing in the Receipts and Payments vouchers will be reported 

Account Code

GL Account for the respective Receipts and Payments will be reported.

Description

Description of the GL Account for the respective Receipts and Payments will be 
reported.

Receipts

Receipts Amount will be reported into this column.

Payments 

Payments Amount will be reported into this column.

Balance

Balance Amount in the Cash/Bank will be reported into this column.

Important:  Cash Book Report will be generated by specifying the Book 
Type 'C'

India - Service Tax Pending Liability Report
This Report gives you the details of Service Tax Pending Liability. This Report shows all
the unpaid / partly paid AR Invoices for which Service Tax Liability has not yet arisen.

Report Submission 

Use the Other Reports form (India Local Receivable module) and enter India - Service 
Tax Pending Liability Report in the Name field to submit the Report.

Report Parameters

Registration Number (Required) PICK

The Registration Number for which the report is being generated.
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Organization (Optional) PICK

The Operating Unit for which the report is being generated.

As on Date (Required) 

The Date as on which the report is being generated.

India - Service Tax Pending Recovery Report 
This Report gives you the details of Service Tax Pending Recovery. This Report shows 
all the unpaid / partly paid AP Invoices for which Service Tax Recovery (Credit) has not
yet been availed.

Report Submission

Use the Other Reports form (India Local Receivable module) and enter India - Service 
Tax Pending Recovery Report in the Name field to submit the Report.

Report Parameters

Primary Registration Number (Required) PICK

The Registration Number for which the report is being generated.

As on Date (Required)

The Date as on, which the report is being generated.

Report Sample :

India - Service Tax ST3 Report
This Report gives you the details for filing the Service Tax return in ST3 Form.

Report Submission

Use the Other Reports form (India Local Receivable module) and enter India-Service 
Tax ST3 Report in the Name field to submit the Report.

Report Parameters

Field Description Type Action Description

Registration Number Required PICK The Registration 
Number for which 
the report is being 
generated.

From Date and To 
Date 

Required Start Date and End 
Date for which the 
report is being run.
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Organization Optional PICK The Inventory 
Organization for 
which the report is 
being generated.

Service Type Optional PICK List of all available 
Service Types, as 
selecting a value in 
this field indicates 
user wants to print 
report for a single 
Service type

India ER1 Report
This Report gives you the detailed data for submission of ER1 report.

Report Submission

Use the Other Reports form(India AR module) and enter India ER1 Report in the 
Name field to submit the Report.

Report Parameters

Organization (Optional) PICK

The Inventory Organization for which the report is being generated.

Location (Optional) PICK

The Inventory Organization for which the report is being generated. This needs to be 
left blank if all locations are to be printed. This gets enabled only if the Inventory 
Organization is selected.

Start Date and End Date (Required) 

Start Date and End Date for which the report is being run.

Service Tax Registration Number (Optional) PICK

The Service Tax Registration Number for which the report is being generated.

Operating unit (Optional) PICK

The Operating Unit for which the report is being generated. This gets enabled only if 
the Service Tax Registration Number is selected.

Name of the Assessee (Optional)

The Name of the Organization which needs to be printed on the report. This is the 
actual name to be printed and would not be picked from Organization setups.

Group Quantitative Data (Required) PICK
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The Report can be either printed for the Inventory Items or for Item Tariff. The values to
be selected are 'I' for Item or 'T' for Tariff. Please see the note below for report behavior 
on selection of this value.

Important: Report Behavior for Group Quantitative Data : Item: When 
Item is selected Quantitative data in report is grouped based on 
individual inventory item and column 'Description of goods' will be 
displaying the Inventory Item description. Tariff: When Tariff is 
selected Quantitative data in report is grouped based on Item Tariff 
provided in India Item Attributes setup (related to Excise) and further 
grouped based on distinct primary UOM. In this case the column 
'Description of goods' will be left blank as the Tariff description is 
currently not captured by India Localization. User needs to enter the 
Item Tariff description in such cases.

India TCS Certificate
Use the Submit Requests from India Local Receivables and enter India TCS Certificate 
in the Name field to submit the report.

Report Parameters

Report Parameter Type Action Description

Legal Entity Required PICK The Legal Entity for 
which the report is 
being generated.

Financial Year Required PICK The Financial year for
which the report is 
being generated.

TAN Number Required PICK The TAN Number for
which the report is 
being generated.
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Report Parameter Type Action Description

Collection Code Required PICK The Collection code 
for which the report 
is being generated. 
This can be any of the
following values:

• Alcoholic liquor 
for human 
consumption

• Timber obtained 
under forest 
lease

• Timber obtained 
under any mode 
other than forest 
lease

• Any other forest 
product not 
being timber or 
tendu leave

• Scrap

• Parking Lot

• Toll Plaza

• Mining and 
Quarrying

• Tendu Leaves

Certificate Nos. from Optional PICK The Certificate Nos. 
from for which the 
report is being 
generated.

Certificate Nos. to Optional PICK The Certificate Nos. 
to for which the 
report is being 
generated.
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Report Parameter Type Action Description

Certificates from Date Optional The Certificates from 
date for which the 
report is being 
generated.

Certificates to Date Optional The Certificates to 
date for which the 
report is being 
generated.

Customer Optional PICK The Customer for 
which the report is 
being generated.

Name of Signee Optional The Name of Signee 
which needs to be 
printed on the report.

Designation Optional The Designation of 
Signee which needs 
to be printed on the 
report.

Place Optional The Place where TCS 
Certificate is issued 
and which needs to 
be printed on the 
report.

Organization Required PICK The Inventory 
Organization for 
which the report is 
being generated.

India - TCS Form 27B
Use the Submit Requests from India Local Receivables and enter India - TCS Form 27B 
in the Name field to submit the report.

Report Parameters

Report Parameter Type Action Description
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Legal Entity Required PICK The Legal Entity for 
which the report is 
being generated.

Org TAN Number Required PICK The Organization 
TAN Number for 
which the report is 
being generated.

Organization Required PICK The Inventory 
Organization for 
which the report is 
being generated,

Financial Year Required PICK The Financial year for
which the report is 
being generated.

Quarter Optional PICK The Quarter of the 
Fiscal year for which 
the report is being 
generated.

Previous Receipt 
Number

Required PICK The Previous Receipt 
Number in case the 
return was filed 
earlier.
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Collection Code Required PICK The Collection code 
for which the report 
is being generated. 
This can be any of the
following values:

• Alcoholic liquor 
for human 
consumption

• Timber obtained 
under forest 
lease

• Timber obtained 
under any mode 
other than forest 
lease

• Any other forest 
product not 
being timber or 
tendu leave

• Scrap

• Parking Lot

• Toll Plaza

• Mining and 
Quarrying

• Tendu Leaves

Person Responsible Required The Name of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
Designation

Required The Designation of 
Person responsible 
which needs to be 
printed on the report.
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Responsible Person 
Address

Required The Address of 
Person responsible 
which needs to be 
printed on the report.

Responsible Person 
City

Required The City of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
State

Required The State of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
Pin

Required The PIN code (Postal 
Code) of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
Telephone

Required The Telephone 
Number of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
email

Required The email Address of 
Person responsible 
which needs to be 
printed on the report.

Start Date Optional The start date from 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.
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End Date Optional The end date till 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.

India TCS Quarterly Report
Use the Submit Requests from India Local Receivables and enter India - TCS Quarterly 
Report in the Name field to submit the report.

Report Parameters

Report Parameter Type Action Description

Legal Entity Required PICK The Legal Entity for 
which the report is 
being generated.

Org TAN Number Required PICK The Organization 
TAN Number for 
which the report is 
being generated.

Organization ID Required PICK The Inventory 
Organization for 
which the report is 
being generated.

Fin Year Required PICK The Financial year for
which the report is 
being generated.

Quarter Optional PICK The Quarter of the 
Fiscal year for which 
the report is being 
generated.
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Report Parameter Type Action Description

Collection Code Required PICK The Collection code 
for which the report 
is being generated. 
This can be any of the
following values:

• Alcoholic liquor 
for human 
consumption

• Timber obtained 
under forest 
lease

• Timber obtained 
under any mode 
other than forest 
lease

• Any other forest 
product not 
being timber or 
tendu leave

• Scrap

• Parking Lot

• Toll Plaza

• Mining and 
Quarrying

• Tendu Leaves

Tax Rates Type Required PICK The Tax rate type for 
which the report is 
being generated i.e. 
'Lower Rates' 
'Standard Rates' or 
'Exempt Rates'.



India Local Receivables    5-109

Report Parameter Type Action Description

Provisional Receipt 
Number

Required PICK The Provisional 
Receipt Number in 
case the return has 
been filed earlier.

Person Responsible Required The Name of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
Designation

Required The Designation of 
Person responsible 
which needs to be 
printed on the report.

Responsible Person 
Address

Required The Address of 
Person responsible 
which needs to be 
printed on the report.

Responsible Person 
City

Required The City of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
State

Required The State of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
Pin

Required The PIN code (Postal 
Code) of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
Telephone

Required The Telephone 
Number of Person 
responsible which 
needs to be printed 
on the report.
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Report Parameter Type Action Description

Responsible Person 
email

Required The email Address of 
Person responsible 
which needs to be 
printed on the report.

Start Date Optional The start date from 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.

End Date Optional The end date till 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.

India TCS Annual Report
Use the Submit Requests from India Local Receivables and enter India - TCS Annual 
Report in the Name field to submit the report.

Report Parameters

Report Parameter Type Action Description

Legal Entity Required PICK The Legal Entity for 
which the report is 
being generated.

Org TAN Num Required PICK The Organization 
TAN Number for 
which the report is 
being generated.
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Report Parameter Type Action Description

Organization ID Required PICK The Inventory 
Organization for 
which the report is 
being generated.

Fin Year Required PICK The Financial year for
which the report is 
being generated.

Collection Code Required PICK The Collection code 
for which the report 
is being generated. 
This can be any of the
following values:

• Alcoholic liquor 
for human 
consumption

• Timber obtained 
under forest 
lease

• Timber obtained 
under any mode 
other than forest 
lease

• Any other forest 
product not 
being timber or 
tendu leave

• Scrap

• Parking Lot

• Toll Plaza

• Mining and 
Quarrying

• Tendu Leaves
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Report Parameter Type Action Description

Tax Rates Type Required PICK The Tax rate type for 
which the report is 
being generated i.e. 
'Lower Rates' 
'Standard Rates' or 
'Exempt Rates'.

Seller Address 
Changed?

Required PICK The Provisional 
Receipt Number in 
case the return has 
been filed earlier.

Responsible Person 
Name

Required The Name of Person 
responsible which 
needs to be printed 
on the report.

Responsible Person 
Designation

Required The Designation of 
Person responsible 
which needs to be 
printed on the report.

Responsible Person 
Place

Required The Address of 
Person responsible 
which needs to be 
printed on the report.

Start Date Optional The start date from 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.

End Date Optional The end date till 
which this report 
needs to be printed. 
This date should 
pertain to the same 
quarter as entered in 
earlier parameter.
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6
India Local Fixed Assets

This chapter covers the following topics:

• Fixed Asset Depreciation Calculation

• Setting up India Local Fixed Assets

• Transactions

• Reports

Fixed Asset Depreciation Calculation
Businesses in India, under the Income Tax Act, have to compute depreciation using the 
"Written Down Value" method. The depreciation percentage has to be applied on the 
Block of Assets and no depreciation can be claimed on individual assets.

Using India Localization, you can:

• Create Block of assets as required under the Income tax Act

• Record the block value of each Block of assets

• Define the depreciation percentage for each asset blocks

• Assign a block of asset to each asset addition

• Identify the block of assets for each asset, which are being retired during the year

• Perform adjustments in the opening written down value of any block and 
adjustments in the depreciation worked out in any year.

Note: It may be noted that localization provides only the reports 
showing the workings of depreciation based on block of assets. No 
accounting entries will be passed on the figures derived through 
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localization will not be considered for any accounting entries 
automatically.

The Tax Handling functionality provides you with the information requirements under 
Income Tax Act. You can:

• Define multiple blocks of assets and associate individual assets to each block of 
assets.

• Define depreciation periods. These periods would be in sync with the financial year
defined under the Income Tax Act. 

• Specify multiple period rates for each depreciation period. You can define multiple 
periods and applicable rate percentage for each period. The depreciation amount 
would be proportionate to the rate percentage specified for each period.

• Specify date of commissioning and enable calculation of depreciation based on the 
date of commissioning. 

• Define the opening written down balances along with depreciation rates at the 
beginning of the year during which you would be rolling out Oracle Assets with 
India Localization. This information would be used for the computation of 
depreciation for the year. 

• Adjust opening written down value and depreciation amounts.

• Calculate depreciation in accordance with Income Tax Act.

• Generate depreciation schedule.

Major Features
Definition of Block of Assets: User will be able to define block of assets by having the 
asset categories defined with highest level of details as required for Income Tax.

Opening Balance of Block of Assets: User is provided with a facility to enter Opening 
balances for block of assets (one time facility). User is provided with a report, which 
will facilitate arriving at asset category wise, Gross Block of Assets and written Down 
Value as required for Income Tax purpose.

Periodical Closing Balances of Block of Assets: User is provided with a facility 
generate monthly closing balances of Block of assets.

Setting up India Local Fixed Assets
Under the Income Tax Act, to work out the income tax liability, depreciation needs to be
worked out based on written down value method for the block of assets and no 
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depreciation can be claimed on individual assets. 

All assets need to be assigned to the respective block of assets and written down value 
need to be worked out based on the equation prescribed under the Income Tax Act. Few
examples for Block of assets widely used in the industry are:

• Land and Buildings

• Plant & Machinery

• Motor Vehicles

• Furniture & Fixtures

Depreciation on asset added to a block needs to be worked based on the period of 
commissioning of the individual asset. As per the current provisions, depreciation for 
an asset block can be claimed up to 100% of the allowable depreciation, if the asset is 
procured between the 1st of April and 30th day of September. Only 50% of the 
allowable depreciation can be claimed on a block, if the asset is procured between 1st 
day of October and 31st day of March. 

As a part of Localization set up the User has to define the Block of assets. This needs to 
be done by defining the block of asset names in the quick codes. User has the option to 
define any logical name that need to be considered as a block of asset. The user is 
expected to define the block of asset names prescribed by the Income tax department. 

In India Localization, navigate to India Local Fixed Assets > Setup > Asset System > 
Quick Codes. 

User needs to query for 'BLOCK OF ASSETS'

Filed Name Type Action Description

Type (Query)   User needs to query for the 'BLOCK
OF ASSETS' and in the lines he can
record the names of the block which
he intends to operate.

Description (Displayed)   By default, BLOCK OF ASSETS will
be displayed as description.

Value (Required)   Name/short name of the Block which
needs to be created needs to be
recorded against this field.

Description (Optional)   The full name with description needs
to be entered in this field.
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Filed Name Type Action Description

Disable Date (Optional)   The User can specify the disable date
for a value if he wants.

Define Depreciation Periods
The User can define the Assessment years for Income Tax purposes. The assessment 
year for Income tax purposes starts on the fist day of April and ends on the 31st day of 
March of the next calendar year.

The User needs to define Depreciation period rate as per Indian Income tax Act. 
Depreciation Rate is based on assets installation date or date on which it is put into use 
within a fiscal year.

Date Placed in Service falls between Depreciation allowed

April 1 to Sept 30 100 % of prescribed rate

Oct 1 to Mar 31 50 % of prescribed rate

The above information can be recorded in define period wise deprecation screen.

It may be noted that the information discussed under topic 7.2.1 and 7.2.2 are 
mandatory setups that needs to done for working out the depreciation under Income 
tax Act. These setups do not have any impact on the set ups that needs to be done in the
base applications as a part of Fixed asset setup. User needs to complete the base 
application setup first and then carry out the localization setups.

India Local Fixed Assets Block of Asset (India) Define Periodwise Dep. Details.

Field Name Type Action Description

Financial Year Block (Required)    

Year start/Year end     The start and end date of the
assessment year under Income
Tax Act needs to be entered in
this field.
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Field Name Type Action Description

Period Rate Block     The User can specify the
appropriate Depreciation rate as
applicable to a Block of Assets as
per Income Tax Act based on
assets installation date or date on
which it is put into use within an
assessment year.

Start Date/End date (Required)   The start and end dates for which
the percentage of allowable
depreciation can be entered in
this field. As per income tax act,
100% of the allowable
depreciation can be claimed for
additions between 1st April to
30th September and only 50% of
the allowable depreciation can be
claimed for assets added between
1st of October and 31st of March.
These dates needs to be recorded
in these fields.

Applicable
Depreciation Rate %

(Required)   As per Income Tax Act 100% of
rate of Depreciation is applicable
to assets fall in the first half year
of a Financial year.

100 % Exempt
Amount

(Optional)   This field has been considered as
a future enhancement. mentioned
here. At present this field is
irrelevant as per the current
enactment applicable as per
Income Tax Act and Zero can be
entered by the user.

Opening WDV Balances
Before rolling on with Oracle Assets with India Localization, user needs to define the 
written down value of each block and the rate of depreciation that can be claimed 
against each block. User also needs to specify the start date of the block for which the 
opening balance is recorded.

Prerequisites:

Before you enter the Opening WDV Balances, you must:
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• Define Books

• Define Asset Category

• Define Quick Codes (for Block of Assets)

In India Localization, navigate to the Opening balance of Block India Location from 
India Local Fixed Assets > Block of Asset (India) > Define > Block of asset.

Field Name Type Action Description 

Book (Required) Name of the 
Corporate Book 
wherein the Opening 
Balance for the Block 
of assets are going to 
be incorporated. 

Note: Note: Reporting of depreciation for income tax purpose is done 
based on the asset books and for each asset book multiple block of 
assets with different depreciation rates can be maintained. User may 
take enough care while setting up their asset books by keeping a view 
on the localization requirement.

Block Name (Required) Block Name can be 
entered from LOV for
which the Opening 
Balance will be 
entered. 

Depreciation rate (Required)   The Corresponding 
depreciation rate for a
block can be entered 
here.

Start Date (Required) This date can be a 
Start Date of a First 
Half or Second half of
a Financial year.
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Opening balance (Required) Opening Written 
down value of a 
Block of assets can be 
entered here. 

Closing Balance 

Adjustment Block 

Opening WDV 
Adjustment 

(Optional) If the User wants to 
adjust Opening 
Written down value 
of a Block after an 
Income tax 
assessment is finished
for a Particular year. 
The adjustment 
amount can be 
entered here and 
Opening WDV value 
will be adjusted 
accordingly. 

Depreciation 
Adjustment 

(Optional) If the User wants to 
adjust Depreciation 
amount after running 
the depreciation 
program, the same 
amount can be 
entered here. In other 
words, this field 
support the 
functionality of 
Unplanned 
Depreciation:

Note: Note: The User must keep in mind the following points while 
entering the Opening balances for a Block. 

Carry forward their WDV Opening Balance only for Current financial 
year. Once the Opening Balance for a Block has been entered for the 
current financial year, the user cannot enter Opening Balances for the 
Same Block in the Previous or subsequent years. 

If Oracle Fixed Assets module has been used in the past years, then the 
user needs to update Block details for every Assets entered into the 
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System. After querying the Individual Assets, the User can update the 
Block details in the Descriptive Flex-field and also once this is 
completed the total number of Assets in a corporate Book for a Block 
will be captured by the System.

Transactions
Various Transactions India Localization Supports in Fixed Assets are mentioned in this 
section.

Asset Additions
While recording the additions of assets in Oracle assets, the user need to allocate the 
individual asset to the Block of assets defined. The block details of the assets need to be 
assigned by recording the details in the flex field. You need to enter localization details 
in Asset Categories flexfield while additions through Quick Additions and New 
Additions. While you would be entering these details in Mass Additions Flex field 
while adding assets through Prepare Mass Additions. On recording the complete asset 
related information including asset book and cost of the asset, user need to click on the 
flexfield and select the context value as India B Assets. 

Before you enter the Asset Additions, you must:

• Define Books

• Define Asset Category

• Define Quick Codes (for Block of Assets)

• Define Depreciation Period Details

Navigate to Assets > Asset Workbench > Quick Additions/New Additions > Asset 
Category.

User will have to complete the asset addition in Base FA and come to the India 
Localization screen to assign the block of asset and date of acquisition.

The user has the flexibility to assign a block name to multiple assets at one go which 
will increase the usability significantly. 

Also, the date placed in service (which is given at the time adding the asset) will be 
defaulted as the Date of Acquisition. This date can be changed by the user. 

Field Name Type Action Description 
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Block of Assets   PICK HELP Users need to enter 
the relevant Block of 
Assets in which the 
asset will be classified
as per Indian Income 
Tax Act. 

Date of Acquisition   User need to record 
the date on which the 
asset was acquired 

Income Tax Depreciation Calculations
The calculation of written down value of the Block of asset is worked out based on the 
prescribed calculations that need to be carried out under Income Tax Act. 

Opening Written down value of the block (as at the beginning of the assessment year) 

Terms Descriptions 

Add Additions during the assessment year 

Less Retirements of asset from each individual 
assets 

Less Depreciation on the opening written down 
value of the block 

Less Depreciation on the additions during the first 
half of the assessment year

Less Depreciation on the additions during the 
second half of the assessment year 

= Closing written down value of the block of 
asset 

Run Depreciation
For calculating the depreciation under Income Tax Act, users need to run a concurrent 
program manually. The program is named as Income Tax Act fixed asset schedule. On 
completion of the program, users can view and print the output and the closing written 
down value will get updated. 
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Income Tax Act fixed asset schedule concurrent program 

Users need to run Concurrent request to Calculate Depreciation for a Financial Year. 

In India Localization, navigate to the Income Tax Act Fixed Asset Schedules concurrent 
program as follows: 

Request Name: Income Tax Act Fixed Asset Schedules 

The parameters for this request are described in the table below: 

Field Name Type Action Description 

Start Date (Required) Users need to enter 
start date from the 
LOV of a Financial 
year to run the 
depreciation 
calculation. Since the 
financial year for the 
Income Tax purpose 
is 1st April to 31st 
March this start date 
use to be 1st of April 
of a year. 

End Name (Required) System will consider 
the End date as 12 
month ending from 
the above start date. 

Book Name (Required) The User need to 
enter Book Name 
where in the 
Depreciation 
Calculation is need to 
be done. 

After completion of Run Depreciation, users can view the Fixed Assets Schedule as per 
Income Tax Act (Block wise) through Reports. If the user needs to add an unplanned 
depreciation, it can be done in the Depreciation adjustment column of Opening WDV 
Balance form. Unplanned Depreciation amount will be shown separately in the report 
output. 

Reports
Fixed Assets generates these reports for India:
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• India Income Tax Fixed Assets Schedule - This report is a Fixed Asset Schedule as 
per Income Act, provides details of Block of Assets.

• India Depreciation Detail Report - This report provides information on depreciation
calculated for each asset.

India Income Tax Fixed Assets Schedule
This report is a Fixed Asset Schedule as per Income Act, provides details of Block of 
Assets. Use the Submit Requests (India Local Fixed Asset ) form and enter 
India-Depreciation for one year in the Name field to submit the report.

• F.Y Start Date: Financial year start will be available in the LOV, Once the start date 
is entered, the system will take the end date as end of the Financial year. The user 
need to enter the relevant Corporate book name for which the Income Tax Fixed 
Assets schedule is to be taken. Report headings provide you with general 
information about the contents of the report . Oracle lists Corporate Book name and
financial year details based on User parameter input.

• S.No: Serial Number for the Block of Assets will be reported

• Type: Block of Assets name will be reported

• Period: Depreciation period in a financial year will be reported

• Opening WDV as on start date of a Financial year: Opening Written Down Value 
for a Block will be reported

• Addition during the year: Addition made during the year to a Block will be 
reported

• Deletion and Sale in the year: Deletion and Sale during the year to a Block will be 
reported

• Deletion and Sale in the year: Deletion and Sale during the year from a Block will 
be reported

• Total: Total of WDV balance for a Block before applying depreciation Block will be 
reported

• Rate of Depreciation: Rate of Depreciation for a block will be reported

• Depreciation for the year: Depreciation for a block for the year will be reported

• Closing WDV as on End date of a Financial year: Closing Written Down Value for 
a Block will be reported
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India Depreciation Detail Report
• Start Date: Financial year start will be available in the LOV, Once the start date is 

entered.

• End Date: End date as per User requirement can be entered.

• Level of details: The user can specify either a Detailed Report or a Summary Report
according to his requirement. Detailed report will provide complete assets details 
and Summary Report will provide Block wise details for multiple years.

• S.No: Block of Assets name will be reported

• Period: Period for which report is submitted

• Opening WDV as on start date of a Financial year: Opening Written Down Value 
for a Block will be reported

• Addition during the year: Addition made during the year a financial year to a 
Block asset wise will be reported 

• Assets Number: Assets Number added to a Block during the financial years will be 
reported 

• Deletion and Sale in the year: Deletion and Sale during the financial years of an 
asset will be reported 

• Deletion and Sale in the year: Deletion and Sale during the year from a Block for 
an asset will be reported

• Total: Total of WDV balance for a Block before applying depreciation Block will be 
reported

• Rate of Depreciation: Rate of Depreciation for a block will be reported. 
Depreciation for a block for the year will be reported

• Closing WDV as on End date of a Financial year: Closing Written Down Value for 
a Block will be reported
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7
Trading Functionality

This chapter covers the following topics:

• Trading Functionality Overview

• Match Receipts Localized Overview

• Transactions

• Reports

Trading Functionality Overview
Every Dealer and Importer dealing in excisable goods is required to obtain Excise 
Registration to issue CENVATable invoices. This registration should be obtained for 
every warehouse of the dealer; and that the Superintendent of Excise has jurisdiction 
over the warehouse and will be the officer responsible to issue Central Excise 
Registration.

Dealers who register themselves with Central Excise will ensure that the Register in 
form RG23D is maintained in the warehouse and should be available for inspection by 
Central Excise Officers.

In a Trading Organization, the following are the essential requirements:

• Capture Registration details for Trading Activity.

• Maintain RG23D Register.

• Ensure Excise Duty per Unit to be constant figure on your Receipts as well Issue 
Tax lines.

• Match receipts quantity before making delivery.

• Enter Manual entries into RG23D to update the physical quantity discrepancies in 
the Book.



7-2    Oracle Financials for India User Guide

Major Features
• Excise Registration details of Trading Organization: Provision has been provided 

for the User to classify an organization location to be trading, in addition to the 
capturing of their excise registration particulars. This will be applicable for all sub 
inventories coming under trading organizations and user can also identify 
individual sub inventories as trading.

• Provision to capture user definable excise invoice numbers for trading 
organization: User will have a provision to capture Excise department approved 
numbers for Excise invoices being generated for shipments from these Trading 
Organizations.

• Tracking original excise invoice of receipt with the shipments from these trading 
organizations: User will have a provision to associate original excise invoice 
reference on the basis of LIFO or FIFO. There is a provision to specify the invoice 
number at the transaction, so as to allow override with each shipment (at the time 
of completing sale invoice, in the case of only AR installation) happening from 
trading organization location.

• Maintenance of RG23D Register: User will be able to maintain Register RG23D for 
each organization location, which is identified as trading. The following 
transactions are considered for the above register.

• Print RG23D Register: Provision to print Register RG 23D has been provided.

• Manual entries to register RG 23D: Provision has been made to add records 
manually to register RG23D. User will not be able to update or delete the existing 
records.

• Stand Alone Accounts Receivables: Provision has been made to add, delete or 
modify the tax lines after mapping of Receipts tax lines in the case of standalone AR
instance.

Match Receipts Localized Overview
This functionality is designed to support the excise related transactions for a trading 
organization or location. If the organization or location is registered under Central 
Excise rules as a Dealer of Depot, you can pass down the credit of duty involved in the 
goods you are trading. The trading organization needs to track the duty involved in 
excise goods and the same needs to be tracked at the time of receipt.

The Match receipts functionality allows the user to satisfy all requirements related to a 
trading organization or location registered under the Central excise rules to pass on 
excise credit to your customers. The excise duty tracked while receiving the goods in a 
trading organization can be allowed as CENVAT credit for its customers. Before 
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confirming the shipment, the organization needs to allocate the excise duty involved 
during receipt of the excisable goods. While shipping from the trading organization, 
you are required to track the exact amount of duty paid by the original manufacturer 
for passing down the credit under CENVAT procedures. This can be done through 
match receipt for trading item screen. This Matching Receipts form provides the 
Information regarding available receipts from which the delivery quantity can be 
picked up. Once the receipt is matched then the Excise amount in the Ship Confirm 
delivery lines will be the Excise amount from Receipt tax line for the respective delivery
quantity. A new feature of Unmatch is provided which will enable the user to roll back 
the matching already made in case of either wrong matching or need for splitting etc.

Major Features
• Facility to pick up available receipts: You have an option to pick up any available 

receipts to which delivery quantity can be matched.

• Find Delivery Details for Matching: You can find the delivery lines for matching, by
giving Organization, Order Type, Customer name, customer number, Delivery id or
delivery detail id. Query can also be based on order number.

• Automatic Matching: A check box is provided to enable you to auto match all the 
delivery lines that satisfies the given inputs. This would match the selected delivery
lines to the available receipts on a FIFO basis.

• Unmatching: You have an option of unmatching a delivery that is already matched 
provided the same is not yet shipped. This unmatch can be done for a full delivery 
or for a delivery detail line. On use of this feature, you can then split the delivery 
detail line into multiple lines, backorder the same, rectify wrong matching etc.

Trading Inventory Organization Setup
Inventory Organization locations are further classified as trading organization in the 
case where only Trading activity is happening in an organization Location.

India Local Inventory > Setup > Organization > Additional Information

Trading Registration Details

Use this window to enter and maintain the registration information of Organization 
and/or Location of Trading Nature under Central Excise Rule. The information entered 
here would be printed on all relevant reports and invoices raised from this 
Organization.

Use Trading Information Button to enter Excise Registration details of a Registered 
Dealer.

In the trading information region, the user needs to give information only if the 
organization/Location is registered under the Central Excise Rules as a Dealer/Depot.



7-4    Oracle Financials for India User Guide

If the Organization/Location is an Excise registered premises, the user needs to give the 
following information against the respective fields. This information will be used while 
generating the Excise related documents generated from the system. User needs to 
ensure that he do not put any values in the Excise related information region of the 
main additional organization information screen which is meant for manufacturing 
Organization/Location.

Range Details of the Jurisdictional Range.

Division Details of the Jurisdictional Division

Zone/Region/Circle These fields can be used to key in additional
Information that needs to be printed in the
excise related documents generated from the
system.

Collectorate

ECC Number ECC Number allotted for the Trading
Activities

Excise in RG23D This flag enables to indicate whether the
Receipt excise tax is inventorised or accounted
to RG23 D account specified in the
Organization Additional information setup. If
the flag is Checked (Yes), the Receipt Excise
amount shall be Debited to the RG23 D
Account on receipt of material. If the flag is
Unchecked (Default) the excise amount is
added to the Inventory cost and debited to
Inventory material account on Delivery of
material.

Order Price Excise Inclusive This flag enables to indicate whether the Sales
Order price for shipments from a Trading
Organization - Location is inclusive of the
Excise tax. If the flag is Checked (Yes), the
Excise tax is not added to the Receivables
when the AR Invoice is created after
Autoinvoice and India Localization program
to interface Order Lines to AR. If the flag is
Unchecked (default), Excise tax attached to the
Shipment is added to the Receivables of the
AR Invoice. Credit is given against the
Account defined in the Excise Tax definition.
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Trading Sub inventory Location Set up
The Sub inventories or Warehouses registered as Trading Warehouses are defined as 
'Trading' Sub Inventory Locations. 

India Local Inventory - Setup - Organization - Subinventory Locations

As a part of Localization setup, the sub-inventories need to be associated with 
Organization or Location combination. Excise related transactions and records would 
get updated only for those sub inventories, which are identified as TRADING for 
Trading organizations. By considering the transactions of a sub inventory, the check box
for bonded/traded needs to be enabled.

India Local Inventory - Set up - Organizations - SubInventory Locations

Field Description Type Action Description

Header Level      

Organization
Name/Location

(Required) PICK HELP The inventory organization name
and its respective Location will be
selected by the User from the LOV.

Line Level      

SubInventory (Required) PICK HELP The User can select the
Sub-inventory name from the LOV

Description (Displayed)   The Description for the selected
Sub-Inventory will be displayed
here.

Bonded (Flag) (Optional) CHECK BOX This field is Disabled for a Trading
Organization and Location.

Trading Flag (Required) CHECK BOX For all Sub-inventories in a Trading
Organization/Location, this field
shall be CHECKED by default.

Trading Item Set Up
Items that are being used in a Trading Organization shall have specific Excise 
requirements. In order to meet these requirements, the Item shall be defined with the 
following flags in the India Items Classification screen.

Excise Flag - 'YES'
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Trading Flag - 'YES'

The user can define templates, which can contain the item attributes that are common 
across many items.

These templates can be attached to multiple items at one go. This provides lot of 
flexibility to the user.

Optionally, the user can also define item attributes separately for an item.

Shipment Register Set Up
The Trading Shipping transactions shall be controlled with the following Register types.
The Shipping Order Types / Invoice Sources shall be assigned to the following Register 
codes in the Trading Organization-Location from which the shipment takes place: 

• Trading Domestic with Excise

• Trading Domestic without Excise

• Trading Export with Excise

• Trading Export without Excise

The Register types will be used to control the instances of RG23D register updation.

Transactions
Purchase Receipts / Returns

Purchase Receipts / Returns in a Trading Organization can be done in the same way as 
it is done in a manufacturing organization. If the Item is defined as Excisable and 
trading, the RG 23 D register shall be hit for the Receipts / Returns.

Based on the setup flag 'Excise in RG 23D ' in the Organization Additional Information 
Definition, the Excise amount on Receipt shall be debited to the RG23 D account or the 
Inventory account. By default , this flag is set to 'NO' and on delivery, if the Trading 
Organization is an Average Costing organization, the Inventory Cost shall contain the 
Excise Tax amount also. In the case of Standard Cost organizations, the Excise Tax 
amount shall be debited to the Purchase Price Variance account.

Shipment - Receipts Matching

In a Trading Organization each Shipment can be matched to the Purchasing Receipts so 
that the Excise Taxes could be passed on to the Customer. FIFO/LIFO method can be 
followed by the dealer while delivering the goods from the godown /store-room. The 
matching can be for shipment Lines or the Delivery itself.

Matching Receipts For Trading Item

This functionality is designed to support the excise related transactions for a trading 
organization/location. If the organization/location is registered under Central Excise 
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rules as a Dealer of Depot, he can pass down the credit of duty involved in the goods 
with which he is trading. The trading organization needs to track the duty involved in 
excisable goods and the same need to be tracked at the time of receipt.

The excise duty tracked while receiving the goods in a trading organization can be 
allowed as CENVAT credit for its customers. Before confirming the shipment, the 
organization needs to allocate the excise duty involved at the time of receipt of the 
excisable goods. While shipping from the trading organization, the user need to track 
the exact amount of duty paid by the original manufacturer for passing down the credit 
under CENVAT procedures. This can be done through match receipt for trading item 
screen.

This Matching Receipts form provides the Information regarding available receipts 
from which the delivery quantity can be picked up. Once the receipt is matched then 
the Excise amount in the Ship Confirm delivery lines will be replaced by the Excise 
amount from Receipt tax line for the respective delivery quantity.

It may be noted that the basic line price charged in a trading organization may be or 
may not be inclusive of the excise duty. If it is inclusive of excise duty , the excise duty 
matched through match receipt screen should not be accounted for the receivables. User
needs to define adhoc taxes with excise type while creating the sales order and the taxes
towards excise duty need to be maintained as zero in the sales order. On matching the 
exact excise duty will get updated as taxes. User need to take enough care not to attach 
any precedence logic to excise type of taxes in this type of set up.

On completion of ship confirmation from a trading organization, the RG 23 D register 
will get updated with the quantity matched. 

Quantity matched could be unmatched before Shipment transaction is completed and 
the 'India - Excise Invoice Generation Program' is run. This shall take care of the 
Backordering scenarios and user mistakes while matching. However it is to be noted 
that unmatching is not allowed once the delivery is shipped and Excise invoice 
generations program is run.

In Oracle India Localization, navigate to the RG23 Register Entries India Localization 
window as follows:

India Local Order Management - Shipments - Trading (India) - Match Receipts

You can find out the receipts available for an item by querying through Find Customer 
Order Screen. The following are the fields in this Find Customer Order Screen.
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Field
Description

Type Action Description  

Match Type (Required)   Match type field provides
two options 'Match' or
'Unmatch'. Match shall be
chosen for normal
matching transactions and
'Unmatch' in cases where
the already matched
transaction needs to be
reversed before the
Shipment is made. Please
note that the UNMATCH
feature can not be used
after completing the
Shipment transaction.

 

Customer Name (Optional)   Customer Name can be
entered from the LOV.

 

Customer
Number

(Displayed)   Customer Number will be
displayed here.

 

Delivery ID (Optional)   Delivery ID may be
entered by the user from
LOV for which the
matching of receipt is
going to be done.

 

Delivery Detail
ID

(Optional)   Delivery Detail ID may be entered by the
user from LOV for which the matching of
receipt is going to be done.

Order Number (Required) PICK HELP Order Number must be entered by the user
from LOV for which the matching of receipt
is going to be done.

Line No (Optional)   Line No. of an Order can be entered here.

Automatic
Matching

(Optional) Check If this flag is checked, the system shall
automatically match the Delivery detail
lines with the available Receipts to the
Subinventory based on a FIFO logic.
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Field
Description

Type Action Description  

Clear (Optional)   This button shall clear fields in the Find
window.

Find / Auto /
Unmatch

(Required)   This button is used for directing the
Transaction in 3 different action paths
based on the values provided in the
MATCH TYPE and 'AUTOMATIC
MATCHING' fields:

If MATCH TYPE is MATCH and
'AUTOMATIC MATCHING' is
UNCHECKED, the RG23 D Register Entries
screen shall be opened for Delivery Detail
level matching.

If MATCH TYPE is MATCH and
'AUTOMATIC MATCHING' is CHECKED,
system shall match the Delivery lines
against available Receipts on FIFO basis.

If MATCH TYPE is 'UNMATCH', the
system shall rollback the matching
previously done against the DELIVERY.
Receipt for which the matching was done
earlier shall again be available for matching
for other deliveries. This feature is available
only if the DELIVERY is NOT SHIPPED

After the above find screen, the cursor will be in the RG23D Register entries. Here the 
User has can match a respective receipt quantity in the following ways.

Automatic Matching

The System will automatically match the Receipt based on Matching method FIFO (First
In First Out) or LIFO (Last In First Out).

Manual Matching

The User can manually match the Receipts quantity by moving the cursor to the 
respective receipts line. After matching receipts and save this screen, the User can view 
the Issue tax Lines in which Excise amount will be replaced by the Excise amount from 
Receipt tax line for the respective matched quantity.

RG23D Register entries Screen's field wise description and features are given for your 
ready reference.
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Field Description Type Action Description

Header Level      

Customer Name (Displayed)   Customer Name will be
displayed here.

Customer No (Displayed)   Customer No will be displayed
here.

Order Number (Displayed)   Order Number will be displayed
here.

Line No (Displayed)   Line No. of an Order will be
displayed here.

Sub-Inventory (Displayed)   Sub-Inventory name will be
displayed here.

Item (Displayed)   Item in the respective line of an
order will be displayed here.

Released Quantity (Displayed)   Released quantity from an order
will be displayed here.

Matched Quantity     Before matching this field will be
blank and after matching this
field will show the matched
quantity.

UOM Displayed)   UOM of an item will be displayed
here.

Line level      

Transaction Type (Displayed)   Transaction type like Receipts
and Return will be displayed
here.

Supplier Invoice No. (Displayed)   Supplier Invoice Number for a
particular receipt will be
displayed here.
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Field Description Type Action Description

Quantity in Receipt
UOM

     

UOM (Displayed)   UOM of the item in the Receipt
line will be displayed here.

Received (Displayed)   Quantity received in a particular
Receipt will be displayed here.

Available (Displayed)   Available Quantity in a particular
Receipt will be displayed here.

Apply     This represents the proposed
match quantity. This will be filled
by the system for a Release
Quantity if the User selected
Automatic Matching. The User
can manually enter number of
quantity also here for matching.

Quantity in Issue
UOM

     

UOM (Displayed)   UOM of the item in the Issue line
will be displayed here.

Available (Displayed)   Available Quantity in a particular
Issue will be displayed here, this
is equivalent to Available receipt
quantity.

Apply (Displayed)   This represents the match
quantity.

Receipt Number (Displayed)   Receipt Number will be
displayed here.

Receipt Date (Displayed)   Receipt Date will be displayed
here.

BOE Number (Displayed)   BOE Number will be displayed
here in the case of Imported
Receipt.
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Field Description Type Action Description

Vendor (Displayed)   Vendor Name will be displayed
here.

Duty Per Unit (Displayed)   Excise Duty per unit as per
receipt line will be displayed
here.

Issue Tax Button 

Through this button, the User can view the Issue Tax lines after saving the Matching 
Screen wherein Excise amount will be replaced by the Excise amount from Receipt tax 
line for the respective matched quantity.

User will be able to view the matched excise duty in this receipt. The actual zero adhoc 
excise duty attached in the sales order will be over written with the matched excise 
amount.

View Receipt Button

Through this button the user can view all matched orders against a particular Receipt.

Unmatching

The User can do un-matching of receipts by entering Zero quantity in the Apply 
column, then the Available Receipt quantity will be reinstated. (Please note that this 
feature is available only before saving and closing the form. In order to unmatch 
already saved transactions, use the UNMATCH feature provided in the Find window).

View RG 23 D Screen

After Ship Confirm Delivery, the User can view the Issue transactions through Manual 
RG 23D, then the User can Run AR interface and Auto Invoice in Receivables Modules 
to generate Invoices.

Unmatching Receipts - For Trading Item

This functionality is specifically provided to rectify user errors at time of Matching of 
receipts. However such delivery can be unmatched only if the same is not shipped. 
Unmatch of Shipped deliveries is not possible as tax impact is already over.

Field Description Type Action Description

Match Type (Required) PICK This is an LOV showing options of
Match & Unmatch
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Field Description Type Action Description

Organization (Required) PICK This shows a list of Trading
Organizations based on
Localization setup

Order Type (Required) PICK This shows a list of Order Types
that are available.

Delivery ID (Optional)   Delivery ID may be entered by the
user from LOV for which the
matching of receipt is already done
but not shipped.

Delivery Detail ID (Optional)   Delivery Detail ID may be entered
by the user from LOV for which the
matching of receipt is done but not
shipped. Leaving this blank will
result in un-matching of all lines
pertaining to the given delivery.

Manual RG 23 D Entry
RG 23D Manual Entry is a view / entry form that can be used to view/enter the Manual 
RG 23D transaction. It displays on query all the transactions that have an entry in the 
RG 23 D register sorted on the Year & Serial Number. Each Trading inventory 
organization is considered as Excise Unit. Thus, you need to specify the Organization 
Name and Location both for querying & for making manual entries into the register. 
Querying can be done based on certain fields on the Entry Block and also Transaction 
Details block.

The Remarks column is editable for all the transactions & can be effectively used for 
recording any comment to be made against specific Transactions.

India Local Order Management Setup Registers Manual RG23D Register Entry

The field wise description for the screen is given below.

Field Description Type Action Description

Header Level    
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Field Description Type Action Description

Organization Required PICK HELP The User needs to enter Trading
inventory organization name
from the LOV for which he wants
view the RG23D entries.

Location (Required) PICK HELP The User needs to enter Location
for the above Trading inventory
organization from the LOV for
which he wants view the RG23D
entries.

Transaction Type (Required) PICK HELP The User needs to specify the
transaction type like Receipts,
Return to Vendor, Issue, Return
for which he wants view the
RG23D entries.

Item (Required) PICK HELP The User needs to specify the Item
for which he wants view the
RG23D entries.

Line Level     The following information will be
displayed for a entered receipts
for selected item in a Trading
Organization Location.

SL.No (Displayed)   System generated Serial Number
will be displayed here.

Comm. Invoice
Number

(Displayed)   Excise Invoice Number of the
Supplier entered in the Receipt
lines will be displayed here.

Date (Displayed)   Date of the above Excise Invoice
of the Supplier will be displayed
here.

Bill of Entry Number (Displayed)   Bill of Entry number for Import
receipts will be displayed here.

Supplier Name (Displayed)   Name of the Supplier will be
displayed here.
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Field Description Type Action Description

Supplier Address (Displayed)   Supplier Address (Pay Site) will
be displayed here.

Transaction Quantity (Displayed)   Quantity in the transaction

UOM will be displayed here.

Transaction UOM (Displayed)   Transaction UOM will be
displayed here.

Quantity Received (Displayed)   Quantity transacted in Primary
UOM will be displayed here.

Primary UOM (Displayed)   Primary UOM of the transacted
item will be displayed here.

Rate of Duty (Displayed)   Rate of Duty will be displayed
here.

Duty per Unit (Displayed)   Excise Duty per unit for a
particular receipt will be
calculated and displayed here.
This is allowed to be changed for
a receipt if the same has not been
matched to any delivery.

Total Duty Amount (Displayed)   Total Excise Duty amount for a
receipt will be displayed here.
This will get recalculated if there
is a change in Duty per Unit for
an unmatched receipt.

Balance quantity (Displayed)   Balance available quantity after a
particular receipts will be
displayed here.

Remarks (Optional/Enter
able)

  Remarks regarding a transaction
can be entered here.

Reports
RG23D Register Report
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This Report gives the complete details of RG23 D Register as per Central Excise Act, for 
an Item

Report Submission

Use the Request Reports others (OE & AR modules) form and enter India-RG23 D 
Report in the Name field to submit the report.

Organization (Required, Default) PICK HELP

Enter A Organization, you wish to take the RG 23D Register Report for.

Location (Required, Default) PICK HELP

Enter a Location, you wish to take the RG 23D Register Report for.

Transaction From/To Date PICK HELP

India Localization allows the user to print selectively the transactions from a given date 
on wards.

Inventory Item (Optional) PICK HELP

Enter a specific Item for which you want to take RG 23D, otherwise Report for all the 
items will taken.

Report Headings

Report headings provide you with general information about the contents of the report. 
Oracle lists information as given in the report format of RG RG23D Registers.

Column Headings

In the Receipt side

S.No

Serial Number for an Item in the Register will be reported

Supplier Invoice and BOE No.

Supplier Invoice (Excise Invoice) will be displayed here. If the Receipt is Import one, 
then BOE Number for the Receipt will also be reported 

Name and Address of the Supplier

Name and address of the supplier and his Excise Registration details will be reported

Quantity

Receipt Quantity will be reported 

Rate of Duty

excise_duty_rate will be reported

Amount of duty per amount

Excise Duty per Unit will be reported

Total Amount of duty



Trading Functionality    7-17

Total amount of Excise duty on receipt will be reported

In the Issue side 

Name and Address of the Customer (Consignee)

Name and address of the Customer if he is a consignee will be reported here and his 
Excise Registration details will also be reported.

Name and Address of the Customer

Name and address of the Customer (Other than consignee) will be reported here and 
his Excise Registration details will also be reported

Quantity

Issue Quantity will be reported

Amount of duty per amount

Excise Duty per Unit will be reported

Total Amount of duty

Total amount of Excise duty on receipt will be reported

Balance Quantity

Balance Quantity for an Item at the end of the report date will be displayed.

Quantity Remaining / Matched

Against a Receipt entry, the values of quantity available for matching against the 
particular receipt and quantity already matched shall be shown in this column
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8
India Local Projects

Projects Costing
Oracle Project Costing records and reports cost against a Project; and integrates with 
other Oracle Applications, including Oracle Purchasing, Oracle Payables, Oracle 
Inventory, Oracle Assets and Oracle General Ledger to account for costs. Costs reflected
for a project may flow from different modules like Oracle Purchasing and Oracle 
Payables. These costs shown in Projects include non-recoverable portion of the India 
Localization taxes. There are two dimensions to the information reflected in Oracle 
Projects costing with respect to Purchasing and Payables Module.

• Commitments

• Actual Costs

Solution Flow
Non recoverable Financials For India Taxes in Projects Commitments

1. Enter Requisition/Purchase Order with Project Related Information. Taxes default 
and get calculated based on IL tax setups. There is no change in the tax defaulting 
hierarchy provided by India Localization.

2. You can view taxes by clicking Taxes on the localization Purchase Order. 
Non-recoverable taxes are indicated by the Modvat Flag. An unchecked Modvat 
Flag indicates a non-recoverable tax. Further, the destination type of the receipt also
determines recoverability.

3. Approve the Purchase Order.

4. Run the PRC: Update Project Summary Amounts for a Single Project concurrent to 
view the commitments created in the Oracle Projects Module. Commitments in 
Project Status Inquiry form include the NonRecoverable tax component. The 
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Projects cost reflected in Project Raw Cost and Project Burdened Cost column are 
inclusive of Item cost, and Financials for India Non Recoverable Taxes.

Note: Commitments view in projects also gets updated with 
Financials for India Non recoverable taxes in case of Supplier 
invoices matched to Purchase order, prior to interface to Projects. In
this case the tax lines appear as individual lines on the Project 
status inquiry form.

Non-Recoverable Financials for India Taxes in Projects Costs

Costs Interfaced from Receipt or Invoice would be sent in as separate lines for the Item 
cost and Non-recoverable tax component to Projects.

1. Enter Purchase Order with Project Related Information.

2. Enter Receipt for the Purchase Order. You can view taxes by clicking Taxes on the 
localization receipt form.

3. Non-recoverable taxes are indicated by way of the "Recoverable Flag" checkbox. 
Further, as the destination type of this receipt is EXPENSE even the Central Excise 
taxes are considered as non-recoverable as per the India Localization functionality. 
Central Excise type of taxes is considered as recoverable only for Capital goods 
when the destination type is EXPENSE. All the receipts to destination type 
RECEIVING and INVENTORY are part of the Project Manufacturing transaction 
flow and not the Project Costing transaction flow.

4. Run the PRC: Interface Supplier Costs concurrent to import the actual costs from 
Oracle Purchasing or Oracle Payables module to in the Oracle Projects module.

5. On querying for the receipt in expenditure inquiry you would see the item cost as a 
separate line and the total of all non-recoverable financials for India tax amounts on
the receipt as a separate line.

Note: Project costs include Financials for India Non recoverable 
taxes interfaced from Supplier invoices matched to Purchase 
order/Receipt In this case each non recoverable tax line appears as 
individual lines on the Expenditure inquiry form.

Integrating with Purchasing
When you enter project-related transactions in Oracle Purchasing, you only need to 
enter project information on the source document; either the requisition or the purchase
order. When you create purchase orders from requisitions using Oracle Purchasing 
AutoCreate feature, the project information from the requisition is copied to the 
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purchase order. India Localization taxes on the purchase document will be 
appropriately considered as Commitment Costs and Actual Costs in projects. The 
process below describes how each purchase document is handled in integration with 
India Localization taxes:

1. Enter Requisitions

Enter project-related purchase requisitions using the Requisitions window in Oracle
Purchasing. Enter default project information in the Requisitions Preferences 
window in the Project Information tab. This default information will be used to 
populate requisition distribution lines you create during your current session.

The requisitions distribution line has a Project tab to enter project-related 
information. A requisition can have a combination of project-related and 
non-project-related distribution lines.

India Localization taxes will default on the requisition based on its 3-Way tax 
defaulting mechanism. Non-recoverable taxes for project related distribution lines 
will be included in the commitment amount for the Project.

2. Using AutoCreate

When you automatically create purchase orders from project-related requisitions in 
the AutoCreate Documents window, Oracle Purchasing copies the project 
information and accounting information from the requisition to the purchase order. 
You do not need to enter any additional project-related information on your 
purchase order when you use this feature. For further information, see: AutoCreate 
Documents Overview, Oracle Purchasing User's Guide.

You can change the project information on the purchase order that was copied from
the requisition; the project information on the requisition is not updated.

India Localization taxes will be copied from the requisition to the Purchase Order or
taxes are redefaulted in the Purchase Order. Non-recoverable taxes for project 
related distribution lines would be included in the commitment amount for the 
Project. If the project information is changed from Requisition to Purchase Order, 
India Localization non-recoverable taxes will be included in the respective project 
as Commitment cost.

3. Enter Purchase Orders

If your company does not use online requisitions or the AutoCreate feature, enter 
project-related information directly on your standard purchase orders using the 
Purchase Orders screen in Oracle Purchasing.

When you use this window, you specify project-related information in the Project 
tabbed region of the distribution line. Based on the project-related information 
entered, the account information will be automatically created by the Account 
Generator. For further information, see: Overview of Purchase Orders, Oracle 
Purchasing User's Guide.

India Localization taxes will default on the Purchase Order based on its 3-Way tax 
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defaulting mechanism. Non-recoverable taxes for project related distribution lines 
will be included in the commitment amount for the Project.

4. Enter Releases

Enter project-related releases against blanket purchase agreements and planned 
purchase orders using the Enter Releases window in Oracle Purchasing. Specify if 
the release distribution line is project-related. If it is project-related, you continue to 
enter project information for the line. See: Entering Release Headers, Oracle 
Purchasing User's Guide.

India Localization taxes will default on the Blanket Purchase Agreement and 
Planned Purchase Order based on its 3-Way tax defaulting mechanism. 
Non-recoverable taxes for project related distribution lines will be included in the 
commitment amount for the Project.

5. Recording Receipts and Delivery

You can track receipt and delivery of goods for project-related purchase orders 
using the Receipts window in Oracle Purchasing. You can report the delivery of 
purchased goods in your commitment reporting. Oracle Purchasing does not record
the received goods as delivered for your project until the goods are delivered and 
assigned to a purchase order distribution line. See: Overview of Receipts, Oracle 
Purchasing User's Guide.

When a purchase order line is flagged to accrue on receipt and the purchased goods
are delivered to an expense destination, you can interface receipt accrual accounting
entries from Oracle Purchasing to Oracle Projects as actual transactions. This allows
you to recognize the cost to your project in the period in which it is incurred rather 
than in the period in which it is invoiced. For more information, see: Overview of 
Receipt Accounting, Oracle Purchasing User's Guide, and Interface Supplier Costs, 
Oracle Projects Fundamentals.

India Localization taxes on receipts are derived from the Purchase Orders. User has 
the ability to modify the defaulted taxes at the time of making the receipt. You can 
add, delete or modify taxes on the receipts. Further, user can modify amounts of 
adhoc taxes as well. While interfacing costs from receipts to projects, India 
Localization non-recoverable taxes on receipts are also interfaced as actual cost 
transactions.

Note: Since the receipt is made to an expense destination, India 
Localization functionality considers recoverable Central Excise 
taxes (other than taxes on Capital Goods) as non-recoverable.

Requisition Adjustments
You can update project information on a requisition. If the requisition is included on a 
purchase order before you update the project information, the purchase order is not 
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updated with the new project information. If the requisition line is included on a new 
purchase order after you change the project information, Oracle Purchasing copies the 
new project information to the new purchase order.

The Account Generator builds a new account number value when you change the 
project information. The new project information is used in commitment reporting.

India Localization taxes will be included as commitment cost in the appropriate 
projects.

Purchase Order Adjustments
You can update project information on a purchase order, even after it is approved and 
invoiced. However, you cannot update project information if there has been any 
accounting activity on the purchase order (for example, if it is encumbered, or if it is 
accrued on receipt and the distribution has been received or billed). If the purchase 
order is invoiced before you update the project information, the invoice is not updated 
with the new project information. If the purchase order line is invoiced on a new 
invoice after you change the project information, Oracle Payables copies the new project
information to the new invoice.

The Account Generator builds a new account number when you change the project 
information. The new project information is used in commitment reporting.

India Localization taxes will be included as commitment cost in the appropriate 
projects.

Integrating with Payables
When you match an invoice to a purchase order or receipt in Oracle Payables, the 
project information from the purchase order or receipt is copied to the invoice. When 
you enter new project-related invoices in Oracle Payables, you only need to enter 
project information on the source document, the invoice. If you use distribution sets 
with project information, Oracle Payables automatically supplies project information for
your supplier invoice distribution lines.

Matching Invoices

If you use Oracle Purchasing and have already associated project-related information to
a purchase order, and you are matching an invoice to a purchase order or receipt using 
the Invoices windows instead of manually creating invoice distribution lines, Oracle 
Payables automatically copies the project information from the purchase order or 
receipt to the invoice.

Note: You cannot change the project information that is copied from the
purchase order to the invoice.

India Localization Taxes on Payables Invoice are interfaced based on matching to either 
Receipt or Purchase Order. In case of non-recoverable India Localization taxes, the 
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Projects details will be copied from the parent Item line in the Invoice Distributions. 
These non-recoverable taxes will be interfaced to Project Costing module as separate 
cost lines. From India Localization perspective, you must ensure the following:

• When a receipt is made, Payables invoice should always be matched to the receipt.

• When a receipt is made for the Purchase Order, the receipt should be interfaced to 
Project Costing module as Supplier Cost and not the Supplier Payables Invoice (this
is controlled by way of parameter to concurrent program – PRC: Interface Supplier 
Costs to Projects.

• Third party taxes on receipts are not interfaced to Payables Invoice. To interface 
third party taxes (non-recoverable) to Project Costing, receipts should be interfaced 
to Project Costing module as Supplier Cost.

• Customs taxes on receipts are not interfaced to Payables Invoice. To interface 
Customs taxes (non-recoverable) to Project Costing, receipts should be interfaced to 
Project Costing module as Supplier Cost.

Entering Invoices

You can enter project-related invoices directly in the Invoices windows in Oracle 
Payables. You can enter project-related information in the Invoices window, which will 
default to all distributions you enter for the invoice. These values can be overridden. 
You also enter project-related information in the Distributions window. You can create 
a folder with project-related fields to be used for entering information. An invoice can 
have both project-related and non-project-related distribution lines. See: Entering 
Invoices Overview, Oracle Payables User Guide.

Note: You can also import through the Payables Open Interface tables 
projects-related invoices from the Invoice Gateway and other systems.

Currently, India Localization does not support taxes to be entered on Payables Invoices 
directly. Users should use Purchase Order or Receipt matched Payables Invoices for the 
transactions.

Supplier Invoice Adjustments in Payables
You can perform supplier invoice adjustments in Oracle Payables at any stage in the 
process flow.

Adjusting project information for matched invoices

If you have matched an invoice to a purchase order, you cannot directly change any of 
the project information copied from the purchase order. You may encounter cases in 
which you want to change the project information; in particular, you may want to 
change the expenditure item date that was copied from the purchase order, because the 
expenditure item date on the purchase order was not maintained.
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If you want to change the project information in this case, there are two ways of making
the change.

You can reverse the matching distribution line from the purchase order in the 
Distributions window in Oracle Payables, change the purchase order project 
information in Oracle Purchasing, and match the invoice to the purchase order again.

India Localization tax distributions (for non-recoverable) tax, derive the project 
information from the parent line distribution. If you wish to make any changes in the 
project information for parent distribution, please make sure that similar adjustment is 
carried out on the related India Localization tax distribution in order to achieve correct 
project cost.

Adjusting manually entered, unposted invoices

You can directly change any or all of the project information before an invoice is posted.
The Account Generator derives a new account number based on the new project 
information that you enter. India Localization does not support taxes on manually 
entered payables invoices.

Adjusting manually entered, posted invoices

You cannot directly change any project information on a posted invoice. You must 
reverse the distribution line and create a new distribution line with the new project 
information using the Distributions window in Oracle Payables. India Localization does
not support taxes on manually entered Payables invoices.

Interfacing Adjustment Lines to Oracle Projects
If the original invoice distribution line that was reversed was not yet interfaced to 
Oracle Projects, the Interface Supplier Invoices from Payables process does not interface
the original or reversing items that are included on the same invoice, to Oracle Projects. 
These items are marked as net zero adjustment lines that are not to be interfaced to 
Oracle Projects. The new line with the correct project information is interfaced to Oracle 
Projects.

India Localization tax distribution (for non-recoverable tax) derives the project 
information from the parent line distribution. If you wish to make any changes in the 
project information for parent distribution, please make sure that similar adjustment is 
carried out on the related India Localization tax distribution to achieve correct project 
cost.

Supplier Invoice Adjustments in Oracle Projects
You can perform the following adjustments for supplier invoices in Oracle Projects:

• Transfer between projects/tasks

• Split expenditure item

• Adjust supplier invoice expenditure items



8-8    Oracle Financials for India User Guide

• Enter a miscellaneous pre-approved expenditure item to adjust the related discount 
amounts

• Reclassify item as billable or non-billable

• Reclassify item as capitalizable or non-capitalizable

• Edit comment

• Hold or Release from Billing

Project users can perform these adjustments in Oracle Projects because the actions do 
not change the amount of the invoice that is processed in Oracle Payables. These 
adjustment actions change the project information of the supplier invoice item, which is 
used in Oracle Projects processing.

After you have made adjustments to supplier invoice items, you must send the 
adjustment information back to Oracle Payables so the Payables distribution lines 
match what is recorded in Oracle Projects. Oracle Payables will interface adjustments 
that affect the GL account number to Oracle General Ledger. You run the following 
processes in Oracle Projects for supplier invoice adjustments:

• PRC: Distribute Supplier Invoice Adjustment Costs

• PRC: Interface Supplier Invoice Adjustment Costs to Payables

If you need to change the invoice amount, supplier, or expenditure type, organization, 
or item date for a supplier invoice line, reverse the line and create a new line in Oracle 
Payables. For further information, see: Adjusting Project Information for Matched 
Invoices, Oracle Projects User's Guide.

Restrictions to Supplier Costs Adjustments
Adjustments to supplier costs in Oracle Projects must adhere to the specific business 
rules for supplier invoices and receipt accruals.

Supplier Invoices

When Projects is integrated with Payables, you cannot adjust supplier invoices (either in
Oracle Projects or in Oracle Payables) if the invoice is:

• Cancelled: When you cancel an invoice in Payables, reversing distribution lines are 
created for each distribution line, and the invoice amount is set to zero. The invoice 
status is set to Cancelled, and its distribution lines are posted to GL the next time 
the Transfer to General Ledger program is run in Payables. When an invoice has a 
status of Cancelled, it cannot be adjusted.

• Paid: If any of the following conditions apply:

• The Payables setup option Allow Adjustments to Paid Invoices is disabled. 
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Oracle Payables provides a system-level control to prevent users from adjusting
paid invoices. If you want to allow adjustments to paid invoices, enable the 
Allow Adjustments to Paid Invoices setup option in the Payables Options 
window.

• You are using the Prorate Expense or Prorate Tax discount distribution method 
Oracle Payables does not allow adjustments to paid invoices if a prorated 
discount distribution method is used.

• You are using cash basis accounting.

• Prepaid, either fully or partially.

• Selected for payment.

Note: You cannot adjust an invoice selected for payment until the 
Confirm Payment Batch action has been performed.

Receipt Accruals

You cannot adjust the item in Oracle Projects when the item is interfaced from Oracle 
Purchasing. If the invoice is matched to accrue on receipt purchase order line and the 
invoice line (rather than the purchase order receipt) is interfaced, then the invoice line 
can be adjusted in Oracle Projects.

India Localization tax distributions are interfaced to Project Costing module as separate 
expenditure line items. User should not make any modifications to these expenditure 
lines and interface them back to Oracle Payables module.

Integrating with Inventory
You can perform inventory transactions related to projects – such as Issue to Projects, 
Issue from Projects etc. This is achieved by checking the "Project" check box at the time 
of defining User Inventory Transaction Types. These Inventory transactions related to 
Projects are also considered for appropriate quantity register update as per India 
Localization functionality. For e.g. Issue to Project inventory transaction for a raw 
material item will update the RG 23 Part I register, Issue to Project inventory transaction
for a finished good item will update the RG I register.

India Local Projects Billing
This section provides an overview and details of each step involved in completion of 
setups required for India Localization support for Project Billing solution.

• Complete Oracle Projects Setup, Oracle Projects Implementation Guide
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• Tax Code Setup, page 1-78

• Tax Category Setup, page 1-89

• Tax Defaults and Preferences setup

Setting Up Projects Billing Tax Defaults and Preferences
This setup determines the tax defaulting hierarchy to be used for defaulting tax 
categories on Projects related invoices. You can define tax defaulting hierarchy for each 
Distribution Rule used in Oracle Project Billing. Within the Distribution Rule, you can 
define tax defaulting hierarchy for Event Type, Project, Expenditure Type and 
Customer or Customer Site.

Tax defaults and preferences for Project Billing is setup in a new user interface called 
Tax Defaults. To access it, login with India Local Project Billing responsibility and 
navigate to India Local Tax Setup under Setup.

Field Description Description

Preferences Tab Use this tab region to define the tax defaulting
hierarchy preference for Distribution Rule and
Context Name.

Distribution Rule This will display the distribution rules as per 
Project Billing Setup.

Context Name This will display the following context names:

• Event Type

• Project

• Expenditure Type

• Customer/Site

Define the preference number for each of the 
context name. This preference number will 
determine the hierarchy of tax defaulting to be
used.
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Field Description Description

Preferences Enter Preference number. You can enter any 
unique number for a combination of 
Distribution Rule and Context Name. This 
preference number will determine the tax 
defaulting hierarchy.

For instance, consider the following setup:

• Event Type = 1

• Project = 2

• Expenditure Type = 3

• Customer/Site = 4

Tax Category defined in the Context Tab 
Region of the form for the Event Type in the 
invoice will take highest precedence for tax 
defaulting. If the tax category is not setup for 
Event Type, then the tax category at the 
Project level will be defaulted in the invoice.

Header Section  

Contexts Tab Use this tab region to define the tax categories 
to be used for each of these context names:

• Event Type

• Project

• Expenditure Type

• Customer/Site
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Field Description Description

Context Name • Event Type

• Project

• Expenditure Type

• Customer/Site

You can enter the above context names and 
query all the context values in the lines 
section.

Default Context Name Use this Default button to query the default 
context name.

Tax Category LoV contains all the defined tax categories.

Default Tax Category If you select this radio button the Tax 
Category will be assigned to all the context 
values in the lines section where the tax 
category is empty. This will not override the 
current tax categories for any of the context 
values.

All, Override All Tax Categories If you select this radio button the Tax 
Category will be assigned to all the context 
values in the lines section. This will override 
the current tax categories for any of the 
context values.

Lines Section  

Context Name • Event Type

• Project

• Expenditure Type

• Customer/Site

Pick the appropriate context name for which 
you want to assign a tax category.
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Field Description Description

Context Value LOV contains values based on the context 
name selected.

For e.g. If the Event Type context name is 
selected, then all the event types as per Oracle 
Project Billing setup will be displayed here.

Pick the appropriate Context Value for which 
you want to assign a tax category.

Customer Site LOV contains customer site for the customer 
selected as the Context Value.

This LOV is available only if Context Name is 
Customer/Site.

Tax Category LOV contains the tax categories defined.

Pick the appropriate tax category you wish to 
use as the default tax category for the selected 
Context Value.

Enter events or expenditures and distribute costs in Oracle Projects
For related information, see: Expenditures, Oracle Project Costing User Guide.

Generate draft revenue
Generate draft revenue wherever required. For more information, see: Processing 
Adjustments, Oracle Project Costing User Guide.

Generate Draft Invoices
Generate draft invoice using the Oracle Projects Billing concurrent program:

• PRC: Generate Draft Invoices for Single Project, or

• PRC: Generate Draft Invoices for Multiple Projects

This process will calculate and default India taxes on the India Draft Invoice Screen. The
tax defaulting will take place based on the setup created. See Setting Up Projects Billing 
Tax Defaults and Preferences, for further information.

Invoice - India screen can be viewed from a separate menu option or from View > Zoom
on the base Projects draft invoice screen. Login with India Local Projects Billing 
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responsibility and navigate to Oracle Projects > Billing > Invoice Review > Find Invoices 
> Invoice Summary > Tools > India Invoice. In the Find Invoices screen, query your 
required invoices.

Field Description Description

Projects Region  

Project Number Enter the project number by which you want 
to query the invoices.

Project Name Enter the project name by which you want to 
query the invoices.

Invoices Region  

Invoice Number Enter the invoice number by which you want 
to query the invoices.

Invoice Status Enter the invoice status by which you want to 
query the invoices.

Creation Date Enter the creation date by which you want to 
query the invoices.

Customers  

Customer Number Enter the customer number by which you 
want to query the invoices.

Customer Name Enter the customer name by which you want 
to query the invoices.

Based on the selected query criteria the invoices will be queried and displayed in the 
Invoice Review screen.

Field Description Description

Draft Invoice Area  

Number This field will display the invoice number.
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Field Description Description

Status This field will display the invoice status.

Creation Date This field will display the invoice creation 
date.

Customer Area  

Number This field will display the customer number 
related to the invoice.

Name This field will display the customer name 
related to the invoice.

Amount This field will display the invoice amount.

Tax Amount This field will display the invoice tax amount.

Currency This field will display the invoice currency.

Taxes This field will indicate if there is any tax 
defaulted for this invoice.

Click Lines to display the invoice lines.

Field Description Description

Invoice Region  

Draft Invoice This field displays the Invoice number.

Creation Date This field displays the creation date for the 
Invoice.

Invoice Status This field displays the invoice status for the 
Invoice.

Amount This field displays the invoice amount for the 
Invoice.
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Field Description Description

Tax Amount This field displays the tax amount for the 
Invoice.

Currency This field displays the currency for the 
Invoice.

Project Name This field displays the Project name for the 
Invoice.

Project Number This field displays the Project number for the 
Invoice

Customer Name This field displays the Customer name for the 
Invoice.

Customer Number This field displays the Customer number for 
the Invoice.

Organization Select the Inventory Organization for which 
you wish to update the Central Excise and 
Value Added Tax Registers

Note: Selecting Inventory Organization 
and Location is mandatory in this form. 
Organization and Location selected here 
will be used for updating the Central 
Excise and Value Added Tax registers. 
User will not be able to close this form 
unless Inventory Organization and 
Location is selected.
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Field Description Description

Location Select the Location related to the Inventory 
Organization for which you wish to update 
the Central Excise and Value Added Tax 
Registers.

Note: Selecting Inventory Organization 
and Location is mandatory in this form. 
Organization and Location selected here 
will be used for updating the Central 
Excise and Value Added Tax registers. 
User will not be able to close this form 
unless Inventory Organization and 
Location is selected.

Register details Region Register Details Region will not display any 
values until the Projects Invoice is released. 
Draft Invoice generated in projects, this 
invoice is approved. User can modify any tax 
details after approval of the invoice as well. 
All the tax details will be frozen once the 
Invoice is released. Release of Invoice will also
generate Excise and VAT Invoices. This will 
perform Central Excise and VAT Accounting 
and update the respective Central Excise 
Register and VAT repository as well.

Note: Project Invoices do not have any link
to items. Hence the quantity registers will 
not be updated. You should make manual 
entries for the required quantity register 
updates.

Excise Invoice This field will display the excise invoice 
number generated related to this Project 
Invoice.

Excise Invoice Date This field will display the excise invoice date 
related to this Project Invoice.

Excise Register This field will display the excise register 
updated related to this Project Invoice. This 
register relates to the utilization of excise.
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Field Description Description

VAT Invoice This field will display the VAT invoice 
number generated related to this Project 
Invoice.

VAT Invoice Date This field will display the VAT invoice date 
related to this Project Invoice.

Lines Section  

Field Name • Tax Category

• Service Type

You can use this option to default the tax 
category on the invoice lines.

Default Value LOV contains the values of tax category or 
service type, based on the Field Name 
selected.

Default for all the record If you select this check box then the default 
values will be inserted for all the lines. If you 
leave this check box unchecked, then values 
will be inserted only for those lines where the 
values are NULL.

Default Use this button to default the values of Tax 
Category or Service Type based on Field 
Name selected.

Line Number This field displays the line number for the 
invoice line.

Description This field displays the description for the 
invoice line.

Line Amount This field displays the line amount for the 
invoice line.

Tax Amount This field displays the line tax amount for the 
invoice line.
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Field Description Description

Tax Category You can select a tax category here. This will 
override the tax category defaulted for the 
invoice line.

Service Type Select the Service Type to be used for the 
invoice line.

Click Taxes to view taxes for the line.

Field Description Description

Header Section  

Application This field will display Projects as default 
value.

Document Type This field will display 
PROJECT_DRAFT_INVOICE as default value.

Document Number This field will display Document Number.

Document Line Number This field will display Document Line 
number.

Line Amount This field will display the Line amount.

Lines Section  

Line No This field will display Tax Line number.

Tax Name You can delete the tax line. You can also add a
tax line by clicking on the next line.

Tax Type This field will display Tax Type related to the 
line.

Precedences 1-10 This field will display the precedences (from 1
to 10) for this tax line.
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Tax Rate This field will display Tax Rate for this tax 
line.

UOM This field will display UOM for this tax line, 
only if the tax is UOM based.

Qty Rate You can enter the quantity rate for this tax 
line. This will display only if the tax is UOM 
based.

Tax Amount This field will display Tax Amount for this tax
line.

The Invoice - India form with localization tax details can also be viewed from the Tools 
special menu option on the Oracle Project Billing Invoice Review form.

Approve and release the invoice so that the invoice can be imported into Oracle 
Receivables.

Note: Once the invoice is released, none of the tax information can be 
modified.

Run the PRC: Interface Invoices to Receivables process to interface the invoices to 
Oracle Receivables and run AutoInvoice program to import the invoice into Oracle 
Receivables.

You must run the India - Import Projects Taxes to Receivables program to import India 
Localization taxes to Oracle Receivables. You can view the India Local taxes in 
Transactions Localized form after running the program.

Service Tax repository updates take place after performing these steps:

1. Apply receipt to the projects invoice with service taxes in Receivables (after running
the India Import Project Taxes to Receivables.)

2. Run the India Service tax processing concurrent program.

Run the tie back to receivables process of Oracle Projects to complete the billing cycle

Credit Memos and Foreign Currency Invoices
Credit Memos

For Invoices with "Accepted in Receivables" Status, write off or cancellation can be 
done. This generates a new draft invoice with negative amounts, which has negative 
India Local taxes. A credit memo is generated in Receivables for such write-offs and 
cancellations. Taxes are inherited from the parent invoice and you must not make any 
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modifications to these taxes. Any such modification performed will create 
inconsistencies in Original Invoice taxes and Credit Memo taxes. All the processes 
described above are applicable for the negative draft invoice as well.

Foreign Currency Invoices

For foreign currency invoices in unapproved status, changes may be made to the 
exchange rate or currency. India taxes will be recalculated when such changes are 
made.
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9
India Local iProcurement

This chapter covers the following topics:

• India Local iProcurement Overview

• Setting up India Local iProcurement

• Processing iProcurement Transactions

• Requisitions

• Purchase Orders

• Receiving

• Reports

India Local iProcurement Overview
IL support for iProcurement satisfies all tax needs of corporate requestors by providing 
tax links in existing base iProcurement transactions. Tax Codes defined in India 
Localization setups can be used in iProcurement transactions. Taxes get defaulted on 
iProcurement Requisitions, Receipts including ISO Receipts, Returns and Receipts 
Correction transactions based on the India tax defaulting hierarchy. These taxes can be 
viewed or modified based on the user access authorization assigned to you.

Tax calculation and tax accounting operations available in India Local Purchasing are 
also applicable to iProcurement. You can view accounting entries passed for 
iProcurement Receiving transactions using the IL forms. In case of Excise and Value 
Added Tax (VAT) type of taxes, CENVAT and VAT recovery claim can be done using 
India Localization forms. Excise registers and VAT repository gets updated 
appropriately on completion of CENVAT and VAT claim process.

IL support to iProcurement also facilitates application of Bill of Entry (BOE) payments 
to Receipts created in iProcurement. The Receipt can be fetched in the Receipt Localized
form for application of Customs Duty against the advance BOE payment made to the 
authority.
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Major Features
• User Authorization for Tax Review: Only authorized users are allowed to modify 

sensitive tax information on iProcurement Requisitions and Receipts.

• Defaulting Taxes to iProcurement Requisitions: For Items that attract Localization 
Taxes, Taxes will be defaulted on the iProcurement Web UI when a Requisition is 
created. These taxes will be defaulted based on the Tax Defaulting Rules. Taxes 
would be defaulted automatically based on Item Category assigned to the Supplier 
– Supplier Site; Supplier – Null Site or based on the Item Class assigned to the Tax 
Category for the Supplier. Taxes applicable to an Agreement shall be defaulted on 
shopping a specific item attached to a Blanket Purchase Agreement / Contract. In 
case of Non-Catalog Requests, taxes need to be added manually as tax defaulting 
mechanism in IL is available only to items with Inventory Setups.

• Manual Changes to Defaulted Taxes to iProcurement Requisitions: Taxes 
defaulted during iProcurement Requisition can be modified manually in case of a 
need, depending on your Authorization. New taxes can be added or existing taxes 
modified or deleted based on your Authorization levels. You can define or modify 
precedence logic for calculation of Tax Base Amount on which the Tax Rate would 
be applied. The Tax Base Amount can either be the line amount or line amount 
including other taxes calculated for the transaction.

• Taxes Applicable at the Time of Receipt: When material is received against 
Requisitions, the taxes defined at the PO level get defaulted proportional to the 
quantity received. You can modify the taxes defaulted on Receipts based on your 
Authorization. Localization provides the functionality to modify the taxes at the 
time of receipt on completion of base iProcurement Receipt. Tax changes are not 
allowed once you commit the tax changes and initiates the tax accounting process. 
But taxes amounts are displayed against each receipt line to enable viewing.

• CENVAT and VAT claims: CENVAT and VAT claims can be made for the 
iProcurement Receipt using 'MODVAT on Receipts India' and 'VAT-Tax Claim' 
forms respectively. All India tax inputs provided in iProcurement shall be fetched 
to the receipt form automatically.

• Application of Bill of Entry (BOE) at the Time of Receipt: Provision to apply the 
BOE to the receipt is provided similar to CENVAT and VAT claims. You need to 
navigate to the IL Receipt form to identify and apply the BOE payment against the 
particular Receipt. The Bill of Entry can only be applied against the customs duty 
type of taxes (i.e. Basic, Counter veiling Duty and Additional Customs Duty) 
attached to the iProcurement Receipt.

• Advance Shipment Notice (ASN) or Internal Sales Order (ISO) Receipts: Oracle 
iProcurement supports multiple receipts against In-transit Shipments (ASN 
shipments and ISO receipts). IL only supports creation of single receipt against an 
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ASN / ISO. IL support to iProcurement defaults India taxes on these shipments on 
receiving.

• Receipt Corrections: iProcurement provides the functionality of receipt corrections.
On performing receipt corrections to receipts in the base iProcurement application, 
corresponding modifications are made to the Cenvat or VAT or Tax costing entries 
as these taxes have already been processed in India Localization.

Setting up India Local iProcurement
This section provides an overview and details of each step involved in completion of IL 
support to iProcurement Setup.

• Define Organization Additional Information: Identify and Define Inventory 
Organizations and Locations that would be procuring items or services using 
iProcurement. The information defined at this level would be the basis for 
Recording, Reporting and Accounting of the local taxes. Apart from this you would 
also define the Organization Registration details with Excise, Customs, Sales Tax 
and TDS authorities. This information available in Additional Organization 
Information is the basic data for all India Localization activities. The Organization 
and Locations defined through Common Application would be available for setup. 
While creating the Additional Organization Information, it is mandatory to create 
two sets of records, one at Null Location level and another with Location.

The master child relationship among the Organization and Location would be used 
only for consolidation of Excise Registers at Master Organization Level. For further 
information, see:Defining Organization Additional Information, page 1-4.

• Define Organization Trading Information: Define Organizations Registered under
the Central Excise Rules as a Dealer/Depot. Navigate to Trading Information Tab of 
the Additional Organization Information to enter Excise Registration details of a 
Dealer. The information entered here would be printed on all relevant reports and 
invoices raised from this Organization.

You need to ensure that no values are entered in any of the boxes falling under the 
Excise region of the Tax Information tab of the Additional Organization 
Information. Any value entered in this region would categorize this Organization as
a Manufacturing Organization. For further information, see: Defining Trading 
Registration Details, page 1-8

• Define Sub Inventory Location: As a part of Localization setup, sub-inventories 
have to be associated to a combination of Organization/Location. Excise related 
transactions and records would be updated only for those sub Inventories that are 
identified as bonded for Manufacturing Organizations and as traded for Trading 
Organizations. For further information, see: Defining Sub Inventory Location, page 
1-23
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• Define Excise Invoice Generation: This feature can be used to automate the Excise 
Invoice document sequence generation. You can setup a document sequence for the
combination of Transaction Type, Order or Invoice Type and Register Type. You 
can define an alpha or alphanumeric value which would be prefixed to the number 
series generated for each Excise Invoice. The setup would be restricted to the Order 
or Invoice Types for which it is created. For all other Excise Invoices which are 
created using Order or Invoice Types for which setup has not been made, the 
system use the default number series. This would be a numeric series, starting with 
one, increased by one. The sequence would be different for each Organization or 
Location and the nature of clearance. Within the Organization, the sequence would 
be different for the Domestic clearances and Export Clearances. For further 
information, see: Defining Excise Invoice Generation, page 1-19

• Define Localization Item Information: The recording, recoverability and reporting 
of Localization Taxes would depend on India Localization related information 
setup for the Item. These values have to be entered in 'India Localization' context of 
the Items DFF, attached to the Item Master. Excise Registers would be updated only
when the Excise Flag is set to 'YES'. Similarly, considering CENVAT Credit and 
updating the Excise Registers for a Receiving transaction would happen only when 
the 'MODVAT' flag is set to 'Yes'. The option chosen in the Item Class attribute 
would be the basis on which the type of Excise Credit Register that has to be hit. 
Items classified in the other classes (such as OTIN, OTEX) would not be updating 
Excise Records. The Trading Flag would work together with the Organization 
Trading Information setup. RG23D Register would be hit only when the Trading 
item is transacted in a trading Organization. For further information, see: Defining 
Item Information, page 1-66

• Define Tax Codes: The Tax Definition is a localization feature to define taxes that 
are applicable to the transactions created in your Organization. The Taxes can be 
classified in different Types. The Type would be useful to recognize the relevance of
the tax for the Excise Registers, Sales Tax Form generation and TDS Certificate 
generation. The Type chosen would also have influence over the behavior of other 
boxes in this form. You can specify the Tax Rate, Surcharge, Recoverability, 
Rounding Rule, Expense Account Code, Tax (Third party) Vendor, Multi-currency 
and Effective Period for the Tax. In a multi-organization setup, Taxes would be 
specific to an Organization. On choosing the Taxes Localized option from the menu,
you would get the list of Inventory Organizations, to choose from. The tax defined 
can be used only for the Organization for which it is defined. Taxes once saved 
cannot be updated. For further information, see: Defining Tax Codes, page 1-78

• Define Tax Categories: If you can identify your purchase and sales transactions 
into clear categories for which a similar set of taxes with similar precedence and 
calculation are applicable, then you can group such taxes into a Tax Category. In a 
Tax Category you can choose the Taxes along with the precedence order and 
calculation basis.

An Item Class can be identified for a Tax Category. These taxes would default for 
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all the Items falling in this class. This would be useful, where the Item class drives 
the tax applicability. These taxes would default for the transactions created for the 
items in the item class. You can however, manually add new tax lines and can 
change, delete, change precedence for the defaulted lines. For further information, 
see: Defining Tax Categories, page 1-89

• Define Item Categories: Item Category allows you to assign Tax Categories to an 
inventory item in an Organization. You can attach an Item Category to the 
Additional Internal Customer information. The Taxes defaulted for a transaction 
line would be based on the Item Category attached to the Internal Customer and the
Tax Category assigned to the Item in this category. For further information, see: 
Defining Item Category, page 1-57

• Define Assessable Price Lists: When the Taxable basis for the calculation of the 
Excise Duty is different from the Price at which the Item is transferred, then you 
will has to create additional Price Lists with the Item Excise Assessable Price. This 
price list has to be attached to the Internal Customer or Customer Site. The 
Assessable Price would be considered only for calculation of the Excise Duty. 
Assessable Price Lists needs to be defined separately for Excise and VAT if the 
taxable basis is different.

• Define Supplier Additional Information: Before you start creating transactions for 
the Supplier, it would prerequisite to record the localization related information for 
the Supplier Site. You need to provide the Supplier Registration details with the 
Excise, Sales Tax and Income Tax Authorities and also attach the Assessable Price 
list that should be considered for the calculation of Excise Duty and VAT. Item 
Category list can also be attached to default localization taxes. You must complete 
this setup for each Supplier Site. For further information, see: Defining Supplier 
Additional Information, page 2-29

• Define VAT Regime: Regime would be used to define rules that would be 
applicable to all Taxes assigned to it. You need to complete this setup step before 
you move ahead with other setups. Setups made for a Regime would be applicable 
to all transactions created from the Organizations assigned to it. Information 
defined here would be generic unless you assign different properties at an 
Organization Level. In the Regime you has to provide VAT Registration Number 
and Accounts associated with the Regime such as Liability and Interim Liability 
accounts for the Taxes and assign Organizations to it. For further information, see: 
Define VAT Regime, page 1-24

• Define VAT Claim Terms: VAT taxes applicable to a purchase of Capital Goods 
can be recovered over a period of time as specified under the VAT Act. The VAT 
Claim terms enables you to define VAT Recovery Term. These terms can be 
assigned to the VAT Item Classes.

• Define VAT Generation Sequence: VAT Invoice sequence can be defined for an 
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Order/Invoice Type. You can also specify prefixes for each series. A default series 
would be defined automatically for the regime. This would be applicable to the 
Transaction Types to which no series has been defined.

• Define User Authorization for IL iProcurement Access: This step has to be carried 
out by the System Administrators. Profile options 'IL: Access iProcurement Tax 
information' and 'IL: Allow iProcurement RTV CENVAT Process' need to be 
selected with values of 'YES' or 'NO' based on the authorization levels of the 
iProcurement users. You will be allowed to modify taxes or claim CENVAT 
through iProcurement only if you have these profile option values set to 'YES'.

Processing iProcurement Transactions

User Authorizations
A new profile name specific to iProcurement for India taxes is added to System Profile 
Values to restrict tax modification and entry. Authority to modify taxes in iProcurement
is controlled by 'JAIN:Access iProcurement Tax information'. The default value for this 
profile is set to 'NO' implying No Access to modify India taxes during the iProcurement
process flows. System Administrators should set the profile to each iProcurement user 
with appropriate values to ensure the proper user authorization levels.

iProcurement Transaction Flow
Oracle iProcurement module handles limited functions of procure to pay cycle. You 
have to switch between the forms and the self-service applications (SSWA) to complete 
the procurement function. You should note that any changes made in the India taxes 
either in Forms or SSWA would get reflected in the other immediately.

The iProcurement process flow:

1. Purchase Requisitions in SSWA

2. Auto Create Purchase Order in forms

3. Approve the Purchase Order in forms

4. Receipts or correction in SSWA

5. Apply BOE in forms or Accounting in SSWA

6. If you applied BOE, proceed to claim CENVAT in forms. If you chose accounting, 
proceed to update item cost for NR taxes

7. After claiming CENVAT, make register or accounting updates in forms
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8. Claim VAT

9. Make accounting or repository update

10. Proceed to Returns

Requisitions
Oracle iProcurement provides following functionality in requisitions:

• Reviewing Requisitions

• Creation of Requisition – Searching and adding items (from local or supplier 
catalogs) to the shopping cart can create Requisitions. On checking out, system 
creates a requisition using the items added to the shopping cart.

• Cancellation or Changing existing Requisition

Requisition Review
In the Requisition Review flow, India Localization tax button or links are made 
available in the following pages for authorized users against individual Requisition 
lines:

• My Requisitions page: Navigate to Indial Local iProcrement > Shops > Stores.

• Requisitions Summary page: Navigate to India Local iProcurement > Requisitions > 
Requisitions.

• Requisitions Lines page: Navigate to India Local iProcurement > Requisitions > Drill
Down on Requisition Number.

Clicking these links, will display the India Localization Taxes for Requisitions page with
the corresponding tax details.

Note: In the Requisition Review flow, tax details page will be displayed
in View Only mode.

Requisition Creation
In the requisition creation flow, India Localization Taxes can be added during the check 
out process in the Checkout: Requisition Information page. Navigate to India Local 
iProcurement > Shop > Stores > Checkout: Requisition information. Click View/Update 
India taxes to navigate to the Oracle Financials for India Tax details page. India 
Localization Taxes page lets you add India Taxes with desired precedence for 
calculation. Taxes are defaulted automatically when Item or Tax categories are mapped 
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to the Supplier, Supplier Site or Item Class. Apart from the defaulted taxes, you can add
new tax lines through Add New Tax. You can also option to delete a particular tax line 
that is not required. Provision to modify the defaulted taxes is available only to 
Authorized Users.

Note: Authority to modify taxes is based on the User Profile Options 
assigned to you. For more details on User Profile Options refer User 
Authorization, page 9-6.

Whenever India Local Taxes are applicable, Taxable field should 
always be set to 'NO' in the Billing section of Requisition Information 
page.

India Localization taxes can also be viewed and edited in the Checkout: Review 
Approver List' page during the Checkout process. Navigate to India Local iProcurement
> Shop > Stores > Checkout: Review Approver List.

Requisition Review and Submit
In the 'Checkout: Review and Submit Requisition' page during the Checkout flow, 
Localization taxes are displayed against each line item of the requisition with a facility 
to drill down to the detailed view. Taxes can be modified at this stage also depending 
on your user authorization. No further modifications are allowed on completion of 
Requisition checkout as the status is updated to 'Approved'. However you can view 
India tax amounts and the Tax details in the Requisitions Lines page. Total India tax 
amount is displayed for each requisition line in the Printable Page provided in 
'Checkout: Review and Submit Requisition'. Navigate to India Local iProcurement > 
Shop > Stores > Checkout: Review and Submit Requisition.

Requisition Change or Cancellation
Oracle iProcurement provides facility to Change or Cancel the approved Requisitions. 
When Requisitions quantities are changed in iProcurement, all India Taxes get 
recalculated based on the revised quantity automatically. In case of Cancellation of 
Requisitions, India Taxes attached to the cancelled requisition are also cancelled 
simultaneously.

Purchase Orders
Purchase Orders can be auto-created based on the Purchase Requisitions created in 
iProcurement. The Taxes provided in the Requisition gets defaulted to the Purchase 
order automatically. You can modify these taxes using the IL Purchase Order form.

Viewing Purchase Order Details
Navigate to India Local iProcurement > Requisitions > Requisition Summary - Order 
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Link. Oracle iProcurement provides links to view details of Purchase Orders created 
using iProcurement Requisition Summary page. India Localization tax links are also 
made available in the Purchase Order details page. India Localization tax amount and 
details will be displayed in a view only mode for each purchase order line in this link 
page. You can navigate to the Purchase Order India Tax details page by clicking these 
links available in the Requisition summary page.

Purchase Order Change Requests
Navigate to India Local iProcurement > Requisitions > Requisition Summary > Change 
Requisition. Changes can be made to Requisitions on approving the Purchase Order 
created by submitting an iProcurement Requisition Change Request. The Change 
Request page accepts the modifications made by you and highlights the changes by 
indicating both Original and Changed values before Submission. In case of multiple 
changes, all modifications made to the requisition are displayed with appropriate icons 
to identify the last updated values.

Approving Purchase Order Changes
Navigate to India Local iProcurement > Requisitions > Notifications > Open Change 
Requisition Notification. Authorized Approver can Approve, Reject or Reassign the 
submitted Change Request by opening the appropriate Notification.

On Approval, all changes made to the Requisition are effected to the PO automatically. 
Existing India Localization functionality ensures that corresponding changes are done 
to related tax lines based on the changes affected to the Requisition.

On Rejection, changes made to the Requisition are deleted without affecting the 
Purchase Order details. Original Taxes that were calculated remain unaffected.

Receiving
Oracle iProcurement has following functionality in receiving:

• Create receipts – Users can create receipts against orders in Oracle iProcurement. 
For an order to appear in the receiving module it must have a receipt routing of 
Direct Delivery (cannot create receipts against orders with a receipt routing of 
Standard or Inspection). It is also possible to receive against In transit Shipments 
(ASN shipments and ISO receipts).

• Create Returns

• Perform Corrections

Receipts Creation
Navigate to India Local iProcurement > Receiving > Requisition to Receive > Receive. In 
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the iProcurement receipt process flow, India tax entry or update interface will be 
available to you, depending on your User Authorization, after the base item receiving 
details are entered and the receipt process is completed. India taxes can be viewed or 
updated using View/Update India taxes link available against each receipt line on 
confirming a base iProcurement receipt. Similar to Requisitions, Taxes are defaulted 
automatically based on the India Tax Defaulting Hierarchy – from Purchase Order as in 
the case of normal receipts created using the form-based functionality.

Navigate to India Local iProcurement > Receiving > Requisition to Receive > View/ 
Update India Tax to open the India Tax page. You can add new tax lines and delete the 
defaulted taxes when not relevant. This page allows only Authorized Users to do 
receipt tax modification, particularly to add third party taxes, Supplier Name and 
Supplier Site depending on Organization level parameter Allow Tax change on Receipts
and User Authorization. It also facilitates modification of tax precedence.

On completion of modification, the taxes can be recalculated and saved. Changed made 
to the India taxes can also be ignored when not necessary. This action should however 
be done before saving the changes. On Completion of the Receipt, accounting entries 
and costing for all non-recoverable taxes gets effected through India Local concurrent 
program 'India Receiving Transaction Processor' which is automatically launched on 
completion of the above mentioned web process.

Note: You must note the following in case of an iProcurement Receipt:

• CENVAT and VAT Claim need to be done using the existing India 
Localization forms as per the existing IL processes.

• BOE application process needs to be done separately in the BOE 
application form available in IL Receipts after the receipt is created 
in the iProcurement Web process.

Advanced Shipping Notice and Advanced Shipping Billing Notice
Oracle iProcurement supports Receiving based on ASN/ASBN created from the 
iSupplier portal. Navigate to India Local iProcurement > Receive Items. You can receive 
items referring the ASN/ASBN Shipment Number created by the supplier in the 
supplier portal. The shipment number is defaulted against the Order with a facility to 
view the ASN/ASBN details.

If the ASBN is created using the India Localization iSupplier solution, India 
Localization taxes can be assigned to the ASBN. When receipt is created in 
iProcurement using such an ASBN number, taxes attached to the ASBN are defaulted to
the receipt instead of directly from the Purchase Order.

Note: You should note the following in case of ASN / ASBN receipts
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• The referred ASN/ASBN should be in 'PROCESSED' status in 
iSupplier. To make a receipt of the ASN/ASBN in India Local 
iProcurement you should run the 'RECEIVING TRANSACTION 
PROCESSOR' concurrent in Forms.

• Taxes defaulted from the ASBN cannot be modified at the 
iProcurement Receipt. Further only third party or customs type of 
taxes can be added to an ASBN receipt.

• India Localization does not currently support creation of multiple 
Receipts against a single ASN/ASBN.

Receipt Corrections
iProcurement provides the functionality of receipt corrections in the Receiving home 
page. You can select "Correct Items" and proceed to correct an existing receipt. The 
existing India Localization process of running the concurrent "India Receiving 
Transaction Processor " after Receipt corrections is also applicable to iProcurement 
Receipt Corrections. You can run this concurrent using the IL Requests form after 
making necessary Receipt corrections. The concurrent will make the necessary 
modifications to the India Localization registers, accounting and costing records based 
on the receipt corrections done in iProcurement.

Returns
Navigate to India Local iProcurement > Receiving > Returns > Return Confirmation. 
iProcurement provides the functionality of receipt returns in the Receiving home page. 
You can select "Return Items" and proceed to return quantities of an existing receipt to 
the Supplier. Returns processing of India Localization Excise / VAT taxes must be done 
using the Return to Vendor (India) form by querying the concerned receipt.

Reports
India Localization support for iProcurement do not involve any additional reports at 
the iProcurement solution. Existing India Localization reports available in the form 
based functionality need to be used for all reporting purposes.
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10
India Local iSupplier

This chapter covers the following topics:

• iSupplier Overview

• Setting Up iSupplier

• Processing iSupplier Transactions

• Buyer Actions

iSupplier Overview
Oracle iSupplier (Supplier View) enables Suppliers to have real-time access to 
information (such as purchase orders and delivery schedules) and respond to the 
buying company with order acknowledgments, change requests, shipment notices, 
invoices and planning details. The major functions supported in this process are:

• Reviewing Supplier Agreements and Releases, Request for Quotations (RFQ)

• Viewing, Printing and Acknowledging Purchase Orders, Submitting Change Order 
Requests

• Viewing Shipments, Entering Advance Shipment Notice (ASN) / Advance 
Shipment and Billing Notice (ASBN)

• Viewing Receipts and Returns

• Viewing and initiating Invoices

• Supplier Profile Management

• Reviewing Planning and Inventory Information
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Major Features
Ability for review of Purchase Agreements and Releases, RFQs

Oracle iSupplier provides facility to review the existing Purchase Agreements and 
corresponding releases. It also provides the facility to review any Request for 
Quotations from the buying company. India Localization taxes associated with the 
Purchase Agreement, Releases, RFQs etc. are displayed along with base document 
details on the iSupplier pages.

• In the Supplier Agreements Summary page, India Localization tax amounts 
released are displayed along with the base amounts released.

• In Blanket Agreement Details page that opens on drilling down from an Agreement
number, India Localization taxes (without amounts) are displayed for the Price 
Breaks defined for the Blanket Agreement.

• In the Blanket Agreement Details page that opens on drilling down from an 
agreement, India Localization Tax Amounts are displayed along with the base 
amounts for each Blanket Release or related Standard Purchase Order (in case of a 
Global Blanket Agreement).

• Blanket Release/ Receipt/ Invoice Tax amounts are displayed along with base 
amounts in the Summary block in the Blanket Release details page that open up on 
drilling down from a Blanket Release number.

• Tax details are displayed in a view only mode for each blanket release line in the 
Blanket Release details page that opens up on drilling down from a Blanket Release 
number.

• India Localization Tax Amounts are displayed in the Receipts, Invoices and 
Payment details pages that open up from the Blanket Release 'Related Information' 
links.

• Cancellation and Change requests from Blanket release impacts India Localization 
taxes as in the case of Purchase Orders. Similarly Printable View displays PO report
for the blanket Agreement / Release with India Localization tax amount.

Viewing, Acknowledging and Printing Purchase Orders, Initiating Change Requests

• India Localization Tax Amount is displayed along with base amount in the 
Purchase Order Summary page. Tax details are displayed in a view only mode for 
each Purchase Order line in the Purchase Order details page that opens up on 
drilling down from a Purchase Order Number.

• Purchase Order/ Receipt/ Invoice Tax amounts are displayed along with base 
amounts in the Summary block in the Purchase Order details page.



India Local iSupplier    10-3

• PO Shipment level tax details are also displayed in the Purchase Order details page.

• India Localization Tax Amount and details are displayed in the Receipts, Invoices 
and Payment details pages that open up from the Purchase Order 'Related 
Information' links.

• Tax details are displayed in a view only mode for each Purchase Order line in the 
Request Cancellation page that opens when you click Request Cancellation. On 
approval of the cancellation of the line or order initiated from iSupplier, related 
India Localization tax lines are also cancelled.

• Tax details are displayed in a view only mode for each purchase order line in the 
Request Changes page that opens up on pressing the 'Request Changes' button. On 
approval of the changes (Quantity or Price change, Shipment splitting etc.) initiated 
from iSupplier, related India Localization tax lines are also changed accordingly.

Shipments

In India Localization context, Suppliers shall be providing Excise / VAT Invoice 
Number, Excise /VAT Invoice Date while creating ASNs/ASBNs through iSupplier 
portal. This information is vital for India Localization receipt processing and the Buying
Company may require that when receipts are created out of these ASNs/ASBNs, the 
Excise/VAT details be automatically populated to the relevant India Localization tables 
without having to re-enter these details. Suppliers also has an option of adding or 
modifying tax information while creating ASBNs through iSupplier portal. This 
information is vital for India Localization receipt processing and the buying company 
may require that when receipts are created out of these ASBNs, the tax details be 
automatically populated to the relevant India Localization tables without having to 
re-enter these details. This involves overriding the taxes specified at the PO level.

Create Advanced Shipment Notice (ASN) page

• Additional fields are provided in the iSupplier 'Create ASN Shipment Header' page
to capture the Excise Invoice, Excise Invoice Date details

• On submitting the ASN, these details are interfaced to Purchasing to make it 
automatically available in the Receipt DFF.

Create Advanced Shipment Billing Notice (ASBN) page

• Additional fields are provided in the iSupplier 'Create ASBN Shipment Header' 
page to capture the Excise Invoice, Excise Invoice Date details

• On submitting the ASBN, these details are interfaced to Purchasing to make it 
automatically available in the Receipt DFF.

• Additionally, a feature is made available at ASBN level (in the ASBN Shipment 
lines page) to view the India Localization taxes (defaulted from Purchase Order), 
add, modify and delete the first party taxes (taxes pertaining to the Supplier) by the 
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Supplier User. On submitting the ASBN, these taxes are automatically defaulted to 
the Receipts and Invoices created from the ASBN. No further modification is 
allowed to these taxes at the Receipt or Invoice level. Third Party taxes, mentioned 
in the PO if any , shall be defaulted to the ASBN in a view only mode.

View / Cancel ASN / ASBN page

• India Localization Excise Invoice details are available for viewing when Supplier 
user is viewing an ASN or ASBN. Tax details are displayed while viewing an 
ASBN.

• India Localization taxes are cancelled when an ASN or ASBN is cancelled. However
the taxes can still be viewed in a read only mode for cancelled ASBNs, though these
taxes shall not be available for any receipts / invoices created for the Purchase 
Order.

Receipts

Receipts and Returns can be viewed from iSupplier. The Supplier user will be able to 
see India taxes to be part of the Receipt while viewing the receipts. India Localization 
tax amount and details are displayed in the Receipt details page that opens on drilling 
down from the Receipt Number.

In the form based India Localization receipt functionality, tax defaulting is provided on 
the receipts created from ASBN. No modification is allowed to ASBN taxes at the 
receipt level. If ASBN has a Third party tax, it shall be modifiable to the extent of 
Vendor and Vendor Site fields in the Receipt form. However new Third party taxes can 
be added while creating a Receipt from an ASBN.

Invoices

Invoices initiated from the iSupplier are interfaced to Payables through the Payables 
Open Interface Import process. India Localization taxes get defaulted from the Purchase
Order for such invoices imported from iSupplier.

India Localization taxes are included in the Invoices / Payment amounts displayed in 
the Invoice / Payment Summary pages.

In the form based India Localization functionality, invoice level tax defaults from PO to 
PO Matched Invoices, from Receipt to Receipt Matched Invoice and from ASBN for 
invoices created from ASBN.

Setting Up iSupplier

Define Organization Additional Information
Identify and Define Inventory Organizations and Locations that would be reporting to 
the Tax Authorities. The information defined at this level would be the basis for 
Recording, Reporting and Accounting of the local taxes. Apart from this you would also
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define the Organization Registration details with Excise, Customs, Sales Tax and TDS 
authorities. This information available in Additional Organization Information is the 
basic data for all India Localization activities. The Organization and Locations defined 
through Common Application would be available for setup. While creating the 
Additional Organization Information, it is mandatory to create two sets of records, one 
at Null Location level and another with Location. The master child relationship among 
the Organization and Location would be used only for consolidation of Excise Registers 
at Master Organization Level. For further information, see: Defining Organization 
Additional Information, page 1-4.

Define Organization Trading Information
You would enter the information of the Organizations registered under the Central 
Excise Rules as a Dealer/Depot. Navigate to Trading Information Tab of the Additional 
Organization Information to enter Excise Registration details of a Dealer. The 
information entered here would be printed on all relevant reports and invoices raised 
from this Organization. You would ensure that no values are entered in any of the fields
falling under the Excise region of the Tax Information tab of the Additional 
Organization Information. Any value entered in this region would categorize this 
Organization as a Manufacturing Organization. For further information, see: Defining 
Trading Registration Details, page 1-8.

Define Excise Invoice Generation
This feature can be used to automate the Excise Invoice document sequence generation. 
You can setup a document sequence for the combination of Transaction Type, Order / 
Invoice Type and Register Type. You can define an alpha / alphanumeric value which 
would be prefixed to the number series generated for each Excise Invoice. The setup 
would be restricted to the Order / Invoice Types for which it is created. For all other 
Excise Invoices which are created using Order / Invoice Types for which setup has not 
been made, the system use the default number series. This would be a numeric series, 
starting with one, increased by one. The sequence would be different for each 
Organization / Location and the nature of clearance. Within the Organization, the 
sequence would be different for the Domestic clearances and Export Clearances. For 
further information, see: Defining Excise Invoice Generation, page 1-19.

Define Sub Inventory Location
As a part of Localization setup, sub-inventories have to be associated to a combination 
of Organization/Location. Excise related transactions and records would be updated 
only for those sub Inventories that are identified as bonded for Manufacturing 
Organizations and as traded for Trading Organizations. For further information, see: 
Defining Sub Inventory Location, page 1-23.
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Define Localization Item Information
The recording, recoverability and reporting of Localization Taxes would depend on 
India Localization related information setup for the Item. These values have to be 
entered in 'India Localization' context of the Items DFF, attached to the Item Master. 
Excise Registers would be updated only when the Excise Flag is set to 'YES'. Similarly, 
considering CENVAT Credit and updating the Excise Registers for a Receiving 
transaction would happen only when the 'MODVAT' flag is set to 'Yes'. The option 
chosen in the Item Class attribute would be the basis on which the type of Excise Credit 
Register that has to be hit. Items classified in the other classes (such as OTIN, OTEX) 
would not be updating Excise Records. The Trading Flag would work together with the 
Organization Trading Information setup. RG23D Register would be hit only when the 
Trading item is transacted in a trading Organization. For further information, see: 
Defining Item Information, page 1-66, India Local Inventory Chapter.

Define Tax Codes
The Tax Definition is a localization feature to define taxes that are applicable to the 
transactions created in your Organization. The Taxes can be classified in different 
Types. The Type would be useful to recognize the relevance of the tax for the Excise 
Registers, Sales Tax Form generation and TDS Certificate generation. The Type chosen 
would also have influence over the behavior of other fields in this form. You can specify
the Tax Rate, Surcharge, Recoverability, Rounding Rule, Expense Account Code, Tax 
(Third party) Vendor, Multi-currency and Effective Period for the Tax. In a 
multi-organization setup, Taxes would be specific to an Organization. On choosing the 
Taxes Localized option from the menu, you would get the list of Inventory 
Organizations, to choose from. The tax defined can be used only for the Organization 
for which it is defined. Taxes once saved cannot be updated.

Define Tax Categories
If you can identify your purchase and sales transactions into clear categories for which a
similar set of taxes with similar precedence and calculation are applicable, then you can 
group such taxes into a Tax Category. In a Tax Category you can choose the Taxes along
with the precedence order and calculation basis. An Item Class can be identified for a 
Tax Category. These taxes would default for all the Items falling in this class. This 
would be useful, where the Item class drives the tax applicability. These taxes would 
default for the transactions created for the items in the item class. You can however, 
manually add new tax lines and can change, delete, change precedence for the 
defaulted lines. For further information, see: Defining Tax Categories, page 1-89.

Define Item Categories
Item Category allows you to assign Tax Categories to an inventory item in an 
Organization. You can attach an Item Category to the Additional Internal Customer 
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information. The Taxes defaulted for a transaction line would be based on the Item 
Category attached to the Internal Customer and the Tax Category assigned to the Item 
in this category. For further information, see: Defining Item Category List, page 1-57.

Define Assessable Price Lists
When the Taxable basis for the calculation of the Excise Duty is different from the Price 
at which the Item is transferred, then you will have to create additional Price Lists with 
the Item Excise Assessable Price. This price list has to be attached to the Internal 
Customer / Customer Site. The Assessable Price would be considered only for 
calculation of the Excise Duty. Assessable Price Lists needs to be defined separately for 
Excise and VAT if the taxable basis is different.

Define VAT Regime
Regime would be used to define rules that would be applicable to all Taxes assigned to 
it. You need to complete this setup step before you move ahead with other setups. 
Setups made for a Regime would be applicable to all transactions created from the 
Organizations assigned to it. Information defined here would be generic unless you 
assign different properties at an Organization Level. In the Regime you have to provide 
VAT Registration Number and Accounts associated with the Regime such as Liability 
and Interim Liability accounts for the Taxes and assign Organizations to it. For further 
information, see: Define VAT Regime, page 1-24.

Define VAT Claim Terms
VAT taxes applicable to a purchase of Capital Goods can be recovered over a period of 
time as specified under the VAT Act. The VAT Claim terms enable you to define VAT 
Recovery Term. These terms can be assigned to the VAT Item Classes.

Define VAT Generation Sequence
VAT Invoice sequence can be defined for an Order/Invoice Type. You can also specify 
prefixes for each series. A default series would be defined automatically for the regime. 
This would be applicable to the Transaction Types to which no series has been defined.

Define Supplier Additional Information
Before you start creating transactions for the Supplier, it is required to record the 
localization related information for the Supplier Site. You would enter the Supplier 
Registration details with the Excise, Sales Tax and Income Tax Authorities. You will 
also attach the Assessable Price list that should be considered for the calculation of 
Excise Duty & VAT. You would also define the Item Category list to default localization
taxes. You will have to make this setup for each Supplier Site.
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Processing iSupplier Transactions
In the iSupplier Portal of the Supplier View you can view documents created by the 
Buyer, Accept the Documents and also make request for change in Delivery Schedules, 
Rate and Quantity etc. iSupplier View provides the following features:

• Reviewing Supplier Agreements and Releases, Request for Quotations (RFQ)

• Viewing, Printing and Acknowledging Purchase Orders, Submitting Change Order 
Requests

• Entering ASN / ASBN & Viewing Shipments

• Viewing Receipts and Returns

• Viewing Invoices and Payments

Request for Quotation (RFQ)
You can view the Requests for Quotation (RFQ) in which your organization is included 
as a Supplier. India Localization tax details (indicative taxes) can be viewed in the RFQ 
Details page in the iSupplier portal. Navigate to iSupplier > Orders > RFQ > Go. 
Clicking View India Taxes displays India Localization Taxes for each RFQ.

Blanket Purchase Agreements
In the iSupplier Portal, you can view blanket Purchase Agreements (BPA) created by 
the Buyer. In the iSupplier Portal, you can also make requests for change of the Rate, 
Quantity, Change the Delivery Schedule and Accept the BPA. After making such a 
request, document will be shown in Pending Status till the changes are accepted or 
rejected by the Buyer. India Localization taxes associated with the Purchase Agreement,
Releases. are displayed along with base document details on the iSupplier pages.

• In the Supplier Agreements Summary page, India Localization tax amounts 
released are displayed along with the base amounts released.

• In Blanket Agreement Details page that opens on drilling down from an Agreement
number, India Localization taxes (without amounts) are displayed for the Price 
Breaks defined for the Blanket Agreement.

• In the Blanket Agreement Details page that opens on drilling down from an 
agreement, India Localization Tax Amounts are displayed along with the base 
amounts for each Blanket Release or related Standard Purchase Order (in case of a 
Global Blanket Agreement).

• Tax details are displayed in a view only mode for each blanket release line in the 
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Blanket Release details page that opens up on drilling down from a Blanket Release 
number.

• India Localization Tax Amounts are displayed in the Receipts, Invoices and 
Payment details pages that open up from the Blanket Release 'Related Information' 
links.

• Cancellation and Change requests from Blanket release impacts India Localization 
taxes as in the case of Purchase Orders. Similarly Printable View displays PO report
for the blanket Agreement / Release with India Localization tax amount.

Navigate to iSupplier > Orders > BPA > PO Number. Clicking Taxes link will take you 
to the details of the taxes.

Standard Purchase Orders
In the iSupplier Portal, you can view and acknowledge the orders, request change of the
Orders / cancellation of orders. Your requests for Cancellation or Changes related to the 
Orders have to be Accepted / Rejected by the Buyer for the changes to be effective India 
Localization iSupplier support provides an additional Column of 'Tax Amount' to 
enable you to view the tax details associated with the Purchase Order. The major 
features in India Localization context are:

• India Localization Tax Amount is displayed along with base amount in the 
Purchase Order Summary page. Tax details are displayed in a view only mode for 
each Purchase Order line in the Purchase Order details page that opens up on 
drilling down from a Purchase Order Number.

• PO Shipment level tax details are also displayed in the Purchase Order details page.

• India Localization Tax Amount and details are displayed in the Receipts, Invoices 
and Payment details pages that open up from the Purchase Order 'Related 
Information' links.

• Tax details are displayed in a view only mode for each Purchase Order line in the 
Request Cancellation page. On approval of the cancellation of the line or order 
initiated from iSupplier related India Localization tax lines are also cancelled.

• Tax details are displayed in a view only mode for each purchase order line in the 
Request Changes page that opens up on pressing the 'Request Changes' button. On 
approval of the changes (Quantity or Price change, Shipment splitting etc) initiated 
from iSupplier, related India Localization tax lines are also changed accordingly.

Advance Shipment Notice
An Advance Shipment Notice (ASN) is a notice to the Receiving Organization that a 
shipment is coming. The ASN contains details including shipment date, time, and 
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identification number; packing slip data; freight information; item detail including 
cumulative received quantities; country of origin; purchase order number; and 
returnable container information.

Once you create an ASN in the iSupplier portal, the Buyer gets a notification about the 
shipment being arrived. Buyer has to execute the 'Receiving Transaction Processor' 
concurrent program to import the ASN details into the receiving tables.

After you have entered the ASN Header and Lines details and submitted it for 
processing, iSupplier show the Advance Shipment Notice Confirmation page. 
Navigation Path: iSupplier -> Shipments -> Shipment Notices ->Create Advance 
Shipment Notice -> Shipment Header - > View / Update IL Info. India Localization 
iSupplier Support provides you a button to View / Update the IL Information on the 
ASN. The Excise details like the Excise Invoice Number and Excise Invoice Date can be 
entered and saved by clicking this button.

After entering the Excise Details, if any, for the Shipment, click on Apply Changes to 
save the data on the View / Update India Tax Page and then click on Continue to 
complete the Transaction. The Excise Invoice Number and Excise Invoice Date entered 
on this page will default on to the 'Excise Invoice Number' and 'Excise Invoice Date' 
fields in the 'Receipt Localized' form, when Buyer creates the Receipts against this 
ASBN

The View / Cancel Advance Shipment Notices Page displays all information pertaining 
to the shipments that have been carried out along with the Status of the Shipment.

You have the option to go back to the Shipment creation process without pressing the 
'Continue' button. In such an event the ASN will be in a status 'Partially processed' and 
it will not be interfaced to the Receiving transaction interface and hence will not be 
available for receiving. You can query the ASN again using the 'View / Cancel Advance 
Shipment and Billing Notices' page, click on the 'View /Update IL Info', update the 
Excise details, if required and press the 'Continue' button to Complete the ASN process.
After completion of the process, ASN gets the 'Pending' status and is ready for 
interfacing into receiving tables After the Shipment is interfaced, the status is shown as 
blank in the Processing Status Column.

Advance Shipment Billing Notice
ASN containing Invoice and Tax information along with shipping information is an 
Advance Shipment Billing Notice (ASBN). Additional details available on ASBN are 
Invoice Number, Invoice Amount, Invoice Date, Payment Terms, Freight Amount, 
Currency, Tax Amount, and Remit To Site etc. An ASBN created in the iSupplier portal 
creates an invoice in the buyer's payables system.

You can enter an Advance Shipment cum Billing Notice, with the tax information. The 
taxes entered in the ASBN will be defaulted on to the Receipt and the Invoice created 
using the ASBN. The Taxes that have been defaulted from the ASBN cannot be 
modified or new first party taxes added on the receipt. Only new Third Party taxes can 
be added on such Receipts.
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While Creating the ASBN, you will enter the Shipment Number, Shipment Date, 
Invoice Number etc. in the Shipment Header Page and the Quantity being shipped in 
the Shipment lines page.

On submitting the ASBN Pages, the ASBN will be created and you will be taken to the 
Advance Shipment Notice Confirmation page.

India Localization iSupplier support provides a new button viz. 'View / Update IL Info' 
in this page. On clicking on the button will take you to the View / Update India Tax 
Page, where you can enter the Excise Invoice Number and Date if the shipment has 
Excise Type of Taxes.

The Excise Invoice Number and Excise Invoice Date entered on this page will default on
the India Receipt DFF when Buyer creates the Receipts against this ASBN. You can also 
modify the Taxes defaulted from the Purchase Order or add new taxes, if required. 
Please note that the taxes specified by you are the final taxes and the same cannot be 
modified at the time of Receipt by the Buyer. If the PO has any third party taxes, they 
shall also be defaulted to the ASBN page, but they can only be viewed here – no 
modification / deletion is allowed for such taxes. After the changes are done, you need 
to press the 'Apply Changes' button to save the changes. ('Ignore Changes' button shall 
clear all the changes done) You need to press the 'Complete' button to complete the 
process and make the ASBN available for interfacing into Receiving Tables.

You have the option to go back to the Shipment creation process without pressing the 
'Complete' button. In such an event the ASBN will be in a status 'Partially processed' 
and it will not be interfaced to the Receiving transaction interface and hence will not be 
available for receiving. You can query the ASBN again using the 'View / Cancel 
Advance Shipment and Billing Notices' page, click on the 'View /Update IL Info', 
update the Excise details, if required and press the 'Complete' button to complete the 
ASBN process. After completion of the process, ASBN gets the 'Pending' status and is 
ready for interfacing into receiving tables After the Shipment is interfaced, the status is 
shown as blank in the Processing Status Column.

Viewing ASN / ASBN Information
Shipments created though ASN / ASBN can be viewed by you in the Supplier View. 
Clicking on the Shipment Number link in the Shipment Number Column will take you 
to the specific Advance Shipment Notice Page. India Localization iSupplier Support 
provides button viz. 'View / Update IL Info' on the View / Cancel Advance Shipment 
Notice Page. Clicking on button will take you to the View / Update India Tax Page. 
Clicking on the Continue Button will take you back to the View / Cancel Advance 
Shipment Notice Page. For Viewing the ASBN shipments, the process is the same but 
when you click on the View / Update IL Info, along with the Excise Invoice Details, the 
page will also show the Tax lines associated with ASBN. The page displayed here is in a
view-only mode unless the ASN / ASBN has the status of 'Partially Processed' 
indicating that the India Localization ASN / ASBN process is not completed yet. In such
a case, the page will open in an editable mode and the process can be completed by 
pressing the appropriate buttons (as mentioned in earlier sections on ASN / ASBN). The
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taxes displayed here are in View-Only Mode, if the ASBN is in a Pending / Blank status.

Viewing Receipts and Returns
iSupplier has following functionality in Receipts and Returns:

• View the Receiving and Returns information

• View the Quality (Inspection) information

Receipts and returns can be viewed from iSupplier. You can view India taxes also while 
viewing the receipts. India Localization tax amount and details will be displayed in the 
Receipt details page that opens on drilling down from the Receipt Number.

Navigate to iSupplier > Shipments > Receipts. On the Receipts Summary page, if the 
Receipt has India taxes, the Tax Total will appear in the Tax Amount column as a link 
against the Receipt. Clicking on the Tax Amount Link takes to the detail page showing 
the taxes pertaining to the Receipt.

Alternatively, you can also click on the Receipt Number on the Receipts Summary Page 
of the iSupplier portal of the Supplier View.

Click View India Tax to view the detail tax lines of the receipt. In case of returns by the 
vendor to the supplier, you can view the same information against the receipt for which
the buyer has made the returns.

Note: No India Localization tax information is provided on the Returns 
page as the same taxes on receipt are reversed during the return 
process.

Viewing Invoices and Payments
You can view the invoices created by the Buyer in the iSupplier Portal along with 
Indian Taxes on the Invoices Page. Navigate to iSupplier > Account > View Invoices.

You can also view the payments made against an invoice through the iSupplier Portal. 
On the Invoices summary page along with the Invoices, the Payment details are also 
displayed. If the payment has been made, the Check Number / Payment Document 
Number will appear in the Payment Number column. Drilling down the Payment 
Number on the Invoice Summary page will take you to the Payment Details Page. The 
amount paid here displays the India Taxes also.

Buyer Actions
As a Buying Company user, you can view order, receipt, invoice, and payment 
information using the Internal User View responsibility in Oracle iSupplier. You can 
also search for information across all suppliers, as well as respond to supplier change 
requests. Features include:
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• Viewing Purchase Order and Purchase Agreement Information

• Viewing Purchase Order Acknowledgements and Change Requests, acting on these
requests

• Viewing Shipment (ASN) and Receipts Information

• Viewing Account (Invoices and Payments) Information

Buying Company view is basically providing a web interface for viewing the 
Procure-to-Pay information. As you have access to the internal Oracle Applications and 
India Localization features, normal India Localization functions (form based) may be 
used for viewing of India Localization tax information on PO or Receipts or Invoices. 
Hence no support is currently provided for this feature of iSupplier portal.

Receipts from ASN / ASBN
After the Supplier creates the ASN /ASBN, you will receive an intimation of the same 
along with the expected date of arrival. On the receipt of the Shipment, you will make a 
receipt as in the normal P2P cycle. Before creation of a Receipt, you have to run the 
concurrent "Receiving Transaction Processor" for interfacing the ASN /ASBN

Create a receipt by navigating from the Receipt Localized form and click New, query 
the ASBN number in the Find Receipts form, and complete the Receipt header and line 
details. After the receipt is created, come back to the Receipt Localized window and in 
the Receipt Header section and Receipt Lines, Excise Invoice Number and Excise 
Invoice Date will be defaulted from the ASBN, if these details are filled in the ASBN.

From here on the process of making of the Receipt and Creation of the Invoice in 
Payables and making payments to the Supplier will follow the normal course of the P2P
cycle.

For an ASN receipt, Taxes get defaulted from the Purchase Order to the Receipt and all 
the taxes can be modified, new Supplier Taxes or Third Party Taxes added (provided 
the Organization level parameter 'Allow Tax Change on Receipt' is set to YES for the 
Organization /Location combination).

For ASBN Receipts, the defaulting shall be from the ASBN (Supplier specified taxes) 
and no further addition / modification can be done to the Supplier specified taxes. Only 
Third party taxes are allowed to be added to the ASBN receipt. If the ASBN has a Third 
party tax (defaulted from PO, nonupdateable in ASBN by Supplier), the same shall be 
defaulted to ASBN receipt – however such taxes also can not be modified except for 
changing the Vendor name or Vendor Site fields on the receipt. Please note here that the
ASBN Invoice is created independent of the receipt and all the ASBN Supplier taxes are 
being defaulted directly to the ASBN Invoice. Any change in the ASBN receipt to the 
ASBN specified taxes shall result in a mismatch between the Receipt and Invoice tax 
details. This is the reason behind the control mechanism in ASBN receipt.

The same control mechanism is applicable even you make an ASBN receipt using the 
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India Localization iProcurement solution (Please read the India Localization 
iProcurement solution User manual for more details).

Creating ASBN Invoice
Once the ASBN is created by the Supplier, you will get an intimation regarding the 
Invoice Number, Invoice Date, Date of Shipment, Taxes on the ASBN. In ASBN type of 
Shipments, the system will automatically create the ASBN Invoice when the 'Receiving 
Transaction Processor' is run if the Purchasing profile option 'PO: Create ASBN invoices
using AP interface tables' is set to YES at the site level. If this profile option is set to NO, 
the ASBN Invoice need to be created using the 'Payables Open Invoice Import' program 
with the Source as 'Advance Shipment Billing Notice'.

After generating the ASBN invoice, query for the Invoice Number given by the Supplier
in the Invoice form in India Local Payables Responsibility.

Navigate to India Local Payables > Oracle Payables > Invoice > Entry > Invoices > 
Query. On querying the same, the invoice will be found. You need to run the concurrent
"India – To Insert Taxes for Pay on Receipt" to load the India Local Taxes to the Invoice 
distributions.

On completion of the concurrent, Supplier taxes specified in the ASBN shall be 
defaulted to the ASBN Invoice. Normal Invoice validation / approval / payment process
can be adopted now to complete the Invoice process.


	Oracle Financials for India User Guide
	Preface
	India Local Inventory
	Miscellaneous Transactions Overview
	Inventory & WIP Transactions Overview
	Organization Information Setup
	Defining Value Added Tax Regime
	Defining TCS Regime
	Service Tax by Inventory Organization and Service Type
	Inter Organization Transfer
	Defining Item Information
	Setting Up Tax Information
	Managing India Local Inventory
	RG - I Register Entry
	RG 23 Register Entry
	Apply Time Extension
	Master Organization RG Consolidation
	View Register Balance
	View Item Definition
	Outside Processing Transaction
	Processing Inter Organization Transfer Transactions
	Reports

	India Local Purchasing
	Defining Tax Overview
	Outside Processing Transactions
	Receiving Corrections
	Mass Tax Update
	Transactions Handled
	Encumbrance Accounting
	Setting Up India Local Purchasing
	Managing Purchasing Transactions
	Receiving Corrections
	Using India - Mass Tax Update
	Receipts (Localized)
	India Localization Receipt Details
	Inquiry
	Reports

	India Local Payables
	eTDS Returns
	Bill of Entry (BOE)
	Capture Personal Ledger Account (PLA) Payment
	Tracking of Sales Tax Forms Issues
	Third Party Taxes - Additions to Fixed Assets
	Defining TCS Authority
	Setting Up India Local Payables
	Managing TDS Transactions
	Service Type Review
	BOE Invoices
	PLA Invoices/Payment
	Using Sales Tax Declaration Forms - Issue Tracking
	India - FA Mass Additions
	Define Invoice Tolerance Limits
	View / Resubmit / Delete Error Tax Lines
	Reports

	India Local Order Management
	Sales Order India Localized
	Ship Confirm India Localized
	Sales Order Returns India Localized
	AR3A Form Receipt Tracking
	Concurrents
	Setting Up India Local Order Management
	Managing Order Management Transactions
	Reports

	India Local Receivables
	Transactions (Localized) Overview
	Managing TCS Trasactions
	TCS Settlement
	Tracking of ST Forms Receipts
	AR 3A Form Receipt Tracking Overview
	RG Consolidation
	Supplementary Transactions Overview
	Duty Drawback Processing
	TDS Certificates Received Overview
	Setting Up India Local Receivables
	Setting Up Concurrent Programs
	Managing Receivables Transactions
	Using Sales Tax Declaration Forms - Receipt Tracking
	Reports

	India Local Fixed Assets
	Fixed Asset Depreciation Calculation
	Setting up India Local Fixed Assets
	Transactions
	Reports

	Trading Functionality
	Trading Functionality Overview
	Match Receipts Localized Overview
	Transactions
	Reports

	India Local Projects
	Projects Costing
	Solution Flow
	Integrating with Purchasing
	Integrating with Payables
	Integrating with Inventory

	India Local Projects Billing

	India Local iProcurement
	India Local iProcurement Overview
	Setting up India Local iProcurement
	Processing iProcurement Transactions
	Requisitions
	Purchase Orders
	Receiving
	Reports

	India Local iSupplier
	iSupplier Overview
	Setting Up iSupplier
	Processing iSupplier Transactions
	Buyer Actions



